


Anime Studio
Users Manual 

ii

Contents

Contents
Welcome� 1

Introduction� 2
Demo Limitations� 2

What’s New: New Features in Anime Studio 8� 2

Other Anime Studio Features� 4

System Requirements� 5

Getting Started� 6

License� 7
End User License Agreement and Limited Warranty� 7

Anime Studio Tutorials� 17
Drawing� 18

Tutorial 2.1: Welding� 18

Tutorial 2.2: Drawing Shapes with Holes� 29

Tutorial 2.3: Hidden Edges� 32

Tutorial 2.4: Shape Ordering� 35

Tutorial 2.5: Brushes� 40

Tutorial 2.6: Layer Masking� 45

Tutorial 2.7: Styles� 49

Tutorial 2.8: Simple 3D Construction� 55

Tutorial 2.9: 3D Shape Design� 61

Bones� 66
Tutorial 3.1: Bone Binding� 66

Tutorial 3.2: Bone Constraints� 75

Tutorial 3.3: Bone Dynamics� 85

Tutorial 3.4: Character Setup� 91

Images� 102
Tutorial 4.1: Image Layers� 102

Tutorial 4.2: Image Warping� 106

Tutorial 4.3: Animating a Talking Head� 109

Tutorial 4.4: Image Textures� 113

Animation� 123
Tutorial 5.1: Automatic Lip-Sync� 124

Tutorial 5.2: Phoneme Lip-Sync� 126

Tutorial 5.3: Animation Curves� 129

Tutorial 5.4: Sorting Layers by Depth� 133

Tutorial 5.5: Cycling� 138

Tutorial 5.6: Actions� 141

Tutorial 5.7: Frame by Frame Animation� 147

Tutorial 5.8: Creating a 3D Scene� 152

Basic Physics� 161

Effects� 168
Tutorial 6.1: Particles� 168

Tutorial 6.2: Particle Tricks - Grass and Crowds� 171



Anime Studio
Users Manual

iii

Contents

Tutorial 6.3: Using Pre-made Particle Effects� 176

Tutorial 6.4: Speeding Up Particle Effects� 180

Tutorial 6.5: Perspective Shadows� 184

Tutorial 6.6: Shadow Tricks� 191

Tutorial 6.7: Camera and Depth Effects� 195

Tutorial 6.8: Using 3D Models� 199

Tutorial 6.9: Moon and Clouds Effect� 203

Anime Studio Tools� 206
The Draw Tools� 207

Select Points� 208

Translate Points� 210

Scale Points� 213

Rotate Points� 214

Add Point� 215

Freehand� 218

Draw Shape� 220

Insert Text� 223

Scatter Brush� 224

Delete Edge� 226

Curvature� 226

Perspective Points� 228

Shear Points� 229

Bend Points� 229

Noise� 230

Fill Tools� 231
Select Shape� 231

Create Shape� 231

Paint Bucket� 233

Delete Shape� 238

Eyedropper� 239

Line Width� 239

Hide Edge� 240

Curve Exposure� 241

 Curve Exposure Tool� 241

Curve Profile� 242

Working with Fills� 245

Bone Tools� 252
Select Bone� 252

Translate Bone� 253

Scale Bone� 254

Rotate Bone� 255

Add Bone� 256

Reparent Bone� 256

Bone Strength� 257

Manipulate Bones� 258

Bind Layer� 259

Bind Points� 259



Anime Studio
Users Manual 

iv

Contents

Offset Bone� 260

Bone Physics� 260

Layer Types� 264
Enhanced Layer Alignment Features� 266

Vector Layers� 267

Image Layers� 268

Group Layers� 269

Bone Layers� 269

Switch Layers� 271

Particle Layers� 274

Note Layers� 276

Audio Layers� 277

3D Layers� 277

Patch Layers� 278

Layer Tools� 281
Translate Layer� 281

Scale Layer� 282

Rotate Layer Z� 283

Set Origin� 284

Follow Path� 285

Rotate Layer XY� 287

Shear Layer� 288

Vector Shape Selector� 289

Special Tools� 290

Poser� 290

Switch Layer� 292

Particle Layer� 292

Image Masking� 293

Video Tracking� 294

Camera and Workspace Tools� 305
Camera Tools� 305

Workspace Tools� 306

Rotate Workspace� 307

Anime Studio Windows� 309
Anime Studio’s Main Window� 310

Overview� 310

Working Area� 310

Toolbar� 311

Status Bar� 312

Playback Buttons� 312

Display Quality� 313

 Display Quality options� 313

Layers Window� 314

Overview� 314

The Layer List� 315

Layer Toolbar� 316

Layer Settings� 318



Anime Studio
Users Manual

v

Contents

General Tab� 318

Shadows Tab� 323

Motion Blur Tab� 326

Masking Tab� 327

Vectors Tab� 329

Depth Sort Tab� 330

Image Tab� 331

Switch Tab� 334

Particles Tab� 335

3D Options� 335

Note Tab� 337

Physics Tab� 338

Style Window� 339
Fill� 339

Color Picker� 346

Color Swatches� 347

Advanced Options� 348

The Library Window� 352
Displaying the Library Window� 354

Loading and Managing Items using the Library Icons� 354

Searching the Library� 362

Favorites Tab� 363

Using the Old Style Library� 364

The Character Wizard� 366

Using the Character Wizard� 366

Body Tab� 369

Face Tab� 372

Movement Tab� 375

Clothing Tab� 377

Style Tab� 378

Designing a Character and Walk Cycle� 380

Making Your Character Walk� 381

Rotating Your Character 360 Degrees� 383

Designing Your Own Actions� 386

Creating Content for the Character Wizard� 388

Other Windows� 391

Audio Recording� 391

Timeline Window� 392

Actions Window � 404

Anime Studio Menus� 411
File Menu� 412

New� 412

Open...� 412

Open Recent� 412

Close� 412

Save� 412

Save As...� 413



Anime Studio
Users Manual 

vi

Contents

Gather Media� 413

Project Settings...� 414

Import� 420

Poser Integration� 424

Import Notes and Tips� 426

Photoshop Tips� 427

Preview� 431

Exporting Movies� 431

Exporting Still Images (Anime Studio Pro only)� 438

Export OBJ� 438

Export POV� 438

Upload to YouTube� 439

Upload to Facebook®� 439

Batch Export... (Anime Studio Pro only)� 439

Quit� 440

Edit Menu� 441
Undo� 441

Redo� 441

Cut, Copy, Paste� 441

Clear� 441

Select All� 441

Select None� 441

Select Inverse� 442

Select Connected� 442

Preferences...� 442

Draw Menu� 448
Insert Text...� 448

Snap to Grid� 448

Reset Line Width� 448

Random Line Width� 448

Peak� 449

Smooth� 449

Raise Shape� 449

Lower Shape� 449

Raise to Front� 449

Lower to Back� 449

Trace Image� 449

Hide Shape� 454

Show All Shapes� 454

Reset Points� 454

Reset All Points� 454

Bone Menu� 455
Release Points� 455

Flexi-Bind Points� 455

Release Layer� 455

Flexi-Bind Layer� 455

Hide Controlled Bones� 456

Track Bone to Video� 456



Anime Studio
Users Manual

vii

Contents

Freeze Pose� 456

Reset Bone� 456

Reset All Bones� 456

Animation Menu� 457
Allow Frame Skipping� 457

Clear Animation From Layer� 457

Clear Animation From Document� 457

Reset All Layer Channels� 457

Set Layer Start Time� 458

Select All Keyframes� 458

Rescale Keyframes...� 458

Copy Current Frame...� 459

Blend Morphs� 460

Track Layer to Video� 461

Nudge Physics Object� 462

Mute Audio� 462

Restart Audio Track� 462

Audio Level� 462

Scripts Menu� 463
3D� 463

Camera� 464

Draw� 464

Image� 465

Layer Effects� 465

Other� 466

Particle Effects� 466

Script Writing� 467

Sound� 468

Visibility� 469

Warp� 469

View Menu� 470
Reset� 470

Direction� 470

Enable Grid� 470

Grid Settings� 470

Disable Grid Snapping� 470

Video Safe Zones� 471

Show Output Only� 471

Select Tracing Image� 471

Show Tracing Image� 471

Stereo� 471

Window Menu� 472

Tools� 472

Layers� 472

Timeline� 472

Style� 472

Actions� 472

Library� 472



Anime Studio
Users Manual 

viii

Contents

Audio Recording� 473

Poser Parameters� 473

Help Menu� 474
Quick Start Guide� 474

Help� 474

Open Content Library� 474

Online Tutorials� 474

Welcome Screen� 474

Register Your Product� 474

Download Bonus Content Pack� 475

About Anime Studio Pro� 475

About Scripts� 475

Buy Content� 475

Check For Updates� 475

Appendix� 476
Product Comparison� 477

Feature Comparisons� 477

Window Menu� 477

Vector Drawing Features� 478

Vector Modifiers� 478

Fill Features� 479

Fill Modifiers� 479

Bone Features� 479

Layer Features� 480

Layer Modifiers� 480

Layer Types� 480

Camera Features� 481

Workspace Features� 481

Timeline Features� 481

Action Features� 481

Style Features� 482

Preferences� 482

Project Settings� 482

Content� 482

Scripts� 483

View� 483

Import� 483

Export Formats� 484

Upload Features� 485

Technical Support: Where to Go When You Need 
Help� 486

User Manual� 486

Anime Studio on the Web� 486

Anime Studio Discussion Forum� 486

Email Support� 486

Acknowledgements� 487
Artist Acknowledgements� 487

Anime Studio Shortcuts� 490



Anime Studio
Users Manual

ix

Contents

Keyboard Shortcuts� 490

Mouse Shortcuts� 492

Index� 494



Anime Studio Pro 8
Users Manual

1

﻿

Welcome



Anime Studio Pro 8
Users Manual

2

Introduction

Introduction
Anime Studio is a complete animation system for creating 
2D anime and cartoons. This document is the user’s manual, 
containing useful information to get you started, as well as a 
detailed reference to all of Anime Studio’s features.

If you’re just getting started using Anime Studio, the best place 
to begin is with the “Anime Studio Tutorials” on page 17. 
This section will give you a quick overview of how Anime Studio 
works, and what you can do with it. Even if you’ve used Anime 
Studio in the past, you might want to give the tutorials a quick 
read to see what’s changed in this version.

If you’ve been using Anime Studio for a while now, and you want 
more information on some specific feature or interface element, 
choose the section that interests you from the table of contents.

Finally, if you’re having a problem that just isn’t answered in this 
document, please see “Technical Support: Where to Go When 
You Need Help” on page 486. We want to do everything we can 
to make using Anime Studio a fun and productive experience.

Demo Limitations
If you haven’t purchased a copy of Anime Studio, then the 
program will be running in demo mode. While in demo mode, 

Anime Studio still allows you access to all features of the 
program. Anything you can do in the full version you can do in 
the demo. Also, any files you create with the demo version of 
Anime Studio will still work fine if you purchase the full version.

The demo version has just three limitations: First, you can only 
run the demo version of Anime Studio for 30 days. Second, 
you cannot import any external file formats including images 
and movies. Third, you cannot export your animations to other 
formats (QuickTime, AVI, Flash, etc.). 

To purchase Anime Studio, go to http://store.smithmicro.com/.

What’s New: New Features in Anime 
Studio 8
The following is not a comprehensive list of new features, but it 
covers most of the major changes in version 8 that might be of 
interest to experienced Anime Studio users.

•	 The Character Wizard lets you design your own fully-
rigged characters, complete with walk cycles and more. 
The Character Wizard is an ideal tool for anyone working 
on concepts or looking for a fast alternative to drawing and 
rigging a character from scratch. Select a preset, dial in the 
body proportions, and choose from dozens of pre-designed 
2D components such as hands, feet, mouths, eyes, noses, 
and heads. You can also easily apply pre-animated walk, 

http://store.smithmicro.com/
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jump, kick, and wave cycles, and create your own animated 
actions that you can apply to any character created in 
the Character Wizard. For more information about the 
Character Wizard, see “The Character Wizard” on page 
366.

•	 Automatic Image Tracing converts existing artwork to fully 
editable, ready-to-animate vector drawings. Import your 
scanned drawings or existing images and photos, and then 
convert them to vector drawings with the click of a button. 
Trace as black and white, color, or edges only and adjust 
a number of settings to style your vector image. For more 
information, see “Trace Image” on page 449.

•	 Anime Studio 8 introduces new interface colors, allowing 
you to choose from various preset color schemes or create 
your own. See “GUI Colors:” on page 446.

•	 The new smart tool palette provides a less cluttered interface 
and a better user experience. All of the tools are described 
in the section starting with “Anime Studio Tools” on page 
206.

Anime Studio 8 has a smart tool palette, which 
shows and hides tools based on their need. The 

position of the tool shown in the screenshots may differ, 
depending on the selected layer in the Layers palette, 
and the current time in the timeline. 

•	 Enhanced drawing tools allow you to quickly create complex 
shapes by eliminating the need for precise drawing, giving 
you the freedom to sketch as you desire. Combine the 
Freehand tool’s new smart welding feature with the Delete 
Edge tool to create complex shapes quickly (see “Freehand” 
on page 218 and “Delete Edge” on page 226. Additional 
brush styles are included, and optional rounded end caps 
have been added to the drawing tools (see “The Draw Tools” 
on page 207).

•	 Quickly find and edit vector layers using the Vector Shape 
Selector. You no longer have to worry about naming 
each layer to find the one you are looking for. Just click 
on a shape in your project and the corresponding layer 
is automatically selected for editing. See “Vector Shape 
Selector” on page 289 for more information.

•	 Import Photoshop files complete with all layers. Updates 
made in Photoshop are automatically updated in the 
imported file within Anime Studio. Many Photoshop 
features are supported, including blending modes, layer 
opacity, smart objects, and smart filters. Groups imported 
from Photoshop are imported into Anime Studio as switch 
layers, for quick animating. See “Importing Photoshop 
Files” on page 427 for more information.
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•	 The new real time media connection automatically updates 
images, movie files, and audio files that are imported into 
Anime Studio, after they are edited in an external program.

•	 Global rendering styles allow you to easily change the overall 
design of your animations. Choose from various presets 
such as sketch, cutout, crayon, and more to easily transform 
the look and feel of your entire animation. For more 
information, see “Render Style” on page 416.

•	 More 3D video rendering options, with full support for 
Youtube’s 3D formats. Various formats are provided for 
Web and TV. See the Stereo Rendering features discussed in 
“Project Settings...” on page 414.

•	 Patch Layers were designed for constructing characters and 
are similar to masks by allowing you to hide certain parts of 
a layer. Create each body part separately and then hide the 
overlapping lines. Adjust the size of the patch to perfectly 
blend the layers to get the desired style. Patch layers are 
explained in “Patch Layers” on page 278.

•	 Anime Studio Pro 8 provides advanced scripting support, 
including several new scripts. More functions and data 
structures have been exposed through the scripting API, 
allowing advanced technical users to create tools and 
add-ons for the program. The new scripts are discussed in 
“Scripts Menu” on page 463.

•	 Easily apply a cut-out style effect to any character or object 
using the Layer Outline Effect. Set the width and color 
for each outline and customize the look and feel of your 
animation.

Other Anime Studio Features

•	 Audio recording and automatic lip syncing

•	 Set the density, gravity, friction and springiness of objects 
and see how they collide using Simulated Physics

•	 Create 3D objects from 2D vector layers

•	 Content Library with hundreds of ready-to-use characters, 
props and more

•	 Import Poser Scenes into Anime Studio

•	 Track, Zoom, Roll, Pan and Tilt the Camera

•	 Content Library with hundreds of ready-to-use characters, 
props, scenes, and more.

•	 Import Quicktime®, AVI, or MPEG-4 video; incorporate 
audio files such as WAV, AIFF or MP3

•	 Pen tablet support simulates drawing on paper
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•	 Special effects such as motion blur and shadows

•	 Customize functionality with LUA scripts

•	 Output to formats including NTSC/PAL D1/DV Standard 
and Widescreen; HDV and HDTV 720p and 1080p; AVI, 
MOV, Flash, Stereoscopic 3D and more

System Requirements

Windows

•	 Windows 7, XP, Vista

Anime Studio Pro is compatible with 64-bit 
Windows operating systems however Anime 

Studio is a 32-bit Application.

•	 500 MHz Intel Pentium or equivalent

•	 630 MB free hard drive space

•	 256 MB RAM; 1024x768 resolution; 16-bit color display

•	 CD-ROM drive (for physical version of application)

•	 Adobe® Flash® Player 9 or newer (embedded library)

•	 Windows® Internet Explorer® 7

•	 Internet connection for Content Paradise

•	 Poser 7 or later needed to import Poser scenes.

Macintosh

•	 Mac OS X 10.5 or higher (Universal Binary)

•	 PowerPC G4/G5 Processor: 500MHz or above (Intel 
recommended)

•	 680 MB free hard drive space

•	 256MB RAM; 1024x768 resolution

•	 16-bit color display

•	 CD-ROM drive (for physical version of application)

•	 Adobe® Flash® Player 9 or newer (embedded library)

•	 Internet connection for Content Paradise.

•	 Poser 7 or later needed to import Poser scenes.
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Getting Started
After you install Anime Studio 8, you might want to familiarize 
yourself with the many features contained in the program. 

When you start Anime Studio, a splash screen presents the 
following options:

•	 Introductory Tutorial: Opens the Quick Start Guide, which 
you can also open using the Help > Quick Start Guide 
command from the Anime Studio menu.

•	 Bonus Content Pack: Opens your Web browser to the 
Content Paradise web site, specifically to the Anime Studio 8 
bonus content page. A Content Paradise account and valid 
Anime Studio 8 serial number are required to add the free 
content to your shopping cart. You can also navigate to this 
page by choosing the Help > Download Bonus Content 
Pack command from the Anime Studio menu.

•	 Register Your Product: Opens your Web browser to the 
Smith Micro registration page, where you are prompted to 
enter registration information for your Smith Micro software 
products. You can also navigate to this page by choosing the 
Help > Register Your Product command from the Anime 
Studio menu.

•	 ContentParadise.com: Opens your Web browser to the 
Content Paradise home page, where you can order content 

for Anime Studio and other Smith Micro software products. 
You can also navigate to this page by choosing the Help > 
Buy Content command from the Anime Studio menu.

•	 Don’t Show This Again: Choose this command to prevent 
the splash screen from opening each time you start Anime 
Studio.

Splash Screen
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Anime Studio Pro 8

End User License Agreement and 
Limited Warranty
PLEASE READ THIS END USER LICENSE AGREEMENT 
(“EULA”) CAREFULLY BEFORE INSTALLING AND USING 
THE SOFTWARE. BY CLICKING THE “AGREE” BUTTON 
WHEN INSTALLING THE SOFTWARE, YOU ARE AGREEING 
TO BE BOUND BY THE TERMS OF THIS EULA. IF YOU DO 
NOT AGREE TO THE TERMS OF THIS EULA, CLICK ON THE 
“DISAGREE” BUTTON. IF YOU DO NOT AGREE TO THE 
TERMS OF THIS EULA, YOU MAY NOT USE OR ACCESS 
THE SOFTWARE. USING OR ACCESSING ANY PART OF THE 
SOFTWARE INDICATES THAT YOU AGREE TO THE TERMS 
OF THIS EULA. 

This EULA is between you (both the individual installing the 
Software and any single legal entity on behalf of which such 
individual is acting) (“you” or “your”) and Smith Micro Software, 
Inc. and/or its affiliates (collectively or individually, “SMSI”).

1. General

You agree to use the Software, Documentation and Content only 
for lawful purposes. Any use of the Software, Documentation 
or Content other than as granted in this EULA must be by 
SMSI’s prior written consent. SMSI maintains an ongoing EULA 
enforcement program. Violation of any provision of this EULA 
automatically terminates this EULA. SMSI reserves all other 
rights that it may have for violation of this EULA.

2. Definition

“Content” means animations, characters, clothing, faces, 
hair, geometries, images, documentation, materials, meshes, 
morphs, motion files, props, scripts, textures, bump maps, 
transparencies, and similar files and data created or modified 
with the intent of being used within the Software and/or third 
party applications.

“Documentation” means all written material in any form 
for installation and use of the Software provided by or made 
available by SMSI, or its authorized representatives or agents.

“Legitimate Uses” means (a) creating tutorials, books, or other 
educational materials using images of the Software interface 
or Content for sale, distribution, public display, or public 
performance, provided such materials are intended to educate 
users as to use of the Software; (b) creating original Content 
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for sale, distribution, public display, or public performance; 
(c) creating materials for use with either Restricted Content or 
Other Content; (d) creating rendered animations or rendered 
still images based on Restricted Content contained with the 
“Character Wizard” feature of the Software; or (e) creating 
characters or props based on Restricted Content in proprietary 
file formats (meaning, MOHO, ANME and any subsequent/
compressed formats), where the original (or modified) art, 
texture or other Restricted Content files are not distributed with 
such characters or props.

“Other Content” means Content that is not Restricted Content or 
Unrestricted Content. Other Content may be subject to license 
terms imposed by the Other Content’s original creator.

“Restricted Content” means all Content included with or part 
of the Software that is not Unrestricted content, including 
without limitation mesh objects (geometry) in any format, files 
in proprietary file formats (meaning, MOHO, ANME, and any 
subsequent/compressed formats), images, materials, texture, 
transparency maps, Documentation, vector-based content, and 
SMSI’s proprietary data. Except as otherwise expressly permitted 
by this EULA, Restricted Content extracted or exported from the 
Software remains Restricted Content. Except as authorized in 
this EULA, Restricted Content may only be used exclusively on 
one (1) computer.

“Software” means the SMSI computer software and associated 
files (e.g. Content) delivered via the accompanying physical 

media or electronic media. “Software” means to also include 
any upgrades, updates, bug fixes or modified versions or backup 
copies of the Software supplied to you by SMSI or an SMSI 
authorized representative or agent (whether or not for a fee).

“Unrestricted Content” means Content included with or part of 
the Software that is specifically identified in the Documentation 
or listed in this EULA as Unrestricted Content. This version of 
the Software contains no Unrestricted Content.

3. Software License 

A)  Subject to the terms and conditions of this EULA and your 
payment of the license fee, SMSI grants you a limited, personal, 
nontransferable and non-exclusive license (without right to 
sublicense): (i) to use a single copy of the Software (except as 
expressly permitted in the Documentation) solely for your own 
internal use on a single computer (as set forth in Subsection E 
below of this Section 3) either loaded in the temporary memory 
(i.e., RAM) of a computer, or installed on the permanent 
memory of a computer (e.g., hard disk and compact disk) or, 
on a temporary basis, on a backup system if such equipment 
is inoperative, consistent with the limitations specified or 
referenced in this EULA and the Documentation; (ii) to use the 
Documentation provided with the Software in support of your 
authorized use of the Software; and (iii) to copy the Software 
to make one (1) archival copy of the Software for your personal 
archival or backup purposes, and to make sufficient number of 
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copies for Legitimate Uses or the intended use described in the 
Documentation, provided that all titles and trademark, copyright 
and restricted rights notices are reproduced on all such copies. 
Any other uses of the Software, including without limitation the 
Software interface, other than those granted in this EULA must 
be expressly pre-approved by SMSI in writing. 

B) The Software is protected by copyright and other intellectual 
property laws and international treaties. As an express condition 
of this EULA, you must reproduce on the backup copy the SMSI 
copyright notice in the following format: “(C) 2004-2010 Smith 
Micro Software, Inc.” This express condition extends to any 
further updates, software patches, or bug fixes made available 
to you by SMSI, whether distributed on floppy disk, compact 
disk, or in an electronic format via download, BBS, forum, FTP, 
e-mail, etc.

C) The Software (not including the media on which the 
Software may be provided) is licensed to you, not sold. You 
expressly acknowledge that SMSI, Lost Marble, Inc., and/
or their respective licensor(s) have a valuable proprietary 
interest in both the Software and the Documentation. All title, 
ownership, interest and rights in and to the patent, copyright, 
trademark, trade secret and any other intellectual property 
rights in the Software (and any derivative works thereof) and 
the Documentation (and any derivative works thereof) not 
expressly granted to you by this EULA remain with SMSI, Lost 
Marble, Inc. and/or their respective licensor(s). You do not 
acquire any other rights, express or implied, in the Software 

(and any derivative works thereof) and the Documentation (and 
any derivative works thereof) other than those rights expressly 
granted under this EULA. Without limiting the generality of 
the foregoing, SMSI, Lost Marble, Inc. and/or their respective 
licensor(s) retain all title, ownership, interest and rights in and 
to the patent, copyright, trademark, trade secret and any other 
intellectual property rights in the copy of the Software contained 
on your archival media, and all of the terms of this EULA apply 
to such archival copy as if it were the original SMSI-produced 
copy of the Software that was furnished to you when you paid the 
licensing fee. 

D) Portions of the Software include third party software 
and other copyrighted material (collectively, “TPS”). 
Acknowledgements, licensing terms, restrictions and disclaimers 
of such TPS are contained in the “About Box” of the Software and 
your use of such TPS is governed by such respective terms. Any 
terms of this EULA that differs from the terms of any TPS are 
offered by SMSI alone, and not by any other licensor.

E) Except as otherwise expressly permitted in the 
Documentation, you will only use the Software on a single 
computer, meaning that you must treat the Software “like a 
book.” “Like a book” means that the Software may be used 
by any number of people and may be freely moved from one 
computer to another so long as no possibility exists of the 
Software being used at more than one computer simultaneously. 
More than one person at a time cannot read the same copy of a 
book, and this restriction applies to the SMSI. 
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4. Restrictions 

A) You will not, and will not permit any third party to, use, copy, 
modify, derive, or transfer the Software or Documentation, 
or any copy, modification, derivation, or merged portion 
thereof, in whole or in part via any means or for any purpose 
whatsoever except as expressly permitted in this EULA or the 
Documentation. You will not, and will not permit any third 
party to, modify, adapt, translate, rent, lease, loan, resell for 
profit, or create derivative works based upon the Software or 
any part thereof. The Software contains trade secrets in its 
human readable form and, to protect them, you will not, and 
will not permit any third party to, reverse engineer, decompile, 
disassemble, or otherwise reduce the Software to any human 
readable form without the express prior written consent of SMSI 
or except to the extent expressly permitted by applicable law. You 
will not relicense, sublicense, rent, lease, or lend the Software for 
third-party training, commercial time-sharing or service bureau 
use. You will not, and will not permit any third party to, debug, 
bypass, circumvent or defeat any security features of, or interfere 
with the normal functionality and operation of the Software for 
any reason whatsoever without the express prior written consent 
of SMSI or except to the extent expressly permitted by applicable 
law. If the Software is an upgrade to a previous version of the 
Software, you must possess and maintain a valid license to such 
previous version in order to use the upgrade.

B) You, your employees, and/or authorized agents must protect 
the Software’s confidentiality and act to enforce your obligations 
under this EULA. You cannot distribute or otherwise make 
the Software or Documentation available to any third party 
via any means whatsoever, public or private, for any purpose, 
commercial or not, unless explicitly allowed by this EULA.

C) You assume full responsibility for your selection of the 
Software to achieve your intended results and for the installation, 
use, and results you obtain from the Software. SMSI has 
no obligation to provide support, maintenance, upgrades, 
modifications or new releases under this EULA.

5. Content License

A) Subject to the terms and conditions of this EULA and your 
payment of the license fee, SMSI grants you a limited, personal, 
nontransferable and non-exclusive license (without the right to 
sublicense):

1) To reproduce, prepare derivative works based upon, 
distribute, publicly display and publicly perform the 
Unrestricted Content for any lawful purpose other than 
to create a product which is intended to compete with the 
Software or to create new content which is intended to 
compete with the Restricted Content.
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2) To prepare derivative works based upon the Restricted 
Content solely for Legitimate Uses and lawful uses.

3) To reproduce, prepare derivative works based upon, 
distribute, publicly display, and publicly perform content 
you create using Restricted Content, provided that such use 
of Restricted Content shall be solely for Legitimate Uses and 
lawful uses. 

B) Notwithstanding the foregoing, nothing shall limit SMSI’s 
right to independently create, develop, own, market, distribute, 
license, sublicense, import, export, sell, or otherwise exploit any 
content or materials similar to any derivative works based upon 
the Content.

C) Other Content included with the Software and 
Documentation is subject to third-party rights and is copyrighted 
and owned by the Other Content’s original creator(s). You may 
use the Other Content in accordance with all applicable license 
terms imposed by the Other Content’s original creator(s). 
SMSI makes no representations as to the quality, suitability, 
functionality, or legality of the Other Content and you hereby 
waive any claim you might have against SMSI with respect to the 
Other Content.

D) You will not, and will not permit any third party to, use, 
copy, modify, derive, sell, distribute, transfer or sublicense 
the Restricted Content, the Unrestricted Content, or the Other 
Content or any copy, modification, derivation, or portion 

thereof, in whole or in part via any means or for any purpose 
whatsoever, except as expressly permitted in this EULA or the 
Documentation. 

E) You expressly acknowledge that SMSI, Lost Marble, Inc. and/
or their respective licensor(s) have a valuable proprietary interest 
in the Restricted Content and the Unrestricted Content. All title, 
ownership, interest and rights in and to the patent, copyright, 
trademark, trade secret and any other intellectual property rights 
in the Restricted Content (and any derivative works thereof) and 
the Unrestricted Content (and any derivative works thereof) not 
expressly granted to you by this EULA remain with SMSI, Lost 
Marble, Inc. and their respective licensor(s). You do not acquire 
any other rights, express or implied, in the Restricted Content 
(and any derivative works thereof) and the Unrestricted Content 
(and any derivative works thereof) other than those rights 
expressly granted under this EULA.  

F) Except as otherwise expressly permitted in the 
Documentation or unless otherwise provided for herein, you will 
only use the Content on a single computer, meaning that you 
must treat the Content “like a book.” SMSI is pleased to offer site 
licenses (“Site License”) for multiple simultaneous users. Please 
contact SMSI at the address below for details. If you purchased a 
Site License, you may distribute the Restricted Content between 
all computers containing valid copies of the Software, other 
SMSI products, and/or other software able to process Restricted 
Content.
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6. Collection and Use of Your Information

A) Upon launching the Software, you will have the option to 
register the Software with SMSI. If you choose to register the 
Software with SMSI, you agree that SMSI and/or its affiliates 
may collect and process such information about you and the 
Software in order to enable SMSI to: (i) notify you of updates, 
bug fixes and/or modified versions of the Software; (ii) provide 
support and assistance of the Software; (iii) notify you of new 
version offerings of the Software; and (iv) comply with all 
applicable laws and/or regulations, or the requirements of any 
regulatory authority or government agency. 

B) Your use of the Software constitutes consent by you to SMSI’s 
and/or its affiliates’ collection and use of such information and, 
if you are located in European Economic Area (EEA), to the 
transfer of such information to a location outside the EEA. Any 
information collected is done and utilized in accordance with 
SMSI’s Privacy Policy. Your election to use the Software indicates 
your acceptance of the terms of the SMSI Privacy Policy, so 
please review the policy carefully and check our website at the 
following URL to review updates: http://www.smithmicro.com/. 

7. Term; Termination 

A) This EULA remains in full force and effect until terminated. 
You may terminate this EULA at any time by returning or 
destroying both the Software and Documentation, together with 

all copies, modifications, and merged portions of the Software 
and the Documentation in any form. SMSI is in no way obliged to 
issue refunds. SMSI may terminate this EULA at any time upon 
your breach of any of the provisions hereof.

B) Upon termination, you will immediately cease all use of 
the Software, and you must return or destroy the Software, 
Documentation, and all copies, modifications, and merged 
portions of the Software and the Documentation in any form 
and certify in writing your compliance of this paragraph to 
SMSI. Termination of this EULA for any reason in no way limits 
SMSI’s right to continue enforcing all rights provided by law 
and does not entitle you to a refund of your license fees, except 
as provided herein. All provisions of this EULA that protect 
SMSI’s proprietary rights continue in full force and effect after 
termination.

8. Export Law Assurances 

Export and re-export of this Software and Documentation is 
governed by the laws, restrictions and regulations of the United 
States and applicable export and import laws, restrictions and 
regulations of certain other countries (collectively, “Export 
Laws”). You will comply with all such Export Laws. Export or 
re-export of this Software and/or Documentation (including any 
direct product thereof) to any entity on the Denied Parties List 
and other lists promulgated by various agencies of the United 
States Federal Government is strictly prohibited. In addition, 
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if the Software is identified as an export controlled item under 
the Export Laws, you represent and warrant that you are not 
a citizen of, or located within, an embargoed or otherwise 
restricted nation (e.g., Iran, Syria, Sudan, Cuba and North 
Korea) and that you are not otherwise prohibited under the 
Export Laws from receiving the Software.

9. Limited Warranty and Disclaimer 

A) SMSI warrants that any media on which the Software 
may be provided will be free from defects in materials and 
workmanship under normal use for a period of ninety (90) days 
from the date of original purchase. Your exclusive remedy and 
SMSI’s entire liability under this limited warranty will be for 
SMSI, at its option, to replace the Software media or refund the 
purchase price of such Software media. This limited warranty 
is offered solely by SMSI and does not apply to any third party 
product, software, content or service offerings. THE ABOVE 
WARRANTIES ON MEDIA ARE EXCLUSIVE AND IN LIEU 
OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, AND 
SMSI EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES, 
INCLUDING, WITHOUT LIMITATION, ANY IMPLIED 
WARRANTY OF MERCHANTABILITY, SATISFACTORY 
QUALITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT.  

B) TO THE EXTENT NOT PROHIBITED BY APPLICABLE 
LAW, THE SOFTWARE, RESTRICTED CONTENT, 

UNRESTRICTED CONTENT, AND DOCUMENTATION ARE 
LICENSED TO YOU “AS IS” WITH ALL FAULTS, WITHOUT 
WARRANTY, CONDITION OR REPRESENTATION, EXPRESS 
OR IMPLIED, OF ANY KIND, INCLUDING WITHOUT 
LIMITATION, MERCHANTABILITY, PERFORMANCE, 
SECURITY, SATISFACTORY QUALITY, NON-INFRINGEMENT 
OF THIRD PARTY RIGHTS, OR FITNESS FOR A PARTICULAR 
PURPOSE.  

C) YOU ACKNOWLEDGE THAT THE SOFTWARE MAY NOT 
(I) SATISFY ALL YOUR REQUIREMENTS, (II) BE FREE FROM 
DEFECTS, OR (III) OPERATE WITHOUT INTERRUPTION 
OR ERRORS. IN ADDITION, DUE TO CONTINUAL 
DEVELOPMENT OF NEW TECHNIQUES FOR INTRUDING 
UPON AND ATTACKING NETWORKS, SMSI DOES NOT 
WARRANT THAT THE SOFTWARE WILL BE FREE OF 
VULNERABILITY TO INTRUSION OR ATTACK. 

D) THE FOREGOING LIMITED WARRANTY IS NEITHER 
A SERVICE NOR A SUPPORT CONTRACT. NO ORAL 
OR WRITTEN INFORMATION OR ADVICE GIVEN BY 
SMSI, ITS EMPLOYEES, DISTRIBUTORS, DEALERS, 
REPRESENTATIVES OR AGENTS SHALL INCREASE THE 
SCOPE OF THE ABOVE WARRANTIES OR CREATE ANY NEW 
WARRANTIES. YOU MAY HAVE ADDITIONAL WARRANTY 
RIGHTS UNDER LAW WHICH MAY NOT BE WAIVED OR 
DISCLAIMED. SMSI DOES NOT SEEK TO LIMIT YOUR 
WARRANTY RIGHTS TO ANY EXTENT NOT PERMITTED 
BY LAW. This Section 9 and Section 10, below, shall survive 
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any termination of this EULA, howsoever caused, but this will 
not imply or create any continued right to use the Software after 
termination of this EULA.

10. Disclaimer of Liabilities

A) EXCEPT FOR THE EXCLUSIVE REMEDY OFFERED 
BY SMSI ABOVE AND REMEDIES THAT CANNOT BE 
EXCLUDED OR LIMITED BY APPLICABLE LAW, IN NO 
EVENT WILL SMSI OR ITS DEVELOPERS, SUPPLIERS, 
DIRECTORS, OFFICERS, EMPLOYEES, OR SUBSIDIARIES OR 
AFFILIATES BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
INCIDENTAL OR INDIRECT DAMAGES (INCLUDING 
DAMAGES FOR LOSS OF BUSINESS PROFIT, BUSINESS 
INTERRUPTION, LOSS OF DATA AND/OR BUSINESS 
INFORMATION, AND THE LIKE), WHETHER FORESEEABLE 
OR UNFORESEEABLE, ARISING OUT OF THE USE OR 
INABILITY TO USE THE SOFTWARE OR DOCUMENTATION, 
REGARDLESS OF THE BASIS OF THE CLAIM, EVEN IF 
SMSI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES OR FOR ANY CLAIM BY ANY OTHER PARTY. IN 
NO EVENT WILL SMSI’S AGGREGATE LIABILITY (OR THAT 
OF ITS DEVELOPERS, SUPPLIERS, DIRECTORS, OFFICERS, 
EMPLOYEES, OR SUBSIDIARIES OR AFFILIATES), UNDER 
OR IN CONNECTION WITH THIS EULA, EXCEED THE 
AMOUNT PAID BY YOU FOR THE SOFTWARE, IF ANY. 
THIS LIMITATION WILL APPLY EVEN IN THE EVENT OF A 

FUNDAMENTAL OR MATERIAL BREACH OR A BREACH OF 
THE FUNDAMENTAL OR MATERIAL TERMS OF THIS EULA.

B) The above limitations will apply even if any warranty or 
remedy provided under this EULA fails of its essential purpose. 
The above limitations will not apply in case of personal injury 
(including death) only where and to the extent that applicable 
law requires such liability. Because some jurisdictions do 
not allow the exclusion or limitation of implied warranties or 
liabilities for consequential or incidental damages, the above 
limitations may not apply to you. 

11. Indemnification

You will indemnify and hold harmless, and at SMSI’s request 
defend, SMSI and its affiliates, successors and assigns from 
and against any and all claims, losses, liabilities, damages, 
settlements, expenses and costs (including, without limitation, 
attorneys’ fees and court costs) which arise out of or relate 
to any third party claim or threat thereof that your use of the 
Software, Documentation or Content is unlawful or not otherwise 
permitted by this EULA. SMSI reserves the right, at its own 
expense, to assume the exclusive defense and control of any 
matter otherwise subject to indemnification hereunder.
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12. U.S. Government Restricted Rights 

The Software and Documentation are provided with 
RESTRICTED RIGHTS. The use, duplication, or disclosure 
by the United States Government is subject to restrictions as 
set forth in subparagraph (c)(1)(ii) of the Rights in Technical 
Data and Computer Software Clause at DFARS 252.227-7013 
or subparagraph (c)(1) and (2) of the Commercial Computer 
Software Restricted Rights at 48 CFR 52.227-19, as applicable. 
The Manufacturer is Smith Micro Software, Inc., 51 Columbia, 
Aliso Viejo, CA 92656 USA.

13. Applicable Law 

This EULA shall be governed by the laws of the State of 
California, without giving effect to any choice of law principles. 
This EULA will not be governed by the United Nations 
Convention on Contracts for the International Sales of Goods, 
the application of which is expressly excluded. Exclusive 
jurisdiction over and venue of any suit arising out of or relating 
to this EULA will be in the state and federal courts of Orange 
County, California. If for any reason a court of competent 
jurisdiction finds any provision, or portion thereof, to be invalid 
or unenforceable, the remainder of this License shall continue 
in full force and effect. The waiver by either party of any default 
or breach of this EULA will not constitute a waiver of any other 
or subsequent default or breach. You may not assign, sell, 

transfer, delegate or otherwise dispose of, whether voluntarily 
or involuntarily, by operation of law or otherwise, this EULA 
or any rights or obligations under this EULA without SMSI’s 
prior written consent. Any purported assignment, transfer or 
delegation by you will be null and void. This EULA constitutes 
the entire agreement between the parties and supersedes all 
prior or contemporaneous agreements or representations, 
written or oral, concerning the subject matter of this EULA. 

14. Contact Information 

If you have questions concerning this EULA or need to contact 
Customer Service, please contact SMSI at this address: Smith 
Micro Software, Inc., 185 Westridge Drive, Watsonville, 
CA 95076 USA (831) 761-6200 phone, (831) 761-6206 fax; 
Customer Service (returns, warranty): service@smithmicro.com; 
and Legal (EULA questions, illegal activity reporting): legal@
smithmicro.com.

15. Copyright & Trademark Notice

Smith Micro Software, Anime Studio, Anime Studio Debut and 
Anime Studio Pro are trademarks of Smith Micro Software, 
Inc. Lost Marble and Moho are trademarks of Lost Marble, 
Inc. All other product names mentioned in the Software, 
the Documentation, or other documentation are used for 
identification purposes only and may be trademarks or 
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registered trademarks of their respective companies. Registered 
and unregistered trademarks used herein are the exclusive 
property of their respective owners. For purposes of Japan law 
regarding unregistered trademarks (e.g., a pending trademark 
application), the right in and to a trademark in Japan may not 
be exclusive until it is validly registered. You may not remove, 
modify, alter, cover or deface any trademark, trade names, 
product names, logo, copyright or other proprietary notices, 
legends, symbols or labels in the Software and Documentation. 
This EULA does not authorize you to use SMSI’s or its licensors’ 
names or respective trademarks.

Version: 20110518-AnimeStudio/AnimeStudio
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Anime Studio 
Tutorials

In this section, we will walk you through various aspects of using 
Anime Studio. This is the perfect place to start if you’ve never 
used Anime Studio before. Even if you’re an experienced Anime 
Studio user, this version of Anime Studio has some big changes, 
so we recommend reading through the tutorials again.

The best way to get started is to read all the tutorials in the Basics 
section in order. Each of these tutorials builds on skills learned 
in the earlier ones, and one-by-one will get you up to speed with 
Anime Studio’s basic drawing and animation techniques. Once 
you’re comfortable working in Anime Studio, then you can move 
on to the other tutorial sections. You don’t have to read them all 
(although that probably wouldn’t hurt), but choose the ones that 
address the specific techniques you want to learn about.

Finally, all of the Anime Studio files created or used by the 
tutorials have been installed along with Anime Studio itself. You 
can find them by going to the Anime Studio program folder, and 
looking for the Tutorials sub-folder. If you’re having trouble with 
a tutorial, try opening the corresponding Anime Studio file to see 
what it should look like.

Once you’ve finished the tutorials, you should be comfortable 
enough to continue on your own. However, the tutorials won’t 

teach you how to use every feature of Anime Studio - the rest of 
this manual is a reference that covers Anime Studio’s features 
in detail, and is recommended reading to be able to use the full 
power of Anime Studio.
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Tutorial 2.1: Welding
As you learned in the Quick Start tutorials, Anime Studio features 
an Auto Weld feature that automatically welds shapes and 
segments together when your cursor reaches a point that you 
can weld to. However, there are cases where you may want to 
manually weld points together.

When drawing in Anime Studio’s vector layers, the concept of 
“welding” points is very important. These tutorials will show you 
examples of how (and why) points can be welded, and will go on 
to show you some examples of good and bad welds you can do in 
Anime Studio.

When you weld two points together in Anime Studio, Anime 
Studio really is combining those two points into one. There are 
a couple reasons to do this: First, welding the two endpoints of a 
curve together creates a closed curve. Second, if two shapes join 
up at a particular point, and you want them to remain joined 
during an animation, then welding those points together will 
guarantee that those two shapes will remain joined.

How to Weld Points

There are two ways to weld points in Anime Studio: manually 
and automatically. 

To manually weld two points together with the Translate Points 
tool, first uncheck the Auto-weld option for the tool.

 Translate Points

 Auto-weld option unchecked

Drag one point on top of the other and press the spacebar. Here’s 
an example of this method. Although you can’t see the keyboard 
in the example, keep in mind that the spacebar was pressed at 
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the moment when the two points overlap. After welding, notice 
how the two points move as one.

 Welding Example 1. (SWF File)

 Before spacebar is pressed (left). After spacebar is pressed (right)

The second method of welding is automatic. For automatic 
welding to work, be sure that the Auto-weld checkbox is turned 
on in the tool options area when the Translate Points tool is 
active:

 Make sure Auto-weld is on

Using this method, when you drag a curve endpoint on top of 
another point , the point turns green when it can be welded 
automatically. Let go of the mouse to automatically weld the 
points together. 
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Here’s an example of automatic welding. In this case, the 
spacebar was not pressed to initiate the weld - as soon as the 
mouse is released, the two overlapping points are automatically 
welded together.

 Welding Example 2. (SWF File)

 Automatic welding

Here’s another example of automatic welding. Remember that 
only a curve endpoint can be automatically welded. However, the 
point that it is welded to does not need to be an endpoint:




Anime Studio Pro 8
Users Manual

21

Drawing

 Welding Example 3. (SWF File)

Automatic welding also works with the Add Point tool. 

 Add Point

When you add a new point, you can drag it around as if you 
were using the Translate Points tool. As long as the new point 
you added is a curve endpoint, it can be automatically welded to 
another point. If the new point is not an endpoint, you can still 
weld it to another point manually by pressing the spacebar when 
it overlaps another point.
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 Add Point tool with Auto-weld option on

Besides welding two points together, Anime Studio can weld a 
point to the middle of a curve segment. This can be done with 
either the automatic or manual welding methods. Here’s an 
example:

 Welding Example 4. (SWF File)
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 Welding to a curve segment

Why to Weld Points

OK, so that covers welding points, but why do you want to 
weld points again? Well, the main reason is to create fillable 
shapes. In order to fill a shape with color, that shape needs to be 
completely closed. This is only possible if you weld some points 
together. The following shape cannot be filled with color because 
it is not closed:

 A non-closed shape

By welding the two endpoints together, we can create a closed 
shape that can then be filled:
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 A closed shape that can be filled

Examples of Good Welding

Let’s look at some examples of good welding choices. First, 
the following two points could be welded to create a single, 
continuous curve:

 Joining two curves

The next case shows the classic case of welding a curve closed to 
create a fillable shape:
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 Closing a curve

Next, we show a shape made up of several curves. Notice that 
a closed, fillable shape does not need to be made up of a single 
curve. The shape below, after welding, is made up of three curve 
segments, but is still closed and can be filled with color:

Joining multiple curves into a single closed shape
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 The welded and filled shape

Finally, the example below shows two circles lined up side-by-
side. The two side points of the circles have been welded together 
so that when they move around during an animation they remain 
joined. If those points were not welded, moving them in sync like 
this would require a lot of extra work.

 Joined circles (SWF File)

Examples of Bad Welding

Typically, when you weld together two points, one of them 
should be a curve endpoint. This isn’t always true, but most 
often it is. If you find yourself welding together two points 
and neither is an endpoint, take a moment to think whether 
the weld is appropriate. Here’s an example of a bad choice of 
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welding. Suppose you had the following two shapes and you were 
considering welding the pairs of circled points:

 Before welding the marked points

Although Anime Studio will let you perform those welds, it isn’t 
really a good idea. What you would end up creating is a shape 
with lots of little holes in it. Along the section of curves that you 
welded together are little bubbles that make it impossible to fill 
the two main shapes:

 Bad welding

Instead, a better approach is to just move the two shapes closer 
together without any welding at all. In this case, welding the two 
shapes together doesn’t have any benefit.
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 Fill the shapes without welding them together

 Delete Edge

Another approach in this situation would be to cut the top shape 
apart with the Delete Edge tool and then weld the remaining 
endpoints to the lower shape. First, cut the top shape apart:

 Cut the redundant curve away

Then, weld the newly-created endpoints onto the lower shape. 
With this approach you don’t end up with a double curve all 
welded together. The resulting shape is much cleaner and easier 
to work with:
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 Weld the new endpoints

Tutorial 2.2: Drawing Shapes with 
Holes
Drawing shapes with holes is very easy in Anime Studio, but 
many new users don’t realize that this can be done. There’s really 
no trick at all - just follow the basic rules for creating a fill.

Reminder of Fill Rules

 Create Shape Tool

As a reminder, let’s consider the rules for creating a fill shape: A 
fill must be composed of closed curves that define the border of 
the shape. So, as an example, below is a valid fill shape.
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 A basic fill shape

Creating Holes

So a fill shape is defined by the curves on its border. If we want to 
create a hole, then all we need to do is create curves that outline 
the shape of the desired hole(s). Below we’ve added some extra 
curves before creating a fill shape:

 New curves added

 Create Shape Tool

Once you’ve set up curves to define the shape of the hole, all you 
need to do is select the outline and the hole(s) using the Create 
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Shape tool. Notice that Anime Studio automatically identifies 
the inner curves as borders of holes in the shape. There’s nothing 
in particular you have to do, just draw the holes and Anime 
Studio will know what to do with them. When you’ve selected all 
the correct points, press the spacebar to finalize the shape.

 Selected points for filling

Finally, here is the resulting shape. (The Line Width tool was 
used to narrow the width of the outline at the corner points.)

 The finished shape

Here’s another example of a shape with a hole:
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 Another shape with a hole

Tutorial 2.3: Hidden Edges
When drawing more complex objects like faces, you will often 
run into situations where you want an outline to only go partway 
around a shape. There’s an easy way to accomplish this in Anime 
Studio.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 2.3 and it’s located in the Tutorials 

> 2 - Draw subfolder within the main Anime Studio folder. Open 
this file in Anime Studio and you should see something like this:

 Starting point for this tutorial

Hidden Edges

The drawing we’re working with could be the beginning of a 
character’s face. In this face, the nose and ear are separate shapes 
from the main head outline. The general shape looks OK, but 
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where the separate parts join up we don’t want to have lines 
separating them. To fix this, activate the Hide Edge tool. 

 Hide Edge Tool

There are two edges we want to eliminate from this drawing. 
Click on these two edges as shown below. If you don’t see an 
immediate result, try dragging the mouse across the lines in 
question to make sure you hit them.

 Edges to click on

After clicking on these edges, they should disappear from view, 
and the result should be as follows:
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 After hiding the edges

The Hide Edge tool works by simply hiding the selected edges 
of an outline. It does not affect the underlying curve - the curve 
is still there, you just can’t see the outline on that particular 
section of the curve. Because it works on the outline, and not the 
curve itself, be sure you only use the Hide Edge tool after you’ve 
created the outlines. Otherwise, with no outline, you would not 
see the result of hiding some edges.

The other thing to know about the Hide Edge tool is that you can 
also un-hide edges. If you change your mind, or hide the wrong 
edges, just click on a hidden edge to re-show it.

Finishing Touches

If you hide the edges of a thicker line, you’ll often end up with 
abrupt ends to the outline. You can see this below:

 Blocky curve ends

 Line Width Tool
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A nice way to finish off these endpoints is to use the Line Width 
tool. With this tool, click on the endpoints to set their width to 
0. You can also click and drag to adjust the width of any other 
points you choose. After cleaning up the endpoints, you should 
get a result like this:

 Tapered endpoints

Tutorial 2.4: Shape Ordering
In an Anime Studio vector layer, shapes are ordered from back 
to front. This ordering determines which shapes will appear in 
front of or behind others. This tutorial will show you how to work 
with shape ordering.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 2.4 and it’s located in the Tutorials 
> 2 - Draw subfolder within the main Anime Studio folder. Open 
this file in Anime Studio, and you should see something like this:

 Starting point for this tutorial

As you can see, there are four shapes in this file. By the way they 
overlap one another, you can also tell their ordering. From back 
to front, there is a red shape, a green shape, a blue shape, and a 
yellow circle.
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Raising and Lowering Shapes

 Select Shape Tool

If you want to change the order of some shapes, the first thing 
you need to do is select a shape to work with. Using the Select 
Shape tool, click anywhere on the red shape. It will become 
highlighted with a checkerboard to indicate that it is selected. 
Notice that you can also see it faintly beneath the other shapes 
- this is so that you can see the entire selected shape, even if it is 
normally obscured by other shapes.

 Selected shape highlighted

To raise the shape, press the Up arrow key on your keyboard. 
Notice that the red shape has now moved one step up in the layer 
order, above the green shape:
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 Raised shape

Right now, press the enter key to de-select all objects in the layer. 
The red shape will switch back to normal to indicate that it is not 
selected:

 De-select the shape

Next, use the Select Shape tool and click on the blue shape to 
select it. 

 Select Shape Tool



Anime Studio Pro 8
Users Manual

38

Drawing

Press the Down-arrow key twice to lower the blue shape below 
the red shape, and then below the green shape:

 Lowered blue shape

You can also raise a shape to the top (above all others in that 
layer) or lower it to the bottom (behind all others in that layer). 
Select the green shape and hold down the Shift key while 
pressing the Up-arrow key. With a single key press, the green 
shape moves all the way to the top of the layer’s shape order.

Selecting Hidden Shapes

If you now press the enter key, the green shape will be de-
selected. Notice that at this point the yellow circle is behind the 

green shape, and can’t be seen. You can still see the curves that 
make up the yellow circle, but the shape itself, being behind the 
green shape, is not visible:

 Hidden yellow circle

Now we want to bring the yellow circle back to the front. Using 
the Select Shape tool, click on the yellow circle, even though it’s 
hidden. 
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 Select Shape Tool

As you may have expected, the green shape gets selected because 
it is in front:

 Selected green shape

Now comes the trick for selecting shapes lower in the ordering. 
Hold down the Ctrl key while pressing the down-arrow key. This 
tells Anime Studio to pick the next deeper shape in the layer 
ordering at the same point you just clicked. The yellow circle will 
now be selected. It will be kind of faint to remind you that it is 
actually behind other shapes in the layer:

 Selected yellow circle

Finally, hold down the Shift key while pressing the up-arrow to 
bring the yellow circle all the way to the top of the layer ordering, 
making it fully visible once again:
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 Raised yellow circle

Tutorial 2.5: Brushes
Anime Studio allows you to apply brush effects to outlines if you 
choose. It’s really easy to use brushes, and this tutorial will show 
you how.

Draw Some Freehand Curves

 Freehand

Start with a new, blank file in Anime Studio. In the Style window, 
set the line width value to 16. Next, activate the Freehand tool. 
In the tool options area at the top of the main Anime Studio 
window, adjust the settings for the Freehand tool to match those 
shown below:

•	 Variable Line Width: Use Pen Pressure

•	 Width Variation: 75%

•	 Taper Start: Checked

•	 Taper End: Checked
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 Freehand settings

Draw two or three curvy lines using the Freehand tool in the 
editing view:

 Freehand curves

Because of the line width set in the Style window, these curves 
should be rather thick. The tapering settings in the Freehand 
options should make the ends of these lines taper down to 
narrow points. If you select File > Preview now, the result 
should look pretty much like what you see in the editing view:
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 Rendered curves

Close the rendering window, and use the Select Shape tool to 
select one of the curves:

 Select Shape Tool

 Selected curve

In the Style window, click on the box that currently says No 
Brush.

 No Brush
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 In the brush dialog that appears, select one of the brush shapes 
that interests you - you’ll see a preview of the brush at the 
bottom of the dialog:

 Brush Dialog

Click OK to close the brush dialog, and select File > Preview 
again. In the rendered result you can see the applied brush 
shape:

 Rendered curves

Try applying other brush shapes and Stroke colors to the other 
curves:
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 Different brush shapes

If you notice that your brush effects are not 
visible until you render or export your animation 

(brush shapes are not possible when exporting to SWF 
format), you can change the display quality to show the 
effects during editing. In the lower-right corner of the 
main Anime Studio window is the Display Quality 
popup box. Click this box to open it. Turn on the Brushes 
checkbox. This will turn on brushes in Anime Studio’s 
editing view:

 Turn on Brushes preview option
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 Brushes in editing view

Displaying brushes while editing requires a lot of computation 
and can slow Anime Studio down, so it’s best to use this as a kind 
of preview, but not to leave it on all the time. When you’ve got 
the brushes how you like them, switch this display option back 
off.

Tutorial 2.6: Layer Masking
This tutorial is more of a show & tell than a hands-on creation of 
an animation. We will demonstrate some examples of a powerful 
feature of Anime Studio - layer masking. Layer masking can 

be used for all kinds of effects such as shadows, compositing, 
depth effects, transitions, and to simplify certain modeling and 
animation tasks.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 2.6 and it’s located in the Tutorials 
> 2 - Drawing subfolder within the main Anime Studio folder. 
Open this file in Anime Studio, expand the Masking Group layer 
in the Layers window, and you should see something like this:

 Starting point for this tutorial

This is a simple scene of a wall with a hole broken through it (a 
jailbreak maybe?). Set the current time to frame 24, and choose 
the File > Preview menu command. Notice how the spotlights 
spread across the hole as if it were a flat object as shown below:
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 Spotlights shining across the hole

To make the spotlights more realistic, we can use Anime Studio’s 
masking feature. Double-click the Masking Group layer. In the 
Layer Settings dialog that appears, go to the Masking tab and set 
the Group Mask setting to Hide all as shown below and click OK.

 Mask setting for the Masking Group layer

In the editing view, you’ll notice that the light no longer appears 
over the hole. This is because the masking mode we just set hides 
the areas of the light that fall within the area of the hole:



Anime Studio Pro 8
Users Manual

47

Drawing

 Everything in the group is hidden

The setting that controls how the mask reacts is found in the next 
section of the Masking tab. Double-click the Wall layer to bring 
up the Layer Settings dialog. In the Masking tab, notice that the 
Layer masking value is set to + Add to mask as shown below. 
Click OK to exit the Layer Masking tab:

 Mask setting for the Wall layer

What we’ve done is tell Anime Studio to add the contents of the 
Wall layer to the visible region of all objects in the group. No 
other layers in the same group will be allowed to draw outside 
this visible region (the mask). If you temporarily turn off the 
Background layer, you’ll see that there is an actual hole in the 
wall. Because the wall acts as a mask, the spotlights cannot draw 
themselves in this area. You’re welcome to render out the entire 
animation as a QuickTime movie to see the full, animated effect.
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 The wall acting as a mask

Another Example - Simplified Modeling

Now open the file Tutorial 2.6_2. Take a look at the masking 
group in this project (in this case, the masking function is already 
turned on). In this example, the eyes are used as a mask, and 
the eyelids are forced to render themselves only inside the eyes. 
This makes it much easier to construct and animate the eyelids, 

without having to worry about them spreading outside the eye 
region - with a mask layer, they can’t.

Another Example - Transition Effect

Finally, open the file Tutorial 2.6_3. This project uses a mask 
layer to cause a text object to fade into existence. Play back the 
animation, or export it as a QuickTime movie, then play back 
the movie. In this example, a variation of the masking feature is 
used: the mask itself doesn’t have to be visible. In this case, the 
mask is a rectangle that gradually exposes the text, but we don’t 
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really want to see the rectangle. To use an invisible mask, the 
Mask layer uses the + Add to mask, but keep invisible option 
in the Masking tab.

Tutorial 2.7: Styles
In this tutorial we’ll introduce Anime Studio’s Style feature. A 
style in Anime Studio is a set of shape properties, including fill 
and line color, line width, fill effects, etc. Once you’ve defined 
a style, you can apply it to as many shapes as you wish. The 

benefit to this is that later on you can easily change the color and 
appearance of those shapes just by changing a single style.

Start With a Sample File

To start off, we’ll take a look at an Anime Studio file that already 
contains some styles. It’s named Tutorial 2.7 and it’s located in 
the Tutorials > 2 - Drawing subfolder within the main Anime 
Studio folder. Open this file in Anime Studio, and you should see 
something like this:
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 Starting point for this tutorial

 (Don’t worry that the character is all split apart. This is part of 
the bone setup described in another tutorial. If you want to try 
switching to frame 1, you’ll see that the character snaps back 
together. Just be sure to go back to frame 0 before continuing.)

Let’s see what a style is all about. In the Style window, display the 
Advanced settings by clicking the Advanced option.

Click the Advanced checkbox to display more style options.

Select Skin from the Styles popup menu. The Skin style will 
become selected in the Style window:
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 The skin style selected

Click the Fill color selector to change the Skin fill color. Pick 
any color you wish. Notice that the skin color updates instantly 
on all the body parts of the character, even though they are 
separate shapes and in several separate layers. Styles can be used 

throughout an entire Anime Studio project, and are not limited 
to the shapes in a single layer.

 Modified skin color

If we look at the Style window, there are three things to notice 
about the Skin style:

1: The Skin style defines a fill color. 2: The Skin style does not 
define a line color. 3: The Skin style does not define a line width. 
Because the Skin style does not define a line color or width, 
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changing these parameters will not affect the shapes that use this 
style.

 Skin style settings

Let’s try a style that does control the properties of a line. Select 
the Outline style from the Styles popup menu in the Style 
window. Notice that this style does define a line color and width, 
but does not define a fill color. Change the Line Color to green 
and Line Width to 8 as shown below, and assign a brush to the 
line:

 Modified Outline style

Notice that the Outline style has been applied to all the shapes 
in the entire character. Regardless of their other settings (like fill 
color), all the shapes use the Outline style to draw their outlines:
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 New Outline style

How Styles Are Applied

Now let’s take a look at how styles are created and applied. 
Create a new Anime Studio project file. In the Style window, 
select New from the Styles popup menu. 

The Style window will now be editing the values for that style. 
Give the style a name (any name), and choose a fill and line 
color. Finally, set the line width to 8 or so. If you want to, you can 
also assign a brush and fill and line effects.
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 Creating a new style

Next, create a simple shape in the main window - a circle, 
rectangle, or text object would be fine. Make sure that the shape 
is filled. 

 Create a simple shape

 Select Shape Tool
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If you want to apply a style to any other shape, use the Select 
Shape tool to click on your shape to select it. The Style window 
will update itself to show you the properties of the selected 
shape. Select your style from the Styles popup menu. This tells 
Anime Studio to apply that style to the currently selected shape 
- you should see the properties of your style applied immediately 
in Anime Studio’s editing view.

 Applying a style to a shape

That’s it! As you’ve seen, it’s quite easy to create and apply styles 
in Anime Studio.

Tutorial 2.8: Simple 3D Construction
Anime Studio is primarily a 2D program, although it does have 
some 3D tools for positioning the camera and individual layers. 
Still, even if you position layers in a 3D landscape and fly around 
them with the camera, each vector layer is really just a 2D plane 
in a 3D space. 

While you can’t create 3D objects in the same way that you can 
in a dedicated 3D modeling program, Anime Studio does allow 
you to position and rotate two-dimensional planes in 3D space 
and then fly around them. If you need a more complex 3D shape 
you can import a 3D object as described in “Tutorial 6.8: Using 
3D Models” on page 199. You can also create 3D objects using 
a 2D vector shape, as described in “Tutorial 2.9: 3D Shape 
Design” on page 61.

This tutorial will show you how to build a simple cube in Anime 
Studio. If you need a more complex 3D shape, you can import 
a 3D object file created in a separate 3D modeling program 
(described in another tutorial).

Start With a Blank File

For this tutorial, start with a new, blank project in Anime Studio. 
The completed file is also available for you to examine if you 
wish. It’s named Tutorial 2.8 and it’s located in the Tutorials > 
2 - Draw subfolder within the main Anime Studio folder.



Anime Studio Pro 8
Users Manual

56

Drawing

Creating The Faces

The first step is to create the faces of the cube. In the initial, 
empty layer of your new project, use the Draw Shape tool to 
draw a square. 

 Draw Shape

It’s important that the square be precise. Choose the View > 
Enable Grid command to turn on the grid. This will help you 
draw this square.

The square must be centered at the layer origin, must be truly 
square (not a rectangle), and should touch the top and bottom of 
the viewable area exactly. To draw the square, press the Alt and 
Shift keys concurrently, and click at the layer origin point. The 
Alt key will draw the square outward from the point at which you 
clicked, and the Shift key will constrain the rectangle to create a 
square with four equal sides.

What’s important for this square is that the corners are at (-1, 1), 
(1, 1), (1, -1), and (-1, -1) as shown in the following figure. 

Don’t worry too much about the coordinates - if you use the 
grid, center the square at the origin, and make sure the top 
and bottom touch the top and bottom of the viewable area, the 
corners will be correct. 

 Start with a square

You can select the Transform Points tool and optionally enter the 
coordinates for each point manually in the tool options area.
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 You can manually enter coordinates in the Tool Options area

Select the shape with the Select Shape tool. Then fill the square 
with a color of your choice and set its line width to 2.

In the Layers window, click the New Layer button. Create a 
Group layer, name it Cube, and put the layer with the square 
inside it. Duplicate the square layer five times and you should 
have a setup that looks like this:

 Arranging the layers

Positioning Faces

Select the lowest layer in the group, Layer 1, and make the 
Translate Layer tool active. 
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 Translate Layer

We’re not going to actually use the Translate Layer tool, but 
making it active allows us to position a layer numerically. At 
the top of the main Anime Studio window, in the tool options 
area, set the value of Z to 1. This changes the depth of the layer, 
bringing it forward toward the camera.

 Layer 1 depth setting

Now select Layer 2, and set its Z value to -1. You’ve just 
positioned the front and back faces of the cube. 

 Layer 2 depth setting

The settings get a little more complex from here on out. Select 
Layer 3, and set its X value to 1. Y and Z remain at 0. 

 Layer 3 depth setting

Next, activate the Rotate Layer XY tool. 

 Rotate Layer XY

The tool area will reflect the rotation of the layer around the Y 
axis. Set this value to 90:

 Layer 3 rotated
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Next up is Layer 4 - adjust it similarly to Layer 3. With the 
Translate Layer tool, set X to -1 and Y and Z to 0, and use the 
Rotate Layer XY tool to set the layer Y rotation to 90.

 Layer 4 Depth Setting

 Layer 4 Rotation Setting

Layer 5 is next - use the Translate Layer tool to set its Y 
position to 1 and the X and Z positions to 0. Next, activate the 
Rotate Layer XY tool and set the rotation angle to 90 degrees. 
Note: Be sure to rotate this layer around the X axis, not the Y 
axis.

 Layer 5 Depth Setting

 Layer 5 Rotation Setting

Finally, the last layer, Layer 6 - adjust it similarly to Layer 5. Use 
the Translate Layer tool to set X and Z to 0, and Y to -1. Then 
use the Rotate Layer XY tool to set the layer X rotation to 90.

 Layer 6 Depth Setting

 Layer 6 Rotation Setting

At this point the cube is basically finished, but it’s a little too big 
to see in the workspace. Use the Scale Layer tool on the Cube 
group layer to make the entire thing a bit smaller. 
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 Scale Layer

It should look something like this: 

 The finished cube

Depth Sorting

The final step required to finish the cube is to turn on depth 
sorting. Double-click the Cube layer to bring up the Layer 
Settings dialog. In the Depth Sort tab, turn on the checkboxes 
marked Sort layers by depth and Sort by true distance and 
click OK. The first checkbox tells Anime Studio to draw the back 
faces of the cube first, then the front ones. The second checkbox 
is a different way of sorting the layers that is mostly used for 3D 
constructions like this cube.

Try using the Orbit Workspace tool to view the cube from 
different angles. It should appear as a true 3D object. 
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 Orbit Workspace Tool

You could now use the cube in a scene - using the Translate 
Layer and Rotate Layer tools to position it at an interesting 
angle, or to move it around during the animation.

 The finished cube, with depth sorting

Tutorial 2.9: 3D Shape Design
Anime Studio’s 3D Shape Design feature allows you to convert a 
2D vector layer into a 3D object. To demonstrate this, begin with 
a new project. 

Use the Add Point Tool or the Draw Shape tool to create one or 
more vector shapes in the layer. Your objects can also include 
holes. All of the shapes that you create in the layer will be 
converted to 3D. Therefore, if you want some of the objects in 
your scene to remain two-dimensional, or if you want them 
to have different 3D properties, you will need to put them in 
separate layers.

Start with two 2D shapes in the same layer.
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After you create your 2D artwork, open the Layer Settings 
dialog for that layer. Choose the 3D Options tab. You will find 
some options that allow you choose a 3D Conversion type. The 
choices are Extrude, Lathe, and Inflate, which are detailed in the 
following sections.

Options for 3D conversion

There are several settings that are common to each of the 3D 
conversion types. These options are similar to regular 3D layers, 
and they affect how the edges and shading appear in the 3D 
objects. 

Options for Extrude conversion

•	 Edges: Controls which edges should be shown, and whether 
you want to show them on Silhouettes, Materials, or 
Creases. By default, edges are shown for all three. Uncheck 
the edges that you do not want to display. When displaying 
creases, you can adjust the Threshold setting to control the 
number of creases that are displayed. The Edge Extension 
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setting controls how far beyond the edge of the object that 
edges will be drawn. Increase the Extension setting to make 
the objects it look like they have been sketched.

Edges options

•	 Shading: Choose between None (which gives the object 
a flat appearance), Smooth (which gives a smooth, more 
three-dimensional shaded look), Toon (which has stepped 
shading), or Hatched (which shades with a sketched line 
effect). Shading Color Shading Density 

Extrude Conversions

When you choose the Extrude conversion, the 2D object is given 
a dimension of thickness: You can observe the thickness by using 
the Rotate Layer tool in the Layer section of the tool box. You can 
increase or decrease the thickness of the 3D shape by adjusting 
the Thickness setting in the Style window.

Extrude 3D Conversion

When paths are displayed, you can still edit the path to change 
the shape of the 3D object, and change its color. You can also add 
bones to the 3D layer as well.
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You can still edit the path to modify the 3D shape.

Lathe Conversions

The Lathe conversion allows you to create a three-dimensional 
path by drawing a two-dimensional profile shape that is then 
projected in a 360 degree circular fashion. The rotation occurs 
around the origin point of the shape (represented by the 
crosshairs in the workspace area). 

The following conditions apply when using lathe conversions:

•	 If the vector shape only has a stroke, the stroke color will be 
used for the lathe object, and the outline will be black.

•	 If the vector shape has a fill color, the fill color will be used 
for the lathe object. The stroke color will be used for the 
outline of the lathe object. An example is shown in the 
following figure.

Original filled shape (top); resulting lathed object (bottom)
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Inflate Conversions

Inflate is similar to Extrude, except that the edges are rounded, 
like a pillow. It also involves more computations than the 
Extrude option, so you will tend to see better results after you 
render it than you will during the preview. 

Two inflated shapes on the same layer.
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Bones

Tutorial 3.1: Bone Binding
The purpose of bones in Anime Studio is to provide high-level 
objects that are easy to manipulate in place of moving around 
lots of individual points. In order for bones to do their job, vector 
control points and other objects must first be bound to the bones. 
There are three ways to bind objects to bones: automatic binding, 
manual binding, and layer binding. This tutorial will show you 
the difference between the three.

Start With a Sample File

For this tutorial, we’ll start with a project file that contains some 
artwork to get started with. It’s named Tutorial 3.1 and it’s 
located in the Tutorials > 3 - Bones subfolder within the main 
Anime Studio folder. Open this file in Anime Studio, and you 
should see something like this:

 Starting point for this tutorial

Automatic Binding

The most common method of binding objects to bones is also 
the easiest - automatic bone binding. Whenever you draw new 
artwork in Anime Studio (or import image files as image layers), 
those objects are set up for automatic bone binding. All you need 
to do is add the bones.
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1.	 In the Layers window, click the New Layer button, and select 
Bone from the popup menu. 

 Create a new Bone layer

2.	 Double-click the new bone layer to bring up the Layer 
Settings dialog. Name the new layer Arm Bones and click 
OK. Finally, drag the Arm vector layer upward to move it 
into the bone layer:

 Arm layer placed inside a bone layer

Make sure the bone layer is selected, then activate the Add Bone 
tool. 

 Add Bone Tool

In the main editing view, create two bones: the first one starting 
at the shoulder and ending at the elbow, and the second starting 
where the first left off and ending in the hand. And that’s all it 
takes for automatic bone binding. 
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 Create two new bones

Use the Manipulate Bones tool to try moving the bones around. 
The arm will move with the bones automatically, since it was, 
well, automatically bound to them.

 Manipulate Bones Tool

 Test moving the bones

This arm setup works pretty well as it is, but let’s try to refine it 
a bit. Double-click the bone layer to bring up the Layer Settings 
dialog. Go to the Bones tab, set the binding mode to Region 
binding, and click OK:
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 Turn on region binding

Flexible binding (the default for new bone layers) uses a method 
of bone binding where every bone has some influence over every 
point in a vector layer. The farther away a point is from a bone, 
the less influence that bone has over the point. However, you can 
still experience some rubbery movement where a moving arm 
can cause a toe to twitch a little bit.

With region binding, on the other hand, every bone has a cutoff 
radius, outside of which it will not affect the movement of vector 
points. This can be used for cleaner movement, but requires a 
little extra setup. Now that region binding is in effect, activate 
the Bone Strength tool. 

 Bone Strength Tool

Around each bone you will see its region of influence. Vector 
points are controlled by the bone(s) whose regions overlap them. 
If a vector point is not within any region of influence, it will move 
with the closest bone. Using the Bone Strength tool, click and 
drag on each of the bones to resize its region of influence. The 
idea is to make the regions just large enough to contain the body 
part that the bone is meant to control:
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 Resized regions of influence

Don’t worry about the parts of the forearm that are outside the 
forearm bone’s region of influence - they will just move with the 
closest bone, which is in fact the forearm.

Use the Manipulate Bones tool again to try moving the arm. 
The movement should be a little cleaner than it was with flexible 
binding.

 Manipulate Bones Tool

Manual Binding

Manually binding points to bones is a process that exists mostly 
for compatibility with older versions of Anime Studio. Automatic 
binding, combined with bone regions of influence is the easiest 
way to work with bones in Anime Studio. However, there may 
be some times where you want more control over exactly which 
bones control which points.

To manually bind the arm points to bones:

1.	 Select the Arm vector layer. 

 Arm Vector Layer

2.	 Use the Select Bone tool to select the upper arm bone:
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 Select Bone Tool

 Select the upper arm

3.	 Activate the Bind Points tool.

 Bind Points Tool

4.	 Drag a rectangle around all the points in the arm to select 
them, and press the spacebar to bind the selected points to 
the selected bone:

 Bind all points to the upper arm

5.	 With the Bind Points tool still active, hold down the Alt 
key and click on the lower arm bone to select it. Notice the 
following:
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�� When you select the lower arm bone, notice that no 
points are selected. 

�� When you select a bone with the Bind Points tool, the 
points that are bound to that bone are also selected. 
Because there are currently no points bound to the 
lower arm bone, no points are selected.

6.	 Drag a selection rectangle around the points in the lower 
part of the arm, as shown below. Press the spacebar to bind 
the selected points to the selected bone:

 Select the lower arm bones

You’re done - you have manually bound points to both bones in 
the arm. Now test it out with the Manipulate Bones tool.

 Manipulate Bones Tool

Although this method does work for binding points to bones, we 
don’t really recommend it unless you have a special need to bind 
specific points to specific bones. You may have noticed that the 
arm doesn’t move so smoothly with manual point binding. This is 
because the points around the elbow only move with one bone or 
the other, and so stretch apart and get distorted. With automatic 
binding, on the other hand, the points around the elbow move 
under the influence of both bones, and so move more smoothly.

Manual point binding can also be very labor-intensive, especially 
when your artwork has lots of control points. Finally, automatic 
bone binding can be used to warp image layers, while manual 
binding can’t - another reason to stick with automatic bone 
binding (using either flexible or region binding mode).
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Layer Binding

The last way to bind an object to a bone is to bind an entire layer 
to a single arm. 

1.	 Make sure the Arm vector layer is still selected and activate 
the Bind Layer tool. 

 Bind Layer Tool

2.	 Click on the lower arm bone to bind the entire Arm layer to 
the lower arm bone.

 Bind the Arm layer to the lower arm bone

3.	 Select the Arm Bone layer and use the Manipulate Bones 
tool to try moving the bones around. Notice that the entire 
arm moves rigidly with the lower arm bone - the entire layer 
is bound to that one bone. 
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 Manipulate Bones Tool

This isn’t very useful for this particular arm, but binding a 
layer to a bone is useful when you want to attach an object to 
a character. For example, a switch group containing multiple 
mouth shapes can be attached to a bone in the head. Or, if you 
want to make a character hold an object in its hand, you might 
bind that object to the character’s hand bone.

Go Back to Automatic Mode

Let’s undo all of this extra binding and go back to automatic 
mode. 

1.	 Reselect the Arm layer in the Layers window.

2.	 With the Bind Layer tool, click on some empty space in the 
editing view - this tells Anime Studio to not bind the layer to 
any bone. 

 Bind Layer Tool

3.	 Select the Edit > Select All menu command to select all the 
vector points. 

4.	 Choose the Bone > Flexi-Bind Points menu command to 
flexibly bind the points, as they were at the very beginning. 

 Chose Bone > Flexi-Bind Points to flexibly bind points as originally 
set in the beginning.

5.	 Reselect the Arm Bone layer, and use the Manipulate Bones 
tool if you wish to confirm that the points are automatically 
bound again.
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 The arm under bone control.

 The final result. (SWF File)

Tutorial 3.2: Bone Constraints
This tutorial demonstrates Anime Studio’s bone constraint 
features. Bone constraints allow you to define limits on the way 
bones can move, simplifying your animation work. When used 
carefully, bone constraints can let the bone structures do some of 
the work for you.
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Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 3.2 and it’s located in the Tutorials 
> 3 - Bones subfolder within the main Anime Studio folder. 
Open this file in Anime Studio, and you should see something 
like this:

 Starting point for this tutorial

This file contains two skeleton layers that have no constraints 
set up. We’re going to add constraints to these skeletons to show 
how useful they can be.

Angle Constraints

The first type of bone constraint is angle limits. By limiting the 
angle that a bone can rotate, you can prevent arms and legs from 
bending backwards. 

1.	 Make sure the Arm layer is selected.

 Select the Arm bone

2.	 Use the Select Bone tool to select the bone in the Arm as 
shown below:
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 Select Bone Tool

Select the lower arm bone.

3.	 When the Select Bone tool is active and a bone is selected, 
the Bone Constraints popup box will be available in the tool 
options area of the main Anime Studio window. Click the 
Bone Constraints popup to open it.

4.	 Adjust the settings as shown below. Specifically, turn on the 
Angle constraints checkbox, and set the min/max angle 
fields to -10 and 100.

 Set angle constraints
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5.	 Click the Close button to close the constraints popup box. 

6.	 Set the bone’s name to Forearm in the toolbar options.

 Name this bone Forearm

7.	 Once you’ve set up angle constraints, you can see them in the 
working area as two lines around the bone that indicate the 
minimum and maximum angles the bone is allowed to rotate 
between. Try using the Manipulate Bones tool and move 
the forearm - notice how Anime Studio doesn’t allow you to 
move the bone beyond the minimum and maximum angles 
you set up.

 Manipulate Bones Tool

 Visual display of angle constraints

Here’s a handy little trick. Often, it can be hard to 
judge the correct numerical angles for bone 

constraints. There’s an easy way to adjust them if you 
have a mouse with a scroll wheel. Hold the mouse over 
the angle constraint you wish to change (in the Bone 
Constraints popup), and roll the mouse wheel up and 
down. The angle will change, and the display in the 
editing view will update to match. With this method, you 
can watch the display in the editing view and not worry 
so much about the actual numerical value.
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Control Bones

The next type of bone constraint allows one bone to control 
the motion of another. This is a way to set up simple automatic 
animation. 

1.	 Use the Select Bone tool to elect the small bone above the 
upper arm:

 Upper forearm bone selected.

2.	 Bring up the Bone Constraints popup again, and select 
Forearm from the Angle control bone popup menu (this 
is why we named it earlier), and enter the value 0.5 in the 
angle control field as shown below:

 Angle control setup

3.	 We’ll do something similar for the small bone below the 
upper arm. Select that bone, and set Forearm as the angle 
control bone, but this time set the angle control value to 
-0.5.
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Lower forearm bone selected.

4.	 Finally, use the Manipulate Bones tool again to move the 
forearm. Notice that now the muscles in the upper arm move 
automatically - this is what the Angle Control Bone does - it 
tells other bones to move automatically when it moves.
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 Manipulate Bones Tool

 Upper Arm bones move automatically

Bone Locking

The third category of bone constraint is bone locking. When 
you lock a bone, you’re telling Anime Studio that you don’t 
want it to move. Anime Studio will try to keep the bone still by 
moving its parents as necessary to keep the bone in place. This 
isn’t always possible (depending on what else is happening in the 
animation), but it is still an extremely useful feature.

Bone locking is often used to keep a character’s feet from moving 
around on the ground. To do this, Anime Studio needs to move 
the character’s legs automatically. Thus, it helps to use angle 
constraints to keep the knees from bending backwards. 

1.	 Select the Frank w/Skeleton layer in the Layers window.

Select the Frank w/Skeleton layer.

2.	 Use the Select Bone tool to select Frank’s left shin bone as 
shown:
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 Select the left shin

3.	 Now set up angle constraints for this bone. The minimum 
angle should be -10, and the maximum should be 120:

 Angle constraints for left shin

4.	 Now select the right shin, and set its angle constraints to 
-120 and 10.
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 Angle constraints for right shin

5.	 Now that the legs are prepared, set the time to frame 24. Use 
the Translate Bone tool to drag Frank’s spine bone around 
a small distance. Notice that his feet move around and don’t 
stay in place. 

 Translate Bone Tool

6.	 Choose the Select Bone tool again. Go back to frame 0 and 
select the left foot bone:
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 Select the left foot

7.	 In the tool options area, turn on the Lock bone checkbox for 
this bone. Next, select the right foot bone and turn on Lock 
bone for it as well.

 Lock both foot bones

8.	 Now that the feet are locked, go back to frame 24, and use 
the Translate Bone tool again to drag Frank’s spine around. 

 Translate Bone Tool

9.	 Notice that now Anime Studio tries to keep Frank’s feet 
locked to the ground. If you lift Frank too high, his legs 
will completely straighten out and his feet will lift from the 
ground - there’s really no helping that, the same thing would 
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happen to you if you were lifted off the ground. You can try 
rotating the spine bone too and see how the skeleton reacts.

 Locked feet

Bone locking is an animated parameter. You can 
turn on and off bone locking as many times as 

you want during an animation. This is especially useful 
when making a character walk - lock a bone as soon as 
a foot hits the ground, and unlock it just before the foot is 
to leave the ground for its next step.

Tutorial 3.3: Bone Dynamics
Anime Studio’s bone dynamics system can be used to 
automatically move bones around in response to higher-level 
movement. Anime Studio uses a physical simulation of springs 
to calculate dynamic bone movement, making it suitable for a 
wide range of movements, such as flabby body parts, bouncy 
hair, waving arms, etc.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 3.3 and it’s located in the Tutorials 
> 3 - Bones subfolder within the main Anime Studio folder. 

1.	 Open the Tutorial 3.3 file in Anime Studio. You should see 
something like this:
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 Starting point for this tutorial

2.	 Play back the animation to see what we’re starting with. 
The entire structure will tilt side to side and bounce up and 
down, remaining rigid the whole time. Only the vertical 
bone in the center of the skeleton is animated - all the others 
move with it because they are its descendants. Rewind the 
animation to frame 0 when you’ve seen enough.

3.	 Use the Select Bone tool to select the top-left bone in the 
structure as shown below:

 Select Bone Tool

 Select this bone
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4.	 In the tool options area at the top of the main Anime Studio 
window, click the Bone constraints popup box to open 
it. In the popup box, turn on the Bone dynamics check 
box. This tells Anime Studio to move the selected bone 
automatically according to the spring simulation.

 Turn on bone dynamics

5.	 Select seven more bones (two in each of the arms), and turn 
on bone dynamics for each one. 

Here’s a tip: you can leave the Bone constraints 
popup box open the whole time, just click on each 

bone in turn, then turn on bone dynamics for each one. If 
the Bone constraints popup box covers up some of the 
bones, you can pan the editing view by dragging with 
the right mouse button to expose the hidden bones. At 
this point, you should have turned on bone dynamics for 
every bone in the structure except the vertical center 
bone. 

 All eight leg bones set
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Play back the animation to see the difference. Now as the 
structure tilts side to side, the arms will bounce around in 
response to the movement of the center bone.

Adjusting Spring Parameters

So that shows the basics of how to use bone dynamics. Now let’s 
take a look at how you can make adjustments to the bounciness 
of the springs. 

1.	 Select the top-left bone again, and re-open the Bone 
constraints popup box. 

2.	 Below the Bone dynamics checkbox are three parameters 
that allow you to fine-tune the effect. Set as follows:

�� Torque force to 4, 

�� Spring force to 2

�� Damping force to 2 

 Adjusting dynamics parameters for both bones in the top left arm

3.	 Select the bone’s immediate parent (the second bone in the 
top-left arm), and apply the same dynamics parameters.
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A higher Torque force means that a bone moves 
more in response to its parent’s movement, 

Spring force determines how quickly it bounces back, 
and Damping force controls how quickly a dynamic 
bone stops moving (you can think of damping like 
friction). In this case, a high torque force means that the 
bone will move more strongly. 

4.	 Next, select the two bones of the top-right arm (one at a 
time), and set the bone dynamics parameters to 2, 2, 5 
(Torque, Spring, Damping). These settings will cause these 
bones to slow down their dynamic movement quickly - a 
high damping value is like making the bone move through a 
thick fluid.

 Set a high damping force on these bones

Finally, select the two bones of the bottom-left arm (one at a 
time), and set the bone dynamics parameters to 2, 4, 1 (Torque, 
Spring, Damping). The high spring force will cause this arm to 
bounce back very quickly.
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 Set a high spring force on these bones

Try playing back the animation again. As you watch the final 
animation, note the differences between the four arms. The top-

left arm swings in a wide arc because it has a strong response to 
the parent bone’s movement. The top-right arm’s movement is 
subdued because the damping force causes it to slow down more 
quickly. The bottom-left arm is very springy, and the bottom-
right arm moves in accordance with the default bone dynamics 
settings.

 The final result. (SWF File)
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Tutorial 3.4: Character Setup
In this tutorial, you will learn how to set up the bone system 
for a complex character. This will involve splitting a character 
apart, creating bones, adjusting bone strength, and putting the 
character back together.

Start With a Sample File and Split Apart the 
Character

For this tutorial, we’ll start with a project file that already has the 
artwork for the character drawn - you’ll just set up the bones. It’s 
named Tutorial 3.4 and it’s located in the Tutorials > 3 - Bones 
subfolder within the main Anime Studio folder. 

To begin:

1.	 Open the Tutorials > 3 - Bones > Tutorial 3.4 file in Anime 
Studio. There are six vector layers in this project, containing 
the body parts for this character. Although all the artwork 
could be drawn in one vector layer, it is often easier to draw 
a character in multiple layers, arranging the body parts from 
back to front, as shown below:

 Starting point for this tutorial
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 Starting point for this tutorial

2.	 In order to make bone setup easier, the first thing to do is 
split apart the character. Choose the Edit > Select All menu 
command. All the points in the right arm (your right, his left) 
should be selected. 

3.	 Activate the Translate Points tool and drag the mouse to 
move the arm off to the side and up a bit:

 Translate Points
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 Arm moved off to the side

4.	 Select the Head layer, and select all of its points with the 
Edit > Select All command. Move all of its points upward. 

5.	 Repeat the process for the R Leg, L Leg, and L Arm layers 
of the character (skip the Torso layer). Select all points on 
each of those layers, and move the body parts away from the 
center, as shown below:

The reason we split apart the character is so that 
we can add bones to each part, while keeping the 

bones independent of each other. Later in the tutorial 
we’ll put the character back together again.

 Body parts split apart

Add Bones

The next step is to add bones. 
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1.	 Add a new Bone layer to the project. Name the new Bone 
layer Skeleton. Move the new Bone layer to the top of the 
list if necessary.

 Create a new Skeleton bone layer (top) and move it to the top 
(bottom).

2.	 Move all the vector layers into the new Skeleton layer, 
keeping the same order they are in now:

 Move all of the body part layers into the Skeleton bone layer.

3.	 Using the Add Bone tool, add two bones going up through 
the torso, starting with the bottom one:

 Add Bone Tool
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 Two new bones

4.	 Next, add two bones to one of the arms, starting at the 
shoulder and going down. 

5.	 Before you add bones to the second arm, use the Select 
Bone tool to reselect the upper torso bone. Then switch 
back to the Add Bone tool to add two bones to the other 
arm. This parents the second arm to the upper torso bone 
instead of continuing from the first arm. 

 Arm bones added

6.	 Use the Select Bone tool to select the lower torso bone. 
Then, select the Add Bone tool and add three bones to one 
leg, starting at the hip and moving down through the foot. 
Repeat the process for the other leg, making sure to reselect 
the lower torso bone first. The upper leg bones should be 
parented to the lower torso bone. 
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 Leg bones added

7.	 Use the Select Bone tool to select the upper torso bone, and 
then use the Add Bone tool to add one bone to the head. 

 Head bone added

8.	 The next figure shows the parenting of all the bones. The 
parenting arrows point from child bone to parent bone, and 
can be seen by activating the Reparent Bone tool:
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 Reparent Bone Tool

 All the bones added

 Manipulate Bones Tool

Adjust Bone Influence

At this point, feel free to try using the Manipulate Bones tool 
to see how the bone system works so far. The body parts should 
mostly move how you would expect, but not totally cleanly - the 
next step is to clean up the bones’ influence.

1.	 Double-click the Skeleton layer in the Layers window to 
bring up the Layer Settings dialog. 

2.	 Go to the Bones tab and set the binding mode to Region 
binding:
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 Turn on region binding

When region binding is used, bones only move 
the points that lie in their region of influence. If a 

point is overlapped by multiple regions of influence, it 
will be affected by all the corresponding bones. If a point 
is in no bone’s region of influence, it will move with the 
nearest bone.

This is different from flexi-binding, where all bones affect 
all points. Flexi-binding can be quicker to set up, but 
leads to more rubbery motion, since moving a hand will 
always cause a little bit of movement in a foot. Region 
binding makes separate body parts truly separate.

3.	 For region binding to work, you need to adjust the region 
of influence for each bone. To do this, activate the Bone 
Strength tool to display the bones’ regions of influence:

 Bone Strength Tool

 Initial regions of influence
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4.	 Using the Bone Strength tool, click and drag on each bone in 
turn to adjust its region of influence. The correct adjustment 
for a region of influence it generally to surround the points 
along that section of bone. The most important regions are 
at the joints - the knees and elbows and such. Those are the 
areas where the regions of two bones overlap, and points 
will bend under the control of both bones. For parts like this 
character’s head, the region of influence isn’t very important 
- since there’s just one bone, the points outside the region 
of influence will still move with that bone. Here’s how you 
should adjust the regions of influence (don’t worry about 
matching this exactly, just try to get kind of close):Adjusted 
regions of influence.

 Adjusted regions of influence

5.	 Try using the Manipulate Bones tool again to test the bone 
setup. The character should move much more cleanly now 
- when moving an arm, for example, only that arm should 
move, and you should see no extra movement in other body 
parts.
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 Manipulate Bones Tool

Put the Character Back Together

The final step is to reassemble the character. 

1.	 Activate the Offset Bone tool. 

 Offset Bone Tool

2.	 Click and drag on the top bone of each body part to move 
that part back into position. When each part is moved 

back into place, the character should look as shown in the 
following figure:

�� Move each arm by the upper arm bone

�� Move each leg by the thigh bone

�� Move the head by its single bone.

  Re-assembled character
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Frame 0 is considered the setup frame for bones. 
When the time is set to frame 0, the character 

will still appear split apart (unless you’re using the 
Offset Bone or Manipulate Bones tools). However, at 
other frames in the animation, the character will be 
re-assembled according to how you used the Offset Bone 
tool.

3.	 Try moving the character around again with the Manipulate 
Bones tool. The body parts will still move independently, 
even though they now overlap. Because the bones were set 
up on a split-apart character, that character could be re-
assembled while still keeping the body parts independent.

 Manipulate Bones Tool

 Final character

If you’re interested in taking a look at the final 
Anime Studio file, it’s named Tutorial 3.4 Final 

and it’s located in the Tutorials > 3 - Bones subfolder 
within the main Anime Studio folder.
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Tutorial 4.1: Image Layers
This tutorial introduces another type of layer in Anime Studio: 
Image Layers. Image layers are a way of including artwork 
created in other programs in a Anime Studio project. Any 
application that can produce image files can be used with Anime 
Studio: photo editors, 3D modeling programs, natural media 
painting programs, the list goes on...

An image layer in Anime Studio contains a single image file that 
can be used as a background, or combined with a bone layer to 
build a character. Although they’re called Image layers, an Image 
layer can also make use of a movie file as its source. Image layers 
and vector layers can be mixed and matched in the same project.

Alpha Channels

You’ll notice that the images used in this tutorial do not appear 
rectangular. This is because they make use of an alpha channel 
to mark some parts of the image as transparent. We recommend 
using PNG images with Anime Studio because they support 
full alpha channel transparency. You’ll need to use an image 

editing program (like Adobe Photoshop) to create images with 
transparency.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 4.1 and it’s located in the Tutorials 
> 4 - Images subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 4 - Images > Tutorial 4.1 file in Anime 
Studio. This project is almost complete as it is. The only 
thing that’s missing is the dancer’s left hand.

2.	 Expand the Hula Girl layer in the Layers window, and you 
should see something like this: 
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 Starting point for this tutorial

3.	 Click on the layer named L Arm (we want the new layer to 
be just above the left arm). 

4.	 Click the New Layer button in the Layers window to create a 
new layer. In the popup menu that appears, choose Image. 

Create a new Image layer

5.	 Anime Studio will prompt you to select an image file. Choose 
the Anime Studio/Tutorials > 4 - Images > l_hand.png 
image in your Anime Studio installation folder. 

6.	 In the Layers window, double-click the new layer and 
rename it L Hand. At this point, your Layers window should 
look like this:
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 Left hand added

 The new hand

7.	 You’ll notice that new image layers are centered in the 
workspace, so the dancer’s hand is not yet properly aligned: 
To position the arm properly, use the Translate Layer tool 
to drag the left hand into position at the end of the left arm. 
Allow for a little overlap between the two parts at the elbow:
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 Translate Layer

 Left hand in position

8.	 The last step is to attach the new part to the dancer’s 
skeleton. Select the Bind Layer tool, and click on the lower 
arm bone on the dancer, as shown below:

 Bind Layer Tool

 Bind the image layer to the forearm
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You’re done! To see the animation in action, press the Play 
button. Of course, we skipped over the process of building and 
animating the skeleton, but the basics of working with skeletons 
were covered in previous tutorials - all of that information applies 
when using bones with image layers.

 The final result. (SWF File)

Tutorial 4.2: Image Warping
This tutorial demonstrates Anime Studio’s image warping 
feature. This feature allows you to use a skeleton to distort an 
image. In this way, you can animate photographs, hand-drawn 
artwork, or anything you can get into an image file in a flexible 
way.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 4.2 and it’s located in the Tutorials 
> 4 - Images subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 4 - Images > Tutorial 4.2 file in Anime 
Studio.

2.	 Expand the Skeleton layer in the Layers window, and you 
should see something like the following figure. The Skeleton 
bone layer contains two sub-layers: an image layer (statue.
png) and a vector layer (vector sample).
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 Starting point for this tutorial

3.	 Click the Play button in the timeline to play back the 
animation. Notice that only the vector layer moves with the 
skeleton. The reason that the image layer isn’t moving is that 
it hasn’t been connected to the bones yet (as the vector layer 
has been).

 Only the vector layer moves

Using Image Warping

To warp the image layer with the skeleton, continue with the 
project as follows:
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1.	 Double-click the statue.png layer, and go to the Image tab 
in the Layer Settings dialog. Turn on the checkbox marked 
Warp using bones and click OK. 

Turn on the Warp using bones option

2.	 In the Layers window, turn off the visibility for the vector 
sample layer (it is only an example, and we don’t want it in 
the final animation). 

Hide the vector sample layer

3.	 Play back the animation again, and you should now see the 
image moving with the skeleton:
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 Image warping

Notice the horizontal bone at the base of the 
statue. This bone doesn’t move at all in the 

animation, so why is it even there? When using image 
warping, the image is distorted by all the bones in the 
skeleton, and the nearest bone to any part of the image 
has the most influence. We don’t really want the base of 
the statue to move, so an easy way to prevent this is to 
add a bone in the area we want to remain still, and not 
animate it. Another trick you might use when warping 
images is to break up an image into logical parts (for 
example, make the arms and legs of a person separate 
images from the main body). Then, use different 
skeletons to control the various re-assembled parts. This 
way, a leg bone can’t have any influence over an arm.

Tutorial 4.3: Animating a Talking 
Head
This shows you an easy way to animate a photograph to create a 
cheesy talking-head effect. The quality of the result will depend 
a lot on the photograph you start with and how the bone system 
is set up.
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Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 4.3 and it’s located in the Tutorials 
> 4 - Images subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 4 - Images . Tutorial 4.3 file in Anime 
Studio. The project contains an image layer enclosed in a 
bone layer. Bones have already been set up to control the 
mouth region, and extra bones have been set up around the 
border of the image to hold the rest of the head still. You 
should see this:

Starting point for this tutorial

2.	 In the Layers window, click to select the reagan.png layer.

3.	 Select the Manipulate Bones tool and use it to drag the 
bone at the lower right side of the mouth in the reagan.png 
layer. Notice that the other mouth bones move as well - they 
have been set up using bone constraints to move in sync with 
the lower-right bone.
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 Manipulate Bones Tool

 Moving the mouth

Adding Sound and Motion

Now we’ll add a soundtrack to this animation. 

1.	 In the Layers window, click the New Layer icon and create a 
new Audio layer. 
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2.	 When prompted, pick the reagan.wav file from the Anime 
Studio/Tutorials > 4 - Images folder. 

3.	 Press the Play button in the timeline. The audio file will now 
play back with the project - try playing it back if you like.

4.	 The next step is to add some animation in sync with the 
soundtrack. Select the Mouth Bones bone layer, and 
activate the Select Bone tool. Make sure the bottom-right 
bone in the mouth is selected (it probably already is at this 
point). 

 Select Bone Tool

5.	 In the timeline, set the current time to frame 1. 

6.	 Select the Scripts > Sound > Bone Audio Wiggle menu 
command. This is a script that uses the volume of an audio 
file to control the angle of a bone. 

 Bone Audio Wiggle script

7.	 The Bone Audio Wiggle dialog allows you to choose the 
sound file that you want to use. Select the same reagan.wav 
file you used for the soundtrack. You can only select one 
audio file if there are multiple sounds in your scene. 
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 Bone Audio Wiggle dialog

8.	 There are two additional settings in the Bone Audio Wiggle 
dialog. Set the Max angle to 180, and keep the Frame Step 
setting at 2. This creates keyframes at every other frame. 
Click OK to exit the dialog. The script will run and add 
keyframes to the timeline for the selected bone. Because the 
other bones are controlled by the selected one, the whole 
mouth will move.

 Keyframes for Bone Audio Wiggle

Tutorial 4.4: Image Textures
In this tutorial you will learn how to use images as textures to 
add detail to a character.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 4.4 and it’s located in the Tutorials 
> 4 - Images subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 4 - Images > Tutorial 4.4 file in Anime 
Studio, and you should see something like this:
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 Starting point for this tutorial

2.	 Play back the animation to see what’s going on. 

3.	 Be sure to rewind the animation to frame 0 before you 
continue with the next section. 

Paint the Textures

What you’re going to do is hand paint some texture details to go 
on this character. The first step is to paint some textures to go on 
this headless animal’s body. 

1.	 Select the File > Preview menu command to create a full-
quality view of the animal’s current state. 

2.	 In the popup menu at the bottom of the Render window, 
select Copy To Clipboard. 
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 Rendered animal

3.	 Start up your favorite image editing program (we 
recommend Adobe Photoshop) and create a new document 
the same size as the Anime Studio project (320x240 in this 
case). Paste the copied image into the new document.

4.	 Create a new layer in your image editing program and paint 
some kind of texture details onto the animal’s body parts. 
It’s very important that the texture be on a layer of its own. 

If you’re using Photoshop, the layer arrangement would look 
something like this:

 Layers in Photoshop

5.	 Paint whatever details you want. Here’s an example of 
something you might paint in your image editor. Don’t 
worry about painting outside the lines:
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 Painted on texture

6.	 When your texture is finished, get rid of the background 
layers so that only the texture is left with a transparent 
background (you’re still working in Photoshop or similar 
program at this point):

 Background removed

7.	 You need to save the texture as three separate files. For 
each version of the texture, delete the parts of the texture 
that are not attached to the corresponding body parts. Save 
the images in PNG format, since PNG properly stores the 
transparent background. Examples of the three textures are 
shown in the figures that follow.

�� Save an image for the back legs. Name the file back_tex.
png.
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�� Save an image for the torso. Name the file body_tex.
png.

�� Save an image for the front legs. Name the file front_
tex.png.

8.	 After you save your images, you can close the image editor. 
It’s time to bring the textures back into Anime Studio.

 Back legs texture. back_tex.png

 Body texture. body_tex.png
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 Front legs texture. front_tex.png

If you’re having trouble creating the image 
textures, we have provided some files for you to 

examine. Look at the file Tutorial 4.4 Texture.psd, 
located in the Tutorials > 4 - Images subfolder within the 
main Anime Studio folder - this is the Photoshop file. 
Also, look at the files back_tex.png, body_tex.png, and 
front_tex.png, which are the finished texture files.

Import Textures

To import your painted textures in Anime Studio, follow these 
steps:

1.	 In the Layers window, highlight the Back Legs layer. The 
image file that you import will be placed above this layer.

2.	 Create a new Image layer and select back_tex.png as the 
source image. The new image layer appears in the layers list. 

3.	 Select the Body layer as the current layer. Create another 
image layer for body_tex.png . The new layer should appear 
above the Body layer.

4.	 And finally, select the Front Legs layer, and create a third 
image layer for front_tex.png. The new layer appears above 
the Front Legs layer. Here’s how the new image layers 
should be arranged:
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 Three new image layers

 Textures applied in Anime Studio

Use Masking for Clean Edges

At this point, the textures are finished and in place, but they 
are a little messy, and go outside the bounds of the actual body 
parts. The final step is to clean up the texture edges using layer 
masking. 
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1.	 Double-click the Skeleton layer in the Layers window to 
bring up the Layer Settings dialog. Go to the Masking tab, 
and set the group mask to Hide all:

 Turn masking on for the group

2.	 Next, double-click the Back Legs vector layer to bring up 
the Layer Properties dialog for that layer. Go to the Masking 
tab, and set the masking mode to + Clear the mask, then 
add this layer to it. What this masking mode does is make 
all objects invisible, except where this layer has solid areas. 
So, the back_tex.png image layer will only be visible directly 
on top of the Back Legs vector layer, preventing the texture 
from going outside the lines of the back legs. 
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 Set the masking mode for the Body layer

The Back Legs layer with mask

3.	 Repeat step 2 for the Body and Front Legs vector layers. 
Set the masking mode to + Clear the mask, then add this 
layer to it, just like you did for the back legs. At this point, 
all the textures should be forced to stay inside the lines:
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 Textures cleaned up with masking

4.	 Play back the animation again and you’ll see the image 
layers warp along with the vector layers in response to bone 
movement.



Anime Studio Pro 8
Users Manual

123

Animation

Animation
After all the preparation time drawing your objects, assigning fill 
colors, and setting up bones, you move on to animating them. 
This is where things actually start to move around.

Animating in Anime Studio is based on the concept of keyframes. 
A keyframe is a point in time where you position some object 
(either a point, a bone, or an entire layer). A keyframe tells 
Anime Studio exactly where that object should be and when. 
Keyframes are set up at important moments in time - typically 
where an object begins moving, stops moving, or changes 
direction. Between keyframes, Anime Studio automatically 
calculates how to move an object so that it gets from one 
keyframe to the next in the amount of time allowed between the 
keyframes.

To create a keyframe, just set the current time to whenever 
you want the keyframe to occur, then move the object to the 
desired position. Controlling the current time and working with 
keyframes after they’ve been created is discussed in “Timeline 
Window” on page 392.

You can animate several types of motion in an Anime Studio 
project, and they can each be used alone or in combination. 
The first type is point motion. Point motion very basic - it 
just involves moving individual points around in time. Point 
motion is good for small distortions to an object where you want 

something to look soft and flexible (turning up the corners of 
a mouth into a smile, bulging out a belly, etc.). You can move a 
shape in any way you want with point animation, but it might 
require manipulating a lot of points - in many cases bone 
animation can simplify the job.

Bone animation involves setting up a skeleton system for an 
object and then moving the skeleton around. By carefully 
constructing a skeleton, you can easily move a character around 
like a puppet.

Layer animation is for very simple, large-scale motion. When you 
move a layer, everything in it moves together. This doesn’t give 
you a lot of flexibility as far as what you can animate this way, 
but it’s a good way to get certain effects. If you want an entire 
group of objects to pan side to side or zoom in or out, then layer 
animation is the tool to use.

The keyframes you define are visible in the Timeline, starting at 
frame 1. Frame 0 is a special frame in an Anime Studio project - 
the original placement of all your objects is stored at frame 0. If 
you want to modify an object’s original shape or position, or add 
new objects, this should be done at frame 0. Whatever you do 
to an object in later frames can never affect an object’s original 
shape and position, so even if you think you really screwed 
something up, you can always delete some keyframes and get 
back your original drawings.

This chapter has a useful hands-on overview of how to animate 
in Anime Studio, using each type of motion (point, bone, and 
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layer). Once you’ve mastered Anime Studio’s animation tools, 
animating is a simple job of repeatedly using the tools you 
already know, keyframe by keyframe.

Tutorial 5.1: Automatic Lip-Sync
This tutorial uses Anime Studio’s Switch layers to show you 
how to perform instant, automatic lip-syncing. A switch layer 
contains multiple sub-layers, but only one of the sub-layers can 
be displayed at a time. This makes it very useful for lip-sync 
animation: each sub-layer can be a mouth shape for a different 
sound.

The method of lip-sync described in this tutorial is quick and 
easy, though not always super-accurate (but give it a try - it may 
be accurate enough for your animation).

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 5.1 and it’s located in the Tutorials 
> 5 - Animation subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 5 - Animation > Tutorial 5.1 file 
in Anime Studio, expand the Mouth layer in the Layers 
window, and you should see something like this:

 Starting point for this tutorial

2.	 Examine the sub-layers in the Mouth layer. Notice that from 
bottom to top they range from closed to wide open. This is 
the basic setup for automatic lip-syncing. The number and 
names of the sub-layers don’t matter, as long as the lowest 
one is closed and the highest one is wide open.
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 Layers in the Layers window

3.	 Next, add the audio file that will go along with the lip-
syncing. Choose the File > Import > Audio File menu 
command and select the Tutorials > 5 - Animation > 
MaryLamb-Man.wav file in the main Anime Studio folder. 

Make sure that you select the File > Import > 
Audio File command from the lower section of 

the file menu. This differs from the File > Import > Audio 
command in the upper section of the menu, which is used 
to open files in the Anime Studio library.

 File > Import > Audio File command

4.	 Play back the animation now to hear the result. You’ll notice 
that the mouth doesn’t move yet. Stop the playback before 
proceeding.

5.	 Double-click the Mouth layer. When the Layer Settings 
dialog opens, click the Switch tab:
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 Layer settings for the mouth

6.	 Click the Select audio sync source button to select the 
file that will control the Switch layer. In the file dialog that 
appears, select the file MaryLamb-Man.wav. Click the 
dialog’s OK button.

That’s it! The audio file was analyzed and keyframes were 
attached to the Switch layer. When the audio is quiet, Anime 
Studio activates the lowest layer (the closed mouth), and when 
the audio is loudest, Anime Studio uses the highest layer (the 
wide open mouth). In between, Anime Studio switches on the 
in between mouths. Play back the animation to see and hear the 
result. In general, because automatic lip-sync is based on the 
actual sound in the audio file, it is important to use an audio file 
without background noise or music.

 The final result. (SWF File)

Tutorial 5.2: Phoneme Lip-Sync
This tutorial covers another method of animating lip-sync. With 
this method, the lip-sync is based on phonemes. Phonemes are 
the basic building block sounds that make up words. When you 
do lip-sync based on phonemes, it requires you to break down 
the words of dialog into their basic sound elements. 
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Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 5.2 and it’s located in the Tutorials 
> 5 - Animation subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 5 - Animation > Tutorial 5.2 file in 
Anime Studio.

2.	 Expand the Head layer in the Layers window, and you 
should see something like this:

 Starting point for this tutorial

3.	 This project is almost complete. The only thing apparently 
missing is the animation for the character’s mouth. Play 
back the animation. The mouth is there (it’s a switch layer), 
but no animation data has yet been assigned to it, so it 
doesn’t move.

4.	 Double-click the Mouth layer. When the Layer Settings 
dialog opens, click the Switch tab:
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 Switch tab

5.	 Click the Select audio sync source button to select the 
switch data file that will control this switch layer. In the file 

dialog that appears, select the file vista.dat located in the 
Tutorials > 5 - Animation subfolder within the main Anime 
Studio folder.

The Mouth layer contains all the mouth shapes 
needed to speak any phrase. You can examine the 

Mouth layer to see the sub-layers it contains. Each sub-
layer is named after a different phoneme. You can use 
any set of phonemes you choose. The mouth shapes in 
this mouth are based on the same default set used by a 
great (and free) lip syncing program that we 
recommend: Papagayo (http://www.lostmarble.com/
papagayo/) is a good place to get started. To make the 
mouth speak a different phrase, just create a different 
animation data file in Papagayo, and select it into the 
mouth layer as we just did for the vista.dat example.

6.	 To hear the sound along with the animation, choose the File 
> Import > Audio File command from Anime Studio’s menu 
and select the vista.wav file located in the Tutorials > 5 - 
Animation folder. 

Now, when you play back the animation in Anime Studio you 
will hear the audio that goes with the lip-sync. Also, if you export 
the animation as a QuickTime or AVI movie, the audio will be 
included in the movie file.

http://www.lostmarble.com/papagayo/
http://www.lostmarble.com/papagayo/
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If you plan to export your animations to Flash 
(SWF) format, you will need to use MP3 audio 

files instead of WAV audio files. In addition, if you plan 
to render to SWF format, you can only use a single audio 
file in the project.

 The final result. (SWF File)

Tutorial 5.3: Animation Curves

Introduction

This tutorial introduces the graph mode of Anime Studio’s 
timeline. Graph mode allows you to inspect an animation curve 
plotted as values on a graph. Looking at things this way can help 
with evaluating acceleration, changes in direction, and other 
properties of motion.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 5.3 and it’s located in the Tutorials 
> 5 - Animation subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 5 - Animation > Tutorial 5.3 file in 
Anime Studio.

2.	 We’re interested in the Skeleton layer here - make sure it is 
the active layer. 
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The skeleton here is partially animated - go 
ahead and play it back to see what you’re 

starting with. In case you were wondering, only the 
lowest vertical bone in the skeleton is actually animated. 
The other bones are using bone constraints to follow the 
motion of the lowest bone.

Motion Curves

Continue with your project as follows to work with the motion 
curves:

3.	 Rewind the animation to frame zero, and use the Select Bone 
tool to select the lowest vertical bone as shown below:

 Select Bone Tool

 Select the lowest bone

4.	 In the Timeline window, click the Motion Graph tab. Click 
the Selected Bone Angle channel icon - this is the channel 
icon on the left side of the timeline, and looks like this: 
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 Select the Bone Channel icon

5.	 The first time you click the icon, you turn on the display 
of the channel in the graph. The second click makes the 
channel active for editing. 

By default, not all channels are visible, since this 
would just cause too much visual clutter in graph 

mode. For similar reasons, only one channel can be 
active for editing in graph mode. Double-clicking a 
channel’s icon makes it active for editing.

6.	 Now, press the End key on your keyboard - this rescales the 
graph to accommodate the currently active channel, in this 
case the selected bone rotation channel. After all of these 
adjustments to the graph, it should look like the following 
figure.

In the graph you can see three keyframes. These are just 
like keyframes in the normal timeline, but instead of just 
being spread out along a horizontal line (time), they are also 
spaced vertically (value). Between the keyframes, a curve 
is drawn that represents the value of the selected bone’s 
rotation angle. Looking at this curve, you can tell that over 
the first second (frames 1 to 24), the bone rotates from an 
angle of 1.57 to an angle of about 1.05 (we don’t care about 
the exact values). Then, in less than half a second it rotates 
back again.

 Graph mode
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NOTE: In the timeline’s graph mode, angles are 
displayed in radians so that they’ll be closer in 
magnitude to other values like translation and scale. 
However, if you want to see curves displayed in degrees 
you can tell the timeline to do that in Anime Studio’s 
preferences dialog.

7.	 Now we’re going to edit the bone’s motion by modifying the 
graph. First, set the current time to frame 48 and choose the 
Bone > Reset Bone command. 

8.	 Press the Page Down key to give yourself some room in the 
graph to work (you may need to turn off your Num Lock 
key). 

9.	 Next, click the keyframe at frame 33 and drag it upwards 
slightly as shown below. If you hold the Alt key while 
dragging a keyframe in graph mode, you will only be able 
to drag it vertically. Hold the Ctrl key to move it only 
horizontally.

 Move a keyframe

10.	 Next we’re going to add a new keyframe directly on the 
graph. Right click on the graph around frame 37. In the 
popup menu that appears, select Add Keyframe. A new 
keyframe will appear on the graph - drag it to the location 
shown:
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 Add a new keyframe

11.	 Let’s add three more keyframes like the previous one. Add 
these keys at frames 40, 43, and 46. You don’t need to set 
the time to the frame you want to add a key to - just right-
click at the correct frame and add the new key. Don’t worry 
if the key isn’t exactly at the frame you wanted, since you can 
easily drag it into position. Move these new keys so that the 
curve looks like this:

What this wiggling curve represents is sort of a springy 
back-and-forth motion that decreases over the span of just 
over half a second. You could have animated this using the 
normal timeline and the bone rotation tool, but this gives 
you another way to understand the motion you’re creating. 

 The final graph

12.	 Play back the animation to see what it looks like.

Tutorial 5.4: Sorting Layers by Depth
This tutorial shows you some of the 3D-related features of 
Anime Studio. Anime Studio allows you to move layers in 
three dimensions to create an accurate simulation of depth. In 
addition, Anime Studio has the option of sorting layers by depth, 
allowing layers to move in front of and behind each other during 
the course of an animation.
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Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 5.4 and it’s located in the Tutorials 
> 5 - Animation subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 5 - Animation > Tutorial 5.4 file in 
Anime Studio. You should see something like this:

 Starting point for this tutorial.

2.	 This file contains two layers and a simple animation of a 
circle moving back and forth in front of a square. Try playing 
back the animation to see what it looks like.

Creating Depth

 Translate Layer

Now we’re going to try moving a layer in 3D - towards and away 
from the camera.

1.	 Set the current frame to 12 and activate the Translate Layer 
tool. 

2.	 Make sure the Circle layer is active. Now, while holding 
down the Alt key, drag downwards in the editing area. You’ll 
see the circle get larger - this is because it is moving closer to 
the virtual camera. The Alt key modifies the Translate Layer 
tool to move a layer forward and back. Drag the Circle layer 
until it looks about like this:
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 Circle moved forward

3.	 In the tool options area at the top of the main Anime 
Studio window, notice the value of the Z field. It should 
be somewhere around 1.0 (the exact value isn’t important 
here). Positive depth (or Z) values are closer to the camera 
(in the direction out of your screen), while negative values 
point away from the camera (into the screen).

4.	 Next we’ll try moving the circle away from the camera. Set 
the current frame to 36. Again holding down the Alt key, 
use the Translate Layer tool and drag upward in the editing 
area. Keep going as the circle gets smaller (farther away), 
until it looks like this:

5.	 The Z value in the tool options area should now be close to 
-1.0. Try playing back the animation again - the circle should 
now grow larger and smaller as it moves towards and away 
from the camera. However, it always appears in front of the 
square. As it moves farther away, it should be going behind 
the square, which brings us to the next section.
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 Circle moved backward

Sorting Layers by Depth

If you do move layers forward and back, as in this tutorial, you 
may also want layers to move behind and in front of each other. 
Anime Studio can do this automatically - all you need to do is to 
turn on a single checkbox. 

1.	 Select the File > Project Settings menu command. In the 
Project Settings dialog that appears, turn on the Sort layers 
by depth checkbox and click OK. This tells Anime Studio to 
ignore the layer ordering in the Layers window, and instead 
draw layers in order from furthest to nearest. 

 Sort layers by depth option

2.	 Play the animation again, and you’ll see that the circle is 
drawn behind the square during the time that it is farther 
away.

3.	 To get a clear idea of what’s going on, use the Orbit 
Workspace tool to turn the scene to an oblique angle. If 
you play back the animation from this point of view, you can 
clearly see the circle moving forward and back as it moves 
around the square. 
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 Orbit Workspace Tool

Once you have a good view, activate the Translate Layer tool to 
display the path of the Circle layer’s motion.

 View from above
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A note about depth sorting: The checkbox we 
turned on to sort the layers by depth only sorts 

the top-level layers in an Anime Studio project. If you 
want to sort the sub-layers in a group, double-click the 
group layer to bring up the Layer Settings dialog. There 
you will find a tab labeled Depth Sort - in this tab is a 
checkbox that you can turn on to depth-sort the sub-
layers of the group.

Tutorial 5.5: Cycling
It is possible in Anime Studio to automatically cycle a section 
of animation, repeating it over and over as many times as you 
wish. Cycling is a special type of keyframe interpolation, and this 
tutorial will show you how to set it up.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 5.5 and it’s located in the Tutorials 
> 5 - Animation subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 5 - Animation > Tutorial 5.5 file in 
Anime Studio.

 Starting point for this tutorial

2.	 In the timeline, you can see that the top layer, Red Blinker, 
has two keyframes in the Layer Visibility channel. The layer 
becomes invisible at frame 36, and visible again at frame 
48. This is also shown by the red background in the timeline 
during the layer’s invisible period: 
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 Starting point for this tutorial

3.	 You can play back the animation to see what’s going on. 
Basically, the red light starts off turned on, then it shuts off 
for a while and finally turns back on.

4.	 Using cycling, you can make the light blink over and over. 
Right-click on the second keyframe (the one at frame 48), 
and in the popup menu that appears, select Cycle.... You’re 
telling Anime Studio that after this keyframe, you want the 
animation to cycle back to an earlier point in the animation. 
A dialog will appear asking you the specifics of the cycling. 
Enter 12 as shown below:

 Cycle settings

5.	 When you click OK in the cycle dialog, the timeline will 
update to show the cycle. There are three changes you will 
see: 

�� The keyframe in question will change to a left-pointing 
arrow to indicate that it cycles backwards. 

�� A long red arrow will point back to the point in the 
timeline that the visibility channel is cycling back to. 

�� Later in the timeline you will see other sections with red 
backgrounds to indicate that the layer is invisible during 
those periods:
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 Cycling reflected in the timeline

6.	 You can play back the animation again to see the result. 
The Red Blinker layer will flash on and off multiple times, 
even though you didn’t add any more keyframes - the Layer 
Visibility channel is just cycling back and repeating a section 
of animation over and over again.

7.	 Let’s try adjusting the cycle duration. In the Timeline 
window, hold down the Ctrl key while you click and drag 
on the second keyframe (the one that cycles). As you drag 
the mouse side-to-side, you’ll see that the cycle duration 
changes, as the arrow that points back from the cycling key 
gets longer and shorter. Adjust the cycle duration so that the 
keyframe cycles back to frame 24:

 Adjusted cycle duration

8.	 If you play back the animation now, you’ll see that the light 
blinks more quickly now, since the cycle duration is shorter.

9.	 Finally, to break a cycle, all you have to do is add another 
keyframe when you want the cycle to end. Set the current 
frame to 102, right click in the Layer Visibility channel, and 
select Add Keyframe from the popup menu that appears. 
The new keyframe will appear, and at that point the cycling 
will end. Play back the animation to confirm this.
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 New keyframe at frame 102

Conclusion

Cycling can be used in any animation channel in Anime Studio. 
Any keyframe can be made to cycle back in time by setting Cycle 
as the key’s interpolation method. You can cycle a channel all 
the way back to the beginning of an animation, or just back a few 
frames. Cycling will repeat itself forever or until a new keyframe 
is reached.

Tutorial 5.6: Actions
In Anime Studio Pro, actions are little clips of animation that are 
associated with a layer (or group of layers). Using actions, you 
can create reusable animation for movements that you expect to 
use over and over again. In this tutorial you will learn you how to 
use actions.

Start With a Sample File

For this tutorial, we’ll start with a project file that already has 
some actions set up. It’s named Tutorial 5.6 and it’s located in 
the Tutorials > 5 - Animation subfolder within the main Anime 
Studio folder. 

1.	 Open the Tutorials > 5 - Animation > Tutorial 5.6 file in 
Anime Studio. You should see something like this. (Don’t 
worry - the split-apart character is just part of the bone 
setup process):
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 Starting point for this tutorial

2.	 Let’s take a look at the actions for this character. Select the 
Window > Actions menu command to bring up the Actions 
window. It should appear as shown below:

Each item listed in the Actions window is a clip of animation 
that this character can perform. The first entry in the list, --- 
Mainline --- is kind of special. Mainline is not an action - it 
represents the main timeline for the animation, the one that 
will ultimately be exported as your final movie.

 Actions for this character

3.	 To view or edit an animation, double-click it in the Actions 
window. Let’s do this now with the Step action. After 
double-clicking Step, a little red arrow will appear next 
to it in the Actions window. This indicates that Step is the 
currently active action.

Also notice that the Timeline window has changed. The 
background changed color to indicate that you’re working 
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with an action, not the main animation. Finally, some 
keyframes appeared in the timeline - these are the keys for 
the Step action. 

 Activate the Step action

4.	 Press the playback button to watch this action, and stop it 
when you’ve seen enough.

5.	 Try playing back the other actions as well. For each one in 
turn (Wave, Squat, and Bend), double-click the action’s 

name to activate it. Then, play back its motion to see the 
result. 

6.	 When you’ve watched them all, double-click Mainline to go 
back to the main animation’s timeline.

Using Actions

Now that we’ve seen which actions the character can perform, 
let’s try using them in an animation. 

1.	 Make sure that Mainline is active in the Actions window. 

2.	 Set the current frame to 3, and click once on the Wave 
action. Be sure to just click once - Mainline should still 
be active with an arrow next to it, and Wave should be 
highlighted:
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 Click once on Wave

3.	 Now that Wave is selected, we can insert it into the main 
timeline. Click the Insert Reference button at the top of the 
Actions window. 

 Inserting a reference to the Wave layer

When you insert an action by reference, Anime Studio will 
use that action’s motion in the timeline. If you later modify 
the action, those changes will be reflected in the main 
timeline. As you can see, the timeline has been updated to 
indicate that the Wave action was inserted, plus it shows 
how long the Wave action lasts:
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 Wave action inserted into the timeline

4.	 Actions can also be overlapped. Set the current time to 
frame 12. 

5.	 Click once to select the Squat action in the Actions window.

6.	 Finally, click the Insert Reference button to insert the 
Squat action. Notice that the timeline now shows both 
actions (with the Squat action adding four channels in the 
timeline). Play back the animation to see how these two 
actions overlap.  Inserting a reference to the Squat layer
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 Wave and Squat actions overlapping

7.	 Let’s overlap three actions now. Go to frame 40, and insert 
references to three actions: Wave, Squat, and Bend. One 
after another, click once on the action then click the Insert 
Reference button . Play back the animation now and see 
how the character performs the three actions together, 
starting at frame 40.

8.	 Let’s try repeating an action a few times. Go to frame 66, and 
insert the Step action. 

9.	 Then go to frame 78 (at the end of the first step action) and 
insert the step action again. 

10.	 Do this once more at frame 90. The step action should now 
appear three times in sequence in the timeline:

 Repeating the Step action

11.	 The last thing we’ll do is move the character off screen. Set 
the current frame to 66. Then select the Layer Translate tool 
and click inside the scene to set a keyframe.

 Translate Layer
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 Add a new Layer Translation keyframe

12.	 Finally, set the current frame to 102, and the total number 
of frames to 102, then use the Translate Layer tool to move 
the character to the left off screen:

 Character translated off screen

Tutorial 5.7: Frame by Frame 
Animation
Traditionally, animation was created by drawing frames one 
after another, each one slightly different from the last. Anime 
Studio does not work this way - in Anime Studio, you create 
artwork and then use keyframing to move parts of the object 
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around (using either bone or point motion), and then Anime 
Studio fills in all the in-between frames.

However, there is a way to do some frame-by-frame animation in 
Anime Studio, and this tutorial will show you a simple example 
of how you can do this. Keep in mind that this isn’t what Anime 
Studio was designed for - if you’re looking for a frame-by-frame 
animation program, Anime Studio isn’t the best tool for the 
job. But, if you just need to do a little bit of frame-by-frame 
animation, this technique might work for you.

Start With a Blank File

1.	 Start out with a new, blank Anime Studio project - it should 
just have one layer, Layer 1. 

2.	 Add a new Switch layer and name it Inchworm. Move Layer 
1 into the switch layer. Next, right-click on the switch layer 
and select Layer 1 from the popup menu to make that layer 
active in the switch group. Finally, select the Layer 1 layer 
as we’re about to draw in it. Here’s what the layout should 
look like:

 The starting layout

3.	 Now, select a fill color and a line color in the Style window 
for the inchworm you’re about to draw. Activate the 
Freehand tool and draw a little worm in the editing view. 

�� When drawing the body, make sure that the Freehand 
tool’s Auto close, Auto fill, and Auto-stroke options 
are turned on. 

�� When drawing details, make sure that only Auto stroke 
is checked. 

You might end up with something like this (feel free to put 
more work into it for a prettier result):
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 Freehand

If you find it difficult to draw your worm in one 
stroke, you can create it with shorter strokes that 

overlap each other where you want them to connect. The 
shape will automatically be welded where the lines 
cross. You can then use the Delete Edge tool to delete the 
unwanted hanging edges. Refer to examples shown in 
the Freehand tool..

 The first inchworm frame

4.	 Next, advance the time to frame 3. Create a new vector 
layer - it should be automatically named Layer 2 and should 
appear just above Layer 1. When you create this new layer, it 
becomes the active layer in the switch group: 

If you are unable to add a vector layer at Frame 
3, choose Edit > Preferences to open the 

Preferences dialog. Uncheck the Enable Drawing Tools 
Only on Frame 0 option in the General tab (which is on 
by default to prevent accidental changes to the timeline).
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 New layer added

5.	 In the timeline, turn on an onionskin at frame 2. To do this:

�� Move to Frame 2.

�� Click the Onionskins button in the Timeline toolbar. 
Check Enable onion skins and turn on the Relative 
frames option - this will cause the onionskin to follow 
behind the current time by one frame. 

�� Finally, right-click in the area just below the frame 
numbers to add an onionskin marker at frame 2. Here’s 
what the timeline should look like:

 Onionskin setup in timeline

 Onionskin setup in timeline

6.	 Now let’s get back to drawing. In the editing view, you 
should see an outline of the first drawing you made. On 
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top of this outline, using the Freehand tool, draw a new 
inchworm, slightly advanced ahead of the previous version:

 Advanced inchworm (frame 3)

7.	 Next, move forward two frames to frame 5.

�� Create a new vector layer (it will appear above the 
previous two). You should see the onionskin outline of 
the previous worm.

�� Draw a new one on top of it:

 Advanced inchworm (frame 5)

8.	 Continue this process to add six new frames (on frames 7, 9, 
11, 13, 15, and 17), causing the inchworm to scrunch up and 
then stretch out again as it moves forward over the course 
of the 17 frames. At the end of the animation you will have a 
total of nine layers: 

�� Advance two frames.
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�� Create a new vector layer

�� Draw a new inchworm. 

Play it Back

Before you pay the animation back, select the Inchworm switch 
layer. Then play back your animation, and you should see each 
drawing appear for two frames before moving on to the next 
drawing. 

That’s all it takes to do frame-by-frame animation in Anime 
Studio. The key is that when you create a new layer in a switch 
group, that layer becomes the active layer at that frame. So, by 
adding a layer, drawing a figure, advancing the current time, and 
repeating the process, you can create frame-by-frame animation 
in Anime Studio.

If you want to see a finished example of this, open 
the file Tutorial 5.7, located in the Tutorials > 5 

- Animation subfolder within the main Anime Studio 
folder.

 The final result

Tutorial 5.8: Creating a 3D Scene
This tutorial will show you how to build and move around in a 
3D scene in Anime Studio. Anime Studio isn’t a full 3D program 
- layers in Anime Studio are 2D planes that exist in a 3D space. 
However, by positioning these 2D layers carefully, and moving 
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around them using the 3D camera, you can create a convincing 
3D environment.

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 5.8 and it’s located in the Tutorials 
> 5 - Animation subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 5 - Animation > Tutorial 5.8 file in 
Anime Studio.

This file has some simple artwork that we’ll use to build a 3D 
scene. The layers in this file are set up as shown:

 Starting point for this tutorial

The editing view should look like this to begin with:

 Starting point for this tutorial

Creating a Ground Plane

The first step in creating our 3D scene is to set up the ground 
plane. 

1.	 Select the Background layer - this layer has already had 
a simple terrain drawn onto it, we just need to position it 
correctly. 
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2.	 Activate the Rotate Layer XY tool, and in the tool options 
area at the top of the main Anime Studio window, enter an 
angle of -90. Even though the Background layer is just a flat 
2D object, it can still be rotated and positioned in true 3D 
space:

 Rotate Layer XY

 Adjusting X rotation

3.	 Next, activate the Translate Layer tool, and in the tool 
options area, enter -0.25 as the Y value:

 Translate Layer

 Adjusting position

4.	 Finally, activate the Scale Layer tool, and in the tool options 
area, enter 5, 5, 5 as the layer’s scale values:

 Scale Layer
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 Adjusting scale

What these settings do is to rotate the Background layer so 
that it lies down horizontally, lower it a bit, and spread it 
out wide to cover a large area. Perfect settings for a ground 
plane. The scene should now look like this:

 Ground in position

Arranging Foreground Objects

The next step is to create and position foreground objects. A 
simple tree has already been created for you - let’s set it up in 3D. 

1.	 Often, positioning objects in 3D can be easier done from an 
overhead view. Use the Orbit Workspace tool to rotate the 
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view of the scene so that it looks something like this (partial 
view shown). 

(Notice the little blue wedge in the scene - this represents the 
camera.)

 Orbit Workspace Tool

 View from above

2.	 Now select the Tree layer, and make the Translate Layer 
tool active. Double-click the Tree layer. The Layer Settings 
dialog opens. 

3.	 In the Options section of the General tab, turn on the Rotate 
to face camera checkbox (you’ll see why this is important 
later). 
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 Layer Settings options

4.	 Now, in the tool options area, set the Position X value to 
-3.25, and the Z value to -2.25. The tree will be moved to the 
far corner of the scene:

 Translate Layer

 Moving the tree

5.	 OK, that’s one tree - now add several more. Duplicate the 
Tree layer, and set new values for the X Position and Z 
Position. Any values for X and Z Position will do, as long as 
they’re roughly in the range between -3 and 3. 

6.	 Repeat the process several more times, just scattering trees 
across the landscape. Keep going until you’ve created about 
12 more trees. Position them all over the place - close to 
the camera, far away, behind it, etc. When you’re done you 
should have a small forest:
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Now the reason for the Rotate to face camera checkbox 
may be clear. The Tree layer (and all of its duplicates) 
automatically turns to face the camera - notice how each tree 
is turned in a slightly different direction. This makes sure 
the camera always has a full view of that layer. This may not 
always be what you want, but for scenery objects, it can be a 
good trick, especially when the camera starts moving.

 A forest

Here’s a trick: if you have a mouse with a scroll 
wheel, instead of typing in numbers for the X and 

Z values, try holding the mouse over those text fields and 
turning the wheel. The value in the field will change, and 
you can watch the layer move - just keep turning the 
wheel until the layer is where you want it.

7.	 The last step to finish off the forest is depth sorting. Double-
click the Foreground group layer. In the Layer Settings 
dialog, click the Depth Sort tab. Turn on the Sort layers 
by depth checkbox and click OK. Now all the tree layers in 
this group will be sorted according to their distance from the 
camera.

Moving the Camera

Now that we’ve got a filled-in scene, lets take a tour. 

1.	 Select the View > Reset menu command. You are now 
looking at the scene from the camera’s point of view:
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 Camera view

Track Camera Tool

2.	 Set the current frame to 48 and activate the Track Camera 
tool. While holding down the Alt key, click and drag 
downward in the editing area. (The Alt key tells the Track 
Camera tool to move the camera forward and back.). Keep 
dragging downward until you’ve moved forward almost to 
the edge of the ground layer.

 Forward movement

3.	 Now activate the Pan/Tilt Camera tool. Hold down the Shift 
key and drag to the side to turn the camera around. (The 
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Shift key prevents you from rotating the camera up and 
down.) It doesn’t matter where you turn to - just point the 
camera in an interesting direction:

 Pan/Tilt Camera Tool

 Turn the camera

4.	 Set the current frame to 96, and use the Track Camera tool 
to move forward again (be sure to hold down the Alt key to 
move forward). 

5.	 After moving forward, turn the camera in a new direction 
with the Pan/Tilt camera tool (be sure to hold down the 
Shift key). Continue this process (advance the current time, 
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move forward, and turn the camera) as much as you want, 
taking a little tour of your 3D scene.

 Orbit Workspace Tool

6.	 When you’ve moved around as much as you want, try 
playing back the animation. While playing back the 
animation, use the Orbit Workspace tool to view the scene 
from above. 

There are two things to notice here: 

�� First, if you activate the Track Camera tool again, the 
path of the camera is visible when viewing the scene 
from above. If the path is not visible, check the Show 
Path option in the Track Camera tool status bar. This 
can be useful when planning out camera moves. 

�� Second, watch how the trees turn during the animation 
to always face the camera. That way, the camera never 
catches an edge-on view of any tree, which would kind 
of spoil the 3D effect.

 View from above

Feel free to experiment with more camera moves, or to add 
objects of your own to the scene.

Basic Physics
Anime Studio features a physics engine that allows objects to 
collide with and bounce off of each other. 
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Creating the Objects

An Anime Studio project can contain objects that are not 
affected by physics, as well as objects that are affected by physics. 
The deciding factor between the two types of objects is a group 
layer that holds the objects that physics are applied to. Any 
objects not contained within this group are unaffected by the 
physics properties.

In the first steps in this tutorial, you’ll create a base object Group 
layer that holds three objects, on three different layers. 

To create a physics simulation, 

1.	 Create a new project. Add a new Group layer in the Layers 
window. The new layer will be named Layer 2.

 Create a new Group layer (Layer 2)

2.	 Drag the existing Layer 1 into the new group layer. On this 
layer, use the Add Point tool with the Sharp Corners option 
checked to create a base shape that the physics objects will 
collide with.

 Create a Base object in Layer 1 and drag it into Layer 2

3.	 With layer 1 selected, add another vector layer (which will 
be named Layer 2 by default - name it Layer 3). It will 
automatically be added to the Group layer. Use the Draw 
Shape tool to draw a circle on this layer. This will be one of 
the shapes that collide with Layer 1.

4.	 Add another vector layer (Layer 4) to the Group layer, and 
create a rectangle with the Draw Shape tool on this layer.
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 Three objects in the Group layer

Enabling Physics

You now have a scene with a group that contains three objects: a 
base object, and two additional objects that will bounce against 
it. The first thing you need to do is enable physics in the Group 
layer that holds these objects. 

1.	 Select the Group layer (Layer 2) and open the Layer Settings 
dialog. Click the Physics tab to display the following settings:

 Enable physics for the Group layer

�� Enable physics: Check this option to turn the physics 
simulator on.

�� Gravity direction: Use the directional slider to point 
to the direction from which gravity is originated. By 
default, the direction is straight down (270 degrees). 
0/360 degrees is at the 3:00 position of the dial.

�� Gravity magnitude: Controls the strength of the 
gravity. Lower values make the gravity less forceful 
(objects are lighter) and higher values make the gravity 
more forceful (objects are heavier).

2.	 Click OK to close the Layer Settings dialog. Your group layer 
is now configured to use physics
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Creating a Collision Base

After you enable physics in the Group layer as described in the 
previous section, your next step is to assign one of the objects 
as a stationary collision base for the others to collide against. 
Otherwise, the gravity in the Physics engine will cause all of the 
objects to drop off the screen. 

1.	 Select the base layer (Layer 1) in the Group layer. This is the 
object that the other objects will collide against. Open the 
Layer Settings window to the Physics tab. You will see the 
following settings:

�� Enable Physics: This option should automatically 
be turned on if it is in a Group layer that has Physics 
enabled. If you uncheck the option, physics will not 
work on the current layer.

�� Non-moving object: Check this option to make the 
current layer stationary. When this option is checked all 
of the other options in the Physics tab become disabled

2.	 Click OK to return to the scene

 Check the Non-Moving Object option to create a stationary base 
object

Configuring Physics Objects

After you create one or more stationary objects, you then 
configure the properties for the other objects that will bounce 
against them. In the case of the scene that we have created, these 
objects are the circle and the rectangle. Start with the circle first, 
and then the rectangle, and proceed as follows

1.	 Select the circle layer (Layer 3) inside the Group layer. Open 
the Layer Settings window to the Physics tab. You will see 
the following settings:
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 Physics Settings for Non-Stationary objects

�� Enable Physics: This option should automatically be 
turned on as described in the previous section.

�� Non-moving object: Leave this option unchecked for 
the circle and rectangle layers.

Leave the remainder of the settings at their 
default values for the circle and rectangle layers. 

The functions of the additional settings follow.

�� Start asleep: Check this option if you want an object 
to stay still until something else bumps into it. To 
demonstrate how this works, compare two versions of 
the project.

�� Lifetime (frames): A physics object will fall, bounce 
around, etc. for the duration of its lifetime (number of 
frames). After that time, it will be sent back to its initial 
starting position, where it will start bouncing around 
again. A lifetime of zero means the object will never be 
sent back to its starting point. The Lifetime setting is 
useful for something like a hillside of falling boulders. 
Instead of creating hundreds of boulders, you can 
create a dozen or so and set the lifetime to the length 
of time it takes for the boulders to fall from the top of 
the hill to the bottom. If the top and bottom of the hill 
are offscreen, this will look like an endless number of 
boulders falling down the hill. 

�� Initial direction: Works in conjunction with the 
Initial Speed setting below. If given an initial speed of 
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something more than zero, a physics object will start 
flying out in the designated direction at the specified 
speed. 

�� Initial speed: Controls the speed at which physics 
objects move in the designated direction. Faster speeds 
allow you to create objects like bullets, rockets, etc.

�� Density: The default Density setting is 1. Decrease this 
setting to make objects more responsive to collisions. 
Increase the setting to make objects less responsive to 
collisions.

�� Friction: A contact force between two surfaces that 
controls how much they slow each other down when 
they touch. High friction objects (like a brick sliding 
on concrete) will generally slow down faster than low 
friction objects (blocks of ice).

�� Springiness: When two objects collide, their 
springiness values define how much they will bounce 
apart. A basketball bouncing on a floor would have a 
high springiness value, while a stick of butter would 
have a low springiness value. 

�� Pivot on origin: This option sets an axle around the 
object’s origin point. When another object collides with 
an object that is set to pivot, the object will spin around 
its origin rather than topple over.

�� Motor speed: Works in conjunction with motor 
torque, which follows. The motor speed is the number 
of degrees per second the object will rotate (it can be 
negative to rotate backwards). Depending if the object 
bumps into obstacles or there are other influences, 
it may not actually rotate at that speed, but in a zero 
gravity setup with no collisions, that will be the speed of 
rotation.

�� Motor torque: Motor torque controls the strength of the 
motor. With low torque, when a motorized object bumps 
into other objects it may come to a stop, depending on 
the size and density of the obstacles. With a high torque, 
it will tend to push obstacles out of its way. Even with no 
obstacles, if a motorized object is unbalanced (off center 
of its origin), a low torque setting may mean that it can 
even lift itself up.

2.	 Press Play to see what happens. The circle falls straight down 
and stops at the ground.

3.	 Rewind the project to frame zero, and use the Translate 
Layer tool to move the circle so that it is just above the left 
pillar of the collision base, as shown in the following figure.
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4.	 Press the Play button again to observe how the circle moves. 
This time, it should collide with the rectangle, and the 
rectangle will respond to the collision.

5.	 Experiment with additional settings to learn more about 
how they affect your objects.

Additional Comments

You can also apply physics to bone layers. The physics are 
applied to the region of influence of the bone. See “Bone 
Physics” on page 260.
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Tutorial 6.1: Particles
This tutorial demonstrates Anime Studio’s particle layers feature. 
Particle layers are used to create effects made up of many small 
objects flying around. This includes effects like water, smoke, and 
swarms of insects.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s already 
started. It’s named Tutorial 6.1 and it’s located in the Tutorials > 
6 - Effects subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 6 - Effects > Tutorial 6.1 file in Anime 
Studio, and you should see something like this:

 Starting point for this tutorial

2.	 There are four layers in this file, each containing a small gray 
blob-shaped object. You can zoom in to look more closely at 
these objects.
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 A smoke particle

3.	 These blobs will be used to create a smoke effect, using a 
particle layer. If you examine these blobs, you’ll see that they 
are all semi-transparent, and have the soft edges fill effect 
applied to them. In addition, the blobs all have a simple 
animation applied to them - over the course of 48 frames, 
they spread out horizontally. Play back the animation to see 
this happen.

Using A Particle Layer

1.	 In the Layers window, create a new Particle layer. Particle 
layers are kind of like Group layers - they can contain sub-
layers. 

2.	 Drag all four of the original layers into the particle layer, and 
your project should look like this:

 New particle layer

3.	 Play back the animation and see what we’ve got so far. The 
particles should be flowing, although they don’t look much 
like smoke at this point. 



Anime Studio Pro 8
Users Manual

170

Effects

4.	 Next, double-click the particle layer to bring up the Layer 
Settings dialog. Click the tab marked Particles. In this area, 
set the following values and click OK:

�� Particle lifetime: 48

�� Orient particles: unchecked

�� Velocity: 0.3

�� Velocity spread: 0.05

�� Acceleration: Turn knob to point to the right, or enter 
0.5

�� Rate: 0.5

 Particle settings

These settings tell the particle system that each particle 
should last for 48 frames after being created, and that the 
particles should not rotate to follow the direction they are 
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moving in. Their initial velocity is moderately slow, and 
there is a gentle acceleration to the right (a soft breeze).

5.	 Play back the animation now, the motion of the particles 
should look more like the flow of smoke from a smokestack. 

6.	 Export the animation as a QuickTime or AVI file to see how 
the blur and semi-transparent effects combine to create 
a smoky appearance. The reason four different particle 
types were used is that each has a different gray level, and 
combining them leads to a mottled, dirty effect.

 A rendered example

Tutorial 6.2: Particle Tricks - Grass 
and Crowds
This tutorial shows how to use particle layers for something 
other than swarming insects, smoke, or fireworks. Using the 
correct settings, particle layers can also be used to produce 
clusters of many objects, but without making them fly around 
like particles usually do. Fields of grass and crowds of people are 
just two possibilities that we’ll explore.

Start With a Sample File

To get started quickly with this tutorial, start by opening the 
project file named Tutorial 6.2, located in the Tutorials > 6 - 
Effects subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 6 - Effects > Tutorial 6.2 file in Anime 
Studio. This file has a particle layer that we’ll modify to 
simulate a field of grass. The layers in this file are set up as 
shown:
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 Starting point for this tutorial

The editing view should look like this to begin with:
 Starting point in editing view

2.	 The particle layer Grass in this file is currently set up with 
the default settings for a particle layer. The sub-layers (Layer 
1 - Layer 6) are each a single blade of grass. Each one has a 
slightly different color and shape to create variety. 

3.	 If you play back the animation, you’ll see that the default 
particle layer settings aren’t very good for a field of grass - 
the grass particles fly up in the air and then sink downwards. 
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All we have to do is make a few small changes to get the 
grass to look right.

Changing Particle Settings

1.	 Double-click the Grass layer to bring up the Layer Settings 
dialog. Click the Particles tab to access the settings for the 
particle layer. 

Below we describe why each of the settings is set the way it 
is. Any settings that aren’t mentioned below don’t matter for 
this situation (for example, orient particles doesn’t matter 
since the particles have no velocity).

2.	 Change the settings to match the ones below and click OK.

�� Particle Count: 500. We need a lot of particles for a 
field of grass

�� Preview Particles: 20. In the working view, only show 
a few particles in order not to slow down Anime Studio

�� Lifetime (frames): 0. A lifetime of zero means that 
particles will never die out (disappear).

�� Source width: 3. Make the source nice and wide to 
cover the width of the screen

�� Source height: 0. It’s a flat field of grass, so the height 
is zero

�� Source depth: 1. Spread the particles out in the Z 
direction for a feeling of depth

Besides scattering particles in the Z direction, 
when source depth is set to a non-zero number, 

the particle layer will sort particles according to depth 
- this is very important for the kinds of animations we’re 
working with in this tutorial. We wouldn’t want far 
away blades of grass to appear in front of closer ones. 

�� Velocity: 0. Set to zero to prevent the grass blades from 
flying around

�� Velocity Spread: 0. Set to zero to prevent the grass 
blades from flying around.

�� Acceleration: 0. Zero acceleration, again to prevent the 
grass blades from flying around

�� Rate: 0. Again to prevent the grass blades from flying 
around

�� Randomize playback: Checked. Plays back the blades’ 
animations randomly, otherwise they would be in sync.
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Randomize playback makes the grass look better 
than if all the blades were moving in sync, but it 

can be even more important when working with a crowd 
of people, as we’ll see later in this tutorial.

 Grass particle settings

3.	 OK, the grass is almost finished. All we need to do is use the 
Translate Layer tool to move the Grass layer downwards so 
that it sits on the ground:

 Translate Layer
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 Grass lowered into place

In preview mode, it doesn’t look like much, so you may want to 
try playing back the result and rendering it out as a movie file:

 Final render

Crowds of People

Now we’ll show how to use the same general techniques to 
simulate a crowd of people. 

1.	 Open the file named Tutorial 6.2_2, located in the Tutorials 
> 6 - Effects subfolder within the main Anime Studio folder. 
This file is already completed - there’s nothing you need to 
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change in this file, it just shows another example of using 
particle layers.

2.	 The Crowd layer has the same basic settings we used for the 
field of grass, only using fewer particles. Note the following:

�� Each of the sub-layers in the crowd was created from 
one layer with a simple cycling animation. 

�� This one layer was duplicated and had some colors 
changed just for variety. 

�� The Randomize playback setting for the particle layer 
is really important for this crowd - if it was turned off, 
then each character in the crowd would move in sync 
with all the others (you can try this yourself). This 
may be desirable in some cases, but here we want each 
character to move independently, even though they all 
have the same basic movement. 

�� Depth of field is enabled in the Project Settings dialog 
- that’s why some of the closer or farther characters 
appear a bit blurry.

3.	 Play back the animation or render a movie file to see how it 
all comes together.

  A crowd as particles

Tutorial 6.3: Using Pre-made Particle 
Effects
This tutorial shows how you can use the included scripting 
commands to make use of pre-made particle effects like smoke 
or explosions.
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Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 6.3 and it’s located in the Tutorials 
> 6 - Effects subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 6 - Effects > Tutorial 6.3 file in Anime 
Studio.

2.	 Expand the Rocket Group layer in the Layers window, and 
you should see something like this:

 Starting point for this tutorial.

3.	 Try playing back the animation to see what we’re starting 
with - it’s just a simple animation of a rocket flying around 
the screen for a little while. When you’ve seen enough, 
rewind the animation back to frame 0.

Add the Smoke Effect

Now we’ll add a smoke trail behind the rocket. 

1.	 Select the Scripts > Particle Effects > Smoke... menu 
command. A dialog will appear asking you to customize the 
smoke effect. Use the settings shown below for the smoke 
and click OK:

 Smoke settings
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2.	 The smoke script will then generate a bunch of layers that 
make up the smoke effect. The combined layers will end up 
grouped together in a group layer called Smoke. Move this 
new Smoke layer into the Rocket Group layer, just below 
the Rocket layer. The Smoke layer should end up positioned 
like this:

 Smoke layer added to group

3.	 The final step is to move the smoke into place. Activate 
the Translate Layer tool and move the Smoke layer so 
that it sits just behind the rocket. The smoke itself won’t 
immediately move until the animation is updated, so watch 
the origin of the Smoke layer and line it up behind the 
rocket. Feel free to zoom in close to get a better view:

 Translate Layer

 Smoke layer moved into position
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That’s it! You can now export the animation as a movie file to 
see the fully rendered result. Some of the particle effects in the 
script menu, including smoke, can take a long time to render. In 
“Tutorial 6.4: Speeding Up Particle Effects” on page 180 we’ll 
show you a way to speed up complex particle effects.

 The final result

Another Effect - Sparkles

Here’s an example of another particle effect - the Sparkles script. 
A great use of this effect is for magic wands. The fully finished file 
can be opened in Anime Studio if you wish. It’s called Tutorial 
6.3_2. Here’s what the rendered result looks like:

 The Sparkles effect
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Tutorial 6.4: Speeding Up Particle 
Effects
In “Tutorial 6.3: Using Pre-made Particle Effects” on page 176 
we showed how you can use Anime Studio’s included particle 
effect scripts to easily add effects like smoke and explosions. The 
only drawback to these effects is that they can take a very long 
time to render. In this tutorial, we’ll show you a way to speed up 
the exporting of complex particle effects.

Start With a Sample File

For this tutorial, we’ll start by taking a look at a finished 
animation of an explosion effect.

1.	 Open the Tutorials > 6 - Effects > Tutorial 6.4 file in Anime 
Studio and play back the animation. To see the full effect, 
you would need to export the animation as a movie file. You 
can try this now, but trust us, it’ll take a while to export this 
file. Here’s what the final movie would look like:

 The exported explosion

Preparing a Movie for Re-use

Our goal is to re-use this explosion in another Anime Studio 
animation, but make it a lot faster for rendering. To do this, 
we’ll export the explosion animation as a movie file, using some 
special settings. 
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1.	 Export the project animation as a QuickTime movie, using 
the following options:

The key here is the Do not premultiply alpha 
option. This prepares the alpha channel in the 

exported movie for further compositing. 

 Export options

2.	 When the QuickTime compression dialog appears, select the 
PNG codec, and Millions of Colors+ as shown below. The 
+ is QuickTime’s notation to include an alpha channel in the 
exported movie.
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 Compression options

3.	 When the movie is finished exporting, you can try playing 
it back. You can also open the file that is provided called 
explosion.mov, located in the Tutorials > 6 - Effects 
subfolder within the main Anime Studio folder. You’ll 
see that it looks pretty strange - this is because we didn’t 
premultiply the alpha channel. But don’t worry, once the 
explosion is composited back in, it’ll look just right.

Using Movies in Image Layers

To work with the explosion movie, follow these steps:

1.	 Start a new Anime Studio project file. 

2.	 Drag the explosion.mov file from the folder in which you 
saved it into the main Anime Studio window. A new Image 
layer will be created. 

3.	 Use the Translate Layer tool to move the explosion off to 
the side a bit:

 Translate Layer
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 New explosion layer

4.	 Next, advance the current time to frame 12, and drag the 
explosion.mov file into the main Anime Studio window 
again. Another image layer will be created - move this layer 
off to the other side:

 A second explosion layer

5.	 Repeat this process a few more times - advance the time 
a little bit, drag in another explosion, and position the 
explosion in the frame. Do this until the view is just full of 
explosions:
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 Lots of explosions

6.	 When you’ve got as many explosions as you want, export the 
animation as a QuickTime movie. 

Notice that even though the single explosion took 
a long time to render, this combined set of 

explosions renders fairly quickly. This is because the 
explosion effect has already been created - for the 
combined effect, Anime Studio just needs to composite 
several explosions together. Using this technique, you 
can greatly speed up the time it takes to export an 
animation that uses one or many complex particle 
effects.

Tutorial 6.5: Perspective Shadows
In this tutorial you’ll learn a little trick to create perspective 
shadows. This trick depends on Anime Studio’s layer masking 
feature, and uses it in a creative way.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 6.5 and it’s located in the Tutorials 
> 6 - Effects subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 6 - Effects > Tutorial 6.5 file in Anime 
Studio, and you should see something like this:

 Starting point for this tutorial

2.	 Play back the animation to get an idea of what you’re starting 
with. 
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3.	 When you’ve seen enough, rewind the animation back to 
frame 0. What we’re going to do in this tutorial is give Lenny 
a shadow.

Moving a Layer Into Perspective

We’re going to create a shadow that matches Lenny exactly. 

1.	 At Frame 0, start off by duplicating the Lenny Skeleton 
layer, using the Duplicate Layer button . 

2.	 Move this new copy below the original Lenny Skeleton, 
name it Lenny Shadow.

3.	 Add a new vector layer inside it as shown below. Make this 
new layer active, and name the new layer Shadow.

 New Lenny Shadow with Shadow layer

4.	 In the new Shadow layer, draw a simple rectangle that takes 
up about 2/3 of the left side of the visible area, as shown 
below. Choose Black for the Fill and Stroke colors if they 
aren’t selected already. The idea is to completely surround 
Lenny, with enough extra space for when he moves. 
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 Rectangle in Shadow layer

 Shear Layer

5.	 We’re going to temporarily hide the black shadow layer so 
that you can use the copy of Lenny to shear and reposition 
him for the shadow. To hide the black rectangle, click the 
Visibility icon to hide the Shadow layer as shown below.

 Temporarily hide the Shadow layer

6.	 Next, select the Lenny Shadow bone layer and use the 
Shear Layer tool to shear the lower copy of Lenny so that he 
leans to the right as shown below: You can also enter an X 
value of .60 or thereabouts in the Shear Layer tool options in 
the status bar.
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 Shear the lower copy of Lenny

7.	 Now use the Scale Layer tool to scale the Lenny Shadow 
layer down vertically. Be sure to leave it the same size 
horizontally - we just want it shorter vertically, as shown 
below:

 Scale Layer

 Scale down the shadow layer
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8.	 Next, use the Translate Layer tool to move the Lenny 
Shadow layer into position so that the back heels of the two 
Lennys line up like this:

 Translate Layer

 Position the shadow layer

The Trick

So far we have two copies of Lenny, with the lower one shifted 
into perspective. Here comes the trick with layer masking. 

1.	 First, click the Visibility icon in the Shadow layer to make the 
sheared black rectangle visible again.



Anime Studio Pro 8
Users Manual

189

Effects

2.	 To turn on masking, double-click the Lenny Shadow layer 
and in the Masking tab, set the Group Mask setting to Hide 
all. 

 Mask settings for the Lenny Shadow layer

3.	 Next, double-click the Lenny layer and in the Masking tab, 
set the Layer Masking setting to + Add to mask, but keep 
invisible. The result of these settings is that the big black 
rectangle will now be masked against the shape of Lenny 
himself:

 Mask settings for the Lenny layer
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 The shadow mask effect

4.	 The final touch is to refine the appearance of the shadow. 
Double-click the Lenny Shadow layer. In the Layer 
Settings dialog, set the Blur radius to 8 and Opacity to 50. 
That finishes the shadow effect - you can now export the 
animation as a movie file.

 The adjusted shadow, rendered

The final result is also included as an Anime Studio project file. 
It’s called Tutorial 6.5 Final - take a look at it if you have any 
trouble following the directions above. It’s important when using 
this trick to animate your subject first before you add the shadow 
- that way the shadow will also be animated, leading to a more 
realistic effect.
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Tutorial 6.6: Shadow Tricks
This tutorial shows you how the layer shadow options can be 
used to create visual effects other than shadows. Glows and 
outlines are the two possibilities we’ll look at.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 6.6 and it’s located in the Tutorials 
> 6 - Effects subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 6 - Effects > Tutorial 6.6 file in Anime 
Studio. Render this file to see what it looks like to start with:

 Starting point for this tutorial

Basic Layer Shadow

Before we try any tricks, let’s take a look at a basic layer shadow. 

1.	 Double-click the only layer in this file, Layer 1, to bring up 
the Layer Settings dialog. 
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2.	 Go to the Shadows tab, and leaving all the other settings 
alone, turn on the Shadow on checkbox. Click OK to 
dismiss the dialog.

 Default shadow settings

3.	 Try rendering the scene again, just to be sure that you have 
an idea what a regular layer shadow looks like in Anime 
Studio:

 Layer shadow

Layer Glow

Now we’ll change the shadow settings to create a glow effect. 

1.	 Double-click Layer 1 again to bring up the Layer Settings 
dialog. Change the Layer Shadow settings to match the 
values below:
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 Glow settings

�� An offset of 0 means the shadow will be centered under 
the layer that is casting it. With an offset of 0, the 
shadow direction has no significance. 

�� A high blur value of 16 gives the glow a nice soft edge. 

�� The expansion parameter tells Anime Studio to expand 
the shadow, making it bigger than the layer itself. 

Without expansion, the glow would just barely extend 
beyond the edge of the layer. 

�� The exact color you choose is not important - just 
be sure to make the color opaque (Alpha = 255). A 
transparent glow may be too faint to see. 

2.	 Render the scene again, and it should look like this:

 Layer glow.
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Layer Outline

Let’s change the shadow options once again to create an outline 
effect. Some styles of animation use a heavier outline around 
the outside of objects than for interior lines. Adjusting the layer 
shadow values in the right way can make this style very easy to 
accomplish. 

1.	 Double-click Layer 1 again to bring up the Layer Settings 
dialog. 

2.	 Change the Layer Shadow settings to match the values 
below:

�� Again, we use an offset of 0 to keep the shadow centered 
under the layer. 

�� A blur value of 0 is used to keep a hard edge on the 
shadow. 

�� The expansion parameter is used in this case to set the 
width of the outline effect. 

�� For this effect, it’s important to make the color totally 
black and totally opaque (Alpha = 255) to match the 
interior lines. 

 Outline settings.

3.	 Render the scene again, and it should look like this:
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 Layer outline

Tutorial 6.7: Camera and Depth 
Effects
This tutorial demonstrates Anime Studio’s camera tools. These 
tools allow you to move an entire scene around as if you were 
pointing a camera at it. With a little setup work, you can even 
create different layers of depth in the scene.

Start With a Sample File

For this tutorial, we’ll start with a project file that’s almost 
finished. It’s named Tutorial 6.7 and it’s located in the Tutorials 
> 6 - Effects subfolder within the main Anime Studio folder. 

1.	 Open the Tutorials > 6 - Effects > Tutorial 6.1 file in Anime 
Studio, and you should see something like this:

 Starting point for this tutorial

2.	 This file contains a few layers of simple scenery that we 
will move the camera across. To do this, select the Track 
Camera tool and drag the mouse around in the main editing 
area. 
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Track Camera Tool

Notice how all the layers move together, even though they aren’t 
grouped. When you move the camera around, it affects all the 

layers in a project. In the tool options area at the top of the main 
Anime Studio window, click the Reset button to reset the camera.

Creating Depth

Now we’ll introduce some depth into the scene. 

1.	 Activate the Translate Layer tool and select the layer called 
Right Hill. 

 Translate Layer

2.	 In the tool options area at the top of the main Anime Studio 
window, change the Z value to -1 and press Enter. Below you 
can see where to set the Z value for the layer.

Setting a layer’s Z value

3.	 Now select the Left Hill layer, and set its Z value to -2. 
Finally, select Sky, and set its Z value to -20. When you’re 
finished, your scene should look similar to the following 
figure.
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 Right Hill, Left Hill, and Sky layers moved on the Z plane

4.	 Try dragging the Track Camera tool around again and 
notice the difference. It’s like driving in a car - nearby 
objects go by quickly, while distant objects seem to move 
slowly. 

5.	 In the tool options area at the top of the main Anime Studio 
window, click the Reset button to reset the camera.

Track Camera Tool

6.	 Now try dragging the Orbit Workspace tool around the 
workspace. This tool allows you to examine your scene in 
3D, from outside the view of the virtual camera. In this case, 
notice how the different layers are spaced apart in the Z 
direction - this is what creates the sense of depth from the 
camera’s point of view. The camera itself appears as a small 
blue wedge pointing in the direction of view. 

 Orbit Workspace Tool

7.	 When you’ve seen enough, select the View > Reset menu 
command to go back to the default camera view.
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Animating Camera Movement

Now we’ll try animating the camera. 

1.	 Make sure the current frame is set to 0, and select the Track 
Camera tool. 

Track Camera Tool

Drag to the left in the main editing area until you set up a view 
that looks about like this:

 Camera view at frame 0

2.	 Next, set the current frame to 72, and drag to the right. This 
will pan the camera to the left - keep going until you have a 
view that looks like this:
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 Track to the left

3.	 Press the Play button in the timeline to play back this simple 
camera animation. Notice how the layers of the project seem 
to pass in front of and behind each other. This is a simple 
way in Anime Studio to create a sense of depth.

 The final result. (SWF File)

Tutorial 6.8: Using 3D Models
Although Anime Studio is primarily a 2D program, it is 
possible to import 3D models and use them in an Anime Studio 
animation. This tutorial will show you some of the things you can 
do with 3D models in Anime Studio.
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Import a Basic 3D Model

First, we’ll try importing a basic 3D model. 

1.	 Start Anime Studio and create a new, empty project. 

2.	 Next, select the File > Import > OBJ 3D Model menu 
command. Anime Studio will prompt you to select a file - 
choose the file named 3dmodel.obj located in the Tutorials 
> 6 - Effects subfolder within the main Anime Studio folder. 
Anime Studio will import the model into a new 3D layer, and 
you should see something like this:

 Imported 3D model

3.	 Use the Orbit Workspace tool to rotate around the scene. 
As you rotate around the object, notice that it never appears 
flat from any side (like a vector layer) - it is a true three-
dimensional object. 

 Orbit Workspace Tool

This object was created in a program called 
Wings 3D (http://www.wings3d.com). Whether 

you choose create models in Wings 3D or another 3D 
program, be sure to export them as OBJ files. OBJ is a 
common 3D file format that most 3D programs support, 
and is currently the only 3D format that Anime Studio 
can import.

The colors of this model have been defined in the 
file 3dmodel.mtl - this is a material file that 

Wings 3D created along with the model itself. You cannot 
change the colors of a 3D model within Anime Studio. 
However, you can change the color and width of the 
outline in the Layer Settings dialog, under the 3D 
Options tab, discussed in “3D Options” on page 335.

http://www.wings3d.com
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 Side view of 3D model

Using 3D Models in a Face

Next, we’ll show an example of how you can use a 3D model in 
the construction of a character’s face. One of the limitation’s of 
Anime Studio’s 2D nature is that it is difficult to rotate a head in 
3D space. Using a 3D model can solve this problem. 

1.	 Open the file Tutorial 6.8 located in the Tutorials > 6 - 
Effects subfolder within the main Anime Studio folder. 
This is a completely finished animation - play it back to see 
what’s going on.

 Face pointing up and right
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 Now pointing down and left

2.	 Notice that unlike most faces in Anime Studio, this one can 
freely turn from side to side. This is because the head and 
nose (the major 3D structures in a face) are built as actual 
3D models. The mouth, eyes, and ears are all 2D vector 
layers that have been arranged in 3D space around the head.

3.	 The only other trick involved in getting this character’s 
head to work was sorting the head and ears. Notice that 
the main 3D head shape and the ears are grouped together. 

This is so that those three shapes can be depth-sorted. As 
the head turns from side to side, one of the ears often needs 
to go behind the head layer and then come back in front, 
depending on the head’s angle. Depth sorting is used to 
easily accomplish this reordering.

Textures and Scenery

Anime Studio can also make use of textures on 3D models. You 
can’t create the texturing within Anime Studio itself, but if your 
imported 3D model uses texture maps, Anime Studio will use 
them when it imports the model. 

Now open the file Tutorial 6.8_2 located in the Tutorials > 6 
- Effects subfolder within the main Anime Studio folder. This 
scene makes use of the 3D model simple_scene.obj, which in 
turn uses a texture map file:
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 A textured 3D scene

One of the things you may notice in this scene is that the scenery 
has detailed shadows and shading on it. Anime Studio does 
not provide lighting and shading for 3D models. Instead, these 
effects are part of the texture map for this 3D model. In this case, 
a separate 3D program was used to calculate the lighting effects 
and bake them into the texture map.

Of course, the other element in the scene is a regular Anime 
Studio 2D animated character. Although this character is 
composed of 2D vector layers, it can be positioned in true 3D 
space, so it is quite easy to integrate it into the 3D scene.

Conclusion

We’ve looked at just a couple possible uses for 3D layers - with a 
little thought you can probably come up with many more. Keep 
in mind that Anime Studio is still primarily a 2D program, so 
don’t expect Anime Studio to replace a true 3D modeling and 
animation program. However, for limited uses, like background 
scenery or a few parts of a character, 3D layers in Anime Studio 
can be very useful.

For further information on importing 3D objects within Anime 
Studio Pro please visit http://my.smithmicro.com/tutorials/.

Tutorial 6.9: Moon and Clouds Effect
This tutorial shows you how to create the effect of clouds moving 
in front of a moon. Layer masking and blurring is used to create 
an effect that is not only good for a moon and clouds, but may 
inspire you to think of new ways to use layer masking.

Examine a Finished Animation

For this tutorial, we’re going to examine an animation that is 
completely finished. 

1.	 Open the Tutorials > 6 - Effects > Tutorial 6.9 file in Anime 
Studio. The layers in this file are arranged as shown below:

http://my.smithmicro.com/tutorials/
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 Starting point for this tutorial

2.	 This animation relies on masking and blurring effects that 
aren’t apparent in Anime Studio’s editing view. To see what 
the final effect is, either export the animation as an AVI or 
QuickTime movie. (Because blurring is a key part of this 
effect, exporting to SWF is not an option - SWF export does 
not support blurs.)  The final result

Notice that the moon appears sharp until the cloud moves in 
front of it. Then, the parts of the moon obscured by the cloud 
become blurry. This effect is easy to achieve using layer masking.

How It’s Done

There are two parts to this effect. First, there are actually two 
moons in the animation: 
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•	 The Moon layer is the regular, sharp version of the moon 
you see in Anime Studio’s editing view. 

•	 Two layers up is the Blurry Moon layer - this is a duplicate 
of the Moon layer, with some layer blur applied.

The trick is to control which moon is visible at which point 
in time in the final exported movie. To do this, we use layer 
masking. 

Try double-clicking each of the layers in turn to bring up the 
Layer Settings dialog - then, go to the Masking tab. You’ll find 
that the Sky group has masking turned on - by default, all 
objects are invisible. The Moon layer is set to be immune to 
masking, while the Cloud layer adds to the layer mask.

The result of these mask settings is that first the Moon layer 
is drawn - this is the regular, sharp moon - and is not affected 
by any masking. Next, the Cloud layer is drawn on top of that. 
When the cloud moves in front of the moon, it covers up the 
moon. Finally, the Blurry Moon layer is drawn on top of the 
cloud. Because of the mask, the blurry moon only appears on 
top of the cloud, it is not visible outside of the cloud object. Even 
though the blurry moon is in front of the clouds, the effect looks 
like the moon shining from behind the clouds.

Here’s another example of the same technique. In this case, we 
see a character who appears to be blurred by the smoke passing 
in front of him. The exact same blurring and masking trick is 
used as in the case of the moon:

 Another example of blurring and masking
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Anime Studio 
Tools
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The Draw Tools
Draw tools are used to draw and modify vector artwork. The 
following tools are available when you’re working with a vector 
layer. Most of these tools are used by selecting them from the 
toolbar then clicking and dragging in the working area of the 
main window - a few are used simply by clicking on them, 
and this is noted below. If you hold the mouse over a tool, a 
tooltip will appear with the name of the tool if you need a quick 
reminder. Also, most tools have a shortcut key that can be used 
to activate them. If a tool has such a shortcut, this will show up 
in the tooltip as well.

If a tool has the following symbol next to it: , then it can be 
used for animation - using the tool at different frames in the 
timeline will cause the object you adjust to change over time.

Anime Studio 8 has a smart tool palette, which 
shows and hides tools based on their need. The 

position of the tool shown in the screenshots may differ, 
depending on the selected layer in the Layers palette, 
and the current time in the timeline. 

You can manually choose to use legacy curves 
(such as those used in Anime Studio 6 and 

earlier) in the Layer Settings dialog. Select the layer 
you want to change in the Layers window, and open the 
Layer Settings dialog to the Vectors tab. Check the 
Legacy Curves option to use the old method of 
rendering curves.

 You can choose legacy curves (right) for compatibility with older 
scenes created in Anime Studio 6 and earlier.
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Select Points

 Select Points

 Select Points options

Select Points Tool Options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Text Field: Assigns a name to the currently selected group 
of points.

•	 Create: Creates a group from the selected points.

•	 Delete: Deletes the currently selected group from the 
selection list.

•	 Lasso Mode: When checked, allows you to draw a lasso 
around the points you want to select. When unchecked, 
selects a rectangular area.

•	 Flip Horizontally: Click this button to flip horizontally.

•	 Flip Vertically: Click this button to flip vertically.

Using the Select Points Tool

Many of the following tools work only on the currently selected 
points. This is the tool you use to select/de-select points. This 
tool can be used in a few different ways. 

The most basic way to select points is to drag a rectangle around 
them. Also, using this tool you can click on a single point to select 
it. The third method of selection is to click on a curve to select 
the entire curve. Finally, clicking on a filled-in area will select 
an entire object. Each of these selection methods is illustrated 
below:
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 Selection methods

Below is a short movie clip showing the different ways to select 
points using the Select Points tool.

 Different methods of point selection (SWF file)

Modifier keys: 

•	 By holding the Shift key, you can extend a selection. 
Otherwise, you will always start a new selection when using 
this tool. 

•	 Holding the Alt key will prevent this tool from selecting 
curves or shapes when you click on them (sometimes when 
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things get crowded it’s hard not to click on a shape by 
accident). 

•	 If you hold down the Ctrl key, this tool will work in lasso 
style. (You can also activate lasso style selection by turning 
on Lasso mode in the tool options area.)

The selection commands in the Edit menu are also very useful 
for managing selections. These are described in “Edit Menu” on 
page 441.

The currently selected points may be deleted by pressing the 
Delete or Backspace keys.

Translate Points
 The Translate Points tool is used to move a group of 
selected points. It operates only on the currently selected 

points, unless fewer than two points are selected - then it 
operates on the nearest point to where you clicked.

 Translate Points

It’s important to note that this tool, like most of the Anime Studio 
drawing tools, modifies points, not curves. If you select all the 
points in an object and use this tool, the entire object will move. 
However, if you only select some of the points, then you’ll end up 
distorting the object (which can be very useful). In the pictures 
below, the selected points are highlighted in red. Notice the effect 
of using the Translate Points tool on these points.
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 Top circle fully selected. Bottom circle partially selected  After translation

Holding the Shift key while using the Translate Points tool 
will constrain the selected points to only move vertically or 
horizontally.

The Translate Points tool can also be used in conjunction with 
Anime Studio’s welding feature. The steps differ depending 
on whether the Auto Weld option in the toolbar is enabled or 
disabled:
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•	 When Auto Weld is off: To weld two points together, use 
the Translate Points tool to drag one point on top of another 
(you must drag just one point to weld, not a group of points). 
While dragging the first point on top of the second, press the 
spacebar to weld them together into one point.

•	 When Auto Weld is on: Anime Studio can automatically 
weld points for you. Only the endpoint of a curve can be 
automatically welded. To automatically weld the endpoint of 
a curve, just drag it on top of another point and let go of the 
mouse. Below is a movie demonstrating auto-welding. After 
dragging each endpoint into place, it becomes welded to the 
existing point, and the two can be moved around

 Using Translate Points and auto-weld (SWF file)

Nudging: When the Translate Points tool is active, you can 
nudge the selected point(s) by small increments by holding down 
the Ctrl key and pressing the arrow keys. Hold down Shift in 
addition to Ctrl to nudge the point(s) by a greater increment.
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Translate Points Tool Options

 Translate Points options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Position X: Allows you to numerically enter a value for the 
X coordinate.

•	 Position Y: Allows you to numerically enter a value for the 
Y coordinate.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

•	 Auto Weld: When checked, automatically welds a new point 
to an existing point. The existing point is highlighted when 
the mouse hovers over a point that can be welded.

•	 Auto Fill: When checked, automatically fills a closed shape 
when you create it.

•	 Shape Select: With this option checked, you can click the 
fill of a shape to select its points. Uncheck the option to 
prevent this from happening.

•	 Flip Horizontally: Click this button to flip horizontally.

•	 Flip Vertically: Click this button to flip vertically.

Scale Points
The Scale Points tool operates on the currently selected 
group of points. Two or more points must be selected to 

use this tool. 

When this tool is active, a red box will appear around the 
currently selected group of points. The handles around the edges 
of this box allow you to resize the points. Drag a corner handle in 
and out to scale the points while maintaining their proportions. 
Drag one of the side handles to change the horizontal scale, or 
the top or bottom handle to change the vertical scale. 

If you hold the Alt key while dragging a side handle, Anime 
Studio will resize the selected points in such a way to maintain 
the overall volume of the object - this can be useful for squash 
and stretch.
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 Scale Points

Scale Points Tool Options

 Scale Points options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Scale X: Allows you to enter a numeric value for scaling 
along the X axis.

•	 Scale Y: Allows you to enter a numeric value for scaling 
along the Y axis.

•	 Modify: Click to apply the values entered in the Scale X and 
Scale Y fields

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

•	 Shape Select: With this option checked, you can click the 
fill of a shape to select its points. Uncheck the option to 
prevent this from happening.

•	 Flip Horizontally: Click this button to flip horizontally.

•	 Flip Vertically: Click this button to flip vertically.

Rotate Points
The Rotate Points tool also operates on the currently 
selected group of points. Two or more points must be 

selected to use this tool. Click near the outer boundary of the 
selected group of points. Next, drag the mouse in a circle around 
the selection to rotate the points. Holding the Shift key while 
using the Rotate tool will constrain the rotation to 45 degree 
increments.
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 Rotate Points

Rotate Points Tool Options

 Rotate Points Options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Rotation: Allows you to enter a numerical value for rotation.

•	 Modify: Click to apply the value entered in the Rotation field

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

•	 Shape Select: With this option checked, you can click the 
fill of a shape to select its points. Uncheck the option to 
prevent this from happening.

•	 Flip Horizontally: Click this button to flip horizontally.

•	 Flip Vertically: Click this button to flip vertically.

Add Point
The Add Point tool is what you use to draw most curves in Anime 
Studio. Just click and drag in the working area of the main 
window to create a new curve segment. There are four variations 
to using the Add Point tool - they differ in where the original 
click takes place. 
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 Add Point

The first way to use this tool is to click in empty space and drag - 
this will start a new curve. 

The second technique is to click on the end of an existing curve to 
add another segment to that curve. 

Third, click on a curve segment to add a point there, then drag it 
to the final desired position. 

Finally, click on a curve midpoint to add a new branching curve 
that is welded to the existing point. Each of these uses of the Add 
Point tool is shown below.

 Uses of the Add Point tool

The Add Point tool can also be used to weld two points. Click and 
drag in one of the ways described above to add a new point. 

Drag the new point on top of an existing point. If Auto Weld is 
enabled the new point will weld to the existing point. If Auto 
Weld is off, press the spacebar before releasing the mouse. An 
example is shown below. (This works just like the Translate 
Points tool, above. Read about that tool for more details on 
welding.)



Anime Studio Pro 8
Users Manual

217

The Draw Tools

 Closing a curve

To prevent the Add Point tool from adding on to an existing 
curve regardless of where you click, hold the Alt key to force the 
tool to start a new line segment.

The movie below demonstrates the Add Point tool. Notice how 
clicking on different parts of an existing curve causes the new 
point to be added in different ways.

 Using the Add Point tool (SWF file)

Add Point Tool Options

 Add Point Options




Anime Studio Pro 8
Users Manual

218

The Draw Tools

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Auto Weld: When checked, automatically welds a new point 
to an existing point. The existing point is highlighted when 
the mouse hovers over a point that can be welded.

•	 Auto Fill: When checked, automatically fills a closed shape 
when you create it.

•	 Sharp corners: When checked, creates sharp corners when 
changing the angle of a line. When unchecked, creates 
smooth transitions when changing the angle 

If you hold down the Command key (Mac) or Ctrl 
key (Windows) while you add a new point, it will 

reverse the Sharp Corners option that you have selected 
in the Options toolbar. This allows you to change 
between peaked and smoothed points without 
interrupting your workflow.

Freehand
The Freehand tool lets you draw complex shapes by just dragging 
the mouse around. After using the Freehand tool, you will often 
want to go back and use the Delete Edge tool to delete unwanted 
lines. You can also use the Translate Points tool to modify the 

result, delete unnecessary points, and weld points together. If 
you have a drawing tablet, the Freehand tool can also use the pen 
pressure from your tablet to control the thickness of the lines you 
draw.

The Freehand tool has been enhanced, such that you don’t have 
to draw shapes precisely while using the tool. If you cross a 
line, the new line automatically welds to the line that is crossed, 
allowing you to quickly sketch out shapes without worrying 
about stopping your stroke at precise locations. Later, you can 
use the Delete Edge tool to remove the hanging edges. For more 
information about the Delete Edge tool, see “Delete Edge” on 
page 226.

 Freehand
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Freehand Tool Options

 Freehand Options

The Freehand tool has been improved to give 
much smoother looking curves. As you draw 

with the Freehand tool it looks like you are creating a lot 
of points, but as you let go it only keeps the points that 
are necessary to represent the curve smoothly.

In Anime Studio 8, the welding features of the 
Freehand tool have been improved. You no 

longer have to be concerned with ending a line exactly 
on a point, or later using the Translate Points tool to 
weld points together. Instead, sketch as you normally 
would sketch with a pencil. Any lines that cross will 
automatically weld together, easily allowing you to 
create closed shapes. You can then use the Delete Edge 
tool to delete the unwanted straggling ends that cross 
the lines you want to weld. This allows you to create 
closed shapes quite easily that you can fill later.

Click the Freehand Options button in the Options toolbar to 
display the Freehand Tool options dialog. The options are as 
follows:

•	 Freehand Options: Click this button to display the 
following options

�� Variable line width: When set to None, does not vary 
line width between the start and end of the line. You 
can also vary line width based on pen pressure when 
using a pen tablet, or randomly. The line width will vary 
between the minimum and maximum width settings 
that you specify.

�� Width Variation: Controls the amount of difference 
between the narrowest part of the stroke and the widest 
part of the stroke.

�� Taper Start: When checked, tapers the start of the line.

�� Taper End: When checked, tapers the end of the line.

�� Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the 
layer to the value or values set at frame 0.
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 Freehand options

•	 Auto Weld: When checked, automatically welds a new point 
to an existing point. The existing point is highlighted when 
the mouse hovers over a point that can be welded. When you 
draw two lines that cross, the point at which they cross will 
automatically be welded together when this option is on.

•	 Auto Fill: When checked, automatically fills a closed shape 
when you create it.

•	 Auto-stroke: When checked, automatically creates a stroke 
around the shape that you create. Uncheck this option to 
create a shape that has no outline.

•	 Auto close: When unchecked, closes a shape when the 
cursor is released over the beginning of the shape. When 
checked, connects the shape from the current position to the 
start point when you release the mouse button.

Draw Shape
The Draw Shape Tool provides a way to quickly draw commonly 
used shapes: squares, ovals/circles, triangles, stars, arrows, and 
spirals. Each of the shape options are shown later in this section.

 Draw Shape
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Draw Shape Tool Options

 Draw Shape Options

•	 Auto Fill: When checked, automatically fills a closed shape 
when you create it.

•	 Auto-stroke: When checked, automatically creates a stroke 
around the shape that you create. Uncheck this option to 
create a shape that has no outline.

Rectangle

 Rectangle

The Rectangle tool is a shortcut for creating a rectangular 
shape. Just click and drag to draw a rectangle. Hold the Shift 
key to constrain the shape to a square. Hold the Alt key to make 
the click point the center of the rectangle, instead of one of its 

corners. There’s nothing special about rectangles created with 
this tool - they’re just four points and four curve segments and 
can be manipulated just like anything else. You could create the 
same shape with the Add Point tool, but for a simple rectangle, 
this tool is quicker.

Oval

 Oval

The Oval tool is a shortcut for creating an oval shape. Just click 
and drag to draw an oval. Hold the Shift key to constrain the 
shape to a circle. Hold the Alt key to make the click point the 
center of the circle. There’s nothing special about ovals created 
with this tool - they’re just four points and four curve segments 
and can be manipulated just like anything else. You could create 
the same shape with the Add Point tool, but for a simple oval, 
this tool is quicker.
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Triangles

 Triangles

The Triangle tool is a shortcut for creating a triangle shape. Just 
click and drag to draw a triangle. Hold the Shift key to constrain 
the shape to an equilateral triangle. 

Stars

 Stars

The Stars tool is a shortcut for creating a star shape. Just click 
and drag to draw a star. The star will be drawn from the upper 
point of the star, and all five points of the star will be equal in 
size.

Arrow

 Arrow

Click and drag to draw an arrow shape. Press the Shift key to 
constrain the arrow to a horizontal or vertical line.

Spirals

 Spirals

Click and drag to draw a spiral shape. The number of windings 
increase as you drag outward. By default the spiral radiates in a 
clockwise direction from the center. Press the Alt key to create a 
counter-clockwise spiral.
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Insert Text
To create a text object, just choose the Draw > Insert Text... 
menu command. Type in the text you want, select a font, and 
click OK. The text will appear in your document, pre-filled 
with the current fill color and style, and it can be resized and 
positioned just like any other object.

Remember: there’s nothing special about a text object. It can be 
manipulated just like anything else. This includes using any of 
the drawing tools to distort its shape, or to add new points in the 
middle of a character. This also means that in order to move or 
rotate a text object, you need to select all the points in the object. 
This is easy to do using the Select Points tool - just click on the 
filled in area of the text to select all of it.

 Insert Text

The Insert Text dialog contains the following options:

•	 Text: Enter the text that you want to appear in your project.

•	 Fill: Check or uncheck this option to turn the fill on or off.

•	 Stroke: Check or uncheck this option to turn the stroke on 
or off.

•	 Create one shape: When checked, all of the letters in the 
text you enter will be seen as a single object. Clicking one 
letter on the text will select all the text. When unchecked, 
each letter in the text will be a separate object and will have 
to be manipulated individually.

•	 Center text horizontally: When checked, text will be 
centered. When unchecked, text will be left-aligned.

•	 Font: Select the font that you want to use.
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 Insert Text Options

You can use the Text tool in conjunction with the 
Freehand tool and Delete Edge tool to create 

uniquely colored text. First, create your text as normal, 
making sure that there is a stroke on the text. Then use 
the Freehand tool (with its Auto Weld option on) to slice 
the text or letter up into shapes that you can color 
differently. Finally, use the Delete Edge tool to remove 
the lines that hang out from the edges of the text. See 
“Freehand” on page 218 and “Delete Edge” on page 
226 for more information on how to use those tools.

 Create colorful text using the Freehand and Delete Edge tools with 
the Insert Text tool.

Scatter Brush
The Scatter Brush allows you to spray shapes into your scene. 
There are a number of preset shapes, or you can also copy any 
shape to your clipboard and spray multiple copies of that shape 
into your scene.

To use the Scatter Brush tool, try the following: 

1.	 Copy a vector object into your clipboard, or select one of the 
preset options from the Preset menu. 
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2.	 Choose the vector layer that you want to paint into. 

3.	 Set the Min and Max Width settings appropriately for the 
scale of the objects. 

4.	 Set other options in the Scatter Brush Options panel if you 
want to increase or decrease variation in the angle, spacing, 
or color of the objects you are spraying.

 Scatter Brush

Scatter Brush Tool Options

 Scatter Brush Options

•	 Scatter Brush Options: Click this button to display the 
following options

�� Angle Jitter: Specifies the maximum amount of angle 
variation in the objects that you spray.

�� Spacing: Specifies the minimum amount of space 
between the objects that you spray.

�� Color Jitter: Specifies the maximum amount of color 
variation for the objects that you spray.

�� Flip X: Check this option to flip the objects being 
sprayed along the X axis.

�� Flip Y: Check this option to flip the objects being 
sprayed along the Y axis.

•	 Preset Menu: Click the Preset menu to choose from a 
number of different presets that you can spray into your 
scene. If you choose Use Clipboard, the Scatter Brush tool 
sprays the contents of your clipboard into the scene.

•	 Min Width and Max Width: Sets the minimum and 
maximum width of the objects that you spray. If you want all 
of the objects to be the same size, set both values the same. 
Higher values create larger objects.
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Delete Edge
It’s easy to delete points - just select them and press backspace or 
delete. However, sometimes you may want keep two points, but 
break the curve connecting them. To do this, use the Delete Edge 
tool. Just use it to click on the curve segment you want to delete 
and it will disappear. 

In Anime Studio 8, you can use the Delete Edge tool to delete 
unwanted lines. For example, you can use the Freehand 
tool to quickly sketch out shapes, and the Freehand tool will 
automatically weld crossed lines together as you draw. You can 
then later clean up the shapes by deleting unwanted hanging 
lines with the Delete Edge tool.

If the edge you delete makes up part of the outline 
of a fill shape, that shape will also be deleted.

The Delete Edge tool is also useful when used in 
conjunction with the Freehand tool. Due to the 

improved welding capabilities of the Freehand tool, you 
can freely sketch a character without having to worry 
about exact placement of lines. Any lines that cross will 
be welded together. You can then use the Delete Edge tool 
to remove unwanted straggling ends, simply by clicking 
on them with the Delete Edge tool.

 Delete Edge

Curvature
This tool works on the currently selected points, or on the 
nearest point if less than two points are selected. It adjusts 

the level of smoothness of the curves passing through the 
selected points. Drag to the left to make the curves less smooth, 
and drag to the right to make the curves rounder.
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 Curvature

Curvature Tool Options

 Curvature Options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Peak: Creates a peaked (or hard) transition between the 
curves at the point that you click.

•	 Smooth: Smooths the transition between the curves at the 
point that you click.

Magnet
The Magnet tool is similar to the Translate Points tool - it 
is used to move points around. However, instead of 

moving the selected points, it moves points based on the strength 
of the magnet. When you click with this tool, the region of 
strength is displayed. Any points within this region will move 
with your mouse, but the points closer to the center of the mouse 
click will move the most. (The radius of the magnet’s strength 
region can be adjusted in the tool options area.)

This tool is most useful for artwork that has lots of points. For 
example, the Freehand tool can create curves with many points - 
the Magnet tool can then move them around smoothly. Imported 
Adobe Illustrator files and text objects can also be sources of 
many control points.

 Magnet
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 Magnet Options

Magnet Tool Options

•	 Magnet Radius: Sets the radius of the magnet.

Perspective Points
Click and drag side-to-side to add horizontal perspective 
to the selected group of points. Click and drag up and 

down to add vertical perspective to the selected group of points.

Although Anime Studio is not a 3D program, the effect of this 
tool is similar to rotating the points around a vertical pivot, so 
that one half of the group rotates into the screen and the other 
half out of the screen. If you want to do a true 3D rotation, you 
should use the Rotate Layer Y tool to apply true 3D perspective 
to a layer.

 Perspective Points

Perspective Points Tool Options

 Perspective Points Options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.
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Shear Points
This tool works on a group of two or more selected points. 
Click and drag left, right, up, or down to shear, or slant 

the group of points.

 Shear Points

Shear Points Tool Options

 Shear Points Options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

Bend Points
To use the Bend Points tool, drag your mouse up and 
down to bend the selected group of points up and down. 

For best results, the selected group of points should be wider 
than it is tall.

Drag your mouse side to side to bend the selected group of points 
side to side. For best results, the selected group of points should 
be taller than it is wide.

 Bend Points
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Tool Options

 Bend Points Options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0:

Noise
The Noise tool works on a group of selected points. Click and 
drag to move the points around in random directions. This tool 
can be used for example when you want to duplicate an object 
using Copy and Paste, but you don’t want the new object to look 
exactly like the original. Just use this tool to distort it a little bit.

 Noise

Tool Options

 Noise Options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.
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Fill Tools
Using the Fill tools for vector layers, you take the drawings you 
created with the Draw tools, and you tell Anime Studio which 
areas should be filled with color, where outlines should be 
placed, and what fill and line styles to use.

The drawings created with Draw tools are only guides. As far as 
Anime Studio is concerned, they’re invisible and they won’t show 
up in the final rendered output. That’s where Fill tools come in. 
Draw tools define the shape of objects, while Fill tools define 
the appearance of those objects. Of course, you’re always free 
to switch back and forth between any of Anime Studio’s editing 
tools at any time.

Anime Studio 8 has a smart tool palette, which 
shows and hides tools based on their need. The 

position of the tool shown in the screenshots may differ, 
depending on the selected layer in the Layers palette, 
and the current time in the timeline. 

Select Shape
This tool is used to select an existing shape - either a fill or an 
outline. Just click on the desired shape and it will be selected. At 
that point, you can press the Delete or Backspace keys to delete 

the shape, adjust its properties in the Style Window (see “Style 
Window” on page 339), or change its stacking order using the 
fill modifiers described below.

After clicking on a shape to select it, you then have the option to 
select shapes lower in the stacking order. Just hold down the Ctrl 
key and press the down arrow key to select the next shape lower 
down at the point you clicked the mouse. Hold Ctrl and press the 
up arrow key to select the next shape higher in the stacking order 
at that same point.

 Select Shape Tool

Create Shape
The Create Shape tool is used to select a region to be filled with 
color, or a set of edges to be drawn as an outline. It operates 
exactly like the Select Points tool described in “Select Points” on 
page 208. 
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 Create Shape Tool

Using the Create Shape tool, select all the points that form the 
outer border of the shape you wish to create. If you select a 
set of edges that completes an enclosed shape, a highlighted 
checkerboard will show you the extent of the region you are 
creating. Otherwise, you will just see a highlighted outline on the 
selected edges.

When you have the desired region selected, press the spacebar or 
press the Create Shape button in the status bar to actually create 
a shape from the selected edges. The Style Window (see “Style 
Window” on page 339) can now be used to choose the shape’s 
color, line width, style, etc. This is a very important step - until 
you press the spacebar or use the Create Shape button, you 
are only preparing the selection. A shape is only created 
when the spacebar or button is pressed.

The picture below shows a selection in progress using the Create 
Shape tool. Note that the figure on the left is not filled with a 

checkerboard because its border points are not all selected. The 
checkerboard area indicates the region that would be filled if the 
user hit the spacebar at this particular moment. The left figure 
would only receive a partial outline and no fill, since then entire 
border has not been selected.

 Selecting the curves to make up a shape

The next figure shows the result of pressing the spacebar to 
actually create the two shapes that were being prepared in the 
figure above.
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 The two resulting shapes

After creating a shape, if you decide that you only want a fill, 
and not an outline, you can uncheck the Stroke box in the Style 
window. Similarly, uncheck the Fill box in the Style window to 
make your shape have only an outline, and no fill color.

Tool Options

 Create Shape Options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Create Shape: Press the Create Shape button to complete 
the shape. This is the same as pressing the Spacebar after 
your selection is made.

•	 Lasso Mode: The Create Shape tool selects a rectangular 
area by default. Check this option to select points by drawing 
a lasso around the desired area.

Paint Bucket
The Paint Bucket tool is used to fill a closed region with color. 
Just click inside a closed shape to fill it with the current 
combination of colors and styles. This can make it much easier 
and quicker to fill shapes than with the Create Shape tool, but 
keep in mind you’re still working with the same requirements - a 
shape must be completely closed in order to be filled. Also, the 
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entire shape must be visible onscreen when you use the Paint 
Bucket to fill it - if part of the shape is cut off on the edge of the 
editing window, it can’t be filled. (You can always change the 
view to fit a shape on-screen before filling it.)

 Paint Bucket

The paint bucket tool works by temporarily filling the region you 
click in with a test color. Any edge that touches this test color 
is considered selected, and becomes part of the final shape. If 
you hold the mouse button down and drag the mouse around, 
you can get a preview of how the fill will look when you release 
the mouse button. Below are some examples of sets of curves in 
Anime Studio, where the user might click with the Paint Bucket 
tool, and the resulting fills. In each case, the shape on the left is 
the starting shape, the red X indicates the point where the user 
clicked with the Paint Bucket tool, and the result is the shape on 
the right:

 Filling a basic closed outline



Anime Studio Pro 8
Users Manual

235

Fill Tools

Clicking outside a closed outline (nothing happens - no fill).  A more complex shape. There are some dead-end curves, but the 
overall shape is still closed.
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 A shape with a hole in it.  Clicking inside the hole fills just the hole
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 The shape is not closed (close, but not good enough) - no fill is 
created

 No fill will be created by any of these clicks. The paint bucket cannot 
fill an entire enclosed outline in any of these cases
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 Clicking here will not fill the circle, since some of it is off-screen. The 
paint bucket can only fill shapes that are entirely on-screen

Tool Options

 Paint Bucket Options

•	 Fill: Select this option to affect fill only.

•	 Stroke: Select this option to affect stroke only.

•	 Both: Select this option to affect both fill and stroke.

Delete Shape
To use the Delete Shape tool, click on a fill or outline to delete it 
from the project. Remember, in Anime Studio, the shape of an 
object is separate from its appearance. If you use this tool to 
delete a fill, the underlying points and curves will remain. If you 
want to delete those as well, go back to the Draw tools to work 
with the points and curves.
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 Delete Shape Tool

Eyedropper
To use the Eyedropper, click on a shape to copy its parameters. 
Hold the Alt key to push the current color.

 Eyedropper Tool

Line Width
The Line Width tool is used to adjust the width of a line as it 
passes through a particular point. Using this tool, you can create 
lines that taper at the ends, get thinner in the middle, or change 
width several times along their length. To use it, just click on the 
point you want to adjust, and drag the mouse left and right to 
adjust line thickness. (Be sure you first either set up an outline 
through the point, or a fill shape with a non-zero line width - 
otherwise this tool won’t do you much good.) You can adjust 
more than one point at a time by selecting multiple points with 
the Select Points tool from the Draw tool group.

 Line Width Tool
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Tool Options

 Line Width Options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Width: Allows you to enter a numerical value for the line 
width

Hide Edge
Sometimes, you will have the need to create a fill shape with only 
a partial outline. The Hide Edge tool makes it easy to accomplish 
this. After creating the fill shape and setting the desired line 
width, simply click on the edge(s) that you want to hide - those 
edges will simply disappear from the outline, without affecting 
the fill. Below is a before and after example:

 Hide Edge Tool
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 The Hide Edge tool in action

Curve Exposure
The Curve Exposure tool is located in the Fill section of the tool 
box. Normally, when you apply a stroke to a curve, you see the 
stroke along the entire curve. With the Curve Exposure tool, you 

can click and drag on a curve that has a stroke and control where 
the curve starts and ends. 

 Curve Exposure Tool

•	 Click and drag back and forth to set the end point of the 
stroke on the curve. Dragging toward the left exposes less 
of the curve’s end, while dragging toward the right exposes 
more of the curve’s end

•	 Alt-Click and drag back and forth to set the start point of the 
stroke on the curve. Drag toward the right to expose less of 
the curve’s end, and drag toward the left to expose more of 
the curve’s end.
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 Exposing less of the curve’s end

This parameter can be animated so that you can expose the curve 
over time, making this feature a good option for creating things 
like handwriting or water flowing through a pipe.

Tool Options

•	 Select Group: Used to select a group that was previously 
created with the Select Points tool.

•	 Start Percentage: Allows you to enter a numerical value for 
the start of the curve, based on its distance from the start 
point

•	 End Percentage: Allows you to enter a numerical value for 
the end of the curve, based on its distance from the end point

Curve Profile
Curve profiles provide a way to add interesting detail to a shape. 
You use the Curve Profile tool to create these details on a shape. 
You select a shape on a layer. Additional curves that define the 
profile can appear on the same layer. 

 Curve Profile Tool

Curve profiles can be of any shape, but the start and end of the 
profile should be along the same horizontal line. While you can 
create profile curves with or without a stroke applied to them, it 
makes sense to draw them with Auto Stroke off, since you will be 
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applying a different pattern to the circle based on the style of the 
curve.

 Shapes and curves are drawn on a single layer

After you select the shape you want to apply the profile to (a 
circle in this case, select the Curve Profile tool from the Fill 
section of the tool box. Then click on the curve that you want to 
use as the profile. 

 A shape with a profile curve applied.

Even though the resulting shape appears to have more detail, 
it still has the same number of control points as the original 
shape. For example, if you applied the curve profile to a circle, 
the resulting shape still has only the four original control points, 
even though it appears to have more. You can edit the shape by 
repositioning one or more of the original control points, and the 
curve profile will still be applied. 
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If you want to animate a shape that uses Curve 
Profiles you will need to animate the shape used 

for the profile. You cannot assign one profile shape on 
one frame in a timeline, and then reassign another 
profile shape on another point in the timeline. In 
addition, if you delete the curve that was originally used 
as a profile shape, the curve profile also gets deleted. 

The Repeat Count setting in the options toolbar controls the 
number of times that the curve profile repeats along the path. 
You can increase or decrease this setting to add more or less 
detail to the shape.

 The Repeat Count controls the number of times that the profile curve 
repeats along the path

To remove the curve profile from the shape, select the Curve 
Profile tool from the Fill section of the tool box and click on an 
empty background area. 

Tool Options

•	 Repeat Count: Used to control the number of times that the 
profile shape repeats along the path.
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Working with Fills
To define a region to be filled, you must first select all the points 
along its boundary. That’s what defines a fill region - the set of 
points along its outer edge. We’ll take a look at some examples 
later. You can also create outlines using these tools. Outlines are 
less restrictive than fills - an outline is not a set of points along an 
outer boundary. Instead, an outline can be any set of points you 
choose. The curve segments between these selected points will 
form the outline.

Fills and outlines are stacked on top of each other in the order 
you create them. This determines which fill or outline will be 
visible when two or more overlap. There are tools that allow you 
to change the stacking order of fills and outlines, but you’ll learn 
that you can save yourself a lot of time by planning ahead and 
creating fills in the proper order to begin with.

There are a number of different ways to fill shapes in Anime 
Studio:

•	 Use the Select Shape tool to select the shape you want to 
change. The color and fill properties will be “picked up” in 
the Style window. You can then change the fill colors in the 
Style window.

•	 Use the Create Shape tool to fill closed outlines that do 
not have any fill. You will need to select the points in the 
outlines before you use the Create Shape tool.

•	 You can also use the Paint Bucket to fill shapes that do not 
yet have a fill. For example, you can use the Add Point or 
Freehand tool to create a shape that has a stroke only, and 
then later use the Paint Bucket tool to add a fill.

•	 You can also change colors with the Eyedropper. Use the 
Eyedropper to select a color from any of the shapes that use 
the color you want to apply. Then press the Alt key and click 
other objects with the Eyedropper to push the selected color 
to other shapes.

Color Picking

If the Select Shape or Create Shape tools are active and a 
shape is selected, you can quickly set the shape’s color by picking 
it from another shape in the current layer. Just hold down the 
Alt key and click on the shape you want to copy the color from. 
The color (and style) will instantly be applied to the currently 
selected shape.

You can also push a shape’s color and style onto other shapes. 
If you hold down Alt + Ctrl and click on a second shape, the 
selected shape’s color will be pushed onto the shape you click on. 
This is an easy way to propagate one shape’s color and style onto 
several other shapes in the same layer.

The following Fill tools are available.
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Complex Fill Shapes

When creating fills, Anime Studio tries to be clever and ignore 
selected parts that can’t possibly be part of the outline of a fill, 
such as points on dead-end curves. However, there are times 
when Anime Studio needs a little help from you. As an example, 
take the shape below:

 A complex shape - two curves welded together

To fill this shape with color, your first thought might be to 
select the entire group of points. Unfortunately, Anime Studio 
recognizes this as a shape that can’t be filled, and will only allow 
you to create an outline:

 A shape that can’t be filled

The reason for this is that a fill is defined by the points along its 
boundary. In this case, it’s not obvious to Anime Studio which 
boundary you intended. Many times, Anime Studio can figure it 
out and provide you with the fill you were after, but in a case like 
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this, you have to be more specific about what points define the 
boundary of the shape. The definition of a fill hasn’t changed - 
but sometimes your intentions aren’t as obvious to Anime Studio 
as they are to you. The following selection contains only the 
boundary points of the desired fill region - the points along the 
interior curve are not selected:

 A selection that can be filled

Here are two other examples of possible fills based on the same 
set of curves:

 Alternate shape 1
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 Alternate shape 2

Remember, when a fill shape doesn’t look right (or can’t be filled 
at all), make sure that you’ve only selected the points along the 
fill’s boundary, and nothing else.

Compound Fills

Remember how a fill is defined: a fill is defined by the set of 
points along its boundary. With that in mind, let’s talk about 
fills with holes. To create a fill shape with one or more holes 
inside it, just select the points along the edge of the hole as well 
as the points on the outer boundary. The picture below shows a 
selection made with the Create Shape tool. If only the four points 
of the rectangle had been selected, then the fill shape would have 
been a solid rectangle. However, by selecting the interior curves 
as well, we can create a shape with holes in it - it’s simply a 
matter of defining more boundaries for the fill.

In previous versions of Anime Studio, it was 
difficult to delete a hole from an object that used a 

compound fill. Deleting the hole would also affect the fill 
of the portions of the object that remained. In Anime 
Studio 8, you can now select the points in a hole and then 
delete the points. The area that was once a whole would 
then be filled as if the hole was never there. 
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 A compound fill

The next picture shows a small variation on the one above. In 
this case, there’s a smaller circle inside the first one. The rule is 
the same - we’ve just added more boundary curves to this fill.

 Another compound fill

There’s no limit to the kinds of shapes you can create this way. 
By adding more boundary curves, you can create more and more 
complex fills - feel free to experiment.
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A Trick: Using Two Fills Instead of One

Sometimes you may want to create an object with parts that 
overlap in complex ways. Consider the image below:

 Two interlocking rings

After the discussion about stacking order, is the red ring in front 
of or behind the blue one? Well, the answer isn’t so simple. There 
is no way two objects could be arranged this way with simple 
stacking. (If Anime Studio were a 3D program, things would be 
very different.) The red ring is in fact two objects - one behind the 

blue ring, and one in front of it. The next image shows the same 
object, but colored differently so that the two parts of the red ring 
stand out.

 The coloring shows three different shapes

It takes a little more work to set up an object when you have to 
split it into two (or more) parts, but sometimes it’s the only way 
to achieve a certain effect. The picture below shows the project in 
an Anime Studio window, so that you can see the arrangement of 
points and curves. Note how the ring on the right has some extra 
curves set up so that it can be split into two fills.
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 Point and curve arrangement.

This technique is also useful in animation, for when you want 
an object to bend backwards and overlap itself. Normally, this 
would cause the fill that defined the object to get seriously 
distorted, or even to break holes in itself. However, by building 
the object out of two or more parts and stacking them properly, 
you can achieve this type of effect with no problem.
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Bone Tools
The following tools are available when working with Bone or 
Switch layers. 

If a tool has the following symbol next to it: , then it can be 
used for animation as well. In general, tools that are used for 
bone setup can only be used when the time is set to frame 0 - 
others can be used at any time.

Anime Studio 8 has a smart tool palette, which 
shows and hides tools based on their need. The 

position of the tool shown in the screenshots may differ, 
depending on the selected layer in the Layers palette, 
and the current time in the timeline. 

Select Bone
Using this tool, you can click on a bone to select it. You can also 
draw a marquee or a lasso around multiple bones to select more 
than one bone with the Select Bone tool.

You might want to select a bone in order to delete it (press the 
Delete or Backspace keys - all of its children will be deleted 
too). You also might want to select a bone in order to add new 

child bones to it. Click anywhere besides a bone to de-select all 
bones.

 Select Bone Tool

Tool Options

 Select Bone Options

Click the Bone Constraints button to open the options dialog 
shown below. For detailed instructions and descriptions of the 
options in this dialog, refer to “Angle Constraints” on page 
76.
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 Bone Constraints Options

Two additional options appear in the Options toolbar:

•	 Lock Bone: When checked, prevents accidental changes to 
the current bone.

•	 Lasso Mode: When checked, allows you to select multiple 
bones by drawing a lasso around them. When unchecked, 
you can select multiple bones by drawing a rectangular 
selection around them. 

Translate Bone
The Translate Bone tool (along with the Rotate Bone tool) 
is used to reposition bones after they’ve been created. If 

you’ve added a new bone in the wrong place, or you just want to 
move it later on, click and drag it with this tool. Clicking near the 
base of the bone will move its position, while clicking near the tip 
will move the tip around, changing the bone’s length and 
direction. Note that if the bone has any child bones, they will be 
moved as well.

 Translate Bone Tool

Holding the Shift key will cause the bone to only move 
horizontally or vertically relative to its parent (if you click 
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near the base), or to point in a direction that is a multiple of 45 
degrees (if you click near the tip).

If any objects in other layers have been bound to the bone, 
they will not move if the current frame is 0. At frame 0, you are 
modifying the bone layout - at later frames you are animating 
with this tool, and bound objects will move with the bone.

Nudging: When this tool is active, you can nudge the selected 
bone by small increments by holding down the Ctrl key and 
pressing the arrow keys. Hold down Shift in addition to Ctrl to 
nudge the bone by a greater increment.

Tool Options

 Translate Bone Options

•	 Select Bone: Click this menu button to select a bone by 
name.

•	 Position X: Allows you to numerically enter a value for the 
X coordinate.

•	 Position Y: Allows you to numerically enter a value for the 
Y coordinate.

•	 Length: Allows you to view or enter a numerical value for 
the length of the bone.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

Scale Bone
The Scale Bone tool is used to change the length of a bone. 
This tool is only available during an animation, not at 

frame zero. To change the length of a bone at frame 0, use the 
Translate Bone tool and drag the tip of the bone.

 Scale Bone Tool
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Tool Options

 Scale Bone Options

•	 Select Bone: Click this menu button to select a bone by 
name.

•	 Scale: Allows you to view or enter a numerical value for the 
length of the bone.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

Rotate Bone
The Rotate Bone tool is used to change the direction a 
bone is pointing in. Click the tip of a bone, and drag it in 

circles around its base to change its direction. Hold the Shift key 
to constrain the bone’s direction to a multiple of 45 degrees.

 Rotate Bone Tool

Tool Options

 Rotate Bone Options

•	 Select Bone: Click this menu button to select a bone by 
name.

•	 Angle: Allows you to view or enter a numerical value for the 
angle of the bone.
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•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

Add Bone
Use the Add Bone tool to add new bones to a skeleton. The 
location you click will be the base of the bone (the point it rotates 
about), and where you drag to will be the endpoint. If another 
bone is selected before you click and drag, it will be the parent 
of the new bone you create. Otherwise, the new bone will be 
parentless, a root bone.

 Add Bone Tool

Hold the Shift key to constrain the new bone to point in a 
direction that is a multiple of 45 degrees.

Note that bones don’t have to be touching to have a parent-child 
relationship. In the example shown in “Tutorial 3.4: Character 
Setup” on page 91, the upper arm bones are children of 

the spine, even though they are separated from it by a small 
distance. This will often be the case - arms should rotate about 
the shoulders, not the neck, even though they move when the 
spine moves.

Tool Options

 Add Bone Options

•	 Select Bone: Click this menu button to select a bone by 
name.

•	 Text Field: Allows you to assign a name to the currently 
selected bone

Reparent Bone
Sometimes when building a skeleton, you may accidentally add 
bones to the wrong parent. Later, when you discover the error, 
deleting bones and adding new ones is just too much work. 
Instead, use the Change Parent tool to change a bone’s parent. 
First, select the bone whose parent you want to change (using the 
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Select Bone tool). Then, using this tool, click on the new parent 
bone. (The new parent will become highlighted in blue.) If you 
want to turn the selected bone into a root bone (one that has no 
parent), just click on the background.

 Reparent Bone Tool

Tool Options

•	 Select Bone: Click this menu button to select a bone by 
name.

Bone Strength
When using bones to control the points in a vector layer or to 
warp an image layer, by default every bone has some degree of 
influence over every point in the vector layer (or image). The 
Bone Strength tool lets you adjust how much influence each 
bone has. When this tool is activated, a semi-transparent region 

appears around each bone - this region indicates the strength 
of the bone. If you drag side to side on a bone with the Bone 
Strength tool, you cause the region of influence to shrink or 
grow. Points that are closer to the center of this region move 
more when the bone itself is moved.

 Bone Strength Tool

Although by default, all bones have some influence over some 
points, you can change this behavior. In the Layer Settings 
dialog, under the Bones tab, there are two options, Flexible 
binding and Region binding. Flexible binding means that every 
bone will influence every point. Region binding, on the other 
hand, means that a point will only move under the influence of 
the bone(s) in whose region of influence it lies. If that point only 
lies in one bone’s region, it will only move with that bone - if the 
point is overlapped by the regions of two bones, it will move with 
both of those bones.

Flexible binding is the default setting for new bone layers 
because it works reasonably well almost automatically. The 
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downside is that it leads to rubbery movement of the attached 
vector artwork. Region binding will give you cleaner movement, 
but takes a little more work to set up. The Tutorials section 
of this manual shows you how to use the Bone Strength tool 
together with both types of binding to quickly set up a character’s 
skeleton.

Tool Options

 Bone Strength Options

•	 Select Bone: Click this menu button to select a bone by 
name.

•	 Bone Strength: Allows you to view or enter a numerical 
value for bone strength.

Manipulate Bones
The Manipulate Bones tool has two purposes. First, when 
the current frame is set to 0, it is used to test whether a 

skeleton is set up and working properly. Although it moves bones 

and points around, the changes it makes are only temporary. 
When you switch to another tool, the skeleton is reverted back to 
its original shape.

 Manipulate Bones Tool

The second use of this tool is at frames greater than 0. If the 
current frame is greater than 0, then this tool will move the 
skeleton in the same way, but the move will introduce a keyframe 
for animation.

To manipulate a skeleton, just click and drag the various bones 
that make it up. If points or other layers have been bound to 
the bones, they will move as well. The way the skeleton and the 
bound points move with this tool is exactly the same whether 
at frame 0 or a later frame. If some part of the skeleton doesn’t 
move correctly, you can find out with this tool and fix it before 
you start animating.

Note: If you only want to rotate a single bone, it’s better to use 
the Rotate Bone tool. The Manipulate Bones tool will move a 
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whole chain of bones, which is definitely not what you want if 
you plan to rotate a single bone.

Bind Layer
Other layers can be contained within a bone layer. For example, 
you could create a hand layer and place that within an arm layer. 
To bind the hand to the arm, use this tool. Just click on the bone 
in the parent layer that you want to connect to, and the entire 
layer will move with that bone. In the arm/hand example, you 
would click on the bone nearest the wrist to bind the hand to the 
end of the arm.

Use this tool to bind an entire layer to a single bone. If you would 
rather bind certain points in a vector layer to certain bones, then 
you should use the Bind Points tool instead.

For more information on how to use the Bind Layer tool, see 
“Layer Binding” on page 73.

 Bind Layer Tool

Bind Points
The Bind Points tool operates exactly like the Select Points tool 
described in “Select Points” on page 208. Use it to select a 
group of points to bind to a bone. In order to use this tool, you 
must be on Frame 0, and a bone must first be selected. When 
a bone is selected, the points that are currently bound to it are 
automatically selected as well. Use this tool to add or remove 
points from that selected group. When the correct group of 
points is selected that you want to bind to the bone, press the 
spacebar - this tells Anime Studio to perform the binding. This 
technique is demonstrated in “Tutorial 3.1: Bone Binding” on 
page 66.

 Bind Points Tool

We don’t usually recommend using the Bind Points tool. Instead, 
the best way to attach points to bones is to use automatic bone 
binding, together with the Bone Strength tool.
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Offset Bone
The Offset Bone tool lets you add an extra amount of bone 
movement starting at frame 1 of your animation. The reason 
you might want to do this is to simplify the setup of a complex 
character. Often, parts of a character such as arms and legs 
overlap, making it difficult to set up bones and attach the proper 
parts of the character’s body to them. The Offset Bone tool lets 
you draw the parts of a character in disconnected positions, set 
up bones, and then move them all back into position.

It’s difficult to describe the usefulness of this tool without a 
hands-on example, so look at “Tutorial 3.4: Character Setup” on 
page 91.

 Offset Bone Tool

Tool Options

 Offset Bone Options

•	 Select Bone: Click this menu button to select a bone by 
name.

•	 Animation Offset X: Allows you to numerically enter a value 
for the amount of offset on the X axis.

•	 Animation Offset Y: Allows you to numerically enter a value 
for the amount of offset on the Y axis.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

Bone Physics
When objects that have bones are added to a Group layer that has 
physics applied to it (as mentioned in “Basic Physics” on page 
161), the bones will respond to the physics properties that you 
have set for the object. Physics are applied to each bone based 
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upon the bone’s area of influence, as set by the Bone Strength 
tool.

 Bone Physics Tool

 A boned character placed into a physics group

The Bone Physics tool is a setup tool and will only be available at 
Frame 0, and once a boned object is placed inside a Group layer 
that has physics enabled. The options mentioned in the following 
section become available in the Options bar. You can assign 
different physics properties to the bones by clicking each bone 
with the Bone Physics tool.
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For additional information on configuring 
groups and objects for physics, see “Basic 

Physics” on page 161. 

After you set up the objects in your scene, and the bones in your 
character, you can press the play button to see how the character 
responds to the physics as it comes into contact with the other 
stationary and physics-enabled objects in the scene.

 The boned character responding to other objects in the scene

Tool Options

•	 Select Bone: Click this menu button to select a bone by 
name.

•	 Bone Physics Region: With physics, bones are represented 
internally with a kind of pill-shaped region around them, 
the physics region. You can enter a number numerically, 
but generally you would just use this tool to click and 
drag on individual bones to control the size of the physics 
region, trying to get it to match the underlaying character 
as closely as possible. When you play back the animation, 
the bone physics regions are what is used in collisions, not 
the character artwork. (This is because the bending of the 
character is not directly physics related. The physics pushes 
the bones around according to the physics regions, and the 
bones then move the character just like they would if you 
were hand-animating.)

•	 Motor Speed: . The motor speed is the number of degrees 
per second the object will rotate (it can be negative to rotate 
backwards). Depending if the object bumps into obstacles or 
there are other influences, it may not actually rotate at that 
speed, but in a zero gravity setup with no collisions, that will 
be the speed of rotation.

•	 Motor Torque: Motor torque controls the strength of the 
motor. With low torque, when a motorized object bumps 
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into other objects it may come to a stop, depending on the 
size and density of the obstacles. With a high torque, it will 
tend to push obstacles out of its way. Even with no obstacles, 
if a motorized object is unbalanced (off center of its origin), 
a low torque setting may mean that it can even lift itself up.

•	 Return to Neutral: Check this option to return the bone to 
neutral position.

•	 Lock Tip: When physics are in affect, if a bone has its tip 
locked it acts as though the endpoint of the bone has been 
nailed to a stationary point.
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Layer Types
Drawings in Anime Studio are vector-based. Vector drawings 
are different from pixel-based images (like a photograph) in that 
they use lines and curves to represent a picture, rather than a 
grid of colored pixels. This difference makes a lot of things easy 
in Anime Studio that would be difficult or impossible to do with a 
pixel-based image.

First of all, since an Anime Studio drawing is represented as a 
bunch of curves, you can reshape the curves at any time, without 
ever losing precision. Also, Anime Studio projects are relatively 
small, even for complex animations - this means Anime Studio 
doesn’t require much memory even when working on a long 
movie. Vectors also have benefits when it comes to animation. By 
moving just a few points, you can totally change the shape of an 
object over time.

You’re not restricted to vector artwork, though - Anime Studio 
also has Image Layers. Using this type of layer, you can work 
with regular images within an Anime Studio project. So, Anime 
Studio is not strictly vector-based, but you will probably still use 
mostly vector layers, as image layers are not as flexible when it 
comes to animation.

Of course, most standard image and movie formats are not 
vector-based, so when you’re done working on a Anime Studio 
project, it must be rendered to create a traditional pixel-based 

image. During the rendering process, Anime Studio can apply 
various effects to the objects, such as shading and blurring.

Anime Studio is designed in such a way that projects are split 
into layers. You can have many, many layers in a Anime Studio 
project, each representing a different element in a scene or 
animation, such as background scenery, a character, or a title. 
Some layers can even contain other layers, so a more complex 
object, such as a character, might contain separate layers for each 
arm and leg. 

Anime Studio currently supports the following types of layers:

•	 Vector Layers are used to hold vector-based artwork. These 
are the main type of layer you will use to create drawings. 
See “Vector Layers” on page 267 for more information.

You’ll notice performance improvements in 
Anime Studio 8, when working with Vector 

layers, especially those that contain many points (such 
as when you use the Trace Image feature to convert a 
bitmap image into a Vector Layer, or when you import 
an Adobe Illustrator file). 

You can use the Scripts > Draw > Simplify Curve 
menu command to reduce the number of points 

in a complex Vector layer. 
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•	 Image Layers can be used to bring in images from other 
applications. Image files created in 3D programs or photo 
editing applications can be used in Anime Studio with 
Image Layers. See “Image Layers” on page 268 for more 
information.

•	 Group Layers (Anime Studio Pro only) are used to group 
together multiple layers. If you created 20 layers with trees 
for example, you could put them all in a Group Layer and 
call it a forest. Group layers are a useful tool for organizing 
a complex project. See “Group Layers” on page 269 for 
more information.

Right-click a Group Layer in the Layers window 
to quickly convert the Group layer into a Bone or 

Switch layer. 

•	 Bone Layers contain skeletons that are used to control the 
artwork in your vector and image layers. You manipulate 
skeletons as if they were “puppets” by bending arms and legs 
to make a character move. See “Bone Layers” on page 269 
for more information.

Right-click a Bone layer in the Layers window to 
quickly convert it into a Switch layer. 

•	 Switch Layers are just like Bone layers, except they will 
only display one of their sub-layers at a time. Switch layers 
are an excellent way to perform lip-sync animation. Which 
sub-layer gets displayed is controlled by a switch data file. 
You can create this data file by hand, or better yet, use a 
lip-syncing program like Papagayo. See “Switch Layers” on 
page 271 for more information.

•	 Particle Layers (Anime Studio Pro only) are used as a way 
to simulate water, sparks, smoke, crowds, or any number of 
effects that can be made up of many small objects. A Particle 
layer behaves somewhat like a Group layer, but instead 
of displaying each of its sub-layers, it can display many, 
many copies of each sub-layer arranged in sort of a “spray” 
formation. The sub-layers appear to be moving outward 
from the origin of the Particle layer. For more information, 
see “Particle Layers” on page 274

•	 Note Layers (Anime Studio Pro only) are like sticky notes 
in Anime Studio. You might use a note layer when you 
want to leave a note for yourself or another animator. For 
example, you might create a note layer at a particular frame 
that needs some work, or to describe why a character is set 
up in a particular way. See “Note Layers” on page 276 for 
more information.
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•	 Audio Layers allow you to add a sound file to your project. 
When adding an audio layer you will be prompted to select 
an audio file.

•	 Patch Layers allow you to arrange layers so that part of 
a layer can appear behind a layer, and another part of the 
same layer can appear in front of a layer. They are used in 
conjunction with the Character Wizard, but can also be used 
in other ways.

•	 3D Layers (Anime Studio Pro only) can be used to import 
3D objects that were created in a 3D modeling program. Use 
the File > Import > 3D command to create a 3D Layer. 3D 
models can be a good source of background scenery. Or, use 
a 3D model for a character’s head, and decorate it with eyes, 
mouth, etc. created with Anime Studio’s vector layers. See 
“3D Layers” on page 277 for more information.

Enhanced Layer Alignment Features
The Layer Alignment features in Anime Studio have been 
improved to assist in alignment when using 2D to 3D 
conversions. When you added a new layer to a project in Anime 
Studio 6 or earlier, the layers aligned on the X (horizontal) and Y 
(vertical) planes. In Anime Studio 8, new layers align to face with 
the current camera view. This allows you to create more complex 
3D objects in your Anime Studio scenes. 

To demonstrate, try this:

1.	 Create a new Anime Studio scene.

1.	 Use the Draw Shape tool to draw a box in the scene.

2.	 Use the 2D to 3D conversion features to extrude the 2D box 
into a 3D box. To convert a 2D vector layer to 3D, double 
click on the layer in the Layers Window and click on the 3D 
Options tab. Then select ‘Extrude’ from the 3D Conversion 
drop down menu.

3.	 Use the Orbit Workspace tool to rotate the camera so that 
you are looking at the 2D box from a different angle.

4.	 Create a new layer, and add another extruded box on that 
layer. The new box faces the current angle of the camera. 

5.	 Rotate the camera so that you can see how the two boxes 
relate to each other.
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 New layer alignment features

Vector Layers
Vector layers are the most common layer in Anime Studio 
projects. Artwork that you create in Anime Studio is always 
contained in a vector layer. Tools are available for drawing and 
editing curves, setting up fills and outlines, and connecting your 
drawings to bones.

 Vector Layers

The tools available for working with vector layers essentially 
make up a 2D drawing program. You can draw lines and curves, 
re-shape existing curves, and manipulate objects in various 
ways. There are a couple ways that Anime Studio differs from 
other drawing programs. First, everything you draw in Anime 
Studio is a set of points and curves. In many programs, when you 
draw a circle, you get a circle object, or you may type some text 
to create a text object. In Anime Studio, once you’ve created the 
circle or the text, there’s no difference between them whatsoever 
- they’re both collections of curves. One happens to be in the 
shape of a circle, and the other in the shape of some text. There 
are advantages in treating all objects the same: first, you never 
have to worry about what type of object you’re working with - the 
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answer is always the same: a set of points and curves. The other 
advantage is that any operation you can perform on hand-drawn 
curves can be performed on text, or a circle, or whatever.

The other feature of Anime Studio’s drawing mode that is 
different from many other drawing programs is the concept of 
welding. In Anime Studio, two points can be welded together 
into a single point. In fact, any number of points can be welded 
together. When points are welded together, moving one of 
them moves them all, along with any curves that pass through 
that point. This is particularly useful when you start to animate 
objects. For example, if you want to move a character’s nose, then 
welding it to the face might not be a bad idea. That way, however 
you distort the nose or the face, they’ll always stay connected.

Image Layers
Image layers are a way of importing artwork into Anime Studio 
that was created in other programs. Any program that can 
produce image files can be used together with Anime Studio 
this way. For example, a painting program, photo editor, or 3D 
modeling program can produce images that can be used in an 
Anime Studio image layer. You can’t edit the pixels of one of 
these images in Anime Studio, but you can move, resize and 
rotate image layers, and attach them to skeletons for more 
complex animation.

 Image Layers

The best image format to use with Anime Studio is PNG. PNG 
files have high quality, good compression, and support full alpha 
channels for transparency effects. Although PNG is the preferred 
format for use with Anime Studio, you can also use JPEG, BMP, 
Targa, or GIF images.

Image layers can also be used to bring external movies into 
Anime Studio. Instead of selecting a still image, select a movie 
file when creating a new image layer. Anime Studio can import 
QuickTime (Windows and Mac OS) or AVI (Windows only) 
movies as image layers. When importing a movie file, Anime 
Studio will use the movie’s alpha channel (if present) to 
composite the movie with other elements in the scene.
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Group Layers
Group layers are used to group together multiple sub-layers so 
that they can be manipulated as one. They’re also very useful for 
organizing complex projects. You can think of a group layer as 
a folder that can contain files (layers) and other folders (more 
group layers). When you move a group layer, turn it invisible, or 
apply an effect (such as a layer shadow), these are all applied to 
every layer contained within the group.

 Group Layers

Bone Layers
Bone layers are similar to Group layers - they can both group 
together multiple sub-layers that can then be manipulated as a 
single object. However, bone layers have an additional feature: 
In a bone layer, you can set up a skeleton that can be used to 
manipulate your artwork. A skeleton is exactly what it sounds 
like - an internal structure that can move the outer, visible 
portion of your artwork.

 Bone Layers

Setting up bones is sort of a pre-animation phase. You don’t 
draw shapes in Bone layers, you set up controls that will help you 
animate later on. The purpose of setting up bones is exactly what 
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you might think: creating a rigid skeleton inside your drawing. 
Later on, during animation, when you want to move an object, 
bones make the job easy. By moving a single bone in the arm of a 
character, for example, the whole arm will move with it. Around 
the elbow, the drawing of the arm will bend and stay smooth (as 
long as the bones were set up well with the Bone editing tools).

Bones by themselves don’t really do much of anything: you can 
move them around, but they’re invisible in the final Anime Studio 
output. To really make use of bones, they need to be attached 
to objects in other layers. This process is covered in “Bones” on 
page 66, and also “Bone Tools” on page 252.

When you create a skeleton out of a group of bones, the bones 
have a hierarchical relationship. Each bone has a single parent 
(or maybe no parent at all, in which case it’s called a root bone), 
and each bone may have multiple children. The relationship 
between parent and children is that when a parent bone is 
moved, all of its children move with it. When a child bone is 
moved however, it’s parent remains unchanged.

Below is a picture of a skeleton created in Anime Studio. Red 
arrows have been added that point from each bone to its parent 
(the spine has no parent and is referred to as the root of the 
skeleton). Note that the currently selected bone is highlighted in 
red, and its parent (if it has one) is highlighted in blue, as shown 
below.

 A skeleton hierarchy

When you use bones with a vector layer, you need to consider 
how the bones and curve control points will interact. When a 
bone moves, it moves the points around it as well. Each bone has 
a region of influence (which you can adjust). Points move mostly 
with the bone whose region of influence they fall within, although 
other bones can still have an effect on them. Below is a picture 
of some points and bones. Notice the region of influence around 
each bone. The second picture shows the same object after the 
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bones have been moved. Notice how the points follow the bones 
according to regions of influence (and how the curves pass 
smoothly through the points, wherever they move to).

 A bone and vector setup

 Moving bones moves the curve control points

Switch Layers
Switch layers are used to group together multiple layers, much 
like Group layers. However, switch layers have an interesting 
twist: only one of their sub-layers can be displayed at a time.
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 Switch Layers

One reason you might want to do this is for lip-sync animation. 
In this case, each of the sub-layers would correspond to a mouth 
shape for a particular sound (“A”, “O”, “TH”, etc.). Anime Studio 
includes powerful automatic lip-syncing which is a big time 
saver.

•	 Anime Studio Debut uses the volume of the audio track to 
determine which mouth shape to use. When the audio is 
quiet, the mouth is more closed. When the audio is louder, 
the mouth is more open.

•	 Anime Studio Pro uses a production sync library that 
analyzes the audio track to determine the phonemes (the 

basic components of speech) that are being used. Results 
are improved when you enter the spoken words into Anime 
Studio. After the production sync analysis is done, Anime 
Studio Pro applies the matching mouth shape.

If you prefer more control over lip-syncing than what the 
automatic built-in lip-syncing offers, you can take full manual 
control over the process using a separate, and free, tool called 
Papagayo (see http://www.lostmarble.com/papagayo/). In 
Papagayo, you type in the words that are being spoken. Papagayo 
then uses a phoneme dictionary to break down the words into 
spoken phoneme components. These are lined up on a timeline, 
along with the audio waveform. 

Initially, the lineup on the timeline in Papagayo is rough and 
the phonemes are spaced evenly. You then shift words and 
phonemes along the timeline so that they line up better with the 
actual sounds you hear. The final result is saved out as a “switch 
data file” that can be imported into Anime Studio.

http://www.lostmarble.com/papagayo/
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To set up a mouth that can lip sync, you will need 
to create a switch layer that contains at least ten 

sub-layers with different mouth shapes. Shapes should 
be created for the appearance of the mouth when at rest, 
and when speaking each of 9 different phonemes. For 
further information on this topic, reference Lip Syncing 
Mouths in Anime Studio (http://mysmithmicro.com/
ASLipsyncing), which can be found online in the Smith 
Micro knowledge base. For examples of how lip syncing 
is used, see “Tutorial 5.1: Automatic Lip-Sync” on page 
124 or “Tutorial 5.2: Phoneme Lip-Sync” on page 
126. 

You can also create a switch data file by hand. To do this, the 
data file should look like this:

MohoSwitch1
1 A
2 A
10 B
22 A
37 C
40 C

•	 The first line is a header that just tells Anime Studio that the 
file is a switch data file. 

•	 The following lines contain two items each: 

�� The first item is a keyframe. 

�� The second item is the name of one of the switch 
group’s sub-layers. (In this example, the switch layer 
should have three sub-layers, named “A”, “B”, and “C”.)

If you make changes to the switch data file outside of Anime 
Studio, and you want to incorporate those changes, you will need 
to re-load the data file. To do this, double-click the Switch layer 
in the Layers window, and in the dialog that opens up, go to the 
Switch tab, press Source Data and re-select the data file.

You don’t have to use a data file to work with Switch layers - you 
can also control them manually from within Anime Studio. 
To control which sub-layer is displayed at any frame in your 
animation, just right-click on the Switch layer in the Layers 
window. A pop-up menu will appear that lets you choose which 
sub-layer to display.

Anime Studio includes several sample mouth sets for doing lip-
sync with Papagayo - take a look at those files to see how a switch 
layer should be set up. Also, check out the lip-sync tutorials 
included in this manual.

Switch layers have a feature that allows for smooth switching. 
To use this feature, all the sub-layers need to be Vector layers, 
and they need to have the same number of control points. Then, 
when switching, Anime Studio can smoothly transition between 
sub-layers. To enable this feature, turn on Interpolate sub-
layers in the Switch layer’s properties dialog. An example of 

http://mysmithmicro.com/ASLipsyncing
http://mysmithmicro.com/ASLipsyncing


Anime Studio Pro 8
Users Manual

274

Layer Types

using this feature is included in one of the mouth sets mentioned 
above.

Finally, switch layers can be set up with skeletons, just like bone 
layers. More accurately, a switch layer is a bone layer, just a 
specialized one. If you add bones to a switch layer, you can use 
them (for example) to change the shape of a mouth as it speaks, 
bending it into a smile or a frown.

Don’t feel restricted to lip-sync animation with switch layers. 
They have a lot of potential uses (controlling eyes, syncing 
to music & sound effects, switching between different hand 
gestures, etc.) - get creative!

Particle Layers
Particle layers are a way to simulate such effects as flowing water, 
fire, bubbles, or other effects that you can imagine are made up 
of many small objects. A particle layer is like a group layer in that 
it can contain sub-layers. However, instead of just displaying its 
sub-layers as they are, a particle layer will automatically animate 
its sub-layers so that they appear to be flowing outward from the 
particle layer’s origin.

 Particle Layers

The direction that a particle layer sprays its particles is illustrated 
below.
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 Particle spray direction

During an animation, a particle layer can be turned on or off. 
When it is turned off, no more particles will be created, but those 
that already exist will continue to the end of their lifetime. To 
turn a particle layer on or off, right-click its entry in the Layers 
window. A popup menu will appear to let you turn the particle 
layer on or off.

The complete list of settings for a particle layer is as follows. 
These settings are accessible in the Layer Properties dialog, 
under the Particles tab:

•	 Particle Count: The total number of particles visible at any 
one time

•	 Preview particles: The number of particles displayed in the 
working view (a smaller number than Particle count keeps 
the working view from slowing down too much)

•	 Lifetime (frames): The number of frames before a particle 
is recycled and sent back to the source. If set to zero, the 
particles will keep going for the duration of the animation.

•	 Source width: The width of the spray source

•	 Source height: The height of the spray source

•	 Source depth: The depth of the spray source. If set to a 
number greater than zero, then some particles will appear 
closer to the camera than others.

•	 Velocity: The speed that particles start at (a value of 2 will 
cause a particle to cross the entire screen vertically in one 
second)

•	 Velocity spread: The amount of random variation in the 
particles’ velocity
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•	 Damping: This acts kind of like air resistance, or backwards 
acceleration

•	 On at start: Whether the particle layer should be on at the 
start of the animation

•	 Full speed start: If the layer is on, this checkbox indicates if 
it should be running at full speed, or just starting

•	 Orient particles: If checked, then the particles will rotate to 
face the direction they’re moving in

•	 Free-floating: If unchecked, then the particles will be tied to 
the particle layer if it is moved

•	 Evenly spaced: if checked, then the particles will be 
released in even time increments

•	 Randomize playback: Normally, particles will start their 
animation from the beginning when they are first created. 
If this box is checked, then particles will start playback at 
a random time. This is useful when simulating things like 
crowds of people (see “Effects” on page 168).

•	 Direction: An angle indicating direction to spray particles in 
(see above figure)

•	 Spread: How wide the spray should be (see above figure) (a 
value of 360 will cause particles to spray in all directions)

•	 Acceleration: The direction of acceleration (straight down 
simulates gravity)

•	 Rate: The rate of acceleration

Note Layers
Anime Studio’s Note layers work kind of like sticky notes. You 
can add a note layer to remind yourself of something you need to 
work on, or to explain to other animators some important aspect 
of your project file. If you add a note layer at a frame other than 
zero, the note will only appear starting at that frame. That way, 
you can add notes that refer to specific parts of your animation 
(ex. “Use more exaggeration here!”).

 Note Layers
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By default, Note layers do not appear in final rendered output, 
so your audience doesn’t need to see your comments to yourself. 
However, if for some reason you do want a note to appear in the 
final product, you can do that by unchecking Don’t render this 
layer in the Layer Settings dialog.

Audio Layers
Audio layers allow you to add an audio file to your project. You 
will be prompted to select a file after choosing this layer type. A 
graphic representation of the audio file appears in the timeline 
after the file is selected.

 Audio Layers

3D Layers
3D layers are a way for you to import true 3D models into Anime 
Studio. When a 3D layer is rotated in space (or the camera moves 
around it), you actually see that backside of the model. Anime 
Studio supports importing OBJ files into 3D layers - OBJ is a 
common 3D file format that most 3D programs can read and 
write.

When importing OBJ files, Anime Studio will also load any 
associated material file, importing the objects’ colors and texture 
maps.

3D layers can also be used with skeletons. Using a bone layer, 
you can warp a 3D model by moving bones around. Keep in 
mind that while 3D layers are truly three-dimensional, bone 
layers are only 2D. So, any manipulation you do with bones is 
going to be limited to some degree.

Because Anime Studio is not a true 3D program, not all 3D 
features are supported. In particular, lighting. Any 3D model you 
import will be flat shaded. However, because Anime Studio does 
support texture maps, you can simulate lighting if a texture map 
has lighting effects baked into it.

There are lots of quality 3D programs we recommend for use 
with Anime Studio Pro. The following are products that will work 
well with Anime Studio Pro:

•	 Poser



Anime Studio Pro 8
Users Manual

278

Layer Types

•	 Amapi

For further information on importing 3D objects within Anime 
Studio Pro please visit http://my.smithmicro.com/tutorials/.

When preparing a 3D model for use with Anime 
Studio, it’s usually a good idea to triangulate the 

model before exporting it as an OBJ file. This will 
eliminate any problems with concave or complex faces.

Patch Layers
Patch layers are used in the Character Wizard to create objects 
that appear both in front of and behind objects on another layer. 
You can also create patch layers manually.

 Patch Layers

Patch layers are intended for use when you are constructing a 
character such as a humanoid figure. For example, let’s say you 
are drawing different body parts on different layers in a bone 
group. The head is on one layer, the torso on another, upper left 
and right arms on their own layers, and so on. Each layer has its 
own outline and fill.

However, when one joint meets another joint, there are outlines 
that overlap with other body parts. This is where patch layers 
come in, because you can blend the two layers together and 
“hide” the line where they connect.

http://my.smithmicro.com/tutorials/
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Look at the following example, which shows a number of body 
parts that are placed inside a Bone layer named Skeleton.

 Determine the areas that you want to blend with underlying layers.

Let’s say you want to blend the area between the torso and the 
right upper arm (Upper Arm R), which appears directly above 
the torso in the Layers window. To do this, you would follow 
these steps:

1.	 Select the Upper Arm R layer, so that the new Patch layer 
will appear above it.

2.	 Create a new Patch layer in the Layers window.

3.	  A dialog asks you to select a target, and you can select the 
target layer from the Target dropdown menu. Choose the 
Torso layer and click OK.

4.	  You’ll see a new circle in the project window. The circle is 
the patch. The patch will be named according to the target 
layer that you selected in the Patch Layer dialog. In the case 
of our example, the patch layer is named Torso-Patch.

5.	 Use the Layer tools (such as the Translate Layer and Scale 
Layer tools) to position and scale the patch so that the lines 
are covered. It should be positioned at the point where the 
shoulder will rotate. 
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 The new Patch Layer in place.

6.	 Use the Manipulate Bones tool to test the positioning of your 
patch.

If you need to change the target at any time, you 
can double-click the Patch layer and choose a 

new target from the Patch tab in the Layer Settings 
dialog. 

 Double-click the Patch layer to change the target if necessary.



Anime Studio Pro 8
Users Manual

281

Layer Tools

Layer Tools
The following tools are available to be used with any type of 
layer. Their purpose is to modify an entire layer, not just an 
individual object in that layer.

If a tool has the following symbol next to it: , then it can be 
used for animation - using the tool at different frames in the 
timeline will cause the object you adjust to change over time.

Anime Studio 8 has a smart tool palette, which 
shows and hides tools based on their need. The 

position of the tool shown in the screenshots may differ, 
depending on the selected layer in the Layers palette, 
and the current time in the timeline. 

Translate Layer
Use this tool to move the entire layer. It doesn’t matter 
what objects are selected - everything in the layer will 

move when you use this tool. Holding the Shift key while using 
the Translate Layer tool will constrain the layer to only move 
vertically or horizontally. Holding the Alt key will move the layer 
forward and back (changing its depth, or Z value).

 Translate Layer

When you are working with a 3D camera, the 
original plane of the object might not be the best 

place to move the object. If you are familiar with 
versions of Anime Studio prior to version 7, there is a 
small change in the way the Translate Layer tool works 
in Anime Studio 8. Normally the Translate Layer tool 
moves an object side to side and up and down in its own 
plane. In Anime Studio 8, you can use the Pan and Tilt 
camera tools to position the camera along the plane in 
which you want to move the object, and then use the 
Translate Layer tool to move the object along the plane 
of the camera’s current view.

If the Show Path box in the tool options area is checked, then 
the motion path for the current layer will be displayed in the 
working area when this tool is active. This makes it easier to 
visualize and plan out the motion of a layer.
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Direct Path Editing: To edit the motion path directly, hold down 
the Ctrl key, then click and drag anywhere on the motion path to 
adjust the curve that the layer will follow through space.

Nudging: When this tool is active, you can nudge a layer by small 
increments by holding down the Ctrl key and pressing the arrow 
keys. Hold down Shift in addition to Ctrl to nudge the layer by a 
greater increment.

Tool Options

 Translate Layer Options

•	 Position X: Allows you to numerically enter a value for the 
X coordinate.

•	 Position Y: Allows you to numerically enter a value for the 
Y coordinate.

•	 Position Z: Allows you to numerically enter a value for the 
Z coordinate.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

•	 Show Path: Check or uncheck this option to display or hide 
the motion path

•	 Flip Layer Horizontally: Click this button to flip 
horizontally.

•	 Flip Layer Vertically: Click this button to flip vertically.

Scale Layer
Use this tool to resize the entire layer. When this tool is 
active, a red box will appear on top of the current layer. 

The handles around the edges of this box allow you to resize the 
layer. Drag a corner handle in and out to scale the layer while 
maintaining its proportions. Drag one of the side handles to 
change the horizontal scale, or the top or bottom handle to 
change the vertical scale. If you hold the Alt key while dragging a 
side handle, Anime Studio will resize the layer in such a way to 
maintain the overall volume of the objects in the layer - this can 
be useful for squash and stretch effects.

 Scale Layer
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Tool Options

 Scale Layer Options

•	 Scale X: Allows you to enter a numeric value for scaling 
along the X axis.

•	 Scale Y: Allows you to enter a numeric value for scaling 
along the Y axis.

•	 Scale Z: Allows you to enter a numeric value for scaling 
along the Z axis.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

•	 Flip Layer Horizontally: Click this button to flip 
horizontally.

•	 Flip Layer Vertically: Click this button to flip vertically.

Rotate Layer Z
Use this tool to rotate the entire layer. Holding the Shift 
key while using the Rotate Layer Z tool will constrain the 

rotation to 45 degree increments.

 Rotate Layer Z

Tool Options

 Rotate Layer Z Options

•	 Z Rotation: Allows you to enter a numerical value for 
rotation along the Z axis.
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•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

•	 Flip Layer Horizontally: Click this button to flip 
horizontally.

•	 Flip Layer Vertically: Click this button to flip vertically.

Set Origin
With the Set Origin tool selected, click anywhere in the 
layer to set the origin to that point. The origin of a layer is 

indicated by the crosshair displayed when editing that layer. The 
origin is the point that the layer rotates around when using the 
Rotate Layer tool, and the point that the layer resizes around 
when using the Scale Layer tool. The location of the origin can 
also define how a layer will move when it is attached to a group of 
bones.

 Set Origin

Although you can change the origin at any time, the position 
of a layer’s origin is not animated. We recommend setting the 
layer’s origin just once, and then leaving it alone for the rest of 
the animation - otherwise unpredictable movement can occur. 
In most cases, you will never need to change the origin of a layer 
at all.

Tool Options

 Set Origin Options

•	 Origin X: Allows you to view or enter a numerical value for 
the X origin

•	 Origin Y: Allows you to view or enter a numerical value for 
the Y origin

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

•	 Flip Layer Horizontally: Click this button to flip 
horizontally.
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•	 Flip Layer Vertically: Click this button to flip vertically.

Follow Path
This tool allows you to assign any layer to follow a path in your 
scene. You will need two layers, one with the path, and the other 
with the object that will follow the path.

 Follow Path

 Two layers, one with a path, and another with a character or object

To use the tool, select the layer that contains object that you 
want to follow the path. Then select the Follow Path tool from 
the Layer section of the toolbox. The path appears in the scene 
after you select the Follow Path tool. Click the path in the scene 
to reposition the object to the beginning of the curve. 

You can click and drag left or right with the Follow Path tool to 
position the object along the curve at any point. You can then 
move to a later frame in your animation and set the object to a 
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new position. This allows you to animate the object travelling 
along the path.

 The fish before and after it is placed on the path with the Follow 
Path tool

You can set the object to rotate so that it follows the path. 
Double-click the object’s layer in the Layers window, which 
opens to the General tab. Check the Rotate to follow path 

option in the Options section of the Layer Settings dialog and 
click OK. This causes the object to automatically orient itself to 
follow the path to which it is assigned.

 Check the Rotate to Follow Path option in the Layer Settings dialog 
to orient the object to the path

You can also combine path following with the Curve 
Exposure tool, and expose the stroke of the curve while 
the object moves along the path. 
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If you hold down the Alt key while clicking on a curve, the object 
will now bend along the curve. This allows for text bending, 
characters that warp along a path (like a snake), and so on. You 
can animate this effect. For example if you go to another point in 
the timeline, you can Alt-click somewhere else on the curve. 

 Press the Alt key while using the Follow Path tool to bend the object 
along the path

Tool Options

 Follow Path Options

•	 Percentage: Allows you to enter a numerical value for the 
position of the object on the path. A value of 0 places the 
object at the beginning of the path, while a value of 100 
places the object at the end.

Rotate Layer XY
Click and drag up and down to rotate the layer around the X 
(horizontal) axis. This is a true 3D rotation, so that one half of 
the layer rotates into the screen and the other half out of the 
screen.

Click and drag side-to-side to rotate the layer around the Y 
(vertical) axis. This is a true 3D rotation, so that one half of the 
layer rotates into the screen and the other half out of the screen. 
You can verify this by using the Orbit Workspace tool to change 
your view of the scene.
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 Rotate Layer XY

Tool Options

 Rotate Layer XY Options

•	 X Rotation: Allows you to enter a numerical value for 
rotation along the X axis.

•	 Y Rotation: Allows you to enter a numerical value for 
rotation along the Y axis.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

Shear Layer
Use this tool to shear the current layer horizontally or 
vertically. Click and drag to shear, or slant the current 

layer to the left, right, up, or down.

 Shear Layer

Tool Options

 Shear Layer Options

•	 Shear X: Allows you to view or enter a numerical value for 
shear along the X axis.

•	 Shear Y: Allows you to view or enter a numerical value for 
shear along the Y axis.
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•	 Shear Z: Allows you to view or enter a numerical value for 
shear along the Z axis.

•	 Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the layer 
to the value or values set at frame 0.

Vector Shape Selector
The Vector Shape Selector helps you quickly find and edit vector 
layers. It is very helpful, especially when you have dozens or 
hundreds of layers in your project and can’t remember which 
layer a specific shape appears on. 

This tool can be also be used by Alt+Right-
clicking on the object that you want to select.

This tool only works on Vector layers. If you click a shape that 
appears in a Bone group, for example, it will select the vector 
layer that appears within that Bone group. Also, it will not select 
image layers when you click on them.

There are no options for this tool. Simply click on the object you 
want to select, and its layer is automatically selected for editing. 
If there are multiple objects in the layer, the object that you click 
on is the selected object.

 Vector Shape Selector
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Special Tools
Anime Studio includes a number of special tools that are 
available in specific circumstances. These tools appear in the 
Special section of the tool palette when the conditions are met. 
The sections that follow describe how these special tools are uses.

Anime Studio 8 has a smart tool palette, which 
shows and hides tools based on their need. The 

position of the tool shown in the screenshots may differ, 
depending on the selected layer in the Layers palette, 
and the current time in the timeline. 

Poser
Poser 7 or later must be installed on your system in order 
for this feature to work. In addition, the scene that you 

import into Anime Studio must contain objects that are 
contained within your Poser library folders. Refer to your Poser 
documentation on how to use, add, and maintain content in your 
Poser library folders.

 Poser

After you create your scene in Poser, save it to a folder on your 
hard disk. The file will be saved with a .PZ3 or .PZZ extension, 
depending on whether you use compressed files or not. In Anime 
Studio, choose the File > Import > Poser Scene command, and 
select the scene that you saved from Poser.

Poser scenes that use dynamic hair are very resource 
intensive. If your Poser scene uses dynamic hair or other 
resource-intensive features, be careful not to use extreme 
settings.
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 Andy, Poser’s mannequin, imported into an Anime Studio scene

After the Poser scene has been imported, the Poser tool is 
enabled in the Special section of the tool box. You can click one 
of the body parts to rotate it with the Poser tool, or you can use 
the Poser Parameters dialog (Window > Poser Parameters) to 
rotate or scale the selected body part through the use of sliders. 

 Rotate or scale Poser actors with dials in the Poser Parameters 
dialog

The parameters for each body part can be animated. For 
example, you can pose the figure on one frame in your timeline, 
and then move to a frame that appears later in the timeline and 
reposition the body part. Anime Studio will then animate the 
in-between frames by interpolating the motion between the 
keyframes that you set.
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Switch Layer
This is a specialized tool for use with Switch layers only. 
This tool has no effect if you click and drag in the 

workspace. What it does is supply a popup menu in the tool 
options area that lists all the sub-layers of a switch group. You 
can change the active layer by selecting it from the menu.

 Switch Layer

Tool Options

 Switch Layer Options

•	 Active Child: Use this menu to select the active layer for the 
switch function

Particle Layer
This is a specialized tool for use with Particle layers only. 
This tool has no effect if you click and drag in the 

workspace. What it does is supply a checkbox in the tool options 
area that lets you control whether the particle layer is turned on 
or not (emitting particles or not).

 Particle Layer

Options that appear in the Particle Options dialog are discussed 
in detail in “Particle Layers” on page 274.

 Particle Layer Options
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 Particle Options

Image Masking
Many Anime Studio users do not use Photoshop or other similar 
programs, making it difficult to create images with transparent 
backgrounds. The Image Masking tool assists with this task. 

This tool helps you clear out and remove background areas from 
images that you import into Anime Studio. 

 Image Masking tool

Tool Options

 Image Masking tool

•	 Clear Mask: Click the Clear Mask button to remove all areas 
from the mask and restore the image to its unmasked state.
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 Import an image into your Anime Studio scene

After you import an image, select the Image Masking tool from 
the Layers section of the tool box. Click on an area that you want 
to remove from the background. Click and drag left or right to 
control the sensitivity of the tool. Drag toward the left to decrease 
the sensitivity, and toward the right to increase it. Release the 
mouse button when you have masked out the desired area.

 Click with the Image Masking tool to mask out areas of the image 
that you want to hide

Video Tracking
To use the video tracking feature, you need to have a movie file 
in your project. Either import a movie into an existing project or 
open a movie file from scratch. The following sections describe 
the process of how the video tracking feature works
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Adding Tracking Points

Assume that you have imported a video, and you want to 
eventually add an object that will follow the position and rotation 
of a person’s thumb and wrist. The first step of the process is 
to add tracking points that identify the two points you want to 
follow. The Primary tracking point controls the position of the 
object’s origin. The Secondary tracking point controls the angle 
or scale of the object. To add the tracking points, select the Video 
Tracking tool from the Layer panel.

 Video Tracking tool

Click on the first point you want to track. You can click, and then 
drag to position the point exactly where you want to place it. It is 
optional, but recommended, that you name the tracked point in 
the Tracker Name field of the status bar. For example, since we 
are tracking a thumb here, we name the tracking point Thumb.

 The first tracking point is added to the thumb

Now we add the second tracking point for the wrist, and name it 
(appropriately) Wrist.
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 The second tracking point is added to the wrist

After you place your tracking points, make sure the Video 
Tracking Tool is still selected. Play the video back and watch the 
tracking points follow the points you selected. Playback runs a 
little slower during video tracking. 

As you play the video back, you’ll notice keyframes being added 
to the timeline. While the video is playing, watch for any problem 
spots in the way that the tracking points follow the items you 

want to track. When you see a problem, don’t worry ... there are 
ways to fix them!

 After the tracking points are added, keyframes are generated in the 
timeline

Fine-tuning Marker Positions

You might notice some places where the tracking points seem to 
drift away from the marker, or stop following it entirely. If this 
happens, stop the video playback. Go back to the beginning of 
the movie. Zoom in more closely to the video and use the Video 
Tracking tool to reposition the markers that need to be adjusted. 

Choose View > Reset to reset the zoom level of the video back 
to the default. Play the video again and watch for any other 
problems. Keep making adjustments until you are happy with the 
results. The following movie shows our markers after they have 
been adjusted.
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 Markers after they are adjusted (SWF file)

Re-syncing Tracking Points 

You may also find instances where the tracking points go out 
of sync with the tracked object. The most likely cause for this is 
when the tracked area touches or passes over another area in the 
video that is very close in color. For example, when the tip of the 
thumb goes in front of the paper on the wall, there are similar 

colors in the paper that cause the tracking point to go out of sync 
with the thumb. Fortunately, there is a way to fix that. The next 
movie shows one of those problem areas.

 The tracking point loses focus after reaching the paper on the wall 
(SWF file)

To fix this type of problem, you scrub through the timeline until 
you find the point where it loses track. In the next figure you see 
the spot where the thumb appears to blend in with the paper. 
This is the area that causes the tracking point to lose sync with 
the thumb.





Anime Studio Pro 8
Users Manual

298

Special Tools

 Find the point where the point loses focus

After you find the problem frame, advance ahead a couple of 
frames until you reach a point where there is more contrast. Then 
drag the tracking point to position it where it should be. When 
you press Play, the tracking point will continue tracking from 
there.

 Advance the video to a clear spot and adjust the tracking point

Sometimes color similarities occur for a period that is longer than 
a couple of frames. For example, in our video there is a segment 
where the thumb passes across the face. This is a much larger 
area where there is very little color contrast between the tracked 
object and the area it passes over.

The solution here is slightly different. You can use interpolation 
to calculate the path between two good points. First, move back 
to find the last good point before the thumb crosses the face. 
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Delete the keyframes from that point until the thumb passes 
across the face and reaches the other side.

Here we move to the point just before the thumb passes over the face 
...

... and we delete the keyframes that occur until the thumb reaches 
the other side of the face

Jump ahead in the video to a point after the thumb passes over 
the face and reposition the tracking point. When you play the 
video back, Anime Studio will interpolate the motion between 
the keyframes that are missing.



Anime Studio Pro 8
Users Manual

300

Special Tools

 On the other side of the face, we reposition the tracking point to a 
good spot

Adjusting Tracking Point Sensitivity

When you add tracking points, you can change the sizes of the 
inner and outer rings to adjust the falloff. Click and drag on the 
edge of the rings to change the size. The inner ring defines the 
region that you are trying to track. For example, if you are trying 
to track an eye, adjust the inner ring so that it surrounds the eye.

The outer ring represents how fast the object can move. From 
one frame to the next, the outer ring represents the maximum 
distance that you want the object to move. If you have a fast-
moving object you may need to increase the size of the outer 
circle for tracking. Expanding the search area too much can lead 
to further errors, so you want to keep it as narrow as possible. 
The default settings are generally sufficient for most cases. 
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 Two rings control the sensitivity of the tracking point

Assigning the Tracked Layer 

After you set the two points on the object you want to track, 
you can then assign the layer that will track those points. In our 
example, we returned to Frame 0 and added an exclamation 

point to a new layer. Now we want the exclamation point to 
follow the hand in the video.

To assign the layer that will track the points, choose Animation 
> Track Layer to Video. The Motion Tracking dialog lists the 
videos in your scene (in this case, there is only one). 

 Select the movie to track, then choose the primary and secondary 
tracking points

First we’ll assign the Primary Tracking Point, which is associated 
with the origin point of the tracked layer. We want the origin 
of the exclamation point to track the Wrist point. So, we select 
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Wrist here and choose OK. When we play the result, the origin 
of the exclamation point (represented by the crosshairs) tracks 
the wrist. 

 The crosshairs of the exclamation point, representing the origin, 
now follow the primary tracking point

The secondary tracking point is optional. You can use it to control 
either the angle or scale of the tracked layer. In our case, we want 
the thumb to control the direction of the exclamation point, so 
we select the thumb as the secondary tracking point. Then we 
check the option to control Angle.

 The secondary tracking point can control the angle or scale of 
the tracked layer. We want the thumb to control the angle of the 

exclamation point

The following movie shows the results of our selections. Now 
when you play the movie, the origin of the exclamation point 
follows the wrist, and the angle of the exclamation point is 
follows the angle line from the wrist (primary tracking point) to 
the thumb (secondary tracking point).
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 The exclamation point now follows the wrist, and points in the same 
direction as the thumb (SWF file)

Offsetting the Origin

You can use the Translate tool in the Draw panel to move the 
tracked object away from the origin. The origin still tracks to the 
two tracking points, but the object that you are tracking can be 
offset. 

 You can offset the object from its origin with the Translate tool

Once you have applied video tracking points to another layer, 
the two layers are totally independent. The tracking feature 
creates standard keyframes. You can edit, add or remove 
keyframes to the tracked object. You can also hide or delete the 
video layer that was used to initially create the tracking points 
and keyframes. The layer that was tracked to the video will still 
continue to follow the motion. This allows you to use a video file 
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as a reference whether or not you want to see the video in your 
final project. 
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Camera and Workspace 
Tools

Camera Tools
The following tools let you move a virtual camera around in 
a scene. Although layers in Anime Studio are primarily 2D, 
Anime Studio’s camera can be moved around in true 3D space. 
The camera tools affect all layers in the document, not just the 
currently active layer.

If a tool has the following symbol next to it: , then it can be 
used for animation - using the tool at different frames in the 
timeline will cause the object you adjust to change over time.

Track Camera

This tool moves the camera up and down, and side-to-
side. By giving the project’s layers different depth values, 

you can create parallax (depth) effects (see the tutorials section 
for an example). Holding the Shift key while using the Track 
Camera tool will constrain the camera to only move vertically or 
horizontally. Holding the Alt key will move the camera forward 
and back.

If the Show Path box in the tool options area is checked, then 
the motion path for the camera will be displayed in the working 
area when this tool is active. This makes it easier to visualize and 
plan out the motion of the camera. (The camera’s motion path 
is only visible when the Orbit Workspace tool has been used to 
view the scene from outside the camera.)

Track Camera Tool

Zoom Camera

This tool zooms the camera in and out on the scene, just 
like the zoom control on a real camera. Technically, the 

Zoom Camera tool is changing the field of view angle (or focal 
length) of the virtual camera.

 Zoom Camera Tool
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Roll Camera

This tool rolls the camera side to side. Try tilting your 
head side to side, and you’ll understand this tool 

immediately.

 Roll Camera Tool

Pan/Tilt Camera

This tool changes the viewing angle of the camera. Drag 
the tool up and down to change the tilt angle of the, and 

drag side to side to change the pan angle. Hold the Shift key 
while using this tool to constrain the camera to only one direction 
of rotation.

This tool is most useful when you’ve set up a scene in 3D 
(different layers at different depths), and have placed the camera 
so that it is sitting somewhere among the layers, not viewing 
them from a distance.

 Pan/Tilt Camera Tool

Workspace Tools
Change your view of the workspace 

The last group of tools in the toolbar is always available, 
regardless of the current layer type or the current selected object. 
These are the Workspace tools, and are used to control your view 
of the project, but don’t actually modify the project itself.

Pan Workspace

When the Pan Workspace tool is selected, you can click and drag 
in the working area to move the project side to side and up and 
down. Note that this isn’t the same as moving the objects in your 
project - only your view of them is changing, not where they 
appear in the final image. A shortcut for the Pan Workspace tool 
is to click and drag in the working area using the right mouse 
button - it’s a quick way to pan, regardless of what tool is selected 
in the toolbar.



Anime Studio Pro 8
Users Manual

307

Camera and Workspace Tools

 Pan Workspace Tool

Zoom Workspace

The Zoom Workspace tool is similar to the Pan Workspace tool: 
it moves your view of the project, without modifying the objects 
themselves. With this tool, dragging the mouse left or right 
zooms your view of the project in and out. 

A shortcut for the zoom tool is to click and drag left or right in 
the working area using the right mouse button while holding 
down the shift key - it’s a quick way to zoom, regardless of what 
tool is selected in the toolbar.

 Zoom Workspace Tool

Rotate Workspace

The Rotate Workspace tool is used to temporarily rotate the 
workspace. Think of drawing on paper - sometimes you might 
rotate the physical paper to draw from a different angle. The 
Rotate Workspace tool works in a similar way - sometimes 
(especially with the Freehand drawing tool) it may be helpful to 
orient the workspace in a different direction. A shortcut for the 
Rotate Workspace tool is to click and drag in the working area 
using the right mouse button while holding down the control 
key - it’s a quick way to rotate, regardless of what tool is selected 
in the toolbar.

To get back to the normal view of the scene, you can select Reset 
from the View menu, click the Reset View button in the tool 
options area of the Anime Studio window, or press the Home key 
to reset the view.

 Rotate Workspace Tool
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Orbit Workspace

The Orbit Workspace tool allows you to view your scene from 
outside the camera. It’s like holding the scene in your handing 
and turning it around to look at it from different angles. This 
tool is mainly useful when you’re working on a scene with 3D 
elements (layers with different depths, complex camera moves, 
etc.). Hold the Alt key while using this tool to move your view 
forward and back.

 Orbit Workspace Tool

After using this tool to change your view of the scene, a blue 
wedge will be visible in the scene, representing the location of 
the camera. To get back to the normal view of the scene, you can 
select Reset from the View menu, click the Reset View button in 
the tool options area of the Anime Studio window, or press the 
Home key to reset the view.
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Anime Studio 
Windows
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Anime Studio’s Main 
Window

Overview
The Anime Studio interface has various windows that are used 
for controlling different aspects of a Anime Studio project. In 
this chapter we’ll briefly describe some general components of 
the Anime Studio project window. The more complex parts of 
the Anime Studio interface, such as the Layers window, have 
their own chapters that follow this one. Although this chapter 
will describe how the main window works, it won’t go into detail 
about creating a drawing or animation. For that, please refer to 
one of the chapters in the section entitled Using Anime Studio.

 Anime Studio Pro 8 interface

Working Area
Most of the Anime Studio project window is taken up by the 
working area. This is the region where you will create and view 
your drawings and animations. In every project, even an empty 
one, two items will be displayed in this area. The first is a cross 
marking the center of the currently active layer. The second is 
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a blue rectangle that indicates the visible region of the project. 
Only objects that are within this rectangle will appear in your 
final animation.

 Working Area

Although every project has a fixed image size (for example 
640x480 pixels), the working area is basically an endless flat 
space on which you can draw and animate. The blue visibility 
rectangle mentioned above indicates the actual image area for 
the project. While working, you may want to zoom in or out to 
see more or less detail in your project. A quick way to do this is 
by using your right mouse button. By dragging the right mouse 
button in the working area, you can move around from side to 
side. If you hold down the shift key while right-clicking and then 

drag left or right, you can zoom in and out. If you want to restore 
a reasonable overall view in the working area, press the Escape 
or Home keys, or choose Reset from the View menu (see “View 
Menu” on page 470).

The background of the working area is usually just a blank color, 
but if you drag an image file into the working area, it will appear 
in the visibility rectangle. This is a helpful feature meant to allow 
you to trace the image with the drawing tools.

The real work that happens in the working area is not covered 
here, but is described in the sections “Anime Studio Tools” on 
page 206, and“Anime Studio Windows” on page 309..

Toolbar
The toolbar to the left of the main Anime Studio window is where 
you select which tool you want to work with. The available tools 
will change depending on whether you’re currently animating, 
which objects are selected, and what type of layer is currently 
active. The purpose and use of each tool is described in the 
following chapters:

•	 Draw Tools: See “The Draw Tools” on page 207

•	 Fill Tools: See “Fill Tools” on page 231

•	 Bone Tools: See “Bone Tools” on page 252
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•	 Layer Tools: See “Layer Tools” on page 281

•	 Camera Tools: See “Camera and Workspace Tools” on 
page 305

•	 Workspace Tools: See “Camera and Workspace Tools” on 
page 305

 Anime Studio Pro Tools (some tools not shown)

Status Bar
The status bar along the top of the Anime Studio window displays 
a short description of the currently active tool in the toolbar. If 
you don’t know what a tool does, the best thing is to read this 
manual. However, if you just need a quick reminder, the status 
bar can be helpful.

 Status Bar

Playback Buttons
Near the bottom-left of the main Anime Studio window are a set 
of playback buttons that allow you to play/stop/rewind/etc. your 
animation.
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 Playback controls

Display Quality
Near the bottom-right of the main Anime Studio window is a 
popup box that lets you customize the level of display quality in 
the editing area. The Display Quality popup lets you control the 
following options. 

 Display Quality options

Note that this only applies to the editing view - when rendering 
your final project, everything will be drawn in full quality, 
regardless of the following settings.

•	 Fast buffer: Turns on a faster method of drawing. However, 
color reproduction in this mode is not totally accurate.

•	 Paths: Display points and curves for vector layers.
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•	 Fills: Display the fill colors of vector shapes.

•	 Strokes: Display the outlines of vector shapes.

•	 Shape Effects: 

•	 Images: Display images in image layers.

•	 Smooth images: Display images with higher quality alpha 
blending.

•	 Masking: Display masking effects.

•	 Transparency: Display shape transparency.

•	 Brushes: Display brush effects applied to shape outlines.

•	 Antialiasing: Draw shapes with smooth edges.

A little way to the left of the Display Quality popup is another 
popup box labeled Current Layer. This popup contains similar 
options to those found in Display Quality. The options in Current 
Layer apply only to the current layer, while Display Quality’s 
options apply to the entire project. So, for example, if you wanted 
to display fill shapes for all layers except one, you would leave 
Fills turned on in the Display Quality popup, but turn it off in the 
Current Layer popup for the layer in question.

Layers Window
An Anime Studio document is composed of layers, each of 
which can be independently edited and animated. Layers can 
be thought of as transparent sheets of plastic. You can draw 
separately on each of these sheets, and the final picture is the 
composition of all the sheets stacked on top of one another.

Layers can be added, removed, copied, and re-ordered. The 
Layers window is where all these operations take place in Anime 
Studio, and is the topic of this section.

Overview
The Layers window has two sections of interest. As seen below, 
these consist of the toolbar and the layer list.
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 The Layers window

The Layer List
Most of the Layers window is taken up with the layer list. This 
is a vertical scrolling list of all the layers in the document. The 
layers are stacked in order from bottom to top. That is, when 
the project is displayed, the lowest layer in the list is drawn first, 
followed by the second from the bottom, and so on up to the 

top. When two layers contain objects that overlap, this ordering 
determines which object is in front and which is behind.

Each layer is represented in the list with an entry that looks 
something like this:

 A single layer in Anime Studio

Only one layer can be edited at a time in the Anime Studio 
working area. The layer currently selected for editing (the active 
layer) is displayed in a highlighted color. To select a different 
active layer, just click on its entry in the layer list. A layer’s entry 
provides you with three pieces of information: what type of layer 
it is, its name, and whether the layer is visible.
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At the left side of a layer’s entry in the list is a visibility control, 
which controls whether a layer is visible or not. If a pair of eyes 
is visible in this box, any objects drawn in the layer will appear 
in the main Anime Studio window, as well as in any rendering 
of the project. If you click this box, the layer will turn invisible 
and will not appear in the main Anime Studio window. This can 
be a convenient way to remove clutter in the main window when 
you don’t need to see all the layers at once. Also, only visible 
layers will appear when you render a view of the project or export 
an animation - you can generate test movies much quicker if 
you turn some layers invisible that don’t involve what you’re 
currently working on. Note: the visibility box of the currently 
active layer behaves differently. The currently active layer is 
always visible (how could you edit it if it wasn’t?), and clicking 
its visibility box (while holding the Alt key) will turn all the other 
layers at the same level visible or invisible.

To the right of the visibility control is an icon that indicates what 
type of layer each entry in the layer list is. The different types of 
layers include vector, image, group, bone, switch, particle, 3D, 
and note layers.

Certain types of layers act as groups, and can contain other layers 
within them. (You can think of them like folders on your hard 
drive.) These layers have a triangle on their left side. Clicking 
this triangle opens and closes these group layers, allowing you to 
access or hide the sub-layers they contain.

Layers can be re-ordered simply by dragging one layer above or 
below another layer. Just click and drag the layer you want to 
move - you will see a red insertion bar indicate where the layer 
will be placed when you drop it. When the insertion bar appears 
at the location you choose, just drop the layer and you’re done. 
You can also use this method to drag sub-layers into or out of 
group layers. Layers can be re-ordered at any time, although their 
order is not dynamic over time. That is, the layer ordering cannot 
change in the middle of an animation, for example to make one 
object appear to move in front of another object.

The last thing you can control in the layer list is the property 
set of any layer. By double-clicking a layer in the list, a dialog 
will appear with various options controlling the appearance 
and behavior of the layer. This dialog is described in the Layer 
Settings section below.

Layer Toolbar
At the top of the Layer panel is a toolbar that provides several 
layer operations. The buttons in the toolbar are described below:
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 Layer Toolbar

•	 New Layer: Adds a new, empty layer to the project. A popup 
menu allows you to choose the type of layer you want to add. 
The new layer is placed directly above the current active 
layer.

•	 Duplicate Layer: Makes a copy of the current active layer 
and adds it to the project. This new copy is placed directly 
above the current active layer. If you duplicate a group layer, 
all of the sub-layers inside it will be duplicated also.

•	 Delete Layer: Deletes the current active layer. This 
operation cannot be undone, so you will be asked to verify if 
this is really what you want to do.

•	 Layer Settings: This command brings up a dialog with 
various controls to modify the layer’s appearance and 

behavior. The next section, Layer Settings, goes into detail 
about these options. The Layer Settings dialog can also be 
invoked by double-clicking the current active layer in the 
layer list.
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Layer Settings
The Layer Settings dialog can be invoked either by double-
clicking a layer in the layer list, or by selecting a layer, then 
clicking the Layer Settings button in the layer toolbar. The 
various controls are grouped into tabs that we’ll describe in 
order.

General Tab
This tab is available for all layer types, and controls general layer 
properties.

 General Layer Settings

•	 Name: This field allows you to change the name of the layer. 
You can type in any name for the layer you want here, and 
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the name will appear in the layer list after you click the OK 
button. Good names make working with large projects much 
easier. Examples of layer names might be Background, 
Body, or Head.

•	 Hide in editing view: Turn on this checkbox to hide the 
layer while editing. The layer will still appear in rendered 
output, but will be invisible in Anime Studio’s edit view. This 
can be useful to reduce clutter and improve performance. 
Things you might consider hiding in the editing view are 
background details, texture and detail layers, or special 
effects like particle layers. Note that if a hidden layer is the 
currently active layer, it will temporarily un-hide itself so 
that you can edit whatever it contains.

•	 Don’t render this layer: If this box is turned on, then the 
layer will not appear in any rendered/exported movies. 
This option is usually used for some kind of helper layer. 
For example, you might draw a layer with some guide lines 
to help you draw and animate a scene, but you don’t want 
those guides to appear in the final output. Note layers have 
this option turned on by default.

•	 Allow animated layer effects: When checked allows you 
to animate layer effects by varying settings through the 
timeline. When unchecked, layer effects do not animate.

Compositing Effects

This group of controls allow you to change certain layer 
properties over time. When you modify any of these at a frame 
greater than 0, you will add a keyframe to the corresponding 
layer effects channel. For example, if you go to frame 1 and 
uncheck Visible, then go to frame 20 and re-check Visible, that 
layer will not appear in the final animation until frame 20.

•	 Visible: Controls whether a layer is visible in the final 
output. It is important to note that this checkbox is totally 
independent of the visibility box displayed in the layer list: 
these are two separate notions of visibility, and don’t 
affect each other at all. The visibility control in the layer 
list is meant for your editing convenience: you can turn one 
layer off while you work on another. The visibility checkbox 
in this dialog is meant to allow certain effects during an 
animation. For example, if you had a layer with a drawing of 
a glowing lightbulb, you could uncheck the visibility of this 
layer at frame 1, then turn it on at frame 10, off at frame 20, 
on at frame 30, etc. to create the effect of a blinking light.

•	 Blur radius: Lets you apply a blur (in pixels) to an entire 
layer to simulate such effects as camera focus. The blur can 
be animated over time to make a layer look like its coming in 
and out of focus.
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•	 Opacity: Allows you to modify the transparency of an entire 
layer. An opacity value of 100 will not affect the layer at 
all, while a value of 0 will make it totally transparent. By 
changing the value from 0 at frame 1 to 100 at frame 10, the 
layer will seem to gradually appear out of nowhere, which in 
some cases is more desirable than the type of on/off visibility 
provided by the Visible checkbox.

•	 Auto shading radius: Allows you to simulate 2D ambient 
occlusion effects. Double-click the desired layer, or highlight 
a layer in the layers panel. Turn the Auto Shading option on 
and set the radius to a value other than zero. A good starting 
point is somewhere between 8 and 16 pixels. 

 Without Auto Shading
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 With Auto Shading

•	 Flip horizontally and Flip vertically: Clicking these boxes 
flips the entire layer in the direction specified. (If the layer 
is a group layer, then the sub-layers inside it get flipped as 
well.) This can be convenient in the case where you want to 
duplicate a layer and have the second copy face the first one 
as a mirror image.

Outline

Prior to Anime Studio 8, you needed to use the Shadow 
parameters on the layer to get an outline effect. You can now add 
an outline to a layer by enabling the option in this section and 
specifying the width and color of the outline. 

You can set separate colors and widths for each layer to add nice 
effects to your drawings. If you set just one color and width on 
a bone group, but not on each layer of a bone group, the layer 
outline will only be applied to the outline of the character (and 
not each individual part).

After you specify your outline parameters, you will need to 
preview your drawing with the File > Preview command, or use 
the shortcut Cmd+R (Mac) or Ctrl+R (Windows).

•	 Outline on: Check this option to create an outline around 
the objects on the layer.

•	 Width: Set the desired width of the outline, in pixels.

•	 Color: Click to set the color of the outline.
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 With 10 pixel blue outline around the bone group

Options

•	 Rotate to follow path: When this checkbox is turned on, 
the layer will automatically rotate to follow its direction of 
movement. (Specifically, the up direction will turn to follow 
the direction of layer translation.) This can be useful for 

creating things like flowing arrows that need to point in their 
direction of movement.

•	 Rotate to face camera: When this checkbox is turned on, 
the layer will automatically rotate around its vertical axis 
so that it always faces the camera. This can be useful when 
using Anime Studio’s 3D camera - especially for scenery-type 
objects. Trees, for example, that always face the camera can 
save you a lot of work.

•	 Use HSV modifier image: This checkbox lets you use an 
image file to distort the colors of the layer. Sometimes you 
may want to do this to break up the solid colors in your 
project and make it look less computerized. The exact 
behavior of this feature is difficult to explain. The best way to 
try it out is to use one of the HSV modifier images included 
with Anime Studio. These images should be pretty close to 
50% gray. Other images may produce bizarre, unexpected 
results. Feel free to experiment - you can always turn off this 
checkbox if you don’t like the results.

•	 Embedded Script File: Allows you to attach a lua script to 
a layer. When you play it back in the timeline or render a 
document, the script is executed to go with that layer.

•	 Scale compensation: When this box is checked (as it is 
by default), and you scale an entire layer larger or smaller, 
the lines in the final rendered output will automatically get 
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thicker or thinner so that they retain their relative weight in 
the overall image. Also, layer effects like blurs and shadows 
will become larger or smaller to match the scale of the layer.

•	 Immune to camera movements: Sometimes you may 
want to make some layers ignore camera movements. For 
example, certain backgrounds or title or logo layers you may 
want to stay in one place on the screen even while you move 
the camera around.

•	 Immune to depth of field: The depth of field function (in 
the Project Settings dialog) lets you simulate the blurring 
of objects with different distances from the camera. This 
option allows you to turn off this effect for any particular 
layer.

•	 Layer blending mode: Normally, layers are composited on 
top of each other simply according to the transparency of 
each layer. The layer blending mode popup lets you select 
a different blending mode for each layer. This can be very 
useful for simulating shading and lighting effects.

Shadows Tab
The controls in this tab allow you to apply automatic shadows 
and shading to an entire layer.

 Shadows Layer Settings

Layer Shadow

This section lets you apply a drop-shadow effect to a layer. 
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•	 Shadow On: Checking the Shadow on checkbox will 
make all objects in the layer cast shadows on the layers 
underneath.

•	 Offset: Controls how far the shadow appears from the actual 
objects. A larger offset makes objects appear higher up above 
the layers below them. 

•	 Blur: Determines how hard or soft the edges of the shadow 
appear.

•	 Expansion: Allows you to expand the reach of the shadow. 
This can be useful for halo-type effects. Try an Offset of 0, 
Blur of 8, and Expansion of 8.

•	 Shadow Color: Clicking on the “Shadow color” swatch lets 
you change the color of the shadow that is being cast. You 
can also modify the transparency of the shadow with this 
control.

•	 Shadow Direction: Controls the direction the shadow is 
cast. Just drag the knob in circles to change the direction of 
the shadow.

Layer Shading

This section is similar to the “Layer Shadow” section above. 
However, instead of producing a shadow effect behind the layer, 
these controls let you apply a shading effect on top of the layer. 

•	 Shading On: Checking the “Shading on” checkbox will make 
all objects in the layer appear shaded, giving them a rounded 
edges effect.

•	 Offset: Controls how far inside the layer the shading 
appears. A larger offset makes objects appear to have more 
“rounded” edges. 

•	 Blur: Determines how hard or soft the edges of the shading 
appear. 

•	 Contraction: Allows you to pull the shading further into the 
center of the layer.

•	 Shading Color: Clicking on the “Shading color” swatch 
lets you change the color of the shading that is applied. You 
can also modify the transparency of the shading with this 
control.

•	 Shading Direction: Controls the direction the shading 
appears. Just drag the knob in circles to change the direction 
of the shading.



Anime Studio Pro 8
Users Manual

325

Layer Settings

3D Shadow

Anime Studio allows you to easily create perspective shadows for 
the objects in your scene. Select a layer from the Layers window 
and open the Layer Settings dialog. Click the Shadows tab, and 
adjust the settings in the 3D shadow area. You can animate this 
feature by applying different settings at different points in the 
timeline. You will not see the shadow until after you render the 
current frame, or all or part of a movie. 

The position of the shadow is determined by the Set Origin tool 
in the Layer section of the toolbox. When you set a perspective 
shadow, pay attention to the location of the origin of the object. 
The shadow is cast from the origin point. The origin represents 
the ground point, so you can position it to make the object look 
as though it is resting on the ground, or as if the object is floating 
in the air.

 Position the origin point at “ground” level.

The settings for perspective shadows are as follows:

•	 Perspective Shadow On: Check this button to turn 
Perspective Shadows on. Uncheck it to turn Perspective 
Shadows off.

•	 Blur: Sets the amount of blur on the perspective shadow. 
Higher values create a softer shadow.

•	 Scale: Controls the “depth” of the shadow. Higher values 
make the shadow seem more elongated, while lower values 
make the shadow shorter
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•	 Shear: Allows you to control the slant of the shadow (the 
direction that the light source is coming from).

•	 Color: Allows you to select a color for the shadow. Default 
color is black.

Motion Blur Tab
The controls in this tab control the motion blur effect for this 
layer. Motion blur can be turned on and off during the course of 
an animation. 

 Motion Blur Layer Settings
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•	 Motion Blur On: Checking “Motion blur on” turns on the 
effect. The default settings work pretty well for a basic 
motion blur effect.

•	 Frame Count: Controls how many copies of the layer 
should trail behind itself. The higher this number, the longer 
it will take to render your animation. Sometimes a high 
number may be used for an exaggerated anime or cartoon 
effect.

•	 Frame Skip: Controls the separation between blur frames. 
A larger number will cause the blur effect to trail farther out 
behind the current position.

•	 Start Opacity and End Opacity: Control how the blur 
fades away behind the layer. Generally, a motion blur effect 
will fade a bit as it trails behind the layer. For some special 
effects, however, you may not want the motion blur to fade 
at all. In those cases, set both values to 100 to keep the 
motion blur completely opaque.

•	 Blur Radius: Controls the radius (in pixels) of the motion 
blur effect.

Masking Tab
This tab is used to control layer masking. Layer masking controls 
the visible region of a layer - objects in a layer that are not within 
the visible region of the mask will not appear in the final output.
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 Masking Layer Settings

If the layer is a group or bone layer, then the following options 
are available: 

•	 No masking in this group: Means that no masking will 
occur in this group.

•	 Mask on - reveal all: Means that masking is on, and by 
default all sub-layers will be fully visible. 

•	 Mask on - hide all: Means that masking is on, and by 
default all sub-layers will be invisible (this is the most 
common option when using layer masking).

All other layers inside a group will have the following options for 
layer masking:

•	 Mask this layer: Clip this layer against the current mask.

•	 Don’t mask this layer: Skip all masking operations for this 
layer.

•	 + Add to mask: Add this layer to the mask. Any higher 
layers will be visible wherever this layer is visible.

•	 + Add to mask, but keep invisible: Add this layer to the 
mask, but don’t show it in the final output.

•	 - Subtract from mask: Use this layer to cut a hole in the 
current mask.

•	 + Clear the mask, then add this layer to it: This makes the 
mask identical to the transparency value of the current layer.
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•	 + Clear the mask, then add this layer invisibly to it: 

•	 Exclude Strokes: Check this option to exclude outlines 
from the mask.

The masking controls are simple but powerful options that can 
be used for all kinds of creative tricks. The best way to explain 
these is with a hands-on example that you can try out in the 
Tutorials section.

Vectors Tab
This tab is only available for vector layers, and controls the 
appearance of lines and fills in the layer. The controls here 
enable the vector “noise effect”. By adding “noise” to a layer, you 
can make it look more hand-drawn, or at least get rid of some 
of that pesky computer precision. Of course, that’s up to artistic 
interpretation: if you like computer precision, the noise effect 
may not be the feature for you.

 Vectors Layer Settings

•	 Noisy Outlines and Noisy Fills: The first two checkboxes 
turn on noise for outlines and/or fills. If you turn on both 
of these, all the shapes in the layer will become distorted. 
However, if you check only one, the effect will look like 
someone was coloring but didn’t stay in the lines. The circle 
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displayed on the right side shows a preview of what your 
noise effect settings will do to the final drawing. (The best 
way to understand this feature is to just start clicking the 
checkboxes and watch the circle.)

•	 Animated noise: Controls whether the noise factor will vary 
over time in your animation. This can lead to either a very 
distracting look, or a very sketchy, free-form one, depending 
on your tastes. Again, experiment with this and watch the 
circle.

•	 Extra Sketchy: (Associated with noise settings). Creates 
gaps in the outlines. If you have a curve being drawing you 
might actually have little gaps in it. 

•	 Offset: Determines how far in pixels (on average) your 
drawing will be distorted from its original shape. 

•	 Scale: Determines the “jaggedness” of the distortion. Larger 
scale numbers will result in smoother, lumpier distortion, 
while smaller numbers will give you a more scribbled look. 

•	 Line Count: Tells Anime Studio to draw a number of lines, 
distorting each in a different way.

Depth Sort Tab
This tab is only available for group and bone layers. Depth 
Sort has two controls that can be used with Anime Studio’s 3D 
features. 
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 Depth Sort Layer Settings

•	 Sort Layers by Depth: Allows sub-layers to move in front 
of and behind each other during an animation. Normally, 

layers are drawn in the order they appear in the Layers 
window. However, with this option turned on, layers are 
displayed according to how far they are from the camera. 
See the Tutorials section for an example of using this 
feature. Typically, layers are sorted by their depth from 
the camera, but if you’re trying to create a 3D object using 
multiple Anime Studio layers (like a cube or pyramid), you 
may want to turn on 

•	 Sort by True Distance: Tells Anime Studio to sort layers by 
the distance from the camera to the layers’ origins, rather 
than by depth. Usually this option will be left unchecked.

Image Tab
This tab is only available for image layers. There are five options 
in this tab. 
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 Image Layer Settings

•	 Source Image: Lets you select the image to be used in the 
image layer. Use this if you want to change the image, or if it 
got lost for some reason. 

•	 AVI movie has alpha: Turn this on if the image layer is 
using an AVI movie, and that movie includes an alpha 
channel. 

•	 Loop movie indefinitely: When checked, the movie plays 
in a loop for as long as required in the animation. When 
unchecked, the movie plays once and stops when it reaches 
its end.

•	 Movie FPS: Sets the speed of the movie in Frames per 
Second

•	 Warp using bones: If this box is checked and the image 
layer is placed inside a bone layer, the bones can be used to 
warp the image as if it were printed on a rubber sheet.

•	 Nearest neighbor sampling: When this option is not 
checked, Anime Studio will try to smooth out the areas in 
between pixels when you enlarge the image. If you want the 
images to look blocky when they are resized, turn this option 
on. Anime Studio will not smooth the image and it will start 
to look blocky when it is enlarged. 

Toon Settings

The Toon Effect filter is used with images and movies. Load an 
image or movie into a new layer. Open the Layer Settings dialog 
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to the Image tab and check the Toon Effect option. The image or 
movie will be processed through the Toon Effect filter.

 Toon effects on a photograph

When used with videos, the processing can take quite a while. 
When working with videos, open up the movie file and apply the 
toon effect filter. Immediately afterward, import the animation 
as a new movie file. Use the new movie file, with the toon effect 
applied, in your final project.

Some types of images work better than others. Faces should be 
pretty large in the image. If the face is small then a lot of detail 
will be lost or blurred together. 

The Toon Effect filter has several parameters in the Image tab:

 Toon settings in the Layer Settings Image tab

•	 Edge level: Controls the width of the edges in the toon 
effect. Increase the setting to make the edges wider, and 
decrease to make the edges thinner.
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•	 Gray level: Darkens the middle areas of the toon effect.

•	 Black level: Darkens the dark areas of the toon effect.

•	 Saturation: Increases or decreases the amount of color. 
Negative values make the toon more black and white.

•	 Lightness: Increase the setting to make the image appear 
more faded.

•	 Quantization: Sets the number of colors in the image. When 
set at 0, the quantization works the same as found in Anime 
Studio 7 and earlier. When set to a value greater than 1, the 
value you enter is the number of colors in the image.

Switch Tab
This tab is only available for switch layers.

 Switch Layer Settings

•	 Select Audio Sync Source: Lets you select a data file used 
to control the switch layer. A data file is not required (you 
can control a Switch layer manually by right-clicking its 
entry in the Layers window), but if you do want to use a data 
file you have two choices:
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If you want a quicker lip-sync solution, you can 
use an audio file as a data file. In this case, your 

switch file should contain several version of a mouth 
shape, ranging from closed to wide open. The volume of 
the audio file will control which mouth shape is used at 
which frame. If you do use an audio file to control the 
Switch layer, you can either use automatic volume gain 
(recommended) or set the gain manually. The gain 
controls how wide the mouth gets. When using manual 
gain, start with a value of 1 - if the mouth seems too 
wide, try smaller values (0.75 or 0.5). If the mouth isn’t 
wide enough, try higher gain values (1.5 or 2). See the 
Tutorials section for an example of using this function.

•	 Interpolate sub-layers: If this box is checked Anime Studio 
will do smooth transitions between the sub-layers as long 
as they’re all vector layers and contain the same number of 
points.

Particles Tab
This tab is only available for particle layers. The description 
for how these controls affect a particle layer can be found in 
“Particle Layers” on page 274.

 Particles Layer Settings

3D Options
This tab is only available for 3D layers. 
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 3D Options Layer Settings

•	 Default color and Edge color: Allows you to adjust the 
color of the 3D model. If you imported a 3D model that 
includes colors and textures, then those will be used instead. 

The default color is only used when no color is defined by the 
model itself.

•	 Polygon orientation: Allows you to adjust whether the 
polygons in your model are oriented clockwise or counter-
clockwise. After importing a model, if it looks turned 
inside-out or otherwise distorted, try switching the polygon 
orientation.

•	 Edge offset: Lets you fine-tune how much offset is used to 
draw the anime or cartoon edges around your 3D model. A 
value of zero corresponds to no cartoon edge at all.

•	 Warp using bones: If this box is checked and the 3D layer 
is placed inside a bone layer, the bones can be used to warp 
the 3D model. Be aware that although the model is three-
dimensional, bone layers are only two-dimensional, so you 
will be limited in the ways you can control the 3D object 
using bones.

•	 Reset Z buffer: Anime Studio uses a z buffer rendering 
algorithm and the result is that all 3D objects in the scene 
interact in a visually consistent way. Objects that are closer 
appear in front of those further away, regardless of the layer 
order. However, if you turn this checkbox on for layer X (a 
3D layer), then when layer X gets rendered it first resets 
the z buffer. This is a way to force a 3D layer to appear in 
front of other 3D layers that it might actually be behind. In 
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other words, sometimes you may want multiple 3D layers 
to interact in the Z dimension (hide behind each other, or 
even interpenetrate so that some parts of one object are in 
front of another and some parts behind). This is the normal 
behavior. Turning on the Reset Z Buffer option forces 3D 
objects to act like regular 2D layers and just be in front of or 
behind each other according to the layer order in the Layers 
palette.

Note Tab
This tab is only available for note layers, and lets you change the 
text label in the note.

 Notes Layer Settings
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Physics Tab
The settings in the Physics tab are as follows:

�� Enable physics: Check this option to turn the physics 
simulator on.

�� Gravity direction: Use the directional slider to point 
to the direction from which gravity is originated. By 
default, the direction is straight down (270 degrees). 
0/360 degrees is at the 3:00 position of the dial.

�� Gravity magnitude: Controls the strength of the 
gravity. Lower values make the gravity less forceful 
(objects are lighter) and higher values make the gravity 
more forceful (objects are heavier).

For more information on how to use physics in your Anime 
Studio projects, see “Basic Physics” on page 161.

 Physics Settings
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Style Window
The Style window is where you set up colors, line widths, fill 
effects, and other properties to control the appearance of your 
vector artwork. The Style window has a lot of controls, but it’s 
not too hard to understand if you break them down into sections:

The Style window has two views. With the Advanced option 
unchecked, the following options appear:

 Style window

Fill
These controls allow you to set the appearance of a shape’s 
fill region. First, be sure that “Enable fill” is turned on or off, 
depending whether you want that shape to be filled or not. Click 
the fill color rectangle to pick a new color for the fill. A color 
picker dialog will appear. In addition to the actual color of the 
fill, you can choose the level of transparency in the color picker 
dialog.

 Anime Studio’s color picker
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If a style has been applied to this shape, the style’s color will be 
used instead of the shape’s color. Turn on the checkbox to the left 
of the color swatch to override the style’s color.

Below the fill color are two popup menus that allow you to choose 
one or two fill effects to be applied. These effects include such 
things as color gradients, spots, and shading effects. Just pick 
an effect from the menu to apply it to the fill. If you choose two 
effects, they will be applied in order, one on top of the other. For 
example, you could choose “Gradient” for the first effect and 
“Spots” for the second effect. The result would be a color gradient 
for the background of the fill, with spots drawn on top of it.

To the right of the fill effects are buttons that allow you to control 
the specifics of the fill effect. If a fill effect has been chosen from 
the popup menu, these buttons will bring up dialogs that are 
described in the following sections. Some fill and line effects can 
be animated, with keyframes being added to the timeline when 
you change colors, blur radius, angles, offsets, blurs, and more.

Shaded Fill Effects

When you choose Shaded Fill effects, a dialog displays the 
following options:

•	 Light Angle: Provides a dial that allows you to change the 
direction that the light is coming from. You can also enter 

a numerical value. Zero degrees is located at the bottom of 
the dial.

•	 Offset: Allows you to assign a value for how far the shadow 
is offset from the filled area

•	 Blur: Controls the softness of the shadow.

•	 Shadow Color: Allows you to choose the shadow color from 
a color palette.

•	 Shadow Only: Check this option to only display the shadow, 
without the object that is used to generate the shadow.
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 Shaded Effect Options

Soft Edge Fill Effects

When you choose Soft Edge Fill effects, a dialog displays the 
following options:

•	 Blur Radius: Allows you to increase or decrease the 
softness, or blur, around the edge of the fill.

 Soft Edge Effect Options

Halo Fill Effects

When you choose Halo Fill effects, a dialog displays the following 
options:

•	 Onset Radius: Adjusts the radius of the inner area

•	 Blur Radius: Adjusts the softness around the halo

•	 Halo Color: Click the Color chip to select a color for the 
halo.
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•	 Halo Only: Check this option to only add the halo effect to 
the layer.

 Halo Effect Options

Gradient Fill Effects

Gradient fill effects can be animated and can also respond to 
bone warping. You can animate the location and color of all of 
the color markers in the gradient. All changes in color will show 
up in the timeline when added.

This is the dialog used to control the gradient effect. The 
following options appear: 

•	 Type: Allows you to choose one of four types of gradient 
effects:: Linear, Radial, Reflected, or Angle. The preview 
shows an example of each type.

•	 Allow transparency: Check this option if you want the 
gradient to appear partially or completely transparent in 
some areas. 

Below that are two controls for the colors at each end of the 
gradient. Finally, a preview area: after modifying the other 
controls, this region will display a small preview of the effect. You 
can also add additional colors to the gradient. Select an existing 
color marker, and press the Alt key while you drag a copy of it to 
a new location on the gradient bar. Then click the color chip to 
choose a new color for the marker. 

 Gradient Effect Options
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Image Texture Fill Effects

When you choose Image Texture Fill effects, a dialog displays the 
following options:

•	 Select Texture: Click this button to choose an image file to 
be used as a texture fill.

•	 Tile: Choose this option if you want the image to repeat 
more than once to fill the selected area

•	 Don’t Repeat: Choose this option if you do not want to 
repeat image used for the fill. The image will be rescaled 
proportionally as needed to fit the width or height of the 
area that will be filled.

 Image Texture Effect Options

Drop Shadow

The Drop Shadow feature allows you to quickly and easily create 
a drop shadow for your objects. The feature allows you to set the 
angle from which the light shines, how much the shadow is offset 
from the object, and the blur radius (or softness) of the shadow. 
In addition, you can set the color of the shadow through a color 
swatch.
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When you choose a Drop Shadow, a dialog displays the following 
options:

•	 Light Angle: Provides a dial that allows you to change the 
direction that the light is coming from. You can also enter 
a numerical value. Zero degrees is located at the bottom of 
the dial.

•	 Offset: Allows you to assign a value for how far the shadow 
is offset from the filled area

•	 Blur: Controls the softness of the shadow.

•	 Shadow Color: Allows you to choose the shadow color from 
a color palette.

 Drop Shadow Effect Options

A preview of the settings appears in the preview window as you 
adjust them. When you are satisfied with the appearance of your 
shadow, click OK to apply the settings. You will need to preview 
the frame (Cmd/Ctrl+R) or export the animation (Cmd/Ctrl+E) 
to see the results.

Crayon

The Crayon feature allows you to simulate the effect of something 
that is drawn with a crayon. The feature allows you to adjust 
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the width and density of the crayon stroke. You can also use the 
crayon as an eraser.

When you choose the Crayon effect, a dialog displays the 
following options:

•	 Line Width: Allows you to increase or decrease the width of 
the crayon stroke.

•	 Density: Decrease the setting to give the crayon a more 
grainy appearance. Increase the setting to make the crayon 
more “solid.”

•	 Erase to Background: Check this option to erase 
underlying strokes with the crayon.

 Crayon Effect Options

A preview of the settings appears in the preview window as you 
adjust them. When you are satisfied with the effect preview, click 
OK to apply the settings.

Stroke
These controls allow you to set the appearance of a shape’s 
outline. 

 Brush Settings

The options are:

•	 Stroke: First, be sure that “Stroke” is turned on or off, 
depending whether you want that shape to have an outline 
or not. Click the line color rectangle to pick a new color for 
the outline. 

If a style has been applied to this shape, the 
style’s color will be used instead of the shape’s 

color. Turn on the checkbox to the left of the color swatch 
to override the style’s color.
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•	 Width: Below the line color is a text field used to set the line 
width in pixels. 

If a style has been applied to this shape, the style’s 
line width will be used instead of the shape’s. 

Turn on the checkbox to the left of the line width to 
override the style’s width setting.

•	 Brush: To the right of the line color is a box that displays a 
preview of the brush used to draw the line. Click the box to 
select a brush from the Brush Settings window. 

 Brush Settings

Color Picker
Finally, at the bottom of the Style window is a color picker. You 
can use this as a shortcut for selecting colors for your objects. 
Just click a color in this palette to assign it as the selected shape’s 
fill color. Right-click a color swatch to assign it as the selected 
shape’s outline color.
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There are three buttons that we’ve classified as “other” controls:

•	 Press “Copy” to copy the properties of the selected shape or 
style. 

•	 Press “Paste” to apply a previously copied set of properties 
to another shape or style.

•	 Press “Reset” to switch back to editing the default fill and 
line properties - if a shape or style is currently selected, it 
will be de-selected. 

 Color Picker

Color Swatches
The “Swatches” popup menu lets you select from different sets of 
color swatches. These color swatches are just image files stored 
in a folder called “swatches”. You can add your own image files 
to this folder, and they will appear in the Swatches popup menu 
the next time you start Anime Studio. Or, you can select “Custom 
Image...” from the popup menu and Anime Studio will prompt 
you to select an image file to use.

 Swatches
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Advanced Options
To view the advanced options, check the Advanced option that 
appears at the bottom of the Style window. 

You’ll notice the addition of a Round Caps option in the Stroke 
section of the Advanced Style window. Check this option if you 
want to use strokes that have rounded ends. Uncheck the option 
to use flat ends on your strokes (similar to those used in Anime 
Studio 7 and earlier).

Older files will open with plain end caps to retain their original 
appearance. New artwork will default to round end caps unless 
the Round Caps option is unchecked.

 Rounded end caps compared to ends that are not rounded.

The following additional options appear in the Advanced view of 
the Style window: 

 Advanced Style Options

If you have converted 2D shapes to 3D shapes, using the 3D 
Conversion feature found in the 3D Options tab of the Layers 
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window, you can use the Style window to apply textures to the 
extruded shapes:

•	 Use the Effect 1 or Effect 2 dropdowns in the Style window 
to select the image textures that you want to apply. 

•	 Use the texture handles to translate, rotate, or scale the 
texture on the 3D object. 

 Use the Effect 1 and Effect 2 options in the Style window to apply an 
image texture to a converted 3D shape
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Shapes

You can assign names to the shapes that appear in the editing 
window. To name a shape, use the Select Shape tool to select it 
in the editing window. Then enter a name into the Name field 
found in the Style section of the Advanced Style window. 

After you assign names to shapes, you can use the Shapes popup 
menu to select a shape in the current layer. Only named shapes 
appear in this menu.

 Naming a shape

The Style popup menu provides you with a list of all styles in the 
document. 

Just above the Name field is a text label that indicates the 
currently-selected shape or style. 

•	 When no shape or style is selected, this label will say 
“Defaults.” This means that any changes to fill color, line 

width, etc. that you make in the style window will be applied 
to any new shapes you create. 

•	 When a shape is selected, the label will say “Shape.” Any 
changes you make now will apply to just that one shape. 

•	 When a style is selected, the label will say “Style” - any 
changes you make to a style will not only affect that style, but 
also any shapes that use that style.

Styles

A style is the same set of information used by a shape (color, line 
width, line brush, effects, etc.), but it doesn’t actually appear on 
its own in your animation. Instead, after creating a style, you 
can apply that style to one or more shapes. For example, you 
might create a “Skin” style, and apply it to all the body parts of a 
character. Later, if you want to change the color of the character, 
just modify the Skin style, and any shapes that use that style will 
change instantly. Use the Style popup menu to create new styles 
and to select a style for editing. The Tutorials section of this 
manual will walk you through the process of creating and using 
styles.
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 Styles

Below the Outline controls are two popup menus used to apply 
styles to a shape. By selecting styles from these menus, you can 
apply up to two styles to a shape. The applied styles will be used 
to control the shape’s color, line width, brush, fill effects, etc. 

 Style popup menus

Styles are very useful when you want to re-use the same 
appearance on several objects in a scene - if you later need to 
modify those objects, all you need to change is a single style. 
These popup menus let you apply styles to a shape - to create or 
edit styles, use the Styles popup menu at the very top of the Style 
window.
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The Library Window
The Anime Studio Library window provides access to all of the 
content that ships with Anime Studio such as characters, props, 
images, audio, etc. It has three tabs: the Library tab that provides 
access to the content categories, the Search tab which allows you 
to search your content folders for specific files, and the Favorites 
tab where you can gain easy access to your frequently used or 
favorite content items. 

For Windows users, the Library Window 
discussed in the first part of this chapter requires 

Internet Explorer 7 or later to run. You will see a 
message in the Library window that you need to install 
Internet 7 or later to take advantage of all of the new 
features in the library. If you do not have an Internet 
connection and if you cannot update your browser to 
Internet Explorer 7 or later, you can configure Anime 
Studio to use the old style library, discussed later in this 
chapter in “Using the Old Style Library” on page 364. 

The Library tab contains eight categories, discussed below. Each 
category is further divided into subcategories. You can create and 
remove categories and subcategories, and can add and remove 
content, including your existing content libraries, to/from the 
Library palette. 

Anime Studio can also automatically search for content on 
Content Paradise, allowing you to easily locate and purchase 
content for your Anime Studio projects.

The following figure shows the various controls and options that 
are contained in the library palette. Navigate through the Library 
list as follows:

•	 Use the Up and Down arrow keys to move higher or lower in 
your content tree.

•	 Use the Right and Left arrow keys to open and close folders.

•	 Click or select an item in the list to expand the display and 
view a larger preview of the content item.
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 The Anime Studio Library window

1.	 Library Tabs: Allows you to switch between three views in 
the Library Palette: Library, Search, and Favorites.

2.	 Category Icons: Allows you to select one of the eight library 
categories. From left to right, they are Figures, Props, 
Images, Audio, Video, Effects, Scenes, and 3D.

3.	 Collapsed folder: Click the right arrow to expand the 
contents of the folder. The number that appears in brackets 
at the beginning of the folder name designates the number 
of items that are contained within that folder.

4.	 Expanded folder: Click the down arrow to collapse the 
contents of the folder. The number that appears in brackets 
at the beginning of the folder name designates the number 
of items that are contained within that folder.

5.	 Content preview: If a content item is not selected, a smaller 
preview icon appears beside the name of the file. Click once 
to select the item to view its details.

6.	 Selected item: The currently selected item is highlighted, 
and displayed with a larger icon. File details appear at the 
left of the icon that indicate file name and other details if 
available.

7.	 Double Checkmark (Add button): Click the double-
checkmark icon to add the currently selected item to your 
scene. 
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8.	 Ticker: Displays up to date messages from Smith Micro.

9.	 Library Options widget: Click to display or hide the Library 
Options palette, which allows you to control the appearance 
of the library window

10.	 Add to Favorites: Adds the item that is currently 
highlighted in the library to the library’s Favorites tab.

11.	 Delete from Library (-): Click this button to delete the 
library content item that is currently selected. Note that this 
button completely removes the library item from the Library, 
not from your scene. 

12.	 Save to Library (+): Click this button to save the scene item 
that is currently selected into the Library. 

13.	 Create New Folder (+}: Click this button to create a new 
folder or subfolder beneath the currently selected library 
folder.

14.	 Category Selection: Allows you to select a library category 
(listed above in Category Icons) by name.

Displaying the Library Window
If the Library Window is not open, select Window > Library. You 
can drag either side of the Library palette across your screen to 
the desired width. 

Loading and Managing Items using 
the Library Icons
The Library icons appear as shown in the following figure. These 
icons appear at the bottom of the palette.

From left to right, these icons are:

 Library Icons
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•	 Double checkmark: The Add to Scene (double check) 
button adds the selected item to your scene. After you 
choose a content category and locate the item you want to 
use in your scene, click the Add to scene icon to add the item 
to your project.

•	 Create New Folder: Click the Add a Folder (+) button to 
create a folder beneath the currently selected Library folder.

•	 Save to Library: Clicking the Save to Library (+) button 
adds the selected item to the Library palette.

•	 Delete from Library: Clicking the Delete from Library (-) 
button removes the selected item from the Library palette.

•	 Add to Favorites: Click to add the currently highlighted 
library item to your Favorites list.

About Library Palette Categories

Anime Studio’s new library allows you to quickly select 
categories and the items contained within them:

•	 Click a Category icon to select a Content category. Then 
drill down in the hierarchical list in the Library list to select 
the item you want to add to your scene.

 Category Icons

•	 You can also drill down through the Category menu to 
select an item. Click the arrow in the upper-right section 
of the Library window to open the Category menu, then 
drill down through the menus to make your selection. In 
the following figure, the menu drills down from Video > 
Particle Effects > Particle Effects to list all of the available 
items in that folder.

 Category Menu
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The default categories are broken down by content type: Figures, 
Props, Images, Audio, Video, Effects, Scenes, and 3D. When 
you switch between categories, the Library remembers which 
item was selected the last time you used a specific category.

The content items are shown as a series of thumbnails arranged 
in a tree hierarchy. This area is called the Content pane.

 Content Pane

You can navigate through the Content pane as follows:

•	 When you reach a content folder that contains items, you 
can navigate through the contents in the folder using your 
arrow keys. Click to activate a selection in the Content 
pane, then use the Left and Right arrow keys to collapse or 
expand folders, and the Up and Down arrow keys to navigate 
through the folder contents.

•	 The Category menu displays nested menus, but you can 
also click on a folder or category to switch to it, and then 
highlight an item to load it.

Maintaining Your Library Palette

You can maintain your Library palette by adding and removing 
items to and from the Library palette, as described below.

Creating Subfolders

You can create new subfolders in the library to store your 
content. Follow these steps:

1.	 Click the category icon that applies to the subfolder you want 
to create. For example, if you will use the new folder to store 
your own characters, select the Characters category.

2.	 Highlight the folder beneath which you want the new folder 
to appear (such as the Anime Characters folder shown in the 
following figure.
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3.	 Click the Create New Folder icon located at the bottom of 
the Library palette. You are prompted to enter a name for 
the new folder.

4.	 Enter a new folder name and choose OK. The folder appears 
in the Library window.

 Creating a Subfolder

Adding Items to the Library

Saving an item to the Library palette adds the appropriate item 
to the currently selected category/subfolder. To add an item to 
the Library palette:

1.	 In the Layers window, locate and highlight the item that you 
want to save to the library. Assign a descriptive name to the 
object, if necessary, as the Library uses the layer name to 
identify the Library object name..

2.	 In the Library window, select the desired category/
subcategory by clicking the appropriate Category icon 
(Figures, Props, Images, Audio, Video, Effects, Scenes, 
or 3D).

3.	 Click the Save to Library icon (+) at the bottom of the 
Library palette. The object is saved to the Library folder that 
you selected.

 Library Icons
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Deleting Items from the Library Palette

To delete an item from the Library palette, select it by clicking 
its preview image, then click the Delete from Library icon (-) at 
the bottom of the palette (see below for an image of the Library 
icons).

 Library Icons

Deletions are permanent! Be sure you really 
want to delete the selected item. If you have not 

saved your content elsewhere (such as archiving the 
source files), the deleted content will be permanently lost. 
You cannot undo content deletions.

Changing the Library Appearance

A widget appears at the bottom of the Library palette, just 
beneath the library buttons shown in the previous figure. Click 
this widget to expand the Library palette to view the following 
library display options:

General Options

•	 Reopen Folders: .

•	 Show Path Tool Tip: Enable or disable the tool tip that 
displays the path to a library folder when you hover your 
mouse over a folder name in the library.

•	 Tool Tip Delay (ms): Drag the slider left or right to adjust 
the amount of time between hovering over a library name 
and displaying its path tool tip. Time delay is adjustable from 
100 to 1000 ms.

•	 Show Folder Counts: Check or uncheck this option to show 
or hide the number that represents the number of items in a 
folder. When checked, the number of items contained in the 
folder appears within parentheses.
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 General Options

Display Options

Check or uncheck the options listed below, to show or hide the 
various areas in the Library Palette as desired. These areas are 
labeled in the following figure.

•	 Tree: Displays a hierarchical view of the contents of your 
library. Check or uncheck this option to show or hide the 
hierarchical tree in the Library Palette. If the Item List Panel 
is turned off, thumbnails appear in the tree.

•	 Item List Panel: Displays the folders and content 
thumbnails for the folder that is selected in the tree. The 
thumbnail display appears in multiple rows and columns 
that adjust to the width and height of the Library palette. 

Check or uncheck this option to show or hide the item list 
panel.

•	 Extended Details Panel: Displays information about the 
selected item. Check or uncheck this option to show or hide 
the extended details.

The Extended Details panel will also display 
additional metadata about a library item if it has 

been added by the author of the content. Metadata can 
include additional information such as author name, 
copyright information, usage instructions, and more. 

•	 Breadcrumbs: Displays the path to the selected library 
folder. Check or uncheck this option to show or hide the 
breadcrumbs.

When breadcrumbs are displayed, you can use 
the Up arrow icon (at the right of the 

Breadcrumb trail) to navigate to the next highest folder 
level in the path. You can also click any folder in the 
breadcrumb trail to move up to the selected level.

•	 Ticker: When checked, displays a ticker that updates with 
the latest news from Smith Micro at the bottom of the 
Library window. Uncheck this option to hide the ticker.
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 Display Options

 Display Options shown



Anime Studio Pro 8
Users Manual

361

The Library Window

Tree Options

Thumbnails and additional product details appear in the Tree if 
you have selected to disable the Item List Panel. The options in 
the Tree Options section control the size of preview and selected 
item thumbnails, details, and other items in the Tree.

•	 Thumbnail Size: Drag the slider left or right to decrease or 
increase the size of the preview thumbnails.

•	 Selected Thumbnail Size: Drag the slider left or right to 
decrease or increase the size of the thumbnail for selected 
library items.

•	 Show Item Details: Shows or hides the File Name, Size, 
Installed, and Modified details that appear beside the 
currently selected library item.

•	 Tree Indentation: Drag the slider left or right to decrease 
or increase the amount of indentation for items and folders 
that appear within and beneath library folders.

•	 Show Folder Thumbnails: Check or uncheck this option to 
show or hide Folder icons in the library. When unchecked, 
only the name of a folder will appear in the library. When 
checked, a small Folder icon appears beside the folder name. 

 Tree Options

 List Options

When the Item List is enabled, thumbnails appear in multiple 
columns that adjust to fit the width of the panel. Settings in 
the List Options section control size of the thumbnail and the 
placement of text around the thumbnail.

•	 Thumbnail Size: Drag the slider left or right to decrease or 
increase the size of the content thumbnails.

•	 Label Height: Adjusts the amount of vertical space between 
the thumbnail rows to allow for labels that have multiple 
lines.

•	 Horizontal Gap: Adjusts the amount of horizontal space 
between the thumbnails
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 List Options

Details Options

•	 Show Image: When checked, displays an image of the 
selected item in addition to the text details in the Extended 
Details panel.

•	 Max Image Size: Allows you to adjust the size of the Details 
image with a slider.

 Details Options

Searching the Library
The new Search tab in the library allows you to perform a 
keyword search in all of your content libraries, or in selected 
categories. 

 Library Search Tab
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To perform a search, follow these steps:

1.	 Switch to the Search tab in the Library.

2.	 Enter a keyword (such as Jace) or a series of keywords (such 
as outdoor scene) in the Search For field.

3.	 Check or uncheck options as follows:

�� To perform a search throughout all Library categories, 
check the All Categories option.

�� To perform a search in specific categories in your 
Library, uncheck the All Categories option and then 
check or uncheck Characters, Props, Images, Audio, 
Video, Effects, Scenes, or 3D as needed to find the 
content you are looking for.

 Searching specific categories

4.	 Click the Search button. Anime Studio performs a search 
for the content that you specified, and search results appear 
in the Content pane.

5.	 To scroll forward or backward to view previous or later 
searches, you can use the arrow keys to the right and left of 
the Search button.

 Previous and Next search buttons

Favorites Tab
The Favorites tab allows you to quickly add your favorite content 
to library folders that you create yourself.

To add an item to the Favorites tab:

1.	 Highlight the library item that you want to add to favorites.
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2.	 Click the Add to Favorites button at the bottom of the 
Library palette. An Add to Favorites menu appears above 
the selected item.

3.	 From the menu, select an existing Favorites category, or 
choose <<New Folder>> to create a new Favorites folder. 
When the New Library Name dialog appears, enter a name 
for your new folder and click OK. The new folder appears in 
the Favorites tab and your item appears within it.

 Add to Favorites button

Using the Old Style Library
In previous versions of Anime Studio, you could access the 
library by choosing Import > and selecting content from one 
of the various subcategories. This is the method used in Anime 
Studio 5 and earlier.

 Selecting content from the File > Import command

In Anime Studio 6 you could access content in a library window 
that appears as shown below. To use this library in lieu of the 
newer style library used with Anime Studio 8, choose the Edit > 
Preferences command, and check the Use Old Library option 
in the Options tab of the Preferences dialog. 

After you choose to use the old style library, you access this 
library in one of two ways
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•	 Choose Window > Library

•	 Click the Library button in the top-right corner of the Status 
bar.

 The Old Style Library Window

The Content library opens to display items in your library. Icons 
display movies, folders, sound files, and other Anime Studio 
documents in your library.

•	 Use the zoom tools in the upper right corner of the Content 
Library window to increase or decrease the size of the icons.

•	 Double-click a folder icon to open the folder. The contents 
within that folder will be displayed.

•	 Double-click a content item to insert it into your project.

The status bar at the top of the Content Library displays buttons 
that allow you to back up to previous levels.

 Use buttons in the top toolbar to navigate backward to previous 
folder levels
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The Character Wizard
The Character Wizard allows you to quickly and easily create 
characters that you can animate in Anime Studio. It consists of 
several different tabs that allow you to specify body proportions, 
facial features, movement, clothing and other styling features.

Using the Character Wizard
You can open the Character Wizard by clicking the Character 
Wizard button that is located in the upper right corner of the 
Anime Studio interface. It appears just to the left of the Library 
button.

The Character Wizard consists of a number of different tabs that 
help you design your own character. There are also a few controls 
that appear from one tab to the next.

 Click the Character Wizard button to open the Character Wizard

 The Character Wizard window

Presets
The Presets dropdown allows you to choose from a number of 
different character types: Man, Woman, Boy, Girl, Creature, 
Bighead, and Mannequin. Each of these different humanoid 
character types has a different appearance to start with, varying 
in proportion, body shape, head shape, and so on. Some presets 
are more “human” while other are more fantasy-like. You can use 
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the other tabs to customize the appearance of the Preset even 
further.

Use the + button beside the Preset dropdown to create your own 
preset, or the - button to delete a preset that you have previously 
saved yourself. Built-in presets cannot be deleted.

The preset will be saved at its current state. If 
you go back and later change the character’s 

appearance (such as changing features or colors), the 
saved preset does not automatically update to reflect 
those changes. You can resave the character under its 
original name to overwrite the old one, or save a new 
preset under a different name.

 Presets available in the Character Wizard

Changing the Character Views
On the right side of the Character Wizard, you will see a preview 
of the current character. Beneath the preview is a slider, that 

allows you to view your character in one of eight angles. Move 
the slider to the right or left to change the perspective view of the 
character. The first bar displays the character in its front view. As 
you move the slider toward the right, the view changes to reflect 
1/8 of a circle (as if the character has turned 45 degrees). 

 Changing character views
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 Different character views

Exporting Views
After you complete your character in wizard, either with a preset 
or by customizing in the other tabs (described in the sections that 
follow) you can click OK to exit the character wizard and view the 
character in your Anime Studio project.

Before clicking the OK button, you should check the status of 
the Export All Views option beneath the view slider. With this 
option checked, five views of the character will be exported to 
your Anime Studio project (Front, Front 3/4, Back, Back 3/4, 
and Side). With the option unchecked, only the currently selected 
view will appear in your project.

If any of the parts used in the character have 
pre-animated movement (such as eyes that 

blink), the movement will also be added to your 
character. The animation will show on the Movement 
tab in the Character Wizard, and will be added as 
Actions in your Anime Studio project.

Randomizing Characters
The lower-right corner of the Character Wizard contains a 
Randomize button. When you click this button, the Character 
Wizard combines settings from the different tabs to create a 
totally unique character. This is a quick and easy way to generate 
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a customized character or preset as a starting point that you can 
later modify yourself.

 Some random characters

Body Tab
The Body tab allows you to adjust the proportions of the various 
parts of the character’s body. Move the sliders left or right to 
adjust the proportions as described in the following sections. The 
preview window will update the character in real time while you 
make your adjustments.

 Character wizard Body tab

Proportions

•	 Height: Move the slider toward the left to make the 
character shorter, or toward the right to make the character 
taller.
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•	 Torso height: Move the slider toward the left to decrease the 
height of the area between the shoulders and hip, or toward 
the right to increase the height of this area.

•	 Leg length: Move the slider toward the left to shorten the 
legs, or toward the right to lengthen them. The feet will 
remain stationary on the ground.

•	 Head height: Move the slider toward the left to make the 
head smaller, or toward the right to make the head larger. 
The height of the character will remain the same.

•	 Belly width: Move the slider toward the left to decrease the 
width of the waist, or toward the right to increase it.

 Proportion options

Legs

•	 Hip width: Move the slider toward the left to decrease the 
width of the hip, bringing the legs closer together. Move 
the slider toward the right to increase the width of the hip, 
creating more space between the legs.

•	 Leg width: Move the slider toward the left to make the legs 
and hip thinner, and toward the right to make the legs and 
hip wider.

•	 Leg muscles: Move the slider toward the left to make the 
legs appear less muscular (and more bony). Move the slider 
toward the right to add more muscle to the legs.

•	 Foot length: Move the slider toward the left to decrease the 
size of the feet, or toward the right to increase the size of the 
feet.

•	 Feet: Use the Feet dropdown menu to select the appearance 
of the feet. Choose Generic to create a simple representation 
of a bare foot with no toes. Other choices include Anime 
Boy Sneakers, Bare (with toes), Bowling Shoes, Female 
Sandals, Male Sandals, Reference, and Simple.
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 Leg options

Arms

•	 Arm length: Move the slider toward the left to shorten the 
arms from the shoulder, and toward the right to lengthen 
them.

•	 Shoulder width: Move the slider toward the left to decrease 
the width of the shoulder (bringing the arms closer toward 
the body), or toward the right to increase the width of the 
shoulder (moving the arms away from the body).

•	 Arm width: Move the slider toward the left to decrease the 
size of the arms (making them thinner), or toward the right 
to increase the size of the arms (making them fatter).

•	 Arm muscles: Move the slider toward the left to make the 
arms less muscular and bony, or toward the right to make 
them more muscular.

•	 Hand length: Move the slider toward the left to decrease the 
size of the hands, and toward the right to increase the size of 
the hands. 

•	 Hands: Use the Hands dropdown menu to select a style of 
hands for the character. Choose Generic to create generic 
hands that have no fingers. Other choices include Anime 
Boy Mittens, Female Red Nails, Long Fingers, Simple, 
Square, and Toon.

 Arm options
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Face Tab
The Face Tab of the Character Wizard allows you to select and 
adjust the facial features, including the head, eyes, mouth, and 
nose. Included at the bottom of the various categories are the 
following sliders:

•	 Horizontal adjustment: Move the slider left or right to 
position the facial features, if necessary after you adjust the 
head proportions. For example, you can move the eyes, nose, 
and mouth closer to the face if they appear to be detached 
from the face. The adjustment slider will be disabled in the 
Front and Back views where it does not apply. 

•	 Vertical adjustment: Move the slider left or right to adjust 
the height of the facial features, if necessary after you adjust 
the head proportions. For example, in some cases, the profile 
of the lips will not match up with the line of the mouth and 
this control can match it more closely.

 Character wizard Face tab

Head

•	 Head selector: Click the Head dropdown list to choose 
from a number of preset character heads. Styles range from 
human to fantasy and more. Some characters have hair or 
hats, while others are bald.

•	 Neck width: When you are working with a head where 
the size of the neck can be adjusted, this dial allows you to 
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increase or decrease the width of the neck. The option will 
be disabled when the character does not have a resizeable 
neck.

•	 Head top: (enabled for Generic head only) Move the slider 
toward the left to decrease the width of the crown, or toward 
the right to increase the width.

•	 Head middle: (enabled for Generic head only) Move the 
slider toward the left to decrease the width of the middle 
head, or toward the right to increase the width.

•	 Head bottom: (enabled for Generic head only) Move the 
slider toward the left to decrease the width of the lower 
head, or toward the right to increase the width.

 Head options

Eyes

•	 Eye selector: Use the Eyes dropdown list to select one of 
several different eye shapes.

•	 Size: Move the slider toward the left to decrease the size of 
the eyes, or toward the right to increase the size of the eyes. 
The size will increase or decrease from the center point of 
each eye.

•	 Height: Move the slider toward the left to lower the eyes, or 
toward the right to raise the eyes.

•	 Spacing: Move the slider toward the left to bring the eyes 
closer, or toward the right to move the eyes farther apart.

 Eyes options
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Mouth

•	 Mouth selector: Use the Mouth dropdown list to select one 
of several different mouth shapes.

•	 Size: Move the slider toward the left to decrease the size 
of the mouth, or toward the right to increase the size of the 
mouth.

•	 Height: Move the slider toward the left to lower the mouth, 
or toward the right to raise the mouth.

 Mouth options

Nose

•	 Nose selector: Use the Nose dropdown list to select one of 
several different nose shapes.

•	 Size: Move the slider toward the left to decrease the size of 
the nose, or toward the right to increase the size of the nose.

•	 Height: Move the slider toward the left to lower the nose, or 
toward the right to raise the nose.

 Nose options

Head Prop
Head props are only enabled when the Creature is selected as a 
character preset.

•	 Prop: Use the Prop dropdown list to select one of several 
different head props, such as hats, beards, curls, and other 
facial and head features.

•	 Size: Move the slider toward the left to decrease the size of 
the head prop, or toward the right to increase its size.
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•	 Height: Move the slider toward the left to lower the head 
prop, or toward the right to raise it.

 Head Prop options

Movement Tab
The Movement tab in the Character Wizard allows you to 
generate a walk cycle for your character, very quickly and easily, 
through the use of sliders. As you design the walk cycle, it will 
be applied to all of the character views (front, back, sides, and 
quarter-views). 

The character is not automatically animated by default. When 
you add a character to the scene, the actions will also appear in 
the Actions palette so that you can manually add actions in the 
timeline where you want them to occur. For example, you can 
apply a walk at frame 1, and then add a jump action at frame 100 
and a wave action at frame 120. 

When you export a single view of your character, 
it will appear as a bone group inside your Anime 

Studio scene. When multiple views of the character are 
exported to your Anime Studio scene, the character will 
appear as a Switch Layer. Beneath that switch layer, 
you will see a bone group for each of the character views 
(front, back, and so on). 

You will not initially see the actions appear in the 
timeline because the bone groups and layers are 

contained within a switch layer. The actions that you use 
in your animation will be applied to the currently 
selected view (active switch layer) of the character. To 
view the actions in the timeline, select one of the bone 
groups beneath the main switch layer.

The Walk cycle is a computer generated action. The others 
(Jump, Kick, and Wave) are custom actions that were created in 
Anime Studio Pro. These actions can be applied to any character.
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 Character wizard Movement tab

The following options appear:

•	 Actions: Use the Actions dropdown list to select the type of 
action that you want to use or preview. 

 Actions options

•	 Steps per second: Move the slider toward the left to make 
your character walk more slowly, and toward the right to 
make it walk faster.

•	 Step distance: Move the slider toward the left to make your 
character take shorter steps, and toward the right to make 
your character take longer steps.

•	 Step height: Move the slider toward the left to keep the 
steps closer to the ground (less knee bend); and toward the 
right to raise the feet more from the ground (more knee 
bend).

•	 Arm swing: Move the slider toward the left to decrease 
the arm swing (making it stiffer), and toward the right to 
increase the arm swing (making it looser).

•	 Torso bend: Move the slider toward the left to add less bend 
to the torso (making the posture straighter). Move the slider 
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toward the right to add more bend (adding more bounce to 
the walk).

 Other settings options

Clothing Tab
The Clothing Tab allows you to change the style and colors of the 
pants and shirt that the character wears. There are two sections 
available in this tab.

 Character wizard Clothing tab

Pants

•	 Type selector: Choose whether you want your character to 
wear short or long pants.

•	 Color: Click the color chip to open the color palette, where 
you can select a new color for the pants.
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 Other settings options

Shirt

•	 Type selector: Choose whether you want your character to 
wear a short-sleeved shirt or a long-sleeved shirt.

•	 Color: Click the color ship to open the color palette, where 
you can select a new color for the shirt.

 Other settings options

Style Tab
The Style tab allows you to change the skin color, hair color, and 
stroke color and width for your character. 

 Character wizard Style tab

The settings you select here are as follows:



Anime Studio Pro 8
Users Manual

379

The Character Wizard

 Other settings options

•	 Skin color: Click the color chip to open the color palette, 
where you can select a new color for the skin. 

When you create body parts for the character 
wizard, special colors MUST be used for the skin 

and hair. Use Yellow (R 255, G 255, B 0) for any body 
part that you want to identify as skin color, and Cyan (R 
0, G 255, B 255) for any part that you want to identify as 
hair. Any parts that use these colors will inherit the skin 
or hair colors that you identify in the Character wizard.

•	 Hair color: Click the color chip to open the color palette, 
and select a new color for the hair.

•	 Stroke color: Click the color ship to open the color palette, 
and select a new color for the character outlines.

•	 Stroke width: Sets the stroke width size to use as the 
default. 

If you have a mouse with a scroll wheel, you can 
increase or decrease this value while watching 

the character update in the preview window

•	 Set as default: Click this button after you change the value 
in the Stroke Width field.

•	 Randomize line width: With this setting on, the line width 
will vary slightly across the character. With the setting off, 
the line width will be uniform.

•	 Scale compensation: When checked, the stroke width will 
be proportionally adjusted as the character is resized. If you 
make the character smaller, the strokes will get narrower. 
If you make the character larger, the strokes will get wider. 
When unchecked, the stroke width will remain the same 
when you increase or decrease its size, and changes to stroke 
width will need to be made manually.
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Designing a Character and Walk 
Cycle
The Walk cycle is a computer generated action. The others 
(Jump, Kick, and Wave) are custom actions that were created in 
Anime Studio Pro. These actions can be applied to any character.

To create a walk for your character, follow these steps:

1.	 Click the Character Wizard button in the upper-right corner 
of the Anime Studio interface to open the Character Wizard.

2.	 Design your character using the Body, Face, Clothing, and 
Style tabs as outlined in the previous sections. Use the view 
slider beneath the preview window to view your character 
from all directions as you design it.

Pay attention to the adjustments you make in 
height and placement of the facial features. Use 

the Horizontal and Vertical adjustment sliders to 
position the eyes, nose, and mouth in the side and 
quarter-view, and then verify that the changes are 
acceptable for each of those views. In other words, if you 
use the slider to adjust the position of the nose and mouth 
in the side view, also look at how the changes affect the 
placement of the facial features in the Front 3/4 and 
Back 3/4 views.

3.	 After you design your character, click the Movement tab.

 Character wizard Movement tab

4.	 From the Actions drop-down menu, choose Walk (it should 
be selected by default).

5.	 Adjust the Steps per second, Step distance, Step height, 
Arm swing, and Torso bend sliders until you are happy 
with the walk. 

6.	 The preview window shows a preview of the walk cycle as 
it is applied to your character. You can view the walk from 
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several angles by moving the slider right below the preview 
window. Examine your character from all directions and 
make tweaks as necessary before you export it to your 
Anime Studio project. You will export your character in the 
next tutorial.

7.	 Click the + button at the top of the Character Wizard 
window. Name your character My First Character and click 
OK to save the preset. Now you will be able to reuse that 
character preset in any of your projects.

 Saving a preset character

8.	 Click OK to exit the Character Wizard. You will notice that 
the character appears in your scene when you do so. The 
next two tutorials will explain different ways that you can 
export and use the character in your projects.

Making Your Character Walk
In the previous project you designed a character and a walk, 
and saved the preset. When you exited the Character Wizard, 
you noticed that the character that you worked on appeared in 
the project window. However, because you saved the character, 
you can easily reuse it at any time in any project you start. We 
will begin this tutorial with a new project, and you’ll reuse the 
character preset that you designed in the previous exercise. In 
this tutorial, you will export only one view of the character: the 
Side view.

1.	 Start a new empty project in Anime Studio.

2.	 Optionally, you can shorten the length of the animation 
from its default of 240 frames. To do so, enter 100 in the end 
frame field in the timeline.

 Decrease the length of the animation to 100 frames.

3.	 Click the Character Wizard to open the Character Wizard.
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4.	 From the Presets menu at the top of the screen, select the 
My First Character preset that you created in the previous 
exercise. Your custom character appears in the preview area.

 Choosing a preset character

5.	 Move the View slider so that you see your character in the 
side view.

6.	 Uncheck the Export All Views option beneath the preview 
window. This will export only the current view, which is now 
set to the Side view.

7.	 Click OK to exit the Character Wizard. Your character now 
appears in the scene. Press the Play button and you will see 
the character walking in the center of the scene. Press the 
Stop button after you view the animation.

8.	 Click the Rewind button to move the timeline back to Frame 
0. Then use the Translate Layer tool to move your character 
off the screen to the left.

 Translate Layer

 At frame 0, move the character to the left of the screen.



Anime Studio Pro 8
Users Manual

383

The Character Wizard

9.	 Advance the timeline to frame 96, and move the character 
off to the other side.

 At frame 96, move the character to the right of the screen.

10.	 Press the Play button to view your character as it walks 
across the screen.

Rotating Your Character 360 
Degrees
In this exercise you’ll make your character spin around in a full 
360 degree circle. 

It’s fairly easy to do, if you follow these steps:

1.	 Start a new empty project in Anime Studio.

2.	 Click the Character Wizard to open the Character Wizard.

3.	 From the Presets menu at the top of the screen, select the 
My First Character preset that you created in the previous 
exercise. Your custom character appears in the preview area.

4.	 Select the Front view before you export the character. This 
is the view that will be visible when you initially import the 
character into your scene.

5.	 Make sure that the Export All Views option beneath the 
preview window is checked. This step will be necessary, 
because you will be working with all of the exported views in 
this project.

6.	 Click OK to exit the Character Wizard. The character 
appears in your project. 

7.	 The top layer of the character is a Switch layer, and the 
various character views appear as bone groups beneath 
it. With the character’s switch layer selected (the topmost 
layer), use the Scale Layer tool to resize your character as 
needed. 



Anime Studio Pro 8
Users Manual

384

The Character Wizard

As a general rule, you will want to select the 
Switch Layer (the top layer) when you translate, 

scale, or rotate your character. This applies the changes 
to all views of your character. If you want your 
character to face a different direction at a specific point 
in the timeline, you simply move to a later frame, and 
make the appropriate switch layer active. This will be 
demonstrated in the next few steps. For more 
information about switch layers, see “Switch Layer” on 
page 292.

8.	 If you are not already at Frame 0 in the timeline, use the 
Rewind button to return there. Your character should be 
facing toward the front.

9.	 Now, advance the timeline to Frame 6. Expand the 
character’s switch layer so that you see the various views, as 
shown in the following figure. The view that has the filled-in 
bone is the layer that is currently in view.

When you export multiple views of the character, 
you will see the character appear as a Switch 

Layer. Each of the different views of the character then 
appear as individual bone groups beneath that layer, as 
shown in the following figure. The view that is currently 
visible is the layer that you had selected at the time you 
exported the character (in this case, the Front view).

 The different views of the character appear as bone groups within 
the switch layer. The layer that shows a highlighted bone is the 

switch layer that is currently visible for the character.

10.	 At Frame 6, right-click in the Switch layer (shown as Man 
in the above figure), and select the Front 3/4 view. Your 
character should rotate to that view and a keyframe will 
appear at Frame 6.
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 At Frame 6, right-click the Switch layer (shown here as Man) and 
select the Front 3/4 view.

11.	 Now move to Frame 12 (the next keyframe), and right-click 
to select the Side view in the Layers window. Your character 
will rotate to face the side. 

12.	 At Frame 18, switch to the Back 3/4 view.

13.	 At Frame 24, switch to the Back view. At this point, your 
character has turned one-half of the circle. 

14.	 Now select the Translate Layer tool. You won’t actually use 
this tool, but you will use the Flip Horizontal button later in 
this tutorial.

15.	 Advance to Frame 30. In the Layers window, right-click the 
switch layer, and choose the Back 3/4 view. 

16.	 Next, to make your character continue to spin in the 
same direction (rather than return in the same direction 
from which it came), you’ll need to click the Flip Layer 
Horizontally button in the Translate Layer tool option bar, 
as shown below.
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 At Frame 30, select the Back 3/4 view and then flip it horizontally.

17.	 Complete the remaining three frames as follows:

�� Frame 36: Right-click the switch layer to choose the 
Side view.

�� Frame 42: Right-click the switch layer to choose the 
Front ¾ view.

�� Frame 48: Right-click the switch layer to choose the 
Front view.

18.	 Save the project if you like, and then play back the 
animation. You should see your character spin around in a 
circle.

Designing Your Own Actions
Advanced Anime Studio users may be interested in creating their 
own actions for the Character Wizard. The actions that you create 
will appear in the Actions selection menu that appears at the top 
of the Character Wizard Movement tab.

The steps to create your own custom actions are briefly as 
follows:

1.	 Use Windows Explorer (Windows) or Finder (Mac) to locate 
your Anime Studio installation folder.

2.	 Navigate from your installation folder to the Character 
Wizard > Actions folder. You will see three ANME files 
within that folder: Jump, Kick, and Wave. These are the 
three files that are associated with the actions that appear in 
the Actions selection menu.

3.	 Open one of these projects, and save it under a new name in 
the same Actions folder (named according to the action that 
you want to create). This step is important ... if you edit 
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the file under its original name you will overwrite the 
original action that is furnished with Anime Studio.

4.	 The project will consist of five different bone layers that 
animate a mannequin figure: Back, Back 3/4, Side, Front 
3/4, and Front. If you play the animation you will notice that 
all of the views are animated in unison.

 Five bone layers display a mannequin in different views.

5.	 Choose the Animation > Clear Animation from Document 
command to remove all of the keyframes in the timeline. 
They will be removed from all bone groups in the document.

6.	 Use the Manipulate Bone tool to modify the movement of 
each view so that you again create five different views of the 
character that move in unison. Make sure you make your 
changes on frames 1 or higher (do not make changes on 
Frame 0).

7.	 Make sure that you adjust the length of your animation so 
that the movement is seamless when it is played in a loop. 
Add or remove frames as necessary to create a smooth-
flowing animation where you cannot tell where the loop 
starts or ends.
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 Edit each view for your figure so that the character moves in the 
same manner for each view.

8.	 After all five views of your character have been animated, 
save the modified file. You should now see your new action 
appear in the Actions menu in the Character Wizard 
Movement tab.

 Your new action will appear in the Actions menu in the Character 
Wizard movement tab.

Creating Content for the Character 
Wizard
Your Anime Studio application installation folder includes 
the Character Wizard subfolder as mentioned previously in 
“Designing Your Own Actions” on page 386. In addition to 
the Actions folder previously discussed, you will also find other 
subfolders that contain the ANME files for the Character Wizard 
content that you select in the Body and Face tabs. 
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 Character Wizard content folders.

The additional subfolders are as follows. Examine the files for 
some ideas on how you can create your own content: 

•	 Eyes: Contains the Eyes content that you select from the 
Eyes section of the Face tab. 

•	 Feet: Contains the Feet content that you select from the 
Legs section of the Body tab. Uses a naming convention sim

•	 Hands: Contains the Hands content that you select from the 
Arms section of the Body tab.

Eyes, Feet, and Hands come in pairs ... you have 
a right eye and a left eye, a right foot and a left 

foot, and a right hand and a left hand. When you create 
content for paired body parts, precede the topmost layer 
(switch layer, bone group, or image) with a name that 
starts with Right or Left, where Right corresponds to 
the right part, and Left corresponds to the left part. For 
example, if you create a set of animated eyes for the 
front view, place the character’s right eye in a switch 
layer named Right Front, and the character’s left eye in 
a switch layer named Left Front. Names are case-
sensitive and should be initial-capped. Open one of the 
files in the Eyes, Feet, or Hands folders and examine the 
layers within them to view the naming conventions used.

•	 Head Props: Contains the Prop content that you select from 
the Head Prop section of the Face tab.

•	 Heads: Contains the Head content that you select from the 
Head section of the Face tab.

•	 Mouths: Contains the Mouth content that you select from 
the Mouth section of the Face tab.

•	 Noses: Contains the Nose content that you select from the 
Nose section of the Face tab.
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Heads, Head Props, Mouths, and Noses don’t 
come in pairs, so you won’t need to add the Right 

or Left prefix as you do with paired body parts. When 
you create switch layers for a “single” body part, name 
the switch layer according to the view that you are 
creating. For example, if you create a head for the Front 
3/4 view, place the head in a switch layer named Front 
3/4. Names are case-sensitive and should be initial-
capped. 

Here are some additional notes and tips about creating content 
for use in the Character Wizard. Again, we recommend that you 
study the various ANME files in the Character Wizard subfolders 
to learn more about how these features work. 

•	 Pay attention to the point of origin for the layer that you are 
working on. The point of origin is important for the main 
folder (the topmost layer for the part - whether it be a switch 
group, a bone layer, or an image). For example, if there 
are multiple eyes contained in a switch layer to make an 
animated eye, you only need to set the point of origin on the 
switch layer, instead of on each individual eye layer within 
that switch layer. If you only have one layer for a body part, 
set the point of origin on that one layer.

•	 The points of origin for eyes, mouth, and nose should 
generally be set at the center. On the other hand, if you are 
creating something like a broken nose, the point of origin 

might look better being a little bit off center. For moving 
parts (like hands, feet, and head) you should set the point of 
origin at the point of rotation. 

•	 Parts can be resized, but only to a limited degree. In order 
to work well within the “normal range”, parts should be 
designed to the size of the blue output rectangle. This rule 
can be broken ... for example, if you intentionally want small, 
beady eyes you can make them much smaller.

•	 Examine the heads that are included within the Heads 
folder. Some heads have hair that fall in front of facial 
features (for an example, see the Spike head, and turn 
visibility on and off for the various layers to examine how 
they work). 

•	 Hair color is controlled within the Style tab of the Character 
Wizard. When designing your character, assign the color R 
0, G 255, B 255 to the objects that you are using for hair (or 
eyebrows, moustaches, and beards). The Character Wizard 
will replace this “special” color with the hair color that you 
choose in the Style tab.

•	 Skin color is also controlled within the Style tab of the 
Character Wizard. When designing your character, assign 
the color R 255, G 255, B 0 to any parts that you want to 
replace with the Skin color selected in the Style tab.
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•	 Stroke color is also controlled within the Style tab of the 
Character Wizard. Any strokes in your Character Wizard 
content file that are pure black (R 0, G 0, B 0) will be 
replaced with the Stroke color that is specified in the Style 
tab.

Other Windows

Audio Recording
Anime Studio allows you to record audio tracks within the 
application. Select Window > Audio Recording to open the 
Audio Recording palette. You will see the following controls and 
settings:

•	 Record Button: Press the Record button to start a 
recording. After you have recorded the content you want to 
record (speech, sound effects, etc.), press the same button to 
stop the recording.

You can start a recording at any selected frame 
in the timeline. Simply select the frame at which 

you want the recording to begin, and start your 
recording at that frame.

•	 Play Button: After the recording is complete, press the Play 
button to hear the recording.

•	 Sync with Timeline Playback: If this box is checked, the 
timeline will play back while you record the audio (and when 
you play back the audio). This lets you record in sync with 
the visuals if you choose to do so.

•	 Microphone Dropdown List: Selects the microphone that 
you want to use for audio recording.

•	 Pitch Shifting: Use the Pitch Shifting slider to raise or lower 
the pitch of the recording. Move the slider toward the left to 
lower the pitch, or toward the right to raise the pitch. The 
Reset button returns the recording to its original pitch.

•	 Add to Project: Once you are satisfied with the recording, 
click this button to save the recording as a WAV file. The 
WAV file also appears in the Layers window as a new audio 
layer, and in the timeline of your current project.
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 Audio Recording Window

Timeline Window

Overview

The Timeline window is used when animating in Anime Studio to 
control the current time, and to control objects’ keyframes.

 The Anime Studio timeline

The Timeline window only displays information about the 
currently active layer in the project. When you switch to a new 
layer, the timeline panel will update its display to show the new 
layer’s keyframes.

There are several new features in the way that keyframes are 
displayed. In previous versions of Anime Studio, all keyframe 
types were displayed in the timeline. For example, you would 
see keyframe types for bone changes, layer translation, layer 
scale, layer rotation, and color changes whether or not they were 
actually being used. If you were looking for a particular change, it 
could be hard to find what you were looking for.
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The timeline view is now much simplified. Changes are not 
displayed in the timeline until you actually create a keyframe 
change in a channel. For example, you won’t see a change in the 
Bone channel until you actually move a bone.

 Animation channels are not displayed in the timeline until you add 
them to your project

If you then rotate the layer, you’ll see the Rotation channel added 
to the timeline, along with its keyframe.

 A rotation channel added to the timeline

There is a Preferences option that allows you to consolidate 
timeline channels. This option is off by default in Anime Studio 
Pro 8, and on by default in Anime Studio Debut 8.

 Uncheck the Consolidate Timeline Channels option before you delete 
keyframes
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This option combines all changes on a single layer into one line 
in the timeline. The following image shows an example of a 
layer that has several channel changes (top), and what the layer 
looks like if the Consolidate Timeline Channels option is active 
(bottom).

 A timeline that is not consolidated (top), and a consolidated timeline 
(bottom)

The consolidated timeline view displays a 
keyframe when there is a change in any of the 

consolidated layers. If you delete a keyframe, you may 
not be sure which type of keyframe you are deleting , or 
whether or not there are multiple keyframes being 
deleted at that point. Be sure to uncheck the Consolidate 
Timeline Channels option in the Preferences dialog 
before you remove any keyframes from your timeline.

Controlling Time

The top of the Timeline window has controls for setting the 
current time. Whenever you modify an object in Anime Studio, 
the modification is recorded at the current time. The process of 
modifying an object, changing the time, and modifying it again 
is how an animation is created in Anime Studio. Time in Anime 
Studio is expressed in terms of “frames”, where there are x 
number of frames in a second. By default, a new Anime Studio 
project has 24 frames per second, although this value can be 
adjusted in the Project Settings dialog.

The first set of controls for adjusting time is a set of VCR-like 
playback buttons. (These are actually at the bottom of the main 
window, not in the Timeline window itself.) From left to right 
these buttons are: rewind, step back, stop, play, step forward, 
and jump to end.
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 Playback controls

Rewind sets the current frame to 0, while jump to end sets the 
current frame to the last one in the animation (the length of 
the animation is defined by the shaded area in the time ruler). 
The step forward and back buttons advance and back up by one 
frame. The play button plays back the animation in the main 
editing area, repeating playback in a loop. Finally, the stop 
button stops playback.

At the top-left of the Timeline window is a text control that 
indicates the current frame number. You can change the current 
frame by typing in a new value here and pressing enter.

Directly below the frame field is a sort of ruler that measures 
time. This time ruler has small tick marks, one per frame, and 
has labeled frame numbers at intervals along its length. The 
time ruler also displays the current frame with a red triangular 
marker above the current frame’s tick mark. The time ruler is 
used both as an indicator of the current time, as well as a control 
to adjust it. By clicking (or clicking and dragging) anywhere on 
the time ruler, you can change the current frame.

A certain range of frames in the time ruler are shaded with a 
darker color. This shaded region indicates the length of your 
animation. When you play back your animation in Anime Studio 
or export it as a movie file, this shaded region is the part that 
will play back. You can change the start and end frames of your 
animation in the Project Settings dialog, or you can Alt-click in 
the time ruler to set a new start and/or end time. Alt-Click with 
the left mouse button to set the start of your animation, and Alt-
click with the right mouse button to set the end.

Next, just below the time ruler, is the onionskin controller. It 
has tick marks that line up with the frames in the time ruler. By 
clicking one of these tick marks, you can turn on an “onionskin” 
frame. An onionskin frame appears as just an outline 
superimposed on the current frame, and is used to compare your 
animation at two different times at once. This is helpful for lining 
up certain complex motions. Click an onionskin marker again to 
turn it off. If you turn on the “Relative frames” checkbox in the 
Onionskins popup box, Anime Studio will move the onionskin 
frames along with the current time so that they maintain the 
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same relative distance from one another. You can also turn on 
the “Selected layer only” checkbox to tell Anime Studio to display 
onionskins for just the currently active layer. Anime Studio can 
display up to 8 onionskin frames.

Playing a Partial Segment

Sometimes, you may want to play back just a short segment of 
the timeline, instead of your entire animation. For example, you 
may be working on one small move, and you want to play it back 
over and over while you make small changes to see when you’ve 
got it just right.

To set a limited segment of the timeline for playback, hold down 
the Ctrl key (Windows) or Cmd key (Mac) while you click in the 
time ruler. Click with the left mouse button to set the beginning 
of the segment, and click with the right mouse button to set the 
endpoint. To remove the limited playback segment, Ctrl-click on 
the segment endpoints to remove them from the timeline.

Animation Channels

Most of the timeline panel is taken up with animation channels, 
drawn as horizontal bars below the time ruler. Each animation 
channel displays a certain type of motion or effect that can take 
place in an Anime Studio animation. Different types of layers 
have different animation channels available. For example, vector 

layers are the only ones with a point animation channel, and 
bone layers are the only ones with bone animation channels. 
At the left end of each animation channel is a small icon that 
indicates what type of channel it is. Shown below are the icons 
for the various types of animation channels. Note that the red-
colored channel icons represent animation for the currently 
selected object. (If you’re ever unsure about which channel an 
channel icon refers to, just hold your mouse over it momentarily 
for a tooltip reminder.)

To help reduce visual clutter, not all animation 
channels have to be displayed at once in the 

timeline. For example, you won’t often have to refer to 
the Layer Shading channel in the timeline. Hidden 
channels are still doing their work behind the scenes, 
they just aren’t displayed in the timeline.
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Layer Motion Channels

 Layer Motion channels

Layer Effect Channels

 Layer Motion channels

Camera Channels

 Layer Motion channels
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Vector-Only Channels

 Layer Motion channels

Bone-Only Channels

 Layer Motion channels

Switch-Only Channels

 Layer Motion channels
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Particle-Only Channels

 Layer Motion channels

Along the length of an animation channel are displayed 
keyframes. A keyframe represents a point in time at which you, 
the animator, made a modification to an object. For example, 
if you set the current time to frame 24, then scale the layer, a 
keyframe will appear in the layer scale channel at frame 24. 
Keyframes appear as small markers on the channels. At points in 
time that lie in between keyframes, Anime Studio automatically 
calculates how to move an object from one keyframe position to 
the next.

Working with Keyframes

Keyframes are not just static elements displayed in the 
animation channels. They can be moved, deleted, and copied. To 
modify a keyframe, first it must be selected. This is accomplished 
simply by clicking a keyframe in the timeline panel. A selected 
keyframe shows up in a highlighted color. Multiple keyframes 
may be selected by holding the shift key while clicking on 
keyframes. Alternatively, you can click and drag a rectangular 
selection box around the group of keyframes you want selected.

To delete selected keyframe(s), either click the “Delete” button 
in the timeline, or press the Alt+Backspace keys. Deleting a 
keyframe removes motion from an object. Keyframes can also be 
moved by dragging them forward and back in time. If you want 
some motion to take less time, drag its keyframe to the left. To 
take more time, drag it to the right.

As mentioned before, Anime Studio automatically calculates 
what happens in between keyframes. However, you do have 
some control over this. By default, Anime Studio will compute 
a smooth transition from one keyframe to the next - most of the 
time, this is probably what you want. However, you can change 
the transition type by right-clicking a keyframe and choosing a 
new method from the popup menu that appears. The transition 
methods are: smooth (the default), ease in/out (also a smooth 
motion, but the object starts off moving kind of slowly and slows 
down again as it approaches the next keyframe), linear (motion 
is straight from one keyframe to the next, leading to a somewhat 
mechanical look to the motion), step (there is no transition at all 
- the object just jumps from one keyframe to the next), noisy (the 
object moves in a slightly wobbly motion), and cycle (the value 
from this keyframe to the next will be taken from some earlier 
section of the timeline).

Another way of creating keyframes is to copy an object’s position 
from another point in time. To do this, first select the keyframes 
you want to copy. Next, click “Copy” in the timeline (or press 
Alt+C). Now, set the current frame to when you want the copied 
keyframe to appear (using the time ruler or the step forward/
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back buttons). Finally, click “Paste” in the timeline (or press 
Alt+V) to place a copy of the keyframes at the current time.

Sequencer

The sequencer provides another view of the timeline. It displays 
each layer as a block of time. Keyframe changes are not displayed 
in the sequencer, but you can create keyframe changes in this 
view.

 The Sequencer

The Sequencer allows you to easily move a layer forward or 
backward in time. Move the clip toward the left to have it start 
sooner, or toward the right to have it start later. The green arrow 
in the time ruler, located at the top of the Sequencer timeline, 
indicates the frame at which the currently selected clip will start. 

You can also reposition your clips in the Channels 
timeline view. Select the channel you want to 

move, then right-click in the Time Ruler to drag the 
green arrow to the right or left. You’ll notice the 
keyframes and arrow relocate with the mouse.

For example, you can reposition a layer from frame 1 to frame 
38, causing the animation in that layer to start at a later time. 
To move a layer and its sublayers, click the topmost layer and 
move all of them at the same time. To move a sublayer, click the 
desired sublayer to move it on its own. 

 Select a layer to move it and its sublayers
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 You can also move a sublayer by itself

You can also use the sequencer to show or hide a layer at any 
time during the movie. Advance to the frame where you want 
the layer to become invisible. Open the Layer Settings dialog for 
the layer that you want to hide, uncheck the Visible checkbox, 
and close the Layer Settings dialog. The contents in the layer will 
disappear in the project window, and the track in the sequencer 
will appear as though it ends at the point where it was hidden. 

 Check or uncheck the Visible setting in the Layer Settings dialog to 
show or hide a layer
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To make the layer reappear later in the timeline, repeat the 
process. Select the layer you want to unhide, open the Layer 
Settings dialog, and check the Visible checkbox. After you close 
the Layer Settings dialog the layer will reappear in the sequencer. 

 The sequencer shows a break where the layer is hidden

If you import an audio file, it has a fixed duration in the 
sequencer. You can see where the sound effect will happen. Say 
you want a pop to happen when your character disappears from 
the scene. You can place the pop in the right place.

It works the same way if you import a video layer. For example, 
if you want an explosion to happen just before the pop, you can 
import a video layer and place it just before the sound effect.

 You can precisely place audio and video files in Sequencer view

Motion Graph

In the Motion Graph in the Timeline window, you can enable 
Anime Studio’s graph mode. In graph mode, the animation 
channels of the current layer are displayed graphically, rather 
than just as points along a line. In the example below you can see 
what graph mode looks like:
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 The Timeline window in graph mode

The main body of the timeline is now a graph, showing the value 
of the animation channels as curves. The horizontal dimension 
represents time in frames (just as in the regular timeline mode), 
and the vertical dimension represents the value of the animation 
channels. If all animation channels were displayed at once, 
the graph would become too cluttered to be useful, so it’s up to 
you which channels to display at any given time. To turn the 
display of a channel on and off, click its icon on the left side of 
the timeline. Channels that are turned on become highlighted 
in the color of their respective curves in the graph - in the above 
example, two channels are turned on: Layer Scale and Layer Z 
Rotation.

To further reduce clutter, only one channel can be active in 
editing mode at a time. The active channel’s icon on the left is 
outlined to indicate this - here the Layer Z Rotation channel 
is active. Double-click a channel icon to activate it. The active 
channel is the only one that has its keyframes displayed in the 
graph - the keyframes look the same as in regular mode.

Depending on the values in your animation channels, the curves 
on the graph may be too large to view, or too small to work 
with easily. You can change the vertical scale of the graph in the 
following ways: First, you can set the vertical scale numerically in 
the “Scale” text field in the Graph Mode popup. Second, pressing 
the Page Up/Page Down keys will zoom in and out vertically. If 
you hold the Shift key while pressing Page Up/Page Down, you 
can move the graph up and down. Finally, if you press the End 
key, the graph will automatically scale itself to accommodate the 
currently active channel.

In graph mode, you can still add keyframes (use the popup menu 
through the right mouse button), delete keyframes, and move 
keyframes back and forth. In addition, you can move keyframes 
vertically - that is, change the value of keyframes. To restrict the 
movement of keyframes, hold down the Ctrl key while dragging 
keys to move them horizontally, or hold the Alt key to move 
them vertically.

Something that will become apparent in graph mode is that 
some channels have more than one value for every keyframe. 
For example, the Layer Translation channel has separate values 
for X, Y, and Z translation. These values will appear as separate 
curves in the graph, although they have the same color. Each 
of these curves is thicker than the last - the thinnest curve 
represents the X value of the channel, the medium Y, and the 
thickest curve, Z.
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Another thing you may notice when using animation cycling: A 
channel that cycles will have a repeating curve, without more 
keyframes after the one that cycles. This is illustrated in the 
above picture for the Layer Z Rotation channel.

For a hands-on example of using the timeline in graph mode, see 
the Tutorials section.

Actions Window 
In Anime Studio, “actions” are short clips of animation that can 
be inserted into the timeline and re-used over and over again. 
You might use actions to create little bits of animation that you 
don’t want to have to re-create each and every time you use 
them - for example, eye blinks, head turns, walk cycles, etc. The 
Actions window (as you may have guessed) is where you create 
and use actions. The Tutorials section of this manual will show 
you step-by-step how to use actions in Anime Studio.

When you start up Anime Studio, the Actions window is hidden. 
To bring it up, select “Actions” from the Window menu. The 
Actions window looks like this:  The Actions window

Across the top of the window are four buttons: New Action, 
Insert Reference, Insert Copy, Delete Action. Below the buttons 
is the actions list, which contains a list of all actions available for 
the current layer. New layers have no actions, just “Mainline”, 
which represents the main animation timeline.
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Creating New Actions

To create a new action, just click the New Action button. Anime 
Studio will prompt you to name the action. The new action is 
created in the current layer and, if the layer is a group-type layer, 
in all of its child layers.

Creating a New Layer

Editing Actions

To edit an action, double-click it - this will switch an action into 
editing mode. (When you create a new action, it also starts off in 
editing mode.) You can tell which action is in editing mode by 
the red arrow to its left, as seen below.

The Blink action in editing mode.

When you’re editing an action, you’ll also notice a couple things 
change in the Timeline window. First, the title bar of the timeline 
will indicate the active action. Second, the background of the 
timeline changes color to remind you that you’re editing an 
action, and not the main timeline.
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As you edit an action, the timeline works like normal, but instead 
of working on your main animation, you’re working on a little 
reusable clip. Actions by themselves do not appear in your 
final animation - they only appear if you use them in the main 
timeline. To switch back to the main timeline, double-click on the 
“Mainline” action in the actions window. (Mainline is not really 
an action - it’s just a way to refer to the main animation timeline.)

Using Actions

When you simply create actions, they won’t appear in the final 
animation - they need to be used in the main timeline. To use an 
action, you just need to insert it into the main timeline, which is 
a simple process. First, make sure the “Mainline” action is active 
(double-click it so that it has a red arrow next to it). Second, 
set the current time to the frame at which you wish to use the 
action. Next, click once on the action you wish to use to highlight 
it. Finally, click either the “Insert Reference” or “Insert Copy” 
buttons in the Actions window. This is what the Actions window 
would look like just before inserting the “Step” action:  Inserting an action.

If you insert an action by reference, Anime Studio will insert a 
special keyframe in the Mainline that refers back to the action 
you used. Later, if you make changes to the action, these changes 
will automatically be reflected in the mainline. On the other 
hand, if you insert an action by copy, Anime Studio will simply 
copy all of the keyframes in the action to the mainline, and they 
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will act just like other normal keyframes. If you later modify the 
action, any changes you make will not appear in the mainline.

If you create actions for objects in your scene you can assign 
shortcuts to those actions. You can assign the shortcut when you 
create an action, or you can right-click on an existing action and 
assign a shortcut.

The shortcuts make it easy to reuse the actions in an animation. 
You can press the shortcut keys while an animation is playing 
back to insert the action into the timeline. 

 Setting an Action Shortcut.

Deleting Actions

To delete an action, click once to make sure it is highlighted, then 
click the Delete Action button. When you delete an action, if that 
action was inserted by reference into the mainline at any point, 
those inserted references will also disappear. If you inserted the 
action as a copy, those copies will remain unchanged.

Creating Morphs

Anime Studio 8 allows you to blend several different morph 
targets together to create a combination of actions or effects. For 
further information on this feature, see “Blend Morphs” on page 
460.

To create morph that you can use with the Animation > Blend 
Poses command, choose Window > Actions to open the 
Actions window. This window allows you to create little reusable 
clips of single-frame animations.
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The Actions window.

To create a new morph, click the New Action button (the first 
button in the Actions toolbar). Enter a name for your morph in 
the Action Name dialog.

 Assign a name for your morph.

Then, move some points around in your scene to represent the 
morph that you are creating. The following shows an example of 
the scene before and after the Happy changes are made:
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 Default state (left) and Happy morph (right).

After you create your new morph, click the Mainline (top) line in 
the Actions window. The character should return to its default 
state. Select the Happy action again in the Actions window, and 
notice a single-frame action in the Channels tab of the timeline. 
Notice that all of the keyframes are on Frame 1. This is very 
important when blending poses. A general action can have as 
many keyframes as you like … but if you want to blend poses, the 
action can only contain a single keyframe at Frame 1.

 Select the Happy morph in the Actions window, and notice a single 
keyframe in the timeline

Continue creating additional actions that you want to blend 
together. In our demonstration, we have created two additional 
actions – Angry, and Sad – both shown in the following image. 
Note that your action can change keyframes for anything. In 
addition to moving some points, the Angry action also changes 
the color of the face. Now you should have a number of actions, 
all with single-frame animations that have keyframes on frame 1. 
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 You can morph any type of value. The Angry morph will change the 
color of the face in addition to changing the facial features.
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Anime Studio 
Menus
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File Menu

 File Menu

New
Creates a new, empty Anime Studio project.

Open...
Prompts you to open a Anime Studio project file that was 
previously saved to disk.

Open Recent
Displays a list of recent files that you can reopen.

Close
Closes the current project.

Save
Saves the current project to disk.

Your Anime Studio project is automatically saved 
every 30 seconds while you work, to a temporary 

location on your hard drive. If the application crashes, 
you will be asked if you want to reopen the previous 
project the next time you start Anime Studio.
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Save As...
Prompts you for a name and location, then saves the project to 
disk.

Gather Media
When you import something into an Anime Studio project, such 
as an image, movie, or audio file, the original locations of the 
imported objects are only referenced within the Anime Studio 
project. In other words, they are not actually part of the project 
file itself, rather the project file links to the files on your disk(s).

If your project contains many external files, we recommend that 
you place them in a common folder. When you do that, you have 
a self-contained folder that you can copy, archive, or move the 
project and the project will still work.

If you haven’t kept your files in a single folder, the File > Gather 
Media command allows you to create a single location for all 
related project files. This is very useful if you need to send 
your project to someone else for collaboration or for technical 
support. 

 Gather Media command

After choosing the command, you are prompted to select or 
create a folder in which to store the project-related files. You 
then enter a name for the gathered project and click Save to save 
it to the selected folder. When you look in the folder, you will see 
the Anime Studio project file, along with Audio, Images, and/or 
Movies folders that store the collected media associated with it. 
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Poser scenes will not get gathered, due to the 
complex structure of the Poser library folder 

hierarchy. 

 A Gathered Media folder

Project Settings...
Brings up the project settings dialog. As seen below, the project 
settings dialog lets you control the pixel width and height of the 
project, as well as the number of frames per second. You’re free 
to change these values at any time, although it’s easiest if you set 
up the values you want before you start creating your animation 
(particularly the frame rate). Also in this dialog, you can set the 
start and end frames of your animation, defining how long the 
overall animation will be.

 The Project Settings dialog

Dimensions

•	 Dimensions menu: Allows you to set Custom dimensions, 
or choose from a wide variety of presets. Presets include the 
following:

�� Custom: Allows you to enter or edit your own settings.

�� NTSC D1: 720 x 534 pixels, 24 frames per second
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�� NTSC D1 Widescreen: 872 x 486 pixels, 24 frames per 
second

�� PAL D1/DV: 788 x 576 pixels, 24 frames per second

�� PAL D1/DV Widescreen: 1050 x 576 pixels, 24 frames 
per second

�� HDV/HDTV 720p: 1280 x 720 pixels, 24 frames per 
second

�� HDV 1080p: 1440 x 1080 pixels, 24 frames per second

�� HDTV 1080p: 1920 x 1080 pixels, 24 frames per second

�� VGA: 640 x 480 pixels, 24 frames per second

�� Web: 320 x 240 pixels, 24 frames per second

�� Web Widescreen: 426 x 240 pixels, 24 frames per 
second

�� YouTube: 480 x 320 pixels, 24 frames per second

�� YouTube HD: 1280 x 720 pixels, 24 frames per second

�� iPhone: 480 x 320 pixels, 24 frames per second

�� iPad: 1024 x 768 pixels, 24 frames per second

�� Droid: 854 x 480 pixels, 24 frames per second

•	 Constrain Proportions: This option allows you to maintain 
the aspect ratio of your animation project. When the option 

is checked, you can enter a new width or height, and the 
other dimension will automatically change to maintain the 
same width-to-height aspect ratio. If you choose one of the 
preset configurations from the Dimensions drop-down list, 
it will ignore the Constrain Proportions option and resize 
your project to the dimensions specified in the selected 
preset.

•	 When you select a preset, the following settings appear 
below.

�� Width: The width, in pixels

�� Height: The height, in pixels

�� Frame Rate: The number of frames per second in the 
animation.

�� Start Frame: The starting frame of the animation.

�� End Frame: The ending frame of the animation.

Background Color

•	 Background Color: Sets a background color for the project 
- just click on the color swatch.
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Depth of Field

•	 Depth of Field: Depth of field simulates a camera, where 
a certain range of objects are in focus, while closer or more 
distant objects become blurry

�� Enabled: Check this option to enable or disable the 
Depth of Field feature in your project.

�� Focus Distance: The focus distance value is the 
distance from the camera to the plane of perfect focus.

�� Focus Range: Objects that are within the “focus range” 
distance of this plane will also appear in focus. For this 
feature to work correctly, you need to set up multiple 
layers with different depth values so that some can 
be in focus, and others out of focus. If you move the 
layers (or the camera) in your animation, the focus 
will automatically change based on distance from the 
camera.

�� Max Blur Radius: Sets a maximum value for the 
blurriness of your scene.

Render Style

The Render Style section allows you to select the type of 
rendering that will be performed when you choose the File 

> Preview command, or use the Cmd +R (Mac) or Ctrl+R 
(Windows) shortcuts.

The following settings are included in this section:

•	 Fill Style: Select the fill style that you want to use each time 
you render. Choices are Normal, None (same as turning the 
Fill option off in the Style window); Background; Back 
Transparent; Crayon; Hatched, and Pen. The preview 
window updates as you make your selections.
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 Global Fill styles

•	 Stroke Style: Select the stroke style that you want to use 
each time you render. Choices are Normal; None; Basic 
Black; Sketchy; Crayon; and Pen. The preview window 
updates as you make your selections. In addition, there is a 
Chalk style that is designed for use with a white stroke color 
on a dark background as shown below.

The Crayon style is also available as an effect in 
the Advanced view of the Style window. 

 Global Stroke styles.
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 Chalk Stroke style.

•	 Layer Style: Select the layer style that you want to use each 
time you render. Choices are Normal, Heavy Outline, and 
Cutout. The preview window updates as you make your 
selections.

 Global Layer styles.

•	 Minimize frame-to-frame randomness: If this option is 
not checked, styles like crayon will have lines that appear 
different on each frame, which can cause some distraction 
unless frame rates are lower and the effect is intentional. 
When you turn this option on, Anime Studio will try to use 
the same crayon strokes from frame to frame to reduce the 
amount of flickering.
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Other Settings

•	 Sort Layers by Depth: The “Sort layers by depth” checkbox 
allows top-level layers in Anime Studio to move in front 
of and behind each other during an animation. Normally, 
layers are drawn in the order they appear in the Layers 
window. However, with this option turned on, layers are 
displayed according to how far they are from the camera. 
See the Tutorials section for an example of using this 
feature.

•	 Sort by True Distance: Typically, layers are sorted by their 
depth from the camera, but if you’re trying to create a 3D 
object using multiple Anime Studio layers (like a cube or 
pyramid), you may want to turn on “Sort by true distance”. 
This tells Anime Studio to sort layers by the distance from 
the camera to the layers’ origins, rather than by depth. 
Usually this option will be left unchecked.

•	 Noise Grain: With the “Noise grain” field, you can set up 
some noise grain for the project. Noise grain is a subtle film 
grain-type effect that adds slight variations to the pixels in 
your project and leads to a more natural look to the final 
image. It can also increase the visual quality in some kinds 
of movie compression when you generate an animation. If 
you want to try out noise grain, a value of 16 is a good start 
for a subtle noise effect.

•	 Stereo Rendering: Use the Stereo Rendering dropdown to 
select the type of stereo rendering you want to perform:

�� None: Turns off stereo rendering capabilities.

3D Rendering settings should be set to None if 
you do not want to render out in a 3D format).

�� Red/Blue Anaglyph: When you render or preview your 
project with this setting enabled, you will see 3D objects 
rendered as a red/blue stereo pair. You will need special 
red/blue stereo 3D glasses to see the object in three 
dimensional space.

�� Side By Side (YouTube friendly): Produces two 
separate images rendered side by side in the same 
image, one for the left eye and one for the right eye. 

�� Cross-eyed: Looks similar to Side by Side, except that 
the left eye image is on the right side, and the right 
eye image is on the left side. This is the type of stereo 
rendering that YouTube expects.

Choose View > Stereo to see a live preview of the 
Red/Blue stereo effects. This makes it easier to 

preview and reposition your 3D objects

•	 Eye Separation: This setting controls how far apart the 
right and left eyes are when rendering two images for a 
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stereo rendering. If the value is too close, the 3D effect is 
lost. If the value is too far apart, the 3D effect will cause eye 
strain or won’t look as effective.

•	 Extra SWF Frame: Check this option to add an extra frame 
at the end of the video

 3D Stereo view

•	 Save as Defaults: When you create a new project in Anime 
Studio, your animation defaults to 320x240 pixels at 24 
frames per second. If you create most of your projects at 

different settings, you can change these defaults. Just type 
in new values in this dialog, and click “Save As Defaults” 
to make the new settings the default settings for all new 
projects.

•	 Restore Defaults: Resets the project to the default values.

Import
Anime Studio can import several kinds of other media files into 
an animation project. The commands in this sub-menu let you 
import these files.

•	 Anime Studio Object: This command will ask you to choose 
a Anime Studio project file. Once you’ve chosen a file, a list 
of layers in the project will show up in the dialog 
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 The Insert Object dialog

Select one of the layers to add it to your own project (a 
preview of the selected layer appears on the right side of 
the dialog). The entire layer will be copied into your open 
project, including any animation in the layer. This is an easy 
way to share objects between project files and reuse bits of 
animation here and there.

Several files are included with Anime Studio that contain 
scenery, characters, props, etc. You are welcome to include 
these in your own projects by using this menu command.

•	 Image Imports an image file as a new Image layer. The most 
common type of file to import into Anime Studio is images. 
It doesn’t matter how the images are created, so feel free 
to use pictures from digital cameras, backgrounds from 
scanned drawings or painted on the computer, textures, 
computer-generated 3D scenery, etc. The image formats 
supported by Anime Studio are: JPEG, BMP, Targa, GIF, 
and PNG. Generally, we recommend PNG, since the PNG 
format provides for variable levels of transparency, allowing 
you to create non-rectangular images that can blend in 
smoothly with other elements in the scene. 

•	 Movie: Imports a movie file as a new Image layer. Anime 
Studio supports importing QuickTime (Windows and Mac 
OS) and AVI (Windows only) movie files. A movie that you 
import into Anime Studio will play back along with the 
Anime Studio animation, allowing you to combine 2D and 
3D elements, or to composite an Anime Studio animation 
on top of a pre-recorded video sequence. On Windows, if 
you have problems importing QuickTime movies, then you 
probably need to download and install QuickTime (http://
www.apple.com/quicktime/). Anime Studio will also import 
native Moho files (files ending with .moho). 

•	 Adobe Illustrator File: (Anime Studio Pro only) Asks you 
to select an Adobe Illustrator (.ai) file (http://www.adobe.
com). Anime Studio will import the bezier curve shapes in 
this file into a new Anime Studio vector layer. These objects 

http://www.apple.com/quicktime/
http://www.apple.com/quicktime/
http://www.adobe.com
http://www.adobe.com
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can then be further edited and animated in Anime Studio. 
When creating a file in Illustrator, save it in Illustrator 8 (or 
earlier) format for use with Anime Studio. Anime Studio can 
import vector artwork created in other vector illustration 
programs. These files must be in either Adobe Illustrator or 
EPS format. If your files are in Illustrator format, make sure 
that you save them as Illustrator 8 (or earlier) format.

•	 EPS File: (Anime Studio Pro only) Imports an EPS 
(Encapsulated PostScript) file as a new Anime Studio vector 
layer.

•	 Tracing Image: (Anime Studio Pro only) Loads an 
image file to be used for tracing purposes. The image 
formats supported by Anime Studio are listed in “Product 
Comparison” on page 477. The Tracing Image command 
is the same thing as “Select Tracing Image” in the View 
menu.

•	 Audio File: Loads a sound file to be used as a soundtrack 
for the current animation. The audio formats supported 
by Anime Studio are listed in “Product Comparison” on 
page 477. This command is the same thing as “Select 
Soundtrack” in the Animation menu. Anime Studio has 
limited support for audio, but you can import a single sound 
file as a soundtrack for your animation. Anime Studio uses 
libsndfile to handle sound files (see http://www.mega-nerd.
com/libsndfile/), so any format that libsndfile supports is 

fair game. Generally, it’s best to stick with uncompressed 
WAV or AIFF files.

•	 OBJ 3D Model (Anime Studio Pro only) Imports a 3D model 
as a new Anime Studio 3D layer. Anime Studio can import 
3D files that are in OBJ format. More information about 3D 
layers can be found in “3D Layers” on page 277. Finally, 
Anime Studio can import 3D files created by 3D modeling 
programs. At this time Anime Studio can only import OBJ 
files, but it’s a quite common format, and most 3D programs 
can export to OBJ. OBJ files can include texture maps, and if 
your model uses one, Anime Studio will import and use it as 
well. If you’re new to 3D, and you’re looking for a program to 
create 3D models for use with Anime Studio, we recommend 
Poser (http://store.smithmicro.com/ProductDetails.
aspx?pid=10430).

•	 Poser Scene: If you already own Poser, you can import 
Poser scenes directly as discussed in “Poser Integration” on 
page 424. 

Improvements have been made to the 3D algorithms. When you 
import an OBJ file or Poser scene into Anime Studio, the edges 
are displayed better. 

http://www.mega-nerd.com/libsndfile/
http://www.mega-nerd.com/libsndfile/
http://store.smithmicro.com/ProductDetails.aspx?pid=10430
http://store.smithmicro.com/ProductDetails.aspx?pid=10430
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 Materials appear as Shapes in the Style window

They are also editable in the Style window. You can turn the 
stroke on or off, and adjust the width of the stroke. 

Many OBJ files and Poser objects have multiple 
materials. The multiple materials will show up 

as Shapes in the Style window. Select a material from 
the Shapes dropdown (discussed in “Tutorial 3.1: Bone 
Binding” on page 66) and change material settings if 
desired. If you select None from the Shapes dropdown it 
controls the default material and stroke.

 Materials appear as Shapes in the Style window

When you are using a 3D layer, you can open the Layers 
window and go to the 3D Options tab to control some 
additional properties. See “3D Options” on page 335 
for more information.

Real-Time Media Connection

New in Anime Studio 8 is a “live linking” feature. What this 
means is that you can import images, movies and sound files and 
you can then edit them in their native editors without worry. Any 
edits you make later in third party editors will automatically be 
recognized and updated within Anime Studio. 
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Real-time media connections, combined with Photoshop 
layer support on import, provide an exceptional way to design 
characters and other content for your Anime Studio scenes. For 
more information on Photoshop support, see “About Photoshop 
Layer Support:” on page 430.

Poser Integration
Anime Studio 8 allows you to import Poser scenes into your 
Anime Studio projects. In order for this feature to work, Poser 
7 or later must be installed on your system, and content used in 
your Poser scene must be installed into a Library folder that is 
recognized by your Poser application.

Choose File > Import > OBJ 3D Model. You will be allowed to 
choose OBJ files or Poser scenes (PZ3). Locate the file that you 
want to import. After a brief wait, the Poser file will be imported 
into your scene. It appears as a 3D layer, so you will be able to 
control the appearance of the Poser content by opening the Layer 
Settings dialog and clicking the 3D Options tab.

 An imported Poser object

Poser must be installed in order for the Poser 
integration features to work.

When you rotate the integrated Poser content, the display of 
the character switches to Box mode to reduce demand of your 
computer resources. 
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The Poser integration features also import any animation 
associated with the Poser scene. The Poser tool, located in 
the Layer section of the tool box, allows you to select a Poser 
figure or actor (such as a body part) within the scene, and then 
modify the parameters of the selected item. You will be able 
to edit many of the same parameters as you can in Poser. For 
example, you can select a body part and then adjust the Bend, 
Twist, Front-Back, or Side-Side parameter to rotate the body 
part to a different position. You can also use the Window > 
Poser Parameters command to open the Parameters window for 
the selected body part. When you move a body part, keyframes 
appear in the timeline. 

If the Poser project used a BVH motion capture 
file to generate the animation on the character, 

you will see keyframes on every frame. You can select 
and delete some or all these keyframes and edit the 
animation within Anime Studio if desired. A new 
keyframe will be added at any point in the timeline when 
you make a change in the Poser Parameters palette.

After importing the Poser scene, you may notice 
a difference in the time length of your animation 

after you import into Anime Studio. Poser’s default 
frame rate it 30 frames per second, whereas Anime 
Studio’s default frame rate is 24 frames per second. To 
make the time match up to that created in the Poser 
program, choose File > Project Settings, and set the 
frame rate of your Anime Studio project to 30 frames 
per second.
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 Use the Poser Parameters window to adjust scale or position of 
body parts.

Import Notes and Tips

Referenced Files

Please note that Anime Studio references the directory location 
of images, OBJ’s, sound files and movies files that have been 
imported for use. When exporting into movie format, Anime 
Studio continues to reference this directory location. Moving 
referenced items from one location to another will prevent the 
item from being displayed or heard. We recommend that all 
items used in your animations or artwork accompany it’s native 
file format (ANME) and final exported format.

Startup Folder

Adding your own .anme file to the “Startup Folder” (located in 
the root directory of your Anime Studio installation) will always 
make Anime Studio open this .anme document first when it’s 
initially launched. Please make sure to rename your .anme file to 
“StartupFile.anme”.

Moho Files

Anime Studio will also import native Moho files (files ending with 
.moho).
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Library Content

Please read Section 6 of the EULA (End User License 
Agreement) for rules on using the content that has been 
supplied with your version of Anime Studio. Please note that 
when importing existing content/movies from the Anime 
Studio Content Library using the File > Import option, some 
animations/movies exceed the default “End Frame”. This will 
prevent you from seeing the full movie. To adjust the default 
“End Frame” settings, please select File > Project Settings and 
change the field beside “End Frame”. The default is typically 
72 frames. You can also double click the movie/content file you 
would like to view from within the Content Library. To access the 
Library, select Help > Open Content Library.

The Library content files (characters, props, etc.) 
are installed in a shared documents location on 

both Windows and Macintosh. This allows multiple 
users on the same computer to share library resources, 
and to install additional content that they might 
download (from Content Paradise, for example). On 
Windows systems in particular, it can be difficult to add 
new files to the Program Files directory when running 
newer versions of the Windows operating system, which 
is why the shared documents location is used.

Importing 3D OBJ’s (Anime Studio Pro only)

Please note that loading 3D OBJ files may take some time. 
Loading times depend on the complexity of the OBJ file.

Photoshop Tips

Importing Photoshop Files

When you use the File > Import > Image command to import a 
Photoshop file into Anime Studio, a dialog will ask how you want 
to handle the layer import within Anime Studio. 

 Photoshop images can be imported with individual layers, or as a 
composite image.

The choices are:
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•	 Individually: Choose this option if you want to retain the 
Photoshop layers when you import your Photoshop file. 
Each Photoshop layer will appear in the Layers window 
and will be named exactly as they are named in the original 
Photoshop file. You will be able to show and hide the layers 
individually within Anime Studio in the same way that you 
can in Photoshop, and you will be able to use the Anime 
Studio tools to modify or animate the layers.

 Photoshop layers shown in Photoshop.

 Photoshop layers shown in Anime Studio Pro.

Further, you can group layers in Photoshop that can be 
interpreted as layers in Anime Studio. For example, you 
can create a Photoshop group that contains various mouth 
positions. If you make only one of those mouths visible in 
the group before you import the Photoshop file into Anime 
Studio, the other layers in the group will be configured as 
switch layers for the visible mouth when it appears inside 
Anime Studio.
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 Mouth group in Photoshop (with one mouth layer visible).  Mouth group in Anime Studio Pro (with the same mouth layer 
visible).

There will also be a live connection between Anime Studio 
and Photoshop, such that if you make changes to the 
Photoshop file and resave it, the changes will also appear in 
your Anime Studio project. 
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The opacity of a Photoshop layer will be baked in 
Anime Studio when imported. In other words, if 

the opacity of a layer was set to 50% in Photoshop, 
Anime Studio will see that as the 100% value. You will 
not be able to increase to 100% in Anime Studio.

•	 Composite: Choose this option if you want the Photoshop 
file to be combined into a single image layer in Anime 
Studio.

About Photoshop Layer Support:

When importing a PSD file, you have the option to load layers 
individually or load the composite as a single layer.

The live linking feature between Photoshop and 
Anime Studio may work unexpectedly in certain 

situations. The live link works as expected when layers 
are edited and left visible in Photoshop. However, the live 
link may work unexpectedly after importing into Anime 
Studio if you later move, delete, or hide layers in 
Photoshop and then return to Anime Studio.

Photoshop has many features, and not all of them are supported 
within Anime Studio. In general, standard 8-bit RGB files with 
regular pixel layers are the best way to go for compatibility.

Anime Studio has been tested with several Photoshop examples, 
and the following Photoshop features are known to work within 
Anime Studio:

•	 Blending modes are supported

•	 Layer opacity is supported

•	 Groups are supported. Groups where only one child of the 
group is visible come in as switch layers.

•	 Smart objects and smart filters do work internally to the 
PSD. They store a flat representation of themselves.

The following Photoshop features are not supported in Anime 
Studio:

•	 Layer effects are not imported.

•	 Any layer that has a mask in Photoshop gets skipped.

•	 3D layers, text layers, and other kinds of non-basic or non-
pixel layers cannot be imported.

•	 Layers that have visibility turned off in Photoshop will have 
their names grayed out in the Anime Studio Layers palette.
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Exporting from Photoshop 

Anime Studio is equipped with a Photoshop export script that 
will give you the ability to take your PSD files and export them 
into .ANME format. The .ANME format is the native Anime 
Studio format. This process helps users from having to re-draw 
or export individual layers as images into Anime Studio.

The PSD to ANME script is named Export Layers To Anime 
Studio.jsx. To access this script, please make sure you’ve 
installed Anime Studio. The script is available in the installation 
directory of Anime Studio, in a folder labeled Extra Files.

To use the script within Adobe Photoshop, please make sure 
you have it installed on your computer. Copy the Export Layers 
To Anime Studio.jsx file to your .../Photoshop/Presets/
Scripts folder. You should then be able to open up a Photoshop 
document, run this script from File > Scripts > Export Layers 
to Anime Studio, and it will generate a new Anime Studio file 
complete with an image layer for each original Photoshop layer. 
Basically, the script converts PSD formatted files to .ANME 
files. It exports every layer that was created originally in Adobe 
Photoshop and makes it completely readable when imported into 
Anime Studio. All versions of Adobe Photoshop since version 7 
should support this script.

The script exports the following 2 things: Firstly, it converts the 
PSD file into a .ANME file. Secondly, all the individual layers 
of the PSD file are converted into individual PNG files and are 

placed in a folder of the same name as the .ANME file. The 
folder with the PNG’s and the newly converted .ANME file will 
be located side by side. It is important to note that whenever 
you open the .ANME file, it will reference the PNG folder. So 
please keep them side by side. If the PNG folder and the newly 
converted .ANME are not located in the same folder, the layers 
within your newly opened .ANME will not work properly in 
Anime Studio.

Preview
Generates a preview image of what your project will look like. 
If you’re in the process of animating your project, the image 
will be of the current frame in your animation. A preview image 
does not contain all the fill styles, and is of lower quality, but is 
quicker to generate than a fully rendered image.

When the Preview window opens up to display your work, you 
can save the preview as a still image, using the popup menu in 
the Preview window.

Exporting Movies
Most often, you’ll export an animation as a movie file. You have 
two choices:
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•	 QuickTime (Windows and Mac OS): QuickTime is a very 
flexible format for working with movies. We generally 
recommend using QuickTime with the Sorenson 3 codec 
for the best combination of low file size and quality. If 
you choose QuickTime, Anime Studio will also export the 
soundtrack (if you have applied one to the animation). On 
Windows, if you don’t see QuickTime as an option, then you 
need to download and install QuickTime at http://www.
apple.com/quicktime/.

•	 AVI (Windows only): On Windows you can also export 
movies in AVI format.

When exporting a movie, Anime Studio will include an alpha 
channel if the codec you’re using supports it. This makes it 
possible to composite Anime Studio movies with other media in a 
video editing program.

If you’re using QuickTime, set the color depth to “Millions of 
Colors+”. The “+” is QuickTime’s indication of an alpha channel. 
The codecs that support this include Animation, None, PNG, 
TGA, and TIFF.

AVI on Windows doesn’t include any built-in codecs that support 
alpha channels. However, at least one such codec does exist, and 
you can download it for free - the Huffyuv codec found at http://
neuron2.net/www.math.berkeley.edu/benrg/huffyuv.html.

Anime Studio can only export to a maximum size of 768 pixels 
x 768 pixels and 3000 frames. (Anime Studio Pro does not have 
this limitation.)

Export Animation...

This command brings up a dialog that lets you export an 
animated sequence and save it to disk. The Anime Studio project 
file is where your work is saved, but to view the animation as a 
movie, to put it on the web, or to work with it in other programs, 
you have to export the animation.

http://www.apple.com/quicktime/
http://www.apple.com/quicktime/
http://neuron2.net/www.math.berkeley.edu/benrg/huffyuv.html
http://neuron2.net/www.math.berkeley.edu/benrg/huffyuv.html
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 The Export Animation dialog.

The dialog asks for a starting and ending frame (these default 
to the entire animation), and an output format. You can output 
a sequence of frames, a movie file, or a Flash SWF file. Anime 
Studio will then ask you where to save the result. Once the 

animation begins exporting, you are free to keep working while 
the animation is being drawn. A progress bar at the top of the 
animation window will inform you of the export progress.

The Export Animation dialog also has several options for 
adjusting the output quality of your animation. These default 
to the highest quality rendering, but you may sometimes want 
to lower the quality to increase rendering speed or to output 
animations with smaller file sizes for streaming over the internet. 
The rendering quality options available are:

•	 Start Frame: Enter the start frame for your exported movie 
here.

•	 End Frame: Enter the end frame for your exported movie 
here.

•	 Entire Animation: Press this button to reset the start and 
end frames to include all frames in the movie

•	 Output Format: Choose from AVI Movie, QuickTime Movie, 
or Flash (SWF). You can also export sequenced image files 
in JPEG, BMP, Targa, PNG, or PSD formats.

•	 Antialiased edges (Anime Studio Pro only): Normally, 
Anime Studio renders your shapes with smoothed edges. 
Uncheck this box to turn this feature off.
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•	 Apply shape effects (Anime Studio Pro only): If this box 
is unchecked, Anime Studio will skip shape effects like 
shading, texture fills, and gradients.

•	 Apply layer effects: If this box is unchecked, Anime 
Studio will skip layer effects like layer shadows and layer 
transparency.

•	 Render at half dimensions: Check this box to render a 
smaller version of your movie. This makes rendering faster 
if you just want a quick preview, and is useful for making 
smaller movies for the web.

•	 Render at half frame rate: Check this box to skip every 
other frame in the animation. This makes rendering faster, 
and results in smaller movie files.

•	 Reduced particles (Anime Studio Pro only): Some particle 
effects require hundreds of particles to achieve their effect. 
Check this box to render fewer particles. The effect may not 
look as good, but will render much faster if all you need is a 
preview.

•	 Extra-smooth images: Renders image layers with a higher 
quality level. Exporting takes longer with this option on.

•	 Use NTSC-safe colors: Automatically limits colors to be 
NTSC safe. This is only an approximation - you should still 

do some testing to make sure your animation looks good on 
a TV monitor.

•	 Do not premultiply alpha channel: Useful if you plan to 
composite your Anime Studio animation with other elements 
in a video editing program.

•	 Variable line widths (SWF) (Anime Studio Pro only): 
Exports variable line widths to SWF. See “Exporting Flash” 
on page 434 for more information about variable width 
lines and Flash.

Exporting Flash

Anime Studio can also export Flash files in SWF format. Flash is 
a common vector animation format on the Web. When exporting 
Flash, Anime Studio will also include the soundtrack (if any), if 
the soundtrack is in MP3 format. If you plan on exporting Flash 
files, it is important to read “How to Create Efficient Flash Files” 
on page 436.

If you plan to export your animations to Flash 
(SWF) format, you will need to use MP3 audio 

files instead of WAV audio files. In addition, if you plan 
to render to SWF format, you can only use a single audio 
file in the project.
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Flash Tips

Advice for working with Anime Studio and Flash 

Among the other export formats that Anime Studio offers, you 
also have the option to output Flash SWF files. SWF is a format 
created by Adobe as a way to deliver animated vector artwork 
and interactive applications. Flash animations are very common 
on the web, and most users already have the Flash player 
installed on their computers. Because Anime Studio is also 
vector-based, there are enough similarities to make it possible 
for Anime Studio to export SWF files.

However, Anime Studio and Flash are not completely 
compatible. Therefore, not all the features of Anime Studio can 
be exported successfully to Flash. In addition, because Flash is a 
web format, small file size is important - there are certain issues 
to keep in mind when working with Anime Studio if Flash is your 
intended output format.

When exporting SWF files, you may want to use Macromedia’s 
Flash authoring tool to combine multiple SWF files, add extra 
elements, sound, etc. Be aware that Anime Studio’s SWF files are 
compatible with Flash MX and later - Flash 5 and earlier are not 
able to load Anime Studio-created SWF files.

What Can be Exported

Most common objects in Anime Studio can be exported to Flash. 
These include:

•	 Vector layers

•	 Fills/Outlines/Colors

•	 Transparency

•	 Gradients

•	 Variable-width lines (try to use these sparingly - see below)

•	 Bone warping of vector layers

•	 Image layers (PNG and JPEG only, and only if they are not 
warped by a bone layer)

•	 Particle layers (careful - a complex particle effect can easily 
overwhelm Flash)

•	 A soundtrack can be exported if it’s in MP3 format, and at 
either 44100 Hz, 22050 Hz, or 11025 Hz sample rate. If you 
want your SWF file to contain audio, make sure that your 
project contains only one audio track, and that the audio 
track is in MP3 format. In order for Anime Studio to play 
MP3 format audio files, you must have QuickTime installed

What Can’t be Exported

On the other hand, some things in Anime Studio are just not 
compatible with Flash, and cannot be exported to a SWF file. 
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The following list covers the most important of these objects and 
effects.

•	 Brushes

•	 Fill and line effects (except gradients)

•	 Layer effects (shadows, shading, layer blur, motion blur, 
etc.)

•	 Image warping or 3D movements in image layers

•	 Image layers that use progressive JPEG images (Flash can’t 
handle progressive JPEG images)

•	 Layer masking

•	 3D layers

•	 Multiple audio tracks, or audio tracks other than MP3 
format

How to Create Efficient Flash Files

When you’re creating an animation with the intent to produce an 
SWF file as output, there are several things to keep in mind. An 
important concern with SWF files is keeping the file size down. 
The key way to do this in Anime Studio is to keep as many layers 
“optimized” as possible. An optimized layer when exported to 
SWF will take up much less space than a non-optimized one. (For 

other formats, like QuickTime or AVI, it doesn’t matter.) You can 
tell which layers are optimized by looking for a little red dot next 
to the layer’s icon in the Layers window:

 Notice the red dot by the optimized layer.

A new layer is optimized to start with, but depending on the 
effects you apply, that optimization can go away. The following 
things will “de-optimize” a layer. Note: a non-optimized layer will 
still export to Flash, it just won’t be nearly as efficient.
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•	 3D camera movements (this will de-optimize all layers in the 
project, so it should be avoided if possible when targeting 
SWF)

•	 3D layer rotation (X or Y rotation, or perspective rotation)

•	 Layer shear

•	 A group layer that has 3D rotation or shear will cause all of 
its sub-layers to be non-optimized

•	 Uneven scaling in the X and Y directions

•	 Point animation

•	 Bone animation is a common cause of non-optimized layers. 
What’s happening is that because Flash doesn’t have a bone 
system like Anime Studio, Anime Studio needs to export a 
lot of extra information for Flash to be able to produce the 
same effect. One way to use bone animation and to stay 
optimized is to attach a vector layer to a single bone, instead 
of letting the bones warp all the points in the vector layer. 
The vector layer will then remain optimized. While you can’t 
do this in all cases, sometimes you can break up a character 
into multiple body parts - some parts will be warped with 
the bones, and some will be attached to a single bone. At 
least some parts of the character can remain optimized.

Here are some other things to think about when exporting to 
SWF:

•	 Consider using a lower frame rate (12 fps, for example) for 
your animation. Fewer frames means a smaller file.

•	 If some of your layers can do without any animation at all, or 
just layer translation/scaling/rotation (background scenery, 
props, background characters, etc.), that can save a lot of 
space.

•	 If most of a layer is stationary, except for one small object, 
move that object into its own layer if possible. Example: 
a character who is waving his arms, but is otherwise still 
- move the arms into a separate layer from the rest of the 
body. The body will remain optimized and take up much less 
space.

•	 If an object sits still for a time with no animation, consider 
replacing it with a non-animated object for that time period.

What to Avoid

If your goal is to create a SWF animation, there are some things 
you should try to avoid. Besides the effects that just are not 
possible to export, you should try to avoid the following effects if 
possible. These are all things that can be exported - it’s just that 
they make for a less efficient SWF file. Of course, you won’t want 
to avoid all of these things all of the time. However, if you plan 
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your animation carefully, and use as few of the following effects 
as possible, the resulting SWF file will be smaller, and will load 
quicker over the web.

•	 3D camera moves - no Flash optimization is possible when 
you’re moving the camera around in 3D. Simple side-to-side 
pans and zooms are OK, but when you start using camera 
pan/tilt, Flash efficiency goes down the drain.

•	 Try to use as few control points as possible in your vector 
artwork.

•	 The freehand tool and the insert text dialog can generate a 
lot of points, resulting in a big SWF file.

•	 Limit the use of variable-width lines. It’s easy to overwhelm 
Flash with the complexity of variable-width lines, making the 
resulting SWF file play back unpredictably. Read “How Big 
Can a Flash Movie Be?” at http://kb2.adobe.com/cps/144/
tn_14437.html for more information. If possible, only use 
variable-width lines in SWF-optimized layers.

•	 Avoid compound shapes (two adjacent circles filled as one, 
shapes with holes, or figure 8’s).

Exporting Still Images (Anime Studio 
Pro only)
Finally, you can export an animation as a sequence of numbered 
still images. This option is not used very often, but sometimes 
for certain post-processing tasks, you may prefer to work with 
a sequence of separate still image files. You can choose between 
JPEG, BMP, PSD, Targa, or PNG.

Export OBJ
If your scene contains 3D objects, including those that you have 
converted from 2D to 3D with Anime Studio’s 3D Conversion 
feature (see “3D Options” on page 335), you can use the File > 
Export OBJ command to save the objects to WaveFront OBJ 
format. You will be prompted to enter a file name and choose a 
location for the exported OBJ file.

Export POV
You can use the File > Export POV command to export 3D 
objects from Anime Studio to POV format, which is compatible 
with POV-Ray, a free raytracing application that produces high 
quality 3D renderings. For more information about POV-Ray, see 
http://www.povray.org/.

http://kb2.adobe.com/cps/144/tn_14437.html
http://kb2.adobe.com/cps/144/tn_14437.html
http://www.povray.org/
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Upload to YouTube
The File > Upload to YouTube command allows you to upload 
your Anime Studio animation to YouTube. After choosing the 
command you are prompted to locate the animation that you 
want to upload. Before performing the upload, you will need 
to enter your YouTube Username and Password in the Web 
Uploads tab of the Preferences dialog, as discussed in “Web 
Uploads:” on page 444.

Upload to Facebook®
The File > Upload to Facebook command allows you to 
upload your Anime Studio animation to your page on Facebook. 
After choosing the command you are prompted to locate the 
animation that you want to upload.

Before using this features, you will need to sign 
in to your Facebook account and authorize 

Anime Studio as an application that can upload to your 
Facebook account. 

After logging in to your Facebook account and choosing 
the Upload to Facebook command, your browser will 
display a screen that prompts you to allow the Smith 
Micro Software Video Uploader to upload files to your 
Facebook account. Click the Allow button to enable this 
feature, and then the upload will continue. You should 
only need to authorize the uploader the first time you 
use it

Batch Export... (Anime Studio Pro 
only)
Anime Studio’s batch export window lets you line up several 
Anime Studio project files to be exported one at a time. This is 
very convenient when you’re working on a large project with 
separate project files for different scenes, and you want to render 
them all at once (like during lunch maybe). The batch export 
window has many of the same controls as the Export Animation 
dialog:
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 The Batch Export window.

To queue up files for batch export, drag the Anime Studio files 
into this window, and they will appear in the list view at the 
bottom. You can remove a file from the queue by selecting it and 

pressing the Backspace or Delete keys (this will not delete the 
file from your system, just remove it from batch export).

You can change rendering options by selecting a file and then 
changing the options at the top of the window. The options that 
are set before you queue up any files will apply to all the files as 
you add them. The output file format you select will be the same 
for all files in the batch.

When all your files have been added and the options set, press 
the Start button to begin batch export. The window will display 
the progress of each file as it is exported. When a file is finished 
and disappears from the list, you can find the rendered result in 
the same folder as the Anime Studio file itself.

Quit
Quits Anime Studio. Prompts you to save any unsaved projects.
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Undo
Choose this command to undo the last operation. You may undo 
up to 8 of your most recent editing operations in Anime Studio.

Redo
This command will redo the last operation that you “un-did” 
with the Undo command.

Cut, Copy, Paste
These are the traditional clipboard commands. They can be 
used together with the Draw editing tools for vector layers, and 
operate on the currently selected group of points.

Clear
This command is the same as pressing the backspace or delete 
key: the currently selected object in the working area will be 
deleted from the project.

Select All
Selects all the points in the active vector layer.

Select None
De-selects all the points in the active vector layer.
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Select Inverse
Selects the opposite points in the active vector layer. Selected 
points will become de-selected, and de-selected points will 
become selected.

Select Connected
Selects all points that are connected to any other currently 
selected points. For example, if you have a complex shape like a 
character’s head, just select a few points on it, then choose this 
command: if all the points on the head are somehow connected 
together, the whole head will now be selected.

Preferences...

Mac users will find the Preferences command in 
the Anime Studio menu category.

Brings up a dialog that lets you customize some aspects of Anime 
Studio, such as the display colors used in the working area of the 
Anime Studio window. Some of these features including Edit 
Colors and GUI Colors are only available in Anime Studio Pro.

Options Tab

 Options

•	 Auto-assist with bone locking keyframes: Adds an extra 
keyframe when bones are locked or unlocked to prevent 
them from “drifting”.
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•	 Scale compensation for new layers: When a layer is 
scaled up (or down), its lines get thicker (or thinner) to 
match. If you don’t want this behavior, turn off this option. 
You can also control this on a per-layer basis in the Layer 
Settings dialog. This option controls it for any new layers 
you create.

•	 Show paths for new layers: Determines whether the paths 
(previously called construction curves) are displayed for 
new layers. They’re always shown for the selected layer, but 
usually hidden otherwise.

•	 Auto-name bones and shapes: Bones and shapes can be 
named by the user. If this is turned on, all bones and shapes 
get names like “1”, “2”, etc.

•	 Zoom with drag box: When this option is on, allows you 
to draw a box around the area that you want to zoom into, 
rather than using a continuous zoom.

•	 Consolidate timeline channels: Instead of showing 
separate channels (point animation, bone animation, 
layer translation, layer rotation, etc.), this option groups 
all channels into one in the timeline palette. This is on by 
default in Debut, and off in Pro.

•	 Status bar at top of window: Shows the status bar at the 
top of the window, rather than the bottom. The status bar 

is where tools show their descriptions, like what modifiers 
keys do what, etc.

•	 Use old library: Check this option if you prefer to use the 
library format used by Anime Studio version 6 or earlier.

•	 Highlight frame 0: If on, a red box is drawn on the canvas 
if the current time is set to 0. This can be helpful to remind 
you when you’re working on frame 0 (the setup frame) vs. 
some other frame.

•	 Enable drawing tools only on frame 0: Creation tools 
(Add Point, Freehand, Draw Shape, Add Bone) are only 
available on frame 0 if this option is on. Otherwise, they can 
be used at any time.

•	 Use SMPTE timecode: Shows time in the timeline using 
SMPTE timecode instead of frame numbers. SMPTE 
timecode looks like this: 00:02:34:07 That would be 0 
hours, 2 minutes, 34 seconds, and 7 frames.

•	 Show angles in degrees in timeline: Angle values (like 
layer rotation or bone rotation) are shown in radians in the 
timeline’s Motion Graph. This is because angle values in 
radians are smaller numerically and fit in better with other 
values in the graph. But if the user chooses to, they can 
display these curves using degrees with this option.
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•	 Disable custom tool cursors: A long time ago there was 
a bug on some Windows systems where tool cursors didn’t 
display correctly. Turning on this option will just use the 
standard system arrow cursor, regardless of what tool is 
active on the canvas. It may not be needed anymore (I’m not 
sure if that bug happens for anyone these days).

•	 Disable audio feedback: When welding points, you hear 
a “clicking” sound in Anime Studio. Turning this option on 
will disable the click.

•	 Legacy curves for new layers: When checked, uses the 
old style curves, rather than the smoother curves found in 
Anime Studio 8. 

•	 Nearest neighbor sampling for new image layers: When 
an image is scaled up larger than its original size, Anime 
Studio will try to smooth out the areas in between pixels to 
create a smoother image. Turn this option off if you want the 
enlarged image to appear blocky.

•	 Auto save for crash recovery: When turned on, Anime 
Studio will automatically save your work every thirty seconds 
to a temporary file. If the application crashes, you can 
recover your work the next time you start the application. In 
the event that you are working on very large files and your 
workflow is slowed down by saving every thirty seconds, you 
can turn this option off to improve performance.

•	 Default Interpolation: For any new keyframes you create, 
this sets what the interpolation type will be for that key. 
Smooth is the default, but some advanced users have 
interesting uses for setting the default to something else. The 
available options are Smooth, Linear, Step, Ease In/Out, 
Noisy, Ease In, or Ease Out.

•	 Startup File: Allows you to start Anime Studio with a default 
startup file, an empty document, or a specified project file.

•	 Poser Location: Allows you to specify the location of the 
Poser executable.

Web Uploads:

This tab is used to enter your YouTube user account name 
and passwords. Anime Studio will log into this account to post 
YouTube videos when you select the File > Upload to YouTube 
command to send a project file to another person.

Enter the following information:

•	 Username: Enter your YouTube user name.

•	 Password: Enter your YouTube password.

•	 Private uploads: Check this option if you want your Anime 
Studio uploads to be private uploads rather than public 
uploads.
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 Web Uploads

Editor Colors:

Allows you to change the color scheme for the editor window, 
including various options for background and object colors. 
Press the Reset button to return to default application colors.

 Editor Colors
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 Editor Colors

GUI Colors: 

Allows you to change the color scheme for the application, 
including various options for background, text, and widget 
colors. A preview of your changes appears in the Sample Widget 
area as changes are made.

•	 Click the Color Theme button at the top of the GUI Colors 
tab to choose from one of several different color schemes. 
You can then modify the color scheme further if desired. 

•	 Press the Reset button to set the color scheme back to the 
default settings.

•	 Check the Use Large Fonts option to increase the size of the 
fonts used in the application.
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 GUI Colors
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Insert Text...
A dialog will pop up with controls to type in some text and choose 
a font. When you click OK, the text will appear as a set of curves 
in Anime Studio. These curves are just like any drawing in Anime 
Studio - you can manipulate them with any of the Anime Studio 
tools, like any other object. There is also a checkbox that lets you 
decide whether to create the text as a single fill, or as separate 

fills for each character (in case you want to color/style them 
differently). The text will be filled using the current fill color/
style.

There is no font size control when you create the text: the Anime 
Studio scale tool should be used to control the size of the text 
after you create it.

Snap to Grid
If the grid is turned on in the working area, then this command 
can be used to snap all selected points to the nearest grid 
intersection.

Reset Line Width
Using the Line Width tool, you can adjust the width of a line at 
any point. Choosing this menu command will reset your custom 
line widths at any selected points.

Random Line Width
Use this command to randomize the width of the line(s) through 
the currently selected points. You will be asked to specify the 
minimum and maximum width, and Anime Studio will assign 
random line widths within that range.
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Peak
This command creates a peaked (or hard) transition between the 
curves at the point that you click.

Smooth
This command smooths the transitions between the curves at the 
point that you click.

Raise Shape
Select this menu item to raise a shape in the stacking order. This 
will move it in front of the next higher shape. The stacking order 
only applies to shapes within the same layer - all shapes in a 
layer will appear above any lower layers and behind any upper 
ones, regardless of stacking order. Note that if there is no shape 
overlapping the selected one, you may not see any change when 
this item is selected, even though the shape gets moved higher.

Lower Shape
Select this menu item to lower a shape in the stacking order.

Raise to Front
Works like Raise Shape, but raises the shape above all others in 
its layer.

Lower to Back
Works like Lower Shape, but lowers the shape below all others 
in its layer.

Trace Image
Anime Studio has always allowed you to import black and white 
or color bitmap images and work with them. However, they are 
not as flexible as vector objects for several reasons. You can’t 
zoom in an infinite amount, you can’t bend them quite as much, 
and you can’t edit them. Anime Studio 8 now includes Automatic 
Image Tracing, which allows you to convert a black and white or 
color bitmap image to a vector object.

For this feature to work its best, you should choose drawing 
that have bold lines, such as those created with a felt pen. Pencil 
sketches will be more difficult to trace. 

After you import your drawing into an Image layer, you can use 
the Draw > Trace Image command to display the Trace Image 
dialog. The Trace Image dialog contains the following settings.
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 Trace Image dialog.

•	 Conversion type selection: Choose one of the following 
radio buttons, based on the type of image you are importing:

�� Black and white: Check this option if your source 
image is black and white, or if you want to create a black 
and white vector image.

�� Color: Check this option if your source image is color 
and you want to create a vector image that is also color.

�� Photo Edges: Check this option if your source image 
is a line drawing and you only want to convert it to 

strokes; or if you want Anime Studio to only draw 
strokes where one color meets another color.

Tracing Black and White

You can convert either a color or a black and white image to a 
black and white vector layer. When you choose a Black and White 
conversion, the following settings are available:

•	 Threshold: Adjusting the Threshold value can help remove 
unwanted gray from the black and white conversion. Move 
the slider toward the left to allow less gray, or toward the 
right to allow more gray.
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 Low threshold (left); high threshold (right).

•	 Detail reduction: Move the slider toward the left to add 
more detail to the vector layer. This will increase the number 
of points in the object and make it harder to edit, but it will 
look more like the original image.

 Maximum detail (left); reduced detail (right).

•	 Fatten Lines: When Black and White is selected as an 
image type, this option controls the width of the lines in the 
black and white drawing. Move the slider toward the left 
to decrease the width, and toward the right to increase the 
width.
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 Default lines (left); thickened lines (right)
 A close-up of the traced result

After you click OK, Anime Studio traces the image and adds 
a new vector layer to the Layers palette. The image layer that 
contains the original bitmap image is turned off. 

The Automatic Image Tracing feature remembers 
your last settings. If you are not quite happy with 

the results that you get, you can return to the Trace 
Image dialog and tweak your settings.
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Tracing Color

When you choose a Color conversion, the following settings are 
available:

•	 Number of Colors: Move the slider toward the left to 
reduce the number of colors in the traced result. Move the 
slider toward the right to increase the number of colors. As 
you move the slider, the number of colors that will appear in 
the traced result will display above the slider.

 4 colors (left); 5 colors (right).

•	 Detail reduction: Move the slider toward the left to add 
more detail to the vector layer. This will increase the number 
of points in the object and make it harder to edit, but it will 
look more like the original image.

 Maximum detail (left); reduced detail (right).

•	 Outlines: When converting to a Color vector layer, you can 
check this option to also convert outlines in the drawing, or 
uncheck the option to omit the outlines.
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 A close-up of the traced result

After you click OK, Anime Studio traces the image and adds 
a new vector layer to the Layers palette. The image layer that 
contains the original bitmap image is turned off. 

Tracing Photo Edges

To create a vector image that only contains the outlines in your 
original bitmap, check the Photo Edges option at the top of 

the Trace Image dialog. You are presented with the following 
settings:

•	 Threshold: Move the slider toward the left to accept less 
outline, or toward the right to accept more outline.

Hide Shape
Hides the currently selected shape

Show All Shapes
Shows all shapes that have previously been hidden.

Reset Points
Moves the selected points back to their original positions, adding 
a new keyframe for them at the current time.

Reset All Points
Same as above, but moves all points in the layer back to their 
original positions, not just the selected ones.
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Release Points
This command detaches the selected points from any bones they 
may be bound to.

Flexi-Bind Points
This command binds the selected points to bones in such a way 
that they will influenced by all the bones in the parent bone 
layer, depending on the strength and region of influence of each 
bone. This results in more of a “squishy” type of motion when the 
skeleton is animated. This is the default behavior for all drawings 
in Anime Studio, so you usually won’t have to use this menu 
command - the points are probably already flexi-bound.

Release Layer
This command detaches the current layer from any bone it may 
be bound to.

Flexi-Bind Layer
This command binds the current layer to the bones in the parent 
layer in such a way that the child layer will influenced by all 
the bones in the parent bone layer, depending on the strength 
and region of influence of each bone. This results in more of a 
“squishy” type of motion when the skeleton is animated.
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Hide Controlled Bones
Hides any bones that are set up to have their angle or position 
controlled by another bone. These types of bones are often not 
animated by the user (their animation is “automatic” through the 
control feature), and hiding them can clear up some of the clutter 
in the workspace. This function is not available when the time is 
set to frame 0.

Track Bone to Video
Allows you to link a bone to the tracking points that you defined 
with the Video Tracking tool. For a description of how to use this 
tool, see “Video Tracking” on page 294. 

Freeze Pose
Keyframing can be tricky sometimes for new users of Anime 
Studio, or for those who are new to animation. For example, let’s 
say you move a left foot up on frame 12, and then down again at 
frame 24. At frame 36, you want the right foot to move up, and 
then down again at frame 48.

The problem is, the right foot will start to move up at frame 0, 
and then be fully up at frame 36. In reality, you want the right 
foot to move up from frame 24 through 36, and not from frame 
0 through 36.

To accomplish this, you choose the Bone > Freeze Pose 
command at Frame 24. This sets a keyframe for every part 
in your animated character or object so that you are assured 
that the pose you want to use is correct for that portion of your 
animation. Then you set the keyframe that moves the right foot 
up at frame 36, and down again at frame 48.

 Freezing a pose

Reset Bone
Moves the selected bone back to its original position, adding a 
new keyframe for it at the current time.

Reset All Bones
Same as above, but moves all bones in the layer back to their 
original positions, not just the selected one.
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Allow Frame Skipping
Normally when playing back an animation, Anime Studio will 
display each frame one at a time. Depending on the complexity 
of your animation, the display quality settings, and the speed 
of your computer, the animation may play back slower than its 
specified speed. Select this command to force the animation to 
play back at actual speed. In order to accomplish this, Anime 

Studio may have to skip some frames to keep up to speed, so 
the animation will play back at the correct overall speed, but 
may not appear as smooth. The best way to see the animation at 
final speed and quality is of course to use the Export Animation 
command in the File menu.

Clear Animation From Layer
This command removes all animation from the current layer.

Clear Animation From Document
This command removes all animation from the entire document.

Reset All Layer Channels
Resets all channels in the current layer to their initial values, 
adding a new keyframe at the current time.
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Set Layer Start Time

Select All Keyframes
Selects all the keyframes in the current layer. This is useful if you 
want to move all the animation in a layer forward or backward.

Rescale Keyframes...
With this command you can rescale a group of keyframes so that 
a portion of your animation takes more or less time. 

 The Rescale Keyframes dialog.
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Options included in this dialog are:

•	 Rescale entire document: Check this option to rescale all 
frames in the document.

•	 Start Frame: Enter the existing frame number at which to 
start scaling.

•	 End Frame: Enter the existing frame number at which to 
end the scaling.

•	 New Start Frame: Enter the new target frame number for 
the start of the scaling.

•	 New End Frame: Enter the new target frame for the end of 
the scaling.

•	 Rescale the following channels: Check or uncheck the 
channels that you want to include or exclude from the 
scaling operation. The icons representing the various 
animation channels are described in the Timeline Window 
section.

Examples:

•	 To reduce the amount of time the animation takes (in other 
words, to speed it up), you could set the start frame (and 
new start frame) to 30, the end frame to 60, and the new 
end frame to 45. (45 - 30 = 15, which is half as long as 60 - 
30 = 30)

•	 You can shift a section of your animation by changing the 
start time. For example, to shift the range of keyframes 
between 30 and 60, you could set the start frame to 30, the 
end frame to 60, the new start frame to 90, and the new end 
frame to 120. The duration will be the same (120 - 90 = 60 
- 30), but the animation will take place between frames 90 
and 120, instead of 30 and You can rescale a portion of the 
entire document by clicking the “Rescale entire document” 
checkbox. 

•	 To rescale the current layer, select the animation channels 
that you want to be affected. For example, you may want 
to rescale the bone animation, but leave the layer rotation 
alone. 

Copy Current Frame...
With this command you can copy values from the current 
frame in the timeline to any other frame in your animation. For 
example, if you position some objects in a way that you really like 
at frame 243, you can use this command to copy that position 
back to frame 0, to make it the starting position as well.
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 The Copy Current Frame dialog.

Blend Morphs
You can use the Animation > Blend Morphs command to blend 
poses (or morph targets) together to create a combination pose 
or morph. This feature in Anime Studio 8 is very easy to use.

Anime Studio Pro allows you to both create and 
blend poses. See “Creating Morphs” on page 

407.

To blend your morphs, begin by moving to the frame at which 
you want the new morph to appear.

Next, choose the Animation > Blend Morphs command. The 
Blend Morphs dialog appears. The sliders in this dialog are 
named the same as the morphs you created in the Actions 
window. Adjust the sliders until you get a combination of the 
morphs that you want to keep. Then click OK to set the new 
combination.
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 Use the Blend Morphs dialog to combine your morphs together in 
any combination of values.

You can then advance to other frames in your timeline, and 
use the Blend Morphs command to create new combinations 
throughout the timeline. As you scrub through the timeline, you 
should then see morphs blend from one to the other.

You can select which animation channels to copy to a new 
frame, or you can copy everything in the document by selecting 
the “Copy entire document” checkbox. There doesn’t need to 

be a keyframe at the current frame in order to copy the current 
value. This command will copy the current value, whether it is a 
keyframe or an interpolated in-between value.

An important note about bones: if you position a 
skeleton system during your animation, and try 

to copy that pose back to frame 0, the bones themselves 
will take on that pose at frame 0, but anything bound to 
the bones (points in vector layers, warped images, other 
sub-layers) will not take on that pose. This is because 
frame 0 is a setup frame - bones are set up at frame 0, 
but they have no influence over other objects at frame 0. 
If you’re trying to copy a pose back to frame 0 in order 
to set up an initial pose, consider copying it back to 
frame 1 instead - frame 1 is actually the beginning of the 
animation, and the bones will influence other objects 
starting at frame 1.

Track Layer to Video
This command allows you to link a layer to tracking points that 
have been set up with the video tracking tool. For a complete 
description of the process, refer to “Video Tracking” on page 
294.
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Nudge Physics Object
A nudge is an instantaneous force that affects a physics object 
in small or large amounts, depending on the setting in the 
Physics Nudge dialog. It can be a large force, but after the nudge 
keyframe, the object will start falling, or bouncing, or whatever 
the situation requires. It won’t keep going in the nudge direction 
forever.

 The Physics Nudge dialog.

For example, assume that when you play your animation back 
you see a red ball roll down and bounce to a stop against a block. 
You can position the timeline shortly after it stops, and then 
apply a large nudge (such as 10) that causes the ball to fly off 
again to the left. Smaller nudge values cause objects to wobble.

Mute Audio
Mutes the soundtrack when playing back your project in Anime 
Studio, but the soundtrack is still a part of the project. Just un-
mute it to hear it again.

Restart Audio Track
Starts the audio track in the selected track over again from the 
beginning. This allows you to add repeats in the audio track.

Audio Level
Opens a dialog that allows you to enter a numerical value for the 
audio level.
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 Scripts Menu

The Scripts menu contains commands that are provided by 
script files or plug-ins. Anime Studio includes several scripts 
for a variety of different tasks, and you can also download more 
scripts written by other Anime Studio users. These scripts are all 
written in the Lua programming language - if you’re interested in 

creating your own scripts, feel free to examine the scripts in the 
scripts/menu sub-folder in the Anime Studio program folder.

The scripts in this menu are divided into several sub-menus, 
according to their function:

3D
The scripts in this menu are used to create or manipulate 3D 
models.

Auto-Scale

When you import a 3D OBJ file into your scene, it may be way 
out of scale with the Anime Studio scene. For example, a building 
may be so large that the Anime Studio camera is inside it, or off 
to one side, and you don’t really see anything on import. This 
script centers the object and scales it to an appropriate size for 
the default Anime Studio camera.

Cube

Creates a new 3D layer that contains a simple cube. The color of 
the cube is determined by the current fill and line colors.
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Rotate X

Rotates the current 3D layer 90 degrees around the X axis. 
This can be useful when importing a 3D model if the model’s 
“up” direction is not the same as Anime Studio’s - just use this 
command (and the other rotate commands) to align the model 
properly.

Rotate Y

Rotates the current 3D layer 90 degrees around the Y axis.

Rotate Z

Rotates the current 3D layer 90 degrees around the Z axis.

Torus

Creates a new 3D layer that contains a simple torus (donut). The 
color of the torus is determined by the current fill and line colors.

Camera
These scripts are used to move the camera around and to create 
camera-related effects.

Handheld Camera

Adds noisy interpolation to the camera animation channels to 
simulate a handheld camera.

Orbit Camera...

Adds animation to the camera to cause it to rotate around the 
current scene. You can specify how long this should take, how far 
out the camera should be, and the direction of rotation.

Draw
These scripts can be used to create vector objects in Anime 
Studio.

Apply Sketchy Effect

Applies a sketchy effect to the outline of the shape.

Auto Weld

Finds vector points that are near each other and welds them 
together. Only operates on selected points. This can be useful 
if you have accidental gaps in a drawing, or sometimes when 
working with imported Adobe Illustrator files.
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Polygon...

Draws a polygon shape in either the current vector layer, or 
a new layer. Uses the current fill and line colors to color the 
polygon.

Simplify Curve

Reduces the number of points in a curve by removing points 
which are calculated to be “unnecessary” to maintain the shape 
of the object. This makes it easier to edit your shapes later.

Split Curve

Automatically inserts points into selected curve segments, 
allowing you to modify existing shapes. 

Star...

Draws a star shape in either the current vector layer, or a new 
layer. Uses the current fill and line colors to color the star.

Toggle Legacy Curves

Turns on old style curves, which are less smooth than the new 
curve style. However, this is beneficial for use with files created 
in older versions of Anime Studio.

Image
These scripts can be used to process image layers.

Import Image Sequence...

Imports a numbered sequence of images. Each image is 
imported as its own layer, and the entire group is enclosed in a 
switch group. The image files should be named using a numerical 
sequence. For example, “file0001.jpg”, “file0002.jpg”, “file0003.
jpg”, etc.

Layer Effects
These scripts can be used to generate special layer effects.
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Layer Trail...

Creates an animated trail effect that follows the origin point of 
the current layer.

Perspective Shadow...

Automatically creates a pseudo-3D shadow effect for the current 
layer.

RT: Break Apart Shapes

Offers a number of different options in how you can break apart 
the shapes on a layer. You can put each shape in its own layer 
and group them together or put all shapes in one layer creating 
separate geometry for each shape. Additional options allow you 
to select filled shapes only, and to name layers according to group 
names or shape names. This script is very useful when working 
with physics.

Other
Scripts that don’t fit any other category can be found here.

Credits...

This script can be used to create lists of credits, or other screens 
of text. The script will prompt you to select a text file containing 
the text you want to use. In the text file, each “screen” of text 
should be separated by a blank line. Take a look at the file 
“sample_credits.txt” in the Anime Studio program folder to see 
how this text file should be set up.

Particle Effects
These scripts can be used to create particle effects like smoke, 
fire, or rain. Many of these effects can be time-consuming to 
render, so be aware of that if you plan to use several of them in 
a single animation. Also, even though they can be exported to 
Flash, these effects can be too complex for the Flash player to 
play at full speed. Plus, without the blur effects these scripts use, 
they won’t look very good in Flash. These effects are really useful 
only if you plan to export to a movie or still image format, not 
Flash.

Energy Cloud...

Creates a blobby glowing cloud effect.
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Explosion...

Creates an explosion effect. The explosion starts at the current 
frame, and will fade to a smoke cloud over time.

Rain

Inserts a falling rain effect.

Smoke...

Inserts a plume or cloud of smoke.

Snow

Creates a falling snow effect.

Sparkles...

Inserts a cluster of spiraling sparkles. This effect is very effective 
if you bind it to another moving object - for example, the end of 
a magic wand.

Script Writing
This menu contain utility scripts that can be used as examples 
for writing your own scripts. If you don’t plan to write your own 
scripts, you can completely ignore this menu.

Alert Test

Demonstrates how a script can use an alert box to provide some 
information to the user.

Automation Test

Shows how you can write a script that will open or save a 
document, create a new document, and render a document. The 
script opens all documents in a given directory and renders a 
frame for each one.

Error Test

This script intentionally creates a runtime error. The purpose is 
to show how the Lua Console appears to display the error. When 
you write your own scripts, the console window will be very 
helpful when tracking down errors.
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List Channels

Shows how a script can iterate through all of the animation 
channels in a layer. You can access every animateable parameter 
in the layer.

Load Data File...

This script is a demonstration of how a Lua script can read data 
from an external file. It doesn’t do anything useful itself, but it 
could be used as a starting point if you wanted to write a script to 
import some kind of custom data.

Print Anime Studio API

Prints out all functions, constants, and global variables that 
Anime Studio provides through its scripting interface. This is 
not meant to be the documentation for Anime Studio’s scripting 
interface, but some script writers may find it useful.

Print Globals

Prints out all global variables currently defined in Lua.

Print Test

A simple example that shows how you can print output in a 
Lua script. The printed output will appear in the Lua Console 
window. Printing data in the console window is not generally 
useful when your script is delivered to regular Anime Studio 
users, but can be very helpful when writing a script to track down 
bugs.

Sound
The scripts in this menu use sound to control some part of an 
animation.

Bone Audio Wiggle...

This script uses the volume of a sound file that you select to 
animate the angle of the currently selected bone. Use this script 
to make a character or object move in sync with a sound.

Layer Audio Wiggle...

Use this script to make a layer move in sync with a sound.
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Visibility
These scripts affect the visibility of a layer - for example, causing 
it to fade in and out.

Fade...

Causes the current layer to fade in or out over a specified number 
of frames. If you want a layer to appear or disappear suddenly, 
it is better to change the value of the layer’s visibility channel. 
However, this script should be used when you want a layer to 
appear or disappear more gradually.

Wavy Fade...

This script combines the Fade effect above with the Wavy effect 
below. It can only be used with vector layers.

Warp
This set of scripts is used to distort the contents of a vector layer, 
applying various animated warping effects.

Black Hole...

Causes the selected points in a vector layer to swirl around in an 
inward spiral motion towards the origin point of the layer.

Wavy...

Causes the selected points in a vector layer to move in a wavy or 
underwater style.
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 View Menu

Reset
Resets the view of the working area to the starting pan and zoom 
values. Use this command when you want to jump back to the 
original view of the project.

Direction
This sub-menu lets you select a direction to view your scene 
from. The default view is through the camera - however, 
sometimes when you’re working on a scene with a 3D layout, 
you may want to view the scene from a different point of view. 
Options are Camera, Front, Top, Right, Back, Bottom, and Left.

Enable Grid
Toggles display of the grid on and off. A checkmark appears 
beside the command when the grid is displayed.

Grid Settings
Displays the Grid Settings dialog, which allows you to set the 
number of pixels between each grid space. Default is 20 pixels.

Disable Grid Snapping
When the grid is turned on, control points will snap to the 
nearest grid intersection as you draw them and move them 
around. Select this menu command to disable grid snapping - 
that way you can use the grid as just a visual guide, without it 
interfering in your drawing.
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Video Safe Zones
This command turns on the display of NTSC “safe zones”. When 
creating output for video, it is important to keep important 
action and titles within the safe zones, because most televisions 
cut off some portion of the outside of the picture. (The inner 
rectangle is the safe zone for titles, and the outer one for 
important action.)

Show Output Only
This command will hide all artwork that lies outside the final 
output rectangle. This makes it easy to visualize the final staging 
for your shot. Of course, it’s hard to edit what you can’t see, so be 
sure to turn this option off when you need to edit an object that 
lies outside the visible area of the project.

Select Tracing Image
Use this command to select a tracing image to display in Anime 
Studio’s editing view. This image will not appear in your final 
output - it’s just used as a tracing guide to help you draw your 
artwork in Anime Studio.

Show Tracing Image
To use a background image for tracing out a drawing, just drag 
the image into the working area of the Anime Studio window, or 
use the above menu command. Then, you can use this command 
to hide or show that tracing image. To use a different tracing 
image, just drag a new one in.

Stereo
If Enable Stereo (Red/Blue)Rendering is enabled in the Project 
Settings dialog (see “Project Settings...” on page 414), this 
command makes it easier to preview and reposition your 3D 
objects for stereo rendering.
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 Window Menu

Tools
Shows/hides the Tools window. The Tools window is shown by 
default when you start Anime Studio. Tools are discussed in the 
section beginning with “Anime Studio Tools” on page 206.

Layers
Shows/hides the Layers window. The Layers window is shown by 
default when you start Anime Studio. See “Layers Window” on 
page 314.

Timeline
Shows/hides the Timeline window. The Timeline window is 
shown by default when you start Anime Studio. See “Timeline 
Window” on page 392.

Style
Shows/hides the Style window. The Style window is shown by 
default when you start Anime Studio. See “Style Window” on 
page 339.

Actions
Shows/hides the Actions window. The Actions window is hidden 
by default when you start Anime Studio. See “Actions Window” 
on page 404.

Library
Displays the Library window, which is discussed in “The Library 
Window” on page 352.
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Audio Recording
Displays the Audio Recording window, which is discussed in 
“Audio Recording” on page 391.

Poser Parameters
Opens the Poser Parameters dialog, which allows you to rotate or 
scale Poser objects that are imported into your scene. For more 
information, see “Special Tools” on page 290.
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 Help Menu

Quick Start Guide
Opens the PDF version of the Anime Studio Quick Start Guide, 
which is installed on your hard disk.

Help
Opens this document, the Anime Studio User’s Manual.

Open Content Library
Opens the Content Library.

Online Tutorials
Opens a web browser with Anime Studio online tutorials. 
Internet connection will be required.

Welcome Screen
Opens the Welcome Screen.

Register Your Product
Register your product to receive information on updates and 
upgrades. Internet connection will be required.
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Download Bonus Content Pack
Navigates to the Bonus Content Pack page on Content 
Paradise. You will need a Content Paradise account and a valid 
Anime Studio 8 serial number to obtain the content.

About Anime Studio Pro
Displays some information about Anime Studio, including which 
version of Anime Studio you’re running.

About Scripts
Displays some information about all the scripts currently loaded 
by Anime Studio. All of Anime Studio tools, and all the entries 
in the Scripts menu are implemented in a scripting language 
called Lua. Although some programming/scripting experience 
is required, Anime Studio users are welcome to write their own 
scripts to extend Anime Studio’s built-in features.

Buy Content
Help speed up your animation workflow with ready to use 
content. Buy content from Content Paradise. Internet connection 
will be required.

Check For Updates
Check to see if there are any updates for Anime Studio. Internet 
connection will be required.
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The differences between Anime Studio Debut and Pro 

Feature Comparisons

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Animation Length 2 minutes (3000 
frames)

Unlimited

Motion Tracking 3 points Unlimited

Audio Tracks 2 tracks Unlimited

Video Tracks 1 track Unlimited

Physics No Yes

Poser scene import No Yes

3D layer and object support No Yes

Morph targets Read Only Read and 
create

Automatic image tracing Black and white 
only

Black and 
white, color, 
and edges

Particles Read only Read and 
Create

Import Photoshop Files Yes (1) Yes (2)

Real-time media connection No Yes

Patch Layers Read only Read and 
create

3D Video rendering No Yes

Global Rendering Styles No Yes

Scripting No Yes

Layer Outline Yes Yes

(1) Layered using Anime Studio script

(2) Import directly through File menu.

Window Menu

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Tools X X

Beginner’s Mode Tools X

Layers X X

Timeline X X
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Style X X

Actions X

Library X X

Audio Recording X X

Poser Parameters X

Character Wizard X X (1)

(1) Character Wizard in Pro lets you use and create reusable 
actions that can be applied to any character created with the 
Wizard.

Vector Drawing Features

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Text X X

Select Points X X

Translate Points X X

Scale Points X X

Rotate Points X X

Add Point X X

Delete Edge X X

Curvature X X

Freehand X X

Rectangle X X

Oval X X

Arrow X X

Shear Points X X

Shear Points Y X

Perspective Points H X

Perspective Points V X

Bend Points H X

Bend Points V X

Noise X

Magnet X

Snap to Grid X

Reset Line Width X

Random Line Width X

Vector Modifiers

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Peak X X
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Smooth X X

Flip Points Horizontally X X

Flip Points Vertically X X

Fill Features

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Select Shape X X

Create Shape X X

Paint Bucket X X

Delete Shape X X

Line Width X X

Hide Edge X X

Stroke Exposure X

Curve Profile X

Fill Modifiers

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Lower Shape X X

Raise Shape X X

Bone Features

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Select Bone X X

Translate Bone X X

Scale Bone X X

Rotate Bone X X

Add Bone X X

Reparent Bone X X

Bone Strength X X

Manipulate Bones X X

Bind Layer X X

Bind Points X X

Offset Bone X X

Bone Physics X
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Layer Features
Feature Anime 

Studio 
Debut

Anime 
Studio 
Pro

Set Origin X X

Translate Layer X X

Scale Layer X X

Rotate Layer Z X X

Switch Layer X X

Rotate Layer X X

Rotate Layer Y X

Shear Layer X X

Shear Layer Y X

Particle Layer X

Follow Path X X

Poser X (1)

Image Masking X X

Video Tracking X (2) X

Audio Layers X (3) X

Vector Shape Selector X X

(1) Requires Poser 7 or newer

(2) Limited to 3 tracking points

(3) Limited to 2 audio layers

Layer Modifiers

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Flip Layer Horizontally X X

Flip Layer Vertically X X

Layer Types

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Vector X X

Image X X

Bone X X

Switch X X

Group X

Particle X

3D X

Physics (Layer property) X
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Note X

2D to 3D Layer Conversion X

Patch X

Camera Features

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Track Camera X X

Zoom Camera X X

Roll Camera X X

Pan/Tilt Camera X

Workspace Features

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Pan Workspace X X

Zoom Workspace X X

Rotate Workspace X

Orbit Workspace X

Timeline Features

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Keyframes X X

Playback Controls X X

Animation Channels X X

Ruler X X

Onionskins X

Graph Mode X

Sequencer X X

Action Features

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Store Reusable Animation X

Edit Reusable Animation X

Delete Reusable Animation X
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Style Features

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Save Style X

Pattern Brush X (1) X

(1) Pro version contains more brushes

Preferences

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Options X X

Editor Colors X X

GUI Colors X X

GUI Color Themes X X

Project Settings
Feature Anime 

Studio 
Debut

Anime 
Studio 
Pro

Save Project Settings X X

Edit Dimensions X X

Background Color X X

Depth of Field X

3D Camera X

Stereo Rendering X

Sort Layers by Depth X X

Sort by True Distance X X

Noise Grain X

Up to 120 Frames/Second 
Maximum

X X

Maximum export size (pixels) 788 x 768 9000 x 9000

Maximum number of frames 3000 Unlimited

Content

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro



Anime Studio Pro 8
Users Manual

483

Product Comparison

Built in Content X X

Third Party Content X X

3D Object X

Scripts

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

3D X

Camera X

Draw X

Image Sequences X

Layer Effects X

Particle Effects X

Sound X

Warp X

Visibility X

Script Writing X

View

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Grid X

Adjust Grid Size X

Side by Side View X

Over Under View X

Four-Way View X

Display Quality X

Advanced Current Layer View X

Import

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

2D FORMATS
JPEG X X

BMP X X

PSD X (1) X (2)

PNG X X
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TGA X X

EPS, AI, Tracing Image X

3D FORMATS
OBJ X

SOUND FORMATS
WAV (Windows & Mac) X X

AIFF (Windows & Mac) X X

MP3 (Windows & Mac) X X

M4A (MPEG-4) X X

MOVIE FORMATS
MOV (Mac and Windows) X X

AVI (3) X X

MPEG-4 Video X X

MOHO FORMAT
MOHO File Format X X

(1) Layered using Anime Studio script.

(2) Directly through File menu.

(3) AVI Import works on Windows, and on Macintosh systems 
depending on codecs. If you can play the AVI file in QuickTime 
on a Mac, you should be able to import it into Anime Studio.

Export Formats

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

IMAGE FORMATS
JPEG X X

BMP X X

PSD (Layered) X

PNG X X

TGA X X

Batch Image Export X

MOVIE FORMATS
SWF (1) X X

MOV (Macintosh and Windows) X X

AVI (WIndows Only) X X

Sequential JPEG X

Sequential BMP X

Sequential PSD X

Sequential PNG X

Sequential TGA X

Batch Movie Export X
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TV FORMATS
NTSC Format X X

PAL X X

HD movies X

(1) SWF: Vector animations only; image layers can be used as 
long as they are not warped by bones. See “Exporting Flash” on 
page 434 for more information.

Upload Features

Feature Anime 
Studio 
Debut

Anime 
Studio 
Pro

Upload to Facebook® X X

Upload to YouTube™ X X
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Technical Support: 
Where to Go When You 

Need Help

User Manual
The first source of help when using Anime Studio is the manual 
that you are reading now. We have also included a Quick Start 
Guide that you can view by choosing Help > Quick Start Guide 
from the Anime Studio menus. If you’re just getting started and 
need some basic tips on how to use Anime Studio, beginning with 
“Anime Studio Tutorials” on page 17 is a good place to start.

For more in-depth instructions on using Anime Studio, the 
sections “Anime Studio Windows” on page 309 and “Anime 
Studio Menus” on page 411 go into great detail about 
performing specific tasks in Anime Studio and what all the user 
interface elements are used for, respectively.

Anime Studio on the Web
Another good source is the Smith Micro web site at http://
anime.smithmicro.com. There you will find product information 

and a variety of tutorials. We plan to keep this updated with 
questions and answers and new sample files.

To view in-depth product descriptions, online video gallery, and 
more, visit http://anime.smithmicro.com.

Anime Studio Discussion Forum
Share tips and tricks with other Anime Studio users on the online 
discussion forum: http://www.lostmarble.com/forum/. Smith 
Micro staff members also participate in this online group, and are 
happy to share techniques and answer questions. News about the 
latest Anime Studio updates is first posted to the online forum.

Email Support
You can also get your questions answered by email. If you have a 
question, feature request, or would like to report a bug, contact 
us at cs@smithmicro.com. Please provide us with as much 
detail about your problem as possible, so that we can understand 
exactly what’s happening and more quickly come up with a 
solution for you.

http://anime.smithmicro.com
http://anime.smithmicro.com
http://anime.smithmicro.com/
http://www.lostmarble.com/forum/
mailto:cs%40smithmicro.com?subject=
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Some parts of Anime Studio are based on libraries written by 
third party organizations. Below is a list of libraries used by 
Anime Studio.

•	 Anti-Grain Geometry http://www.antigrain.com Copyright 
© 2002-2004 Maxim Shemanarev (McSeem). 

•	 FreeType http://www.freetype.org Portions of this software 
are copyright © 1996-2002 The FreeType Project. All rights 
reserved. 

•	 libjpeg http://www.ijg.org This software is based in part 
on the work of the Independent JPEG Group. Copyright © 
1991-1998, Thomas G. Lane. 

•	 libpng http://www.libpng.org Copyright © 1998, 1999, 
2000 Glenn Randers-Pehrson. 

•	 libsndfile http://www.mega-nerd.com/libsndfile/ 
Copyright © 1999-2005 Erik de Castro Lopo. 

•	 Lua http://www.lua.org Copyright © 2004 Tecgraf, PUC-
Rio. 

•	 Ming http://www.libming.org/ Copyright © 2001 Opaque 
Industries. 

•	 PortAudio http://www.portaudio.com Copyright © 1999-
2000 Ross Bencina and Phil Burk 

•	 zlib http://www.zlib.net Copyright © 1995-2002 Jean-loup 
Gailly and Mark Adler. 

Artist Acknowledgements
Smith Micro and Lost Marble would like to thank the following 
artists for contributing to the content section. To access these 
files, open Window > Library and navigate to a “Partners” 
Folder. Their creations will be displayed within a folder with 
their name as the title..

•	 DK Toons http://www.contentparadise.com/Search.
aspx?searchText=DKToons

•	 Cartoon Solutions http://www.cartoonsolutions.com

•	 ToonProps http://www.toonprops.com

•	 Víctor Paredes (Studio: Taza Triste): http://www.youtube.
com/tazatriste

•	 Hubumedia http://www.hubumedia.com (tweet: www.
twitter.com/hubumedia)

http://www.antigrain.com
http://www.freetype.org
http://www.ijg.org
http://www.libpng.org
http://www.mega-nerd.com/libsndfile/
http://www.lua.org
http://www.libming.org/
http://www.portaudio.com
http://www.zlib.net
http://www.contentparadise.com/Search.aspx?searchText=DKToons
http://www.contentparadise.com/Search.aspx?searchText=DKToons
http://www.cartoonsolutions.com
http://www.toonprops.com
http://www.youtube.com/tazatriste
http://www.youtube.com/tazatriste
http://www.hubumedia.com
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•	 Alexander Roach (Rudiger): http://www.contentparadise.
com/Search.aspx?searchText=Rudiger)

•	 The Smith Micro Content Team

Smith Micro would like to thank the following artists for imagery 
used in collateral and Promos.

•	 DK Toons http://www.contentparadise.com/Search.
aspx?searchText=DKToons

•	 Cartoon Solutions http://www.cartoonsolutions.com

•	 Cartoon Workshop Sdn Bhd: http://www.cartoonworkshop.
com.my

•	 ToonProps http://www.toonprops.com

•	 Hubumedia http://www.hubumedia.com (tweet: www.
twitter.com/hubumedia)

•	 TUI Studios http://www.tuistudios.com

•	 Freakish kid http://www.freakishkid.com

•	 Naive: http://www.naive.se

•	 Mike Scott Animation http://www.bruandboegie.co.za

•	 Curious Projects: http://www.curiousprojects.com

User Samples/Characters

Library > Characters > Version 5> User Samples

•	 Nate Greenwall: knight Master

•	 Burt Abreu: Jeremy

•	 Philippe Cizaire: frog, stampel

•	 Shi Yang: A2, A3, A4, A6, A7

•	 Víctor Paredes (Studio: Taza Triste): african elephant

•	 Vladimir O. (Studio: StudioSvet): golova, Kati, KISSKI, 
kot, Kozel, lef, sc, slon, tigr, volk, zaiac, zebr

User Movies

Library >Video > Animated Samples > Version 5 User 
Samples

•	 Burt Abreu: fishtank1

•	 Christian -Samb- Wasser (Studio: By Samb): sunscene

•	 Dave Cockburn (Studio: Squeaky Pics): Squeaky_10sec

•	 Erik Svensson: Ghost

http://www.contentparadise.com/Search.aspx?searchText=Rudiger
http://www.contentparadise.com/Search.aspx?searchText=Rudiger
http://www.contentparadise.com/Search.aspx?searchText=DKToons
http://www.contentparadise.com/Search.aspx?searchText=DKToons
http://www.cartoonsolutions.com
http://www.cartoonworkshop.com.my
http://www.cartoonworkshop.com.my
http://www.toonprops.com
http://www.hubumedia.com
http://www.tuistudios.com
http://www.freakishkid.com
http://www.naive.se
http://www.bruandboegie.co.za
http://www.curiousprojects.com
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•	 Mike Scott (Studio: Red Pepper): COOL_CATZ_INTRO_1

•	 Misha Margolis: barnstory

•	 Shi Yang: A1, A5

•	 Vladimir O. (Studio: StudioSvet): otkritka

•	 Víctor Paredes (Studio: Taza Triste): dragón pulento

Direction, script, animation: 

•	 VENT_ErikvanSchaaik, Erik van Schaaik, www.
erikvanschaaik.com, info@erikvanschaaik.com

Production:

•	 Il Luster Productions, www.illuster.nl, illuster@illuster.nl

User Samples/Props

Library > Props > Version 5 User Samples

•	 Burt Abreu: blurtest, bumpy1, curvetest1, epidea1, hair1, 
hand1, leaf1, man1, mouth, myfish2, myfish3, oldman1, 
rasbora_maculata, robohead1, sparkdraw, weedy1

•	 Christian -Samb- Wasser (Studio: By Samb): people

•	 Erik Svensson: Fire, Tree, Water ripple

•	 Philippe Cizaire: collection

•	 Vladimir O.: flag, glaz1, glaz2, glaz3, glaz4, glaz5, gudok, 
noga, palec

DK Content

Library > Props > Partners> DK Toons

•	 David Knight (Studio: Knight animations): Acoustic 
Guitar by D.K, Aliens Dance and Walk by D.K, Anime girl 
frightened - by D.K, Builders - by D.K, Cartoon Fruit - by 
D.K, Cow with Guitar - by D.K, Cupboard with doors - by 
D.K, Funny guy - by D.K, Mobile Phone - by D.K, Modern 
Dude - by D.K, Running Heart - by D.K, Slick Salesman by - 
D.K, Two simple boys - by D.K
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Anime Studio Shortcuts
How to work quickly in Anime Studio 

Once you’ve been using Anime Studio for a while, you’ll probably 
want to find ways to speed up certain operations. Luckily, Anime 
Studio provides several shortcuts for common operations, such 
as activating tools, navigating the workspace, and entering data. 

Keyboard Shortcuts
Many tools and features in Anime Studio can be accessed quickly 
by pressing a single key. These shortcuts make working with 
Anime Studio much faster than the regular method of moving the 
mouse to a toolbar and clicking a button, and are worth learning 
to reduce your drawing and animation time. However, all these 
features are also available through standard user interface 
elements (buttons and menus), so learning these shortcuts isn’t a 
requirement to using Anime Studio.

Note: these shortcuts are not the same as “menu shortcuts”. 
Many of Anime Studio’s menu commands can be accessed 
through the keyboard - for example, Ctrl/Cmd+S will save the 
current document. Those types of shortcuts are listed next to 
the menu item they apply to: just run the program and look at a 
menu to find the shortcut.

 Press the T key to activate the Translate Points tool.

Many of the keyboard shortcuts in Anime Studio are used to 
activate a tool in a toolbar. If you want to know whether a tool 
has a shortcut, hold the mouse over the tool, and watch the 
tooltip that appears. If the tooltip has a single letter at the end 
(ex: “Translate Points (T)”), then that key can be used as a 
shortcut to activate the tool. These keyboard shortcuts are not 
listed here - just look at the tooltips in Anime Studio if you want 
to learn them.

Some keyboard shortcuts work all the time, and some only apply 
in while using certain tools in Anime Studio: the sections below 
lists all the shortcuts and when they can be used.

Common Shortcuts

The following keyboard shortcuts can be used at any time:
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•	 Escape: Automatically adjust the view to see everything 
in the active layer - hold the shift key to zoom in on the 
currently selected points

•	 Home: Reset the view to see the overall project

•	 Enter/Return: De-select all points

•	 Tab: Select all points that are connected to the current 
selection

•	 Left Arrow: Step back one frame in the timeline - hold shift 
to rewind

•	 Right Arrow: Step forward one frame in the timeline - hold 
shift to advance to end of animation

Working with Vector Layers

•	 Delete/Backspace: Delete the currently selected points

•	 Spacebar: Weld two points together - usually used with the 
Translate or Add Point tools

Working with Fill Tools

•	 Delete/Backspace: Delete the selected shape

•	 Spacebar: Define a shape based on current selection

•	 Up Arrow: Raise selected shape up one level - hold shift to 
raise to top

•	 Down Arrow: Lower selected shape down one level - hold 
shift to lower to bottom

Working with Bone Tools

•	 Delete/Backspace: Delete the selected bone (and any child 
bones)

•	 Spacebar: Bind points to selected bone

•	 Up Arrow: Select parent of current bone

•	 Down Arrow: Select child of current bone (only works if 
current bone has just one child)

Working with the Timeline Window

•	 Alt/Option+Backspace: Delete the selected keyframe(s)

•	 Alt/Option+C: Copy the selected keyframe(s)

•	 Alt/Option+V: Paste the previously copied keyframe(s)
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•	 Spacebar: Play/stop the animation

•	 Page Up: When in graph mode, zoom in on the timeline - 
hold shift to move the graph up

•	 Page Down: When in graph mode, zoom out from the 
timeline - hold shift to move the graph down

•	 End: Auto-zoom the timeline, based on the active animation 
channel (when in graph mode)

Mouse Shortcuts
There are a few shortcuts that take advantage of the mouse, 
making work in Anime Studio more convenient once you learn 
them.

Workspace Navigation

The right mouse button can be used to navigate the main Anime 
Studio workspace. 

•	 To pan the workspace, click and drag with the right mouse 
button. 

If you hold down the spacebar while you click 
and drag any tool with the mouse, it will let you 

pan the workspace. This is similar to the panning 
navigation in Photoshop and other graphics 
applications.

•	 To zoom the workspace, hold the shift key while dragging 
left or right with the right mouse button. You can also zoom 
the workspace by rolling the mouse wheel back and forth 
over the workspace. 

•	 To rotate the workspace, hold down the control key while 
dragging with the right mouse button.

Timeline Scrubbing

To scrub the timeline in small increments, hold the mouse over 
the timeline and roll the mouse wheel back and forth.

Numeric Fields and Angle Knobs

An easy way to make small adjustments in numeric text fields 
and angle knobs is to hold the mouse over the control and spin 
the mouse wheel back and forth. Of course, you can still enter 
values into a text field by typing them, but this method lets you 
make small adjustments and view the changes immediately.
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•	 On a Windows PC, when using the mouse wheel to modify 
the value in a text field, holding the Ctrl key halves the 
increment, holding Shift doubles the increment.

•	 On a Macintosh, when using the mouse wheel to modify 
the value in a text field, holding the Cmd key halves the 
increment, holding Alt doubles the increment.

This feature may seem cute but unimportant. However, it’s 
actually very useful when working with the tool info panels 
in Anime Studio. By using the mouse wheel, you can see your 
changes take effect immediately. If you enter the number by 
hand, the change won’t take effect until you press tab or enter. 
An especially helpful place to use this feature is when setting 
bone angle constraints - these numbers can be tricky to figure 
out, but spinning the mouse wheel you can see exactly what’s 
happening.

Finally, you can adjust the value of a text field by dragging in it 
side-to-side with the right mouse button. With a regular mouse, 
the mouse wheel is probably more convenient, but this feature 
was added specifically for animators working with tablets. A 
drawing pen usually has no mouse wheel, so right-dragging 
allows you to adjust the value of a text field without having to 
switch back to the keyboard.
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Deleting  407
Editing  405
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Animation

Frame by Frame  147
Animation channels  396
Animation Curves  129
Animation Menu Commands  457

Allow Frame Skipping  457
Audio Level  462
Blend Morphs  460
Clear Animation from Document  

457
Clear Animation from Layer  457
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Mute Audio  462
Nudge Physics Object  462
Rescale Keyframes  458
Reset All Layer Channels  457
Restart Audio Track  462
Select All Keyframes  458
Set Layer Start Time  458
Track Layer to Video  461

Animations
Exporting  432

Animation Tutorials  123
Anime Studio Discussion Forum  
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Anime Studio Web Support  486
Arranging Foreground Objects  155

Arrows  222
Audio Layers  277
Audio Recording  391
Audio Sync Sources  334
Automatic Lip-Sync  124
Auto shading  320

B
Background color  415
Basic Physics  161
Bend Points Tool  229
Bind Layer Tool  259
Bind Points Tool  259
Bone Binding  66

Automatic  66
Layer  73
Manual  70

Bone Constraints  75
Angle  76

Bone Dynamics  85
Bone Influence

Adjusting  97
Bone Layers  269
Bone Locking  81
Bone Menu Commands  455

Flexi-Bind Layer  455
Flexi-Bind Points  455
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Freeze Pose  456
Hide Controlled Bones  456
Release Layer  455
Release Points  455
Reset All Bones  456
Reset Bone  456
Track Bone to Video  456

Bone-Only Channels  398
Bone Physics Tool  260
Bone Spring Parameters  88
Bone Strength Tool  257
Bones Tutorials  66
Bone Tools  252
Bonus Content

Downloading  475
Brushes  40

C
Camera and Depth Effects  195
Camera Channels  397
Camera movements

Layers immune to  323
Cameras

Animating  198
Camera Tools  305
Category Icons  353
Character Setup  91

Character Wizard  2, 366
Arms  371
Body Tab  369
Changing character views  367
Clothing Tab  377
Creating content for  388
Designing actions  386
Exporting views  368
Eyes  373
Face Tab  372
Head  372
Head props  374
Legs  370
Making a character walk  381
Mouth  374
Movement Tab  375
Nose  374
Pants  377
Presets  366
Proportions  369
Randomizing characters  368
Rotating character views  383
Shirt  378
Style Tab  378
Walk Cycles  380

Color Picker  346
Color Swatches  347
Compositing Effects  319

Control Bones  79
Crayon

Fill effects  344
Create Shape Tool  231
Creating a 3D Scene  152
Creating a Ground Plane  153
Creating Holes  30
Curvature Tool  226
Curve Exposure Tool  241
Curve Profile Tool  242
Cycling  138

D
Delete Edge Tool  226
Delete Shape Tool  238
Depth

Creating  134, 196
Sorting layers by  136

Depth of field  416
Layers immune to  323

Depth Sorting  60
Display Quality  313
Drawing Shapes with Holes  29
Drawing Tutorials  18
Draw Menu Commands  448

Hide Shape  454
Insert Text  448
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Lower Shape  449
Lower to Back  449
Peak  449
Raise Shape  449
Raise to Front  449
Random Line Width  448
Reset All Points  454
Reset Line Width  448
Reset Points  454
Show All Shapes  454
Smooth  449
Snap to Grid  448

Draw Shape Tool  220
Draw Tools  207
Drop Shadow  343

E
Edit Menu Commands  441

Clear  441
Copy  441
Cut  441
Paste  441
Preferences  442

Editor Colors  445
GUI Colors  446
Options Tab  442
Web Uploads  444

Redo  441
Select All  441
Select Connected  442
Select Inverse  442
Select None  441
Undo  441

Effects Tutorials  168, 366
Email Support  486
Embedded script files  322
End caps

Rounded option  348
Exporting

Still images  438
Extrude Conversions  63
Eyedropper Tool  239

F
Facing a camera  322
File Menu Commands  412

Batch Export  439
Close  412
Export Animation  431
Export OBJ  438
Export POV  438
Gather Media  413
Import  420
New  412

Open  412
Open Recent  412
Preview  431
Quit  440
Save  412
Save As  413
Upload to Facebook  439
Upload to YouTube  439

Fill Properties  339
Fills

Complex shapes  246
Compound shapes  248
Picking colors  245
Using two  250
Working with  245

Fill Tools  231
Flash

Exporting  434
Flip horizontally  321
Flip vertically  321
Follow Curve Tool  285
Following a path  322
Freehand Curves  40
Freehand Tool  218

G
Gradient Fill Effects  342
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Check for Updates  475
Help  474
Online Tutorials  474
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Quick Start Guide  474
Register Your Product  474
Welcome Screen  474

Hidden Edges  32
Hide Edge Tool  240
Holes  30
HSV modifier images  322

I
Image Layers  102, 268
Image Masking Tool  293
Image Texture Fill Effects  343
Image Textures  113
Image Tutorials  102

Image Warping  106
Importing Textures  118
Inflate Conversions  65
Insert Text Tool  223

K
Keyboard Shortcuts  490

Bone Tools  491
Common  490
Fill Tools  491
Timeline Window  491
Vector Layers  491

Keyframes  399

L
Lathe Conversions  64
Layer blending  323
Layer blur radius  319
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Layer Glow  192
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Layer Masking  45
Layer Motion Channels  397
Layer opacity  320
Layer Outline  194
Layers

3D  277
Aligning  266
Animated effects  319
Creating new  317
Deleting  317
Duplicating  317
Hiding  319
Naming  318
Patch  278
Rendering off  319
Settings  317
Sorting by depth  133

Layer Settings
3D Options Tab  335
Depth Sort Tab  330
General Tab  318
Image Tab  331
Masking Tab  327
Motion Blur Tab  326
Note Tab  337
Particles Tab  335
Physics Tab  338
Shadows Tab  323
Switch Tab  334
Vectors Tab  329

Layer Shading  324
Layer Shadow  191
Layer Shadows  323
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Layers Window  314
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Layer Tools  281
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Lip-Sync  124, 126
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Masking  119
Moon and Clouds Effect  203
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Creating  407
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Motion Graph  402
Mouse Shortcuts  492
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Timeline Scrubbing  492
Workspace Navigation  492
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Using in image layers  182
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Particles  168

Changing settings  173
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Speeding up effects  180
Using layers  169
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